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ÜBER DIESES HANDBUCH 

SYMBOLE 

Sie finden in diesem Handbuch wichtige Informationen, die Ihnen helfen werden, die Funktionen und die sichere Anwendung des Geräts zu verstehen. Diese wichtigen 
Informationen werden mit den folgenden Symbolen hervorgehoben: 

VORSICHT 

Dies sind Informationen, die Sie kennen müssen, um geringfügige Verletzungen oder eine Produktschädigung zu verhindern. 

WICHTIG 

Dies sind wichtige Informationen über die Anwendung des Geräts. 

HINWEIS 

Dies sind nützliche Informationen oder Gedächtnisstützen zur Anwendung des Geräts. 

ABKÜRZUNGEN 

In diesem Handbuch verwendete Abkürzungen: 

• CHC: Central Hub Computer (in diesem Dokument kurz Hub genannt)

• CFG: Software Configuration File (Softwarekonfigurationsdatei)

• HMI: Human Machine Interface (Mensch-Maschine-Schnittstelle)
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EINFÜHRUNG UND RICHTLINIEN FÜR DIE 
ANWENDUNG 

LABORIEs modulares AQUARIUS®-System der nächsten Generation ist ein 
vollständig kabelloses System, das Mobilität und Anwenderfreundlichkeit bietet. 
Die Untersuchungsverfahren können mit montierbaren Modulen durchgeführt 
und von der AQUARIUS®-Software kontrolliert werden. 

Anschluss an alle Geräte über einen Hub (CHC). Die kabellosen und batte-
riebetriebenen Funktionen jedes Geräts ermöglichen eine verbesserte 
Systemeinrichtung und -anwendung. 

Informationen zur Gewährleistung und zu den Geschäftsbedingungen finden Sie auf 
der folgenden Website: 
http://www.laborie.com/terms-and-conditions/ 

[DE]
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VORSICHTSMAßNAHMEN UND WARNHINWEISE 

 VOR GEBRAUCH SORGFÄLTIG LESEN!

VORSICHT 

NACH DEN BUNDESGESETZEN DER VEREINIGTEN STAATEN VON AMERIKA DARF DIESES GERÄT NUR VON EINEM ZUGELASSENEN ARZT ODER AUF 
ANORDNUNG EINES ZUGELASSENEN ARZTES VERWENDET WERDEN. 

WARNHINWEISE 

NUR VON LABORIE GESCHULTE TECHNIKER DÜRFEN DAS GERÄT WARTEN 

LABORIE Geräte und Zubehörteile sind von Regierungs- und Sicherheitsbehörden NUR für die Anwendung untereinander 
zugelassen und genehmigt. 

Die Garantie für LABORIE Geräte und Zubehörteile gilt NUR dann, wenn diese ausschließlich untereinander angewendet 
werden. 

Nicht verwenden, wenn die Verpackung des Geräts geöffnet oder beschädigt ist, oder wenn das Gerät Defekte aufgrund von 
unsachgemäßem Transport, unsachgemäßer Lagerung oder Handhabung aufweist, wodurch seine Verwendung beeinträchtigt 
sein könnte. 

Während der Untersuchungsverfahren sicherstellen, dass alle Räder blockiert sind, um eine Verletzung des Patienten zu 
verhindern. Nicht auf dem Gerät abstützen und keine zu schweren Gegenstände außer dem LABORIE-Standardzubehör an der 
Plattform anbringen. 

Mit Vorsicht vorgehen, wenn der PC und der Monitor von der niedrigsten Position angehoben werden, da sich die Halterung 
aufgrund der starken Federn, die zum Ausbalancieren des Gewichts verwendet werden, abrupt nach oben bewegen kann. 

Das UDS oder seine Komponenten nicht in Wasser oder andere Flüssigkeiten eintauchen. 

Die Finger nicht in das Innere des Pumpenkopfes stecken, wenn die Pumpenrollen sich bewegen. 
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LABORIE ist nicht verantwortlich für den Verlust von Patientendateien oder Untersuchungsdaten. Es wird empfohlen, die 
Patientendaten regelmäßig zu sichern. 

NICHT bei Vorhandensein einer entflammbaren anästhetischen Mischung mit Luft, Sauerstoff oder Distickstoffoxid verwenden. 

KEINE Elektromyografie (EMG) in der Umgebung von chirurgischen Hochfrequenzgeräten durchführen. 

AQUARIUS® NUR zusammen mit LABORIE-Geräten und -Zubehör verwenden. Einmalzubehör nicht wiederverwenden. Nach 
der Verwendung gemäß den örtlichen Vorschriften entsorgen. 

Die Wiederverwendung, Wiederaufbereitung oder Resterilisation von Verbrauchsmaterial kann zum Versagen des Geräts 
führen und ist mit der Gefahr einer Kreuzinfektion und/oder Kreuzkontamination von Infektionskrankheiten von einem 
Patienten auf einen anderen verbunden.  

Ein Sterilisationsfehler bei wiederverwendbaren Produkten vor der ersten Anwendung oder Wiederverwendung kann zur 
Kreuzinfektion und/oder Kreuzkontamination von Infektionskrankheiten von einem Patienten auf einen anderen führen. 

Um Beschädigungen am Rollwagen zu verhindern: 

• Nicht auf Ablagen, Zubehörteilen, Monitoren, Hauptturm oder dem Rücken des Rollwagens abstützen.

• Der Monitor muss frei von Hindernissen sein. Keine Gegenstände am Monitor befestigen.

• Kein zusätzliches Gewicht am Monitor anbringen/aufhängen.

• Das Maximalgewicht der Arbeitsablagen sollte 11 kg nicht überschreiten .

Die AQUARIUS® nicht in Gegenwart eines Magnetresonanztomografiesystems verwenden, da AQUARIUS® ferromagnetische 
Objekte enthalten kann, die bei Vorhandensein eines Magnetkerns eine Gefahr für den Patienten darstellen. Das vom MRT-
Gerät hervorgerufene starke Magnetfeld kann zur Störung des Geräts führen.  

Vergewissern Sie sich immer, dass das Abflussloch des Bechers am Spinning-Disk-Flowtransducer (Durchflussmesswandler) 
frei ist. Bei einer Verstopfung diese vor der Anwendung beseitigen. 

Bitte denken Sie daran, dass eine längere Videobilderfassung zu erhöhten Temperaturen auf der Rückseite des AIO-PC führen 
kann. 
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Um das Risiko eines Stromschlags zu vermeiden, darf dieses Gerät nur an eine Netzstromversorgung mit Schutzleiteranschluss 
angeschlossen werden. 

Das Gerät ist für die Anwendung in einer klinischen Umgebung mit kontrollierten EMV-Standards bestimmt, um 
potenzielle Störeinflüsse zu begrenzen. Aquarius kann durch Bluetooth®, Mobiltelefone oder elektromagnetische 
Störungen beeinträchtigt werden. Die Störungen von anderen Bluetooth-Geräten minimieren, indem alle Komponenten 
des Systems nahe beieinander aufgestellt werden. 

Nur von Laborie angegebene und zugelassene Geräte an den Mehrfachsteckdosen des AQUARIUS® anschließen. Durch den 
Anschluss von nicht von LABORIE zugelassenen Geräten an das ME-System wird die funktionelle Integrität des Produkts 
verändert, was zu einem Sicherheitsrisiko führt. 

Änderungen am oder Hinzufügungen zum AQUARIUS® medizinisch-elektrischen System sind zu vermeiden. Durch jegliche 
Änderung des AQUARIUS®-Systems durch einen nicht autorisierten Dritten wird die Verantwortlichkeit zum Erfüllen der 
ME-Systemanforderungen von LABORIE an den die Änderung durchführenden Dritten übertragen. Jeder, der zusätzliche 
Gerätekomponenten an ein medizinisches Elektrogerät anschließt, konfiguriert dieses medizinische System und ist daher 
dafür verantwortlich sicherzustellen, dass das System den Anforderungen für medizinisch-elektrische Systeme entspricht, 
wie in der DIN EN 60601-Serie festgelegt. 

Batterien können nicht vom Bediener entfernt werden. Nicht versuchen, die Batterie zu entfernen. Jegliche Servicearbeiten 
am AQUARIUS-System, den Komponenten oder Zubehörteilen müssen von LABORIE durchgeführt werden. 

HINWEIS: Örtliche Gesetze haben Vorrang vor den vorstehend genannten Anforderungen und Warnhinweisen. Wenden Sie sich 
im Zweifelsfall an Ihren zuständigen Laborie-Vertreter vor Ort oder an die technische Serviceabteilung. 
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VERWENDUNGSZWECK 

AQUARIUS®-SYSTEM 

AQUARIUS® LT, AQUARIUS® CT und AQUARIUS® XT sind diagnostische Analysesysteme. Bei dem Produkt handelt es sich um ein Datenerfassungssystem 
für Urodynamik und periphere Diagnostik, das physiologische Daten vom Patienten aufzeichnet und anzeigt. Es ist für die Anwendung als medizinisches 
Diagnosegerät bestimmt. Die Einzelheiten werden nachstehend beschrieben: 

• Hub: Hat einen Touch-LCD als neue HMI und erfasst/synchronisiert Daten von allen Verfahrensmodulen und sendet diese Daten an den PC. Er
zeigt auch den Gerätestatus an und dient als Schnittstelle für Kalibrierung und Pumpeneinrichtung.

• Pumpenmodul: Die Pumpe am zentralen Hub wird verwendet, um Kochsalzlösung aus einem Infusionsbeutel in die Blase eines Patienten zu
infundieren.

• Druckwandler: Dies sind die Sensoren für die Druckmessung.

• EMG: Elektromyografie-Messwertgeber (Transducer) zum Messen der Muskelaktivität (Roh-EMG/Envelope-EMG).

• Urocap/Uroflow: Wägezelle (Flow-Waage), um das Volumen und den Durchfluss von Flüssigkeit (Flow) in einen Becher zu ermitteln.

• Zugmechanik (Puller) für Urethradruckprofil (Urethra Pressure Profile, kurz UPP) Zieht einen Katheter mit konstanter Geschwindigkeit aus dem
Patienten zurück.

• Roam™ DX: Kabelloses, batteriebetriebenes EMG-Messgerät.

• PC: Computer, der die Systemaktivität kontrolliert und Daten anzeigt und speichert.

ANOREKTALES MANOMETRIESYSTEM (ARM-SYSTEM)

• LABORIEs ARM-System ist dafür bestimmt, physikalische Parameter, wie Drücke und EMG des letzten Abschnitts des Verdauungstrakts (Enddarm)
im Hinblick auf Urodynamik, Inkontinenz und Beckenboden zu messen.

SPINNING-DISK-FLOWTRANSDUCER 

Der Flowtransducer dient dazu, die Harnflussrate zu messen. Er wird zusammen mit UDS-Geräten verwendet, um Miktionsstörungen zu 
beurteilen. 

ZIELANWENDER 

• Dieses Gerät ist ausschließlich für die Anwendung durch in Urodynamik geschultes medizinisches Fachpersonal bestimmt. Der Bediener muss das
Benutzerhandbuch vollständig gelesen und zusätzliches Schulungsmaterial eingesehen haben, bevor er das Gerät verwendet. Optionale In-Service-
Schulung wird von LABORIE angeboten.
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• Um das Risiko einer Kreuzkontamination oder -infektion zu reduzieren, müssen Ärzte in der Verwendung der geeigneten aseptischen Technik
während der beabsichtigten Anwendung des Geräts erfahren und qualifiziert sein. Die Verwendung prophylaktischer Antibiotika liegt im Ermessen
des Arztes und erfolgt gemäß den Richtlinien der jeweiligen Einrichtung.

• Um das Risiko einer schwerwiegenden Verletzung des Patienten zu verringern, ist es unbedingt erforderlich, dass Ärzte und Kliniker, die
urodynamische Untersuchungen bei Patienten mit einer Rückenmarkverletzung durchführen, eine autonome Dysreflexie erkennen und behandeln
können.

• Um das Risiko einer schwerwiegenden Verletzung des Patienten zu verringern, ist es unbedingt erforderlich, dass Ärzte und Kliniker, die
urodynamische Untersuchungen durchführen, Symptome in Verbindung mit vasovagaler Synkope (Ohnmacht) während der Urodynamik-Verfahren
erkennen und behandeln können.

• Warnhinweise hinsichtlich der Ureterkatheterisierung sind in der T-DOC-Bedienungsanleitung zu finden (TDOC-UM01)

ZIELPOPULATION 

• Das Hauptanwendungsgebiet der Urodynamik ist die Diagnose des unkontrollierten Harnverlusts (Inkontinenz), anomalen Harnverhalts,
neurologischer Ursachen von Miktionsstörungen oder die anorektale Manometrie.

• Das Hauptanwendungsgebiet der anorektalen Manometrie (ARM) ist die Unterstützung bei der Diagnose von anorektalen Erkrankungen und
Inkontinenz. Die ARM hat bei der Diagnose dieser Erkrankungen bei Männern, Frauen und Kindern Anwendbarkeit gezeigt.

KONTRAINDIKATIONEN 

 Das AQUARIUS®-System ist bei jedem Patienten kontraindiziert, der kein Kandidat für eine urodynamische Untersuchung ist. 

Katheter dürfen nicht an Patienten verwendet werden, die unter Folgendem leiden: 

• Harnblaseninfektionen

• Urethrastrikturen

• Vor der Untersuchung sollten eine Urinanalyse und eine Urinkultur in Erwägung gezogen werden, um das Vorhandensein einer Infektion
auszuschließen.

Einmalkatheter ￼ Medical Technologies sind „steril“, es sei denn, auf dem Verpackungsetikett und in den Anweisungen ist etwas anderes angegeben. 

Wiederverwendbare Katheter werden gereinigt, aber vor dem Versand nicht sterilisiert. 
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REINIGUNG UND VORBEUGENDE WARTUNG 

GERÄT ODER KOMPONENTEN NICHT IN WASSER ODER ANDERE FLÜSSIGKEITEN 
EINTAUCHEN! 

ALLGEMEINE REINIGUNG UND VORBEUGENDE WARTUNG 

• Das AQUARIUS®-System ist nicht in Flüssigkeit eintauchbar. Es sollte mit einem sauberen, mit einer Reinigungslösung angefeuchteten Tuch, wie Seife
und Wasser, oder gemäß den Reinigungsanweisungen des Krankenhauses abgerieben werden.

• Den Uroflow-Becher nach jeder Anwendung abspülen und trocknen. Für die Reinigung können Seife und Wasser oder eine milde Reinigungslösung
verwendet werden. HINWEIS: Obwohl der Becher wiederverwendbar ist, verfärbt er sich im Laufe der Zeit und muss ggf. ausgewechselt werden.

• Die EMG-Elektroden, Schläuche, Einmalkatheter, der optionale Gurt und die Kartuschen sind nur FÜR DIE VERWENDUNG BEI EINEM PATIENTEN
bestimmt. Verbrauchsmaterial NICHT wiederverwenden.

• Der Stuhl, Flowstand, Trichter und EMG-Headstages/Prozessor können mit einem mit Seife und Wasser oder einer milden Reinigungslösung
angefeuchteten Tuch abgewischt und dann sofort trockengerieben werden.

• Die Einführungspunkte des EMG-Headstage/Prozessors müssen trocken gehalten werden. EMG niemals in Wasser oder andere Flüssigkeiten
eintauchen.

• Bei der Reinigung des Trichters darf die maximale Reinigungstemperatur 80 °C nicht überschreiten.

• Von den Druckwandlern alle Flüssigkeiten oder andere Fremdkörper von den Außenflächen des Wandlers und Kabeln mit einem leicht angefeuchteten
Tuch und einer milden Reinigungslösung entfernen. Nicht in Flüssigkeiten eintauchen. Keine chlorbasierten Reinigungslösungen/-mittel verwenden.
Druckwandler nicht autoklavieren oder mit EtO sterilisieren.

• Durch die Durchführung regelmäßiger Wartungstätigkeiten wird die Notwendigkeit teurer Reparaturen verringert. Als notwendiger Schritt für den
Erhalt einer optimalen Systemleistung sollte die Kalibrierung alle 6 Monate bzw. dann überprüft werden, wenn Sie vermuten, dass die Druckwandler
außerhalb der Kalibrierungswerte sind.

• Tragen Sie bei der Reinigung des Geräts immer Schutzhandschuhe, um eine biologische Kontamination zu vermeiden.
• Beachten Sie besonders die LED-Lampen an jedem Gerät. Wenn diese auf eine unterbrochene Verbindung und/oder eine schwache Batterie hinweisen,

sicherstellen, dass die Verbindung wiederhergestellt und die Batterie voll aufgeladen wird. Informationen zu den LED-Lampen finden Sie auf Seite 31.
• Um die beste Leistung zu erzielen wird empfohlen, die Geräte immer aufzuladen, wenn das System zum Aufladen auffordert.
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PFLEGE DES ROAM™ DX 

• Der Roam™ DX darf nicht in Flüssigkeit eingetaucht werden. Die Außenseite nur mit Seife und Wasser oder einem für die Verwendung in
Krankenhäusern geeignetem Desinfektionsmittel abwischen. KEINE REINIGUNGSLÖSUNG DIREKT AUF ODER IN DEN ROAM™ DX SPRÜHEN.

• Der optionale Gurt ist ein Einmalprodukt, unsteril und wird nur zur einmaligen Verwendung empfohlen.
• Das Holster kann mit Standard-Krankenhauswischtüchern gereinigt werden.

Es wird empfohlen, den Roam™ DX mindestens ein- oder zweimal im Jahr aufzuladen und zu benutzen, um die optimale Leistungsfähigkeit zu erhalten. 
Wenn er in einem Lagerraum aufbewahrt wird, sicherstellen, dass die Batterie voll aufgeladen ist. 

PFLEGE DES UROCAP V UROFLOWMETER 

Nach einiger Zeit verschmutzt der Urocap™ V aufgrund von Urinkontamination und muss gereinigt werden. Tragen Sie bei der Reinigung des Geräts immer 
Schutzhandschuhe, um eine biologische Kontamination zu vermeiden. 

Den Urocap™ V nicht in Wasser einweichen oder eintauchen! Das Gerät auch nicht in anderen 
Flüssigkeiten einweichen oder darin eintauchen!
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• Der Deckel des Urocap V ist nicht abnehmbar und es muss darauf geachtet werden, eine Beschädigung zu vermeiden.

• Der Urocap™ V sollte mit einem mit Alkohol, Seife oder Desinfektionsmittel angefeuchteten Tuch gereinigt werden.

• Er sollte bei Raumtemperatur an einem kühlen und trockenen Ort aufbewahrt werden.

Um zu prüfen, ob der Urocap™ V funktioniert, siehe Seite 20. 

PFLEGE DES SPINNING-DISK-FLOWTRANSDUCERS 

Das Gerät wöchentlich auf ordnungsgemäße Funktion prüfen. Dabei die Kabel und den Sensor auf Einschnitte oder andere Beschädigungen untersuchen. 
Das Gerät an die Service-Abteilung einsenden, wenn Sie Zweifel haben. Das Gerät sollte wie unten beschrieben gereinigt werden. Es ist keine weitere 
Wartung erforderlich. 

REINIGUNG 

Der Flowtransducer sollte mindestens einmal wöchentlich sorgfältig gereinigt werden, vorzugsweise aber täglich, um Schmutzansammlungen und 
Geruchsbildung zu vermeiden. Das Gerät wie folgt reinigen: 

Schnelle Reinigung (täglich) 

• Langsam etwa 1 l sauberes Wasser in den Trichter füllen.

• Die Scheibe in Rotation halten, um den Becher des Geräts zu spülen.
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Sorgfältige Reinigung (wöchentlich) 

• Den Flowtransducer vom Hauptgerät abnehmen.

• Den Becher, Trichter und die Scheibe entfernen.

• Für Toilettenbecken geeignete Reinigungsmittel verwenden. Alle Teile gemäß den Empfehlungen des Reinigungsmittelherstellers reinigen, einschließlich
der Innen- und Außenseite des Transducerbechers.

• Alle Teile mit einer geeigneten Desinfektionslösung abwischen.

• Den Flowtransducer wieder zusammensetzen.

• Den Flowtransducer während der Reinigung nicht kippen, wenn sich Flüssigkeit im Becher befindet.

• Trichter, Becher und Drehscheibe können separat für die Reinigung abgenommen werden.

• Um eine Beschädigung des Geräts zu vermeiden, die empfohlenen Reinigungstemperaturen für die einzelnen Gerätekomponenten nicht überschreiten:
Trichter Max. 140 °C 

Drehscheibe Max. 150 °C 

Transducerbecher Max. 100 °C 

Scheibenhalterung Max. 100 °C 

Becher 1,5 l, Stahl Max. 200 °C 

Becher 1 l, weiß Max. 140 °C 

Motorgehäuse Max. 100 °C 

• Die Komponenten nach der Reinigung spülen.

• Den Steckverbinder niemals in Flüssigkeit eintauchen. Immer trocken halten.

• Niemals die Scheibenhalterung zur Reinigung entfernen.

• Niemals Teile des Geräts in Flüssigkeit eintauchen (Motorteile/Gehäuse).
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PFLEGE DER ZUGMECHANIK (PULLER) FÜR UPP 

Die Katheterführung des UPP-Pullers und die Klemme sind so 
konstruiert, dass sie schnell auseinandergenommen, gereinigt und 
wiederaufbereitet werden können, um eine Kreuzkontamination zu 
vermeiden.  

Es ist außerordentlich wichtig, die Katheterführungsspitze des UPP-
Pullers zu sterilisieren. Geschieht dies nicht, kann dies zur 
Kreuzkontamination eines neuen Katheters führen, der mit der nicht 
sterilisierten Spitze in Kontakt kommt und während der Untersuchung 
bei einem Patienten verwendet wird. 

Abbildung 1: Abgenommene Katheterführung 

REINIGUNG DER BEWEGLICHEN KLEMME 

Nach jedem Verfahren die Katheterführungskomponenten auseinandernehmen, 
reinigen und jedes Teil vor der nächsten Untersuchung desinfizieren.  

Abbildung 2: Demontage der Katheterführung 
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Freigabe der beweglichen Klemme: 
1. Auf UPP Return und danach auf UPP Stop klicken. (Diesen Schritt

wiederholen, bis die bewegliche Klemme vollständig vom Motorkörper
freigegeben ist.)

2. Auf UPP Stop klicken, um den Motor anzuhalten.

3. Die bewegliche Klemme nach unten bis zur Katheterführung schieben.
(Abbildung 3)

Abbildung 3: Bewegliche Klemme in Bewegung zur Katheterführung 

4. Wenn die Katheterführung erreicht ist, die bewegliche Klemme nach
unten drehen. (Abbildung 4)

Abbildung 4: Bewegliche Klemme nach unten 
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5. Die bewegliche Klemme vollständig vom Nasenschlauch abschieben. 
(Abbildung 5)

6. Die bewegliche Klemme reinigen und desinfizieren.

7. Die Klemme sorgfältig spülen und trocknen, bevor sie wieder auf den
Nasenschlauch aufgesetzt wird.

Abbildung 5: Bewegliche Klemme vom Nasenschlauch abgenommen 

Wiederanbringen der beweglichen Klemme: 
1. Die bewegliche Klemme auf den Nasenschlauch schieben, wobei die Klemme nach unten zeigt. (Abbildung 5)

2. Beim Passieren der Katheterführung die bewegliche Klemme nach oben drehen.

3. Dabei beobachten, ob die bewegliche Klemme beginnt, sich von allein nach oben zum Motorkörper zu bewegen. Der Magnet am Ende der
beweglichen Klemme erfasst diese Bewegung der beweglichen Klemme und platziert diese zurück in die Öffnung. Sie hört von alleine auf, sich zu
bewegen.

4. Auf UPP Pull klicken, um sicherzustellen, dass die bewegliche Klemme sicher in ihrer Position ist.

5. Auf UPP Stop klicken.

6. Auf UPP Return klicken.
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ENTFERNEN UND AUSTAUSCH DER KATHETERFÜHRUNG 

Die Katheterführung kann auch für eine einfache Reinigung und Desinfektion entfernt werden. 

Um die Katheterführung zu entfernen: 

1. Den runden Abschnitt der Katheterspitze mit Daumen und Zeigefinger
ergreifen.

Abbildung 6: Entfernen der Katheterführung – Schritt 1 
2. Die Katheterführungsspitze herausziehen.

3. Die Katheterführungsspitze mit den erforderlichen Reinigungs-/
Desinfektionslösungen reinigen.

4. Die Katheterführungsspitze wieder in den Nasenschlauch
zurückschieben.

Die Spitze ist mit einer silbernen Kugel versehen, sodass man die Spitze zurück in 
ihre korrekte Position einschnappen und sie dort halten kann. 

Abbildung 7: Entfernen der Katheterführung – Schritt 2 
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STERILISATION

Die Komponenten müssen vor der Sterilisation demontiert werden. 

Die Komponenten des UPP-Pullers sind mit den folgenden Sterilisationsverfahren kompatibel: 

• ETO

• Gasplasma

• Peressigsäure

• Instrumentenreinigungsmittel oder enzymatisches Instrumentenreinigungsmittel

• Vorgeschlagene Reinigungslösungen*:

• KLENZYME (STERIS Corporation 1‐800‐548‐4873)

• ENDOZYME (The Ruhof Corp. 1‐800‐537‐8463)
Befolgen Sie die Anweisungen des Herstellers genau. 
*Die Bezugnahme auf eine bestimmte Handelsmarke ist keine Bestätigung für die Wirksamkeit des Produkts.

HOCHLEISTUNGSDESINFEKTION 

Die Komponenten können mithilfe von zugelassenen Hochleistungsdesinfektionslösungen gemäß den Gebrauchsanweisungen 
hochleistungsdesinfiziert werden.  

Bei der Auswahl eines Hochleistungsdesinfektionsmittels die vollständigen Eigenschaften und Anwendungsbestimmungen beachten. Die Anweisungen 
auf dem Etikett sind genau zu befolgen. 

Die folgenden Desinfektionsmittel können verwendet werden: 

• Aldehyde (Cidex®)

• Corsoline®

• Sporicidin®

• Chlorate (DiversolBX®)

• Sani-Cloth Plus oder gleichwertig

• Desinfektionstücher verdünnen – nicht einweichen lassen
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• Alkohol ist bei bestimmten Organismen nahezu unwirksam. 70%ige Isopropylalkoholreiniger können auf den Geräten verwendet werden, es
werden jedoch leistungsfähigere Reiniger empfohlen.

WARNHINWEISE: Verfahren, durch die das UPP-Gerät beschädigt wird und die zum Erlöschen der Garantie führen 
• Autoklavieren ist nicht erlaubt. Dadurch werden Geräte oder Komponenten nachteilig beeinträchtigt oder zerstört.

• Steckverbinder dürfen nicht in Flüssigkeit eingetaucht werden. Diese immer trocken halten.

• Keine Lösungsmittel oder abrasive Reinigungsmittel verwenden.

• Sicherstellen, dass keine Flüssigkeiten durch die Öffnungen im Gehäuse in den Motor gelangen.

• Keine Chlorbleiche, Ammoniak, Aceton, Methanol, vergällten Ethylalkohol, Mineralöl oder Jod verwenden.

• Die maximale Servicetemperatur beträgt 100 °C.

PFLEGE DES ROLLWAGENS UND SEINER KOMPONENTEN 

Der Rollwagen sollte mit einem sauberen, mit einer Reinigungslösung angefeuchteten Tuch, wie Seife und Wasser, oder gemäß den Rei-
nigungsanweisungen des Krankenhauses abgerieben werden.  

PFLEGE DES LUFTGEFÜLLTEN KATHETERS/KABELS 

Das Risiko einer Kreuzkontamination von einem Patienten auf einen anderen durch sterile luftgefüllte Katheter für den Einmalgebrauch unter steriler 
Technik ist vernachlässigbar. Jedes Verfahren in einem Hochrisikoumfeld mit Körperflüssigkeiten und Haut-zu-Haut-Kontakt erhöht jedoch das 
Kontaminationsrisiko von wiederverwendbaren Komponenten. 

Folgendes wird nach jeder Anwendung bei einem Patienten empfohlen: 

• Luftgefüllte Katheter sind nur für die Anwendung bei einem Patienten bestimmt. Nach dem Gebrauch entsorgen.

• Die angebrachte Schutzkappe am Druckwandlergehäuse via Luer-Lock ersetzen, um den Wandler zu schützen.

• Den Druckwandler mit einem für Krankenhauszwecke geeigneten Breitspektrum-Desinfektionsmittel einsprühen oder feucht abwischen, das
potenzielle Standardpathogene sowie HIV, HBV, HCV, VRE, MRSA, MRSE, Pseudomonas and Mykobakterien abdeckt.

• Den Druckwandler/das Kabel trockenreiben.
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BATTERIE – AUFLADEN UND VORBEUGENDE WARTUNG 

WICHTIG! Um eine ordnungsgemäße und sichere Aufladung zu gewährleisten nur von LABORIE gelieferte USB-Kabel verwenden. 

AUFLADEN DER BATTERIE 

Urocap™ V: Den Urocap™ V in die Aufladeschale/Dockingstation am Rollwagen legen oder ein Ende des USB-
Kabels in das Gerät und das andere in ein von Laborie geliefertes medizinisches Netzteil einstecken. Dieses 
Netzteil kann mit einer Wandsteckdose oder einem Verlängerungskabel für medizinische Zwecke verbunden 
werden; der Urocap™ V sollte auf dem mitgelieferten Abstandstück platziert werden, um sicherzustellen, dass er 
parallel zum oder flach auf dem Boden platziert ist.  

Es dauert etwa 7,5 Stunden, um das Gerät vollständig aufzuladen (wenn es nicht im Betrieb ist).  
Wenn der Urocap™ V im Abtastbetrieb ist, dauert es 9 Stunden, um das Gerät vollständig aufzuladen. 

Es wird empfohlen, das Gerät am Stromnetz anzuschließen oder mindestens eine Batterieleistung von 40 % zur 
Verfügung zu haben, bevor mit einer Untersuchung begonnen wird. 
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Roam™ DX: Den Roam™ DX in die Aufladeschale/Dockingstation am Rollwagen legen. Dabei sicherstellen, dass 
er beim Einlegen einrastet, um eine richtige Verbindung zu gewährleisten (der vollständige Anschluss wird 
durch ein Piepgeräusch bestätigt). Es dauert etwa 7,5 Stunden, um das Gerät vollständig aufzuladen (wenn es 
nicht im Betrieb ist).  
Wenn der Roam™ im Abtastbetrieb ist, dauert es 10,5 Stunden, um das Gerät vollständig aufzuladen.  
Wenn die LED-Lampe am Gerät grün leuchtet ist das Gerät vollständig aufgeladen. 

Es wird empfohlen, das Gerät am Stromnetz anzuschließen oder mindestens eine Batterieleistung von 40 % zur 
Verfügung zu haben, bevor mit einer Untersuchung begonnen wird. 

UPP: Das USB-Kabel vom UPP-Ständer in den vorderen USB-Port unter dem zentralen Pumpenhub einstecken, 
um den UPP aufzuladen. Das Aufladen dauert etwa 7,5 Stunden (im Betrieb dauert dies ca. 9 Stunden).  
Es wird empfohlen, den UPP am Ende eines jeden Tages anzuschließen, um eine volle Batterieladung für die 
Untersuchungen zu gewährleisten. 

Es wird empfohlen, das Gerät am Stromnetz anzuschließen oder mindestens eine Batterieleistung von 40 % zur 
Verfügung zu haben, bevor mit einer Untersuchung begonnen wird. Das Gerät kann während der 
Batterieaufladezeit weiter verwendet werden.  
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VORBEUGENDE WARTUNG 

• Nicht auf die Batterie treten, sie nicht fallen lassen, in Wasser eintauchen oder sie durchstechen. Wenn Missbrauch, Zweckentfremdung oder
Beschädigung vermutet wird oder irgendeine Form einer mechanischen Beschädigung des Gehäuses sichtbar ist, die Anwendung beenden und die
Batterie an LABORIE zurücksenden.

• Wenn eine plötzliche Veränderung der Fähigkeit der Batterie, ihre Leistung aufrechtzuerhalten oder eine plötzliche Änderung der Lebensdauer der Batterie
festgestellt wird, die Anwendung beenden und die Batterie an LABORIE zurücksenden.

• Es wird empfohlen, die Batterien aller Geräte über Nacht aufzuladen, um eine korrekte Funktion zu gewährleisten. Wenn die Batterieleistung auf 40 %
fällt, sollte mit dem Wiederaufladen begonnen werden.

COMPUTER-VIRUSSCHUTZ 

Alle von LABORIE gekauften Computer sind vor dem Versand virusfrei und mit einem installierten Antivirus-Programm versehen. Es liegt in der 
Verantwortung des Kunden, das Antivirus-Programm korrekt anzuwenden und aufrechtzuerhalten, um Virusprobleme zu verhindern. LABORIE ist nach 
der Auslieferung an den Kunden nicht verantwortlich für virusbedingte Computerprobleme. 

HANDHABUNG UND ENTSORGUNG DES PRODUKTS NACH DEM GEBRAUCH 

• Nach dem Gebrauch das kontaminierte Einmal-Verbrauchsmaterial aus Kunststoff und die Verpackung gemäß den Standardarbeitsanweisungen Ihrer
Einrichtung zur Handhabung von Abfallmaterial entsorgen.

• Produkte am Ende ihrer Nutzungsdauer und elektrische und elektronische Altgeräte sind separat zu sammeln und an die zuständige örtliche
Recyclinganlage zurückzugeben.

• Die Entsorgung von Batterien muss am Ende ihrer Lebensdauer gemäß den örtlichen Bestimmungen erfolgen.

• Verpackungsabfall sollte separat gesammelt und der verfügbaren nationalen Altpapiersammlung und den Recyclingdiensten zugeführt werden.

UMWELTASPEKTE DER ABFALLENTSORGUNG 

Aufgrund der Tatsache, dass der Urocap™ V und der Spinning-Disk-Flowtransducer für die Durchführung von Uroflow-Untersuchungen bestimmt sind, 
ist es wichtig, jeglichen Abfall (wie z. B. Urin) ordnungsgemäß zu entsorgen, um Umweltbelastung zu verhindern. Der Abfall sollte so entsorgt werden, 
dass er nicht zur Belastung des Frischwasserversorgungssystems und insbesondere des Trinkwassersystems führt. Dies ist normalerweise in Bereichen mit 
einem ordnungsgemäßen Abwassersystem mit Wasseraufbereitungsverfahren kein Problem. In diesem Fall ist die bequemste Methode die Verwendung 
dieser Abwassersysteme. 
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VORBEUGENDE WARTUNG – ÜBERPRÜFUNG DER KALIBRIERUNG 

Durch die Durchführung regelmäßiger Wartungstätigkeiten wird die Notwendigkeit teurer Reparaturen verringert. Als notwendiger Schritt für den 
Erhalt einer optimalen Systemleistung sollte die Kalibrierung alle 6 Monate bzw. dann überprüft werden, wenn Sie vermuten, dass die Druckwandler 
außerhalb der Kalibrierungswerte sind. 

Wenn der Uroflowmeter, die Pumpe, das EMG, der UPP-Puller, die Druckwandler und/oder der Messwertgeber für Infusion falsche Messwerte anzeigen, 
die folgenden Überprüfungen durchführen, bevor Sie versuchen, das System zu kalibrieren. 

FLOW UND VOLUMEN DES UROCAP™ V UROFLOWMETERS PRÜFEN 

Volumen prüfen 

1. Die AQUARIUS®-Software starten und mit einer Test-Uroflow-Untersuchung beginnen.
2. Einen leeren Becher in den Uroflow-Transducer stellen.
3. Set Zeroes! auswählen.
4. Den leeren Becher entfernen.
5. Den Becher mit 500 ml Wasser füllen und in den Uroflowmeter stellen.

Der Volumenkanal sollte ein Volumen von 500 ml (+/- 5 ml) anzeigen. Wenn der Wert sich ober- oder unterhalb des 5-ml-Grenzwerts befindet ist eine Kalibrierung
erforderlich. Führen Sie nach durchgeführter Kalibrierung eine erneute Überprüfung anhand der hier aufgeführten Schritte 1 bis 5 durch. Wenden Sie sich an den
LABORIE-Service, um Hilfe zu erhalten, wenn die Probleme nach der Kalibrierung und erneuten Überprüfung noch weiter bestehen.

Flow-Überprüfung 

1. Die AQUARIUS®-Software starten und mit einer Test-Uroflow-Untersuchung beginnen.
2. Einen leeren Becher in den Uroflow-Transducer stellen.
3. Set Zeroes! auswählen.
4. Einen weiteren Becher mit 500 ml Wasser füllen.
5. Langsam und gleichmäßig das Wasser aus dem befüllten Becher in den leeren Becher füllen. Dabei versuchen, die Geschwindigkeit zwischen 25 bis 50 ml/Sekunde zu

halten.
Der Volumenkanal sollte ein Volumen von 500 ml (+/- 5 ml) anzeigen. Wenn der Wert sich ober- oder unterhalb des 5-ml-Grenzwerts befindet ist eine Kalibrierung 
erforderlich. Führen Sie nach durchgeführter Kalibrierung eine erneute Überprüfung anhand der hier aufgeführten Schritte 1 bis 5 durch. Wenden Sie sich an den 
LABORIE-Service, um Hilfe zu erhalten, wenn die Probleme nach der Kalibrierung und erneuten Überprüfung noch weiter bestehen. 

ÜBERPRÜFUNG DER PUMPE 

Einige Gedankenstützen vor der Pumpenüberprüfung: 

• Das für die Untersuchungsverfahren verwendete Kontrastmittel sollte auch für die Überprüfung und die Kalibrierung verwendet werden.

• Um genaue Messwerte und Messungen zu erzielen, nur die von LABORIE empfohlenen und zugelassenen Schläuche verwenden.
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1. Den Pumpenschlauch ansaugen lassen.
2. Pumpenschlauch mit Katheter zur Pumpe in einen leeren Becher installieren.
3. Die AQUARIUS®-Software starten und mit einer Test-Untersuchung beginnen.
4. Bis zu einem Volumen von 150 ml füllen und den Test beenden.
5. Das Volumen messen.

Der Volumenkanal sollte dem Pumpenfüllvolumen entsprechen (+/- 10 ml). Wenn der Wert sich ober- oder unterhalb des 10-ml-Grenzwerts befindet ist eine 
Kalibrierung erforderlich. Führen Sie nach durchgeführter Kalibrierung eine erneute Überprüfung anhand der hier aufgeführten Schritte 1 bis 5 durch. Wenden Sie sich an den
LABORIE-Service, um Hilfe zu erhalten, wenn die Probleme nach der Kalibrierung und erneuten Überprüfung noch weiter bestehen.

EMG-ÜBERPRÜFUNG 

Einige Gedankenstützen vor der EMG-Überprüfung: 

• Die Lebensdauer von EMG-Verbindungsleitungen läuft im Allgemeinen nach sechs Monaten Anwendung ab. Es wird empfohlen, sie alle sechs Monate
auszutauschen.

1. Die AQUARIUS®-Software starten und mit einer
Test-Untersuchung mit einem EMG-Kanal
beginnen.

2. Zwei EMG-Elektroden etwa 2,5 cm voneinander
entfernt auf Ihrem Unterarm (da, wo der Muskel
am meisten anspannt) und die dritte EMG-
Elektrode an Ihrem Ellenbogen platzieren.

3. Den Arm entspannt an Ihrer Körperseite nach
unten und die Handfläche dabei offen halten. Sie
werden eine minimale EMG-Aktivität feststellen.
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4. Halten Sie Ihre Handfläche weiterhin offen und
heben Sie den Arm leicht an (in einem Winkel
von 45°). Behalten Sie diese Position konstant
bei. Sie werden einen Anstieg der Aktivität im
EMG-Kanal feststellen.

bei 50 % Anspannung 
5. Die Handfläche offen halten und Ihren Arm

weiter nach oben bewegen, bis er parallel zum
Boden ist. Sie werden einen weiteren Anstieg
der Aktivität im EMG-Kanal feststellen.

bei 100 % Anspannung 
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6. Halten Sie Ihren Arm in dieser parallelen Position
und machen Sie eine Faust. Sie werden einen
Anstieg der Aktivität im EMG-Kanal feststellen.

7. Lösen Sie die Faust und kehren Sie in die
entspannte Position zurück.

8. Prüfen Sie den EMG-Kanal auf Aktivität.

bei 100 % Anspannung mit vollständiger Kontraktion 

Ein Beispiel für einen Messwert kann hier sein: 
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Wenn keine Aktivität auf dem EMG-Kanal zu sehen ist, muss eine Kalibrierung durchgeführt werden. Führen Sie nach durchgeführter Kalibrierung eine 
erneute Überprüfung anhand der hier aufgeführten Schritte 0 bis 8 durch. Wenden Sie sich an den LABORIE-Service, um Hilfe zu erhalten, wenn die 
Probleme nach der Kalibrierung und erneuten Überprüfung noch weiter bestehen. 

ÜBERPRÜFUNG DES UPP-PULLERS 

1. Mit einem Bleistift zwei Punkte in einer Entfernung von 50 mm am Schaft des UPP-Pullers markieren.
2. Die AQUARIUS®-Software starten und mit einer UPP-Untersuchung beginnen.
3. Den UPP zum distalen (äußersten) Marker auf dem Puller-Schaft bewegen.
4. Einen Zeitmesser einschalten und dann die Zugmechanik betätigen; dabei die Zeit messen, die der UPP-Puller benötigt, um sich hin zum proximalen

(näheren) Marker auf dem Puller-Schaft zu bewegen.
Die Zugmechanik sollte nach 50 Sekunden (+/- 3 Sekunden) am proximalen (näheren) Marker stoppen. Wenn sich die Zugmechanik nicht innerhalb des
erforderlichen Zeitbereichs bis zum proximalen Marker bewegt, ist eine Kalibrierung erforderlich. Führen Sie nach durchgeführter Kalibrierung eine
erneute Überprüfung anhand der hier aufgeführten Schritte 1 bis 4 durch. Wenden Sie sich an den LABORIE-Service, um Hilfe zu erhalten, wenn die
Probleme nach der Kalibrierung und erneuten Überprüfung noch weiter bestehen.

ÜBERPRÜFUNG DES DRUCKWANDLERS

1. Die Ladevorrichtung am T-DOC in die Position OPEN schalten.
2. Den Katheter an der Ladevorrichtung anbringen und den Ballon am Katheter vorsichtig zusammendrücken, um jegliche Luft aus dem Ballon abzulassen.

entspannt 50 % 
Anspan

100 % 
Anspan

Kontraktion entspannt 
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3. Die Ladevorrichtung am T-DOC in die Position CHARGE schalten.
4. Einen graduierten Standardbecher mit 1.000 ml Wasser füllen.
5. Die AQUARIUS®-Software starten und mit einer Test-Untersuchung mit Druckkanälen beginnen.
6. Auf Set Zeroes klicken.
7. Den Katheter in den Becher tauchen, bis sich der Ballon auf dem Katheter unmittelbar unterhalb der Wasserlinie befindet.

Ergebnis: Der Druckkanal sollte zwischen 0 und 1 cmH2O anzeigen.
8. Den Katheter vorsichtig in den Becher herablassen, bis die Spitze leicht den Becherboden berührt. Dabei die Becherseiten nicht berühren.
9. Den Katheter in einer stabilen Position halten und auf einen Messwert auf dem Druckkanal warten.

Der Druckkanal sollte einen Wert von 15 cmH2O (+/- 2 cmH2O) anzeigen. Wenn der Wert sich ober- oder unterhalb des 2-cmH2O-Grenzwerts befindet,
ist eine Kalibrierung erforderlich. Führen Sie nach durchgeführter Kalibrierung eine erneute Überprüfung anhand der hier aufgeführten Schritte 1 bis 9
durch. Wenden Sie sich an den LABORIE-Service, um Hilfe zu erhalten, wenn die Probleme nach der Kalibrierung und erneuten Überprüfung noch weiter
bestehen.

ÜBERPRÜFUNG DES MESSWERTGEBERS FÜR INFUSION 

• Vergewissern Sie sich, dass der Uroflowmeter vor der Überprüfung des Messwertgebers für Infusion geprüft und kalibriert wurde. Um den
Uroflowmeter zu prüfen, siehe Seite 20.

• Der Beutel mit der Kochsalzlösung darf keine anderen mechanischen Komponenten des Systems berühren (wie Druckwandler usw.).

1. Einen vollen Infusionsbeutel am Messwertgeber für Infusion anbringen.
2. Einen leeren Becher in den Uroflowmeter stellen.
3. Die AQUARIUS®-Software starten und mit einer Test-Untersuchung mit einem VH2O-Kanal beginnen.
4. Auf Set Zeroes klicken.
5. Mit der Infusion beginnen und diese laufen lassen, bis der Infusionsbeutel in den Becher im Uroflowmeter geleert wurde.
6. Den Volumenkanal ablesen.

Das am Kanal angezeigte Volumen sollte dem in den Becher entleerten Volumen entsprechen. Wenn es einen großen Unterschied (+/- 10 ml) zwischen
dem Volumen aus dem Infusionsbeutel und dem auf dem Bildschirm angezeigten Volumen gibt, ist eine Kalibrierung erforderlich. Führen Sie nach
durchgeführter Kalibrierung eine erneute Überprüfung anhand der hier aufgeführten Schritte 1 bis 6 durch. Wenden Sie sich an den LABORIE-Service,
um Hilfe zu erhalten, wenn die Probleme nach der Kalibrierung und erneuten Überprüfung noch weiter bestehen.

SICHERE BEWEGUNG DES ROLLWAGENS 

1. Vor dem Bewegen des Rollwagens immer sicherstellen, dass alle Systemkomponenten von der Hauptstromquelle getrennt wurden.
2. Vor dem Bewegen muss sich der Rollwagen in der Transportposition befinden. Die Transportposition besteht aus Folgendem:
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• Alle Lenkrollen sind zu entsperren.

• Alle losen Teile und das Zubehör sind zu sichern.

• Den Rollwagen nicht bewegen, während er an der Hauptstromquelle angeschlossen ist.

• Den Rollwagen nicht bewegen, während er am separaten Zubehör angeschlossen ist (Ausstattung usw.).

• Monitore sollten beim Durchqueren von Türöffnungen gedreht werden, um besser passieren zu können.

• Alle Schubfächer und Türen müssen geschlossen und gesichert sein (falls zutreffend).

• Alle Kabel und Schläuche sollten geordnet und gebündelt sein, um Stolpergefahren zu verhindern.
3. Den Rollwagen bewegen, indem Sie den ausgeschnittenen Bereich auf der Tastaturablage mit beiden Händen ergreifen. Wenn kein Ausschnitt

vorhanden ist, die höchste Ablage horizontal mit beiden Händen ergreifen.
4. Nicht am Rollwagen ziehen. Den Rollwagen vorwärts schieben, wie in Abbildung 8 dargestellt.

Abbildung 8: Sicheres Bewegen des Rollwagens 

5. Den Rollwagen nicht schneller als in durchschnittlicher Schrittgeschwindigkeit bewegen (1,4 m/s).
6. Mit dem Rollwagen keine Hindernisse überwinden, die höher als 10 mm sind.

 Um Beschädigungen am Rollwagen zu verhindern: 

• Nicht auf Ablagen, Zubehörteilen, Monitoren, Hauptturm oder dem Rücken des Rollwagens abstützen.

• Der Monitor muss frei von Hindernissen sein. Keine Gegenstände am Monitor befestigen.

• Kein zusätzliches Gewicht am Monitor anbringen/aufhängen.
Das Maximalgewicht der Arbeitsablagen sollte 11 kg nicht überschreiten .
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SOFTWARE UND AUSRÜSTUNG 

Die AQUARIUS®-Software wird vor der Auslieferung installiert. Installieren Sie die Software nur dann, wenn sie versehentlich deinstalliert wurde, oder 
Sie ein Upgrade auf eine neuere Version durchführen. Installationsanweisungen finden Sie im Software-Installationsleitfaden bei der LABORIE Software-
CD. 

Bitte beachten Sie, dass einige der Software-Funktionen optional sein können. Einzelheiten hierzu erfahren Sie von Ihrem LABORIE-Vertreter. 

Führen Sie kein Upgrade eines Microsoft Windows® 7 PC/Laptops auf Microsoft Windows® 10 OS durch, da die von 
LABORIE gelieferten UDS-Systeme und Software als Komplettpaket getestet wurden und nach einem solchen Update 
nicht korrekt arbeiten werden. Bitte wenden Sie sich für weitere Informationen an Ihren LABORIE Support-Vertreter.

STANDARDAUSRÜSTUNG UND OPTIONALES ZUBEHÖR 

Das AQUARIUS® ist in vier Modellausführungen erhältlich, die jeweils mit einem Hub (CHC) ausgestattet sind, in dem sich Pumpe, 
Verbindungsanschlüsse für Kabel usw. befinden. 

Überprüfen Sie, ob Sie die gesamte bestellte Ausrüstung und das Zubehör erhalten haben. Wenden Sie sich bitte an LABORIE, wenn es zu Abweichungen 
zwischen der bestellten und der erhaltenen Ausrüstung kommt. Die Ausrüstung auf sichtbare Anzeichen einer Beschädigung oder fehlerhaften 
Handhabung überprüfen. Informieren Sie sofort den Spediteur, wenn Sie eine Beschädigung feststellen.  

Transportbehälter und -kartons sollten aufbewahrt werden, um so über eine bequeme und sichere Methode für die Rücksendung der Geräte zu 
verfügen, falls Servicearbeiten erforderlich sind.

Eine detaillierte Liste der Systemteile und des Zubehörs finden Sie auf Seite 389 im Abschnitt AMHANG hinten im Handbuch. 
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AQUARIUS® LT AQUARIUS® CT 

o Laptop
o Tastatur/Arbeitsablage
o 1 Roam™ DX (maximal)
o AQUARIUS Hub (CHC)
o 1 Ladeschale für Roam™ DX
o Luftblasendetektor (optional)
o Halter für Messwertgeber für Infusion mit Tropfbecher (optional)
o Pumpe – 4 Rollen
o LIT 
o Uroflowmeter (Urocap™ V oder Spinning-Disk-Flowtransducer) (separater

Ladestecker im Lieferumfang)
o UPP-Puller-Ständer (optional)
o AquaVU™ 360 (optional)

o Laptop oder Industrie-PC (1 oder 2 Monitore)
o Tastatur/Arbeitsablage
o 2 Roam™ DX
o AQUARIUS Hub (CHC)
o 2 Ladeschalen für Roam™ DX
o Luftblasendetektor
o Halter für Messwertgeber für Infusion mit Tropfbecher (optional)
o Pumpe – 4 Rollen
o LIT
o Uroflowmeter (Urocap™ V oder Spinning-Disk-Flowtransducer) (bis zu 2; separater

Ladestecker im Lieferumfang)
o UPP-Puller-Ständer (optional)
o AquaVU™ 360 (optional)
o Fernbedienung (optional nur mit Industrie-Mini-PC-Version)
o Video (nur für Industrie-PC – optional)

AQUARIUS® XT AQUARIUS® CTS 

o Industrie-Mini-PC
o AQUARIUS-Turm und AQUARIUS Computer-Workstation
o Tastatur/Arbeitsablage
o 2 Roam™ DX
o AQUARIUS Hub (CHC)
o 2 Ladeschalen für Roam™ DX
o Luftblasendetektor (optional)
o Halter für Messwertgeber für Infusion mit Tropfbecher (optional)
o Pumpe – 4 Rollen
o 2 LIT – einer für die Workstation und einer für den Turm
o Uroflowmeter (Urocap™ V oder Spinning-Disk-Flowtransducer) (bis zu 2;

separater Ladestecker im Lieferumfang)
o UPP-Puller-Ständer (optional)
o AquaVU™ 360 (optional)
o Video (nur für Industrie-PC – optional)

o Industrie-PC
o LCD-Monitoranzeige
o Tastatur/Arbeitsablage
o 2 Roam™ DX
o AQUARIUS Hub (CHC)
o 2 Ladeschalen für Roam™ DX
o Pumpe – 4 Rollen
o LIT
o Uroflowmeter (Urocap™ V oder Spinning-Disk-Flowtransducer) (bis zu 2; separater

Ladestecker im Lieferumfang)
o Farbdrucker
o Luftblasendetektor (optional)
o Halter für Messwertgeber für Infusion mit Tropfbecher (optional)
o UPP-Puller-Ständer (optional)
o AquaVU™ 360 (optional)
o Fernbedienung (optional nur mit Industrie-Mini-PC-Version)
o Video (nur für Industrie-PC – optional)
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EINRICHTUNG DER GERÄTE 

LABORIE empfiehlt die folgende Einrichtung der Geräte für das AQUARIUS-System: 
Den Versandkarton öffnen. 

• Bei Rollwagen mit einem
Drehgelenk die Klemme 
entfernen, sodass sich das 
Modulgehäuse drehen kann.

• Bei Rollwagen mit Einlegeböden 
diese anheben und mit Schrauben 
ausrichten und in ihre Position 
schieben. Die Schrauben mit einem
1/8”-Innensech-
skantschraubendreher festziehen.

• Die Kunststoffbodenabdeckung auf
das Unterteil des Rollwagens legen.

• Bei Rollwagen mit PC-Regal die 
PC-Stromversorgung unter
dem PC-Regal mithilfe von 
Dual-Lock-Befestigungen 
anbringen.
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AQUARIUS LT AQUARIUS CT AQUARIUS XT AQUARIUS CTS 

LABORIE empfiehlt die Einrichtung des Spinning-Disk-Flowtransducers wie folgt vorzunehmen: 

1 = Spritzschutz 

2 = Transducerbecher 

3 = Drehscheibe 

4 = Scheibenhalterung 

5 = Motorgehäuse 

6 = Becher (1,5 l Stahl, 1 l weiß) 

7 = Motorkabel 

8 = Steckverbinder (Anschluss an Steuerkasten am 
Ständer) 

9 = Uroflow-Halterung (das Ende der Halterung im 
Uhrzeigersinn drehen, um sie sicher am Ständer zu 
befestigen) 

Vergewissern Sie sich, dass alle Kabel geordnet 
und gebündelt sind, um Stolpergefahren 
auszuschließen. 
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FESTSTELLBARE RÄDER 

Während der Untersuchungsverfahren sicherstellen, dass alle Räder blockiert sind, um eine Verletzung des Patienten zu verhindern.

Das AQUARIUS®-System ist mit eingebauten feststellbaren Lenkrollen versehen, sodass das 
System beweglich ist und von Raum zu Raum geschoben werden kann. Hierbei handelt es sich auch 
um eine Sicherheitsfunktion, um zu gewährleisten, dass das System sicher an seinem Platz 
stehen bleibt und sich während der Untersuchungen nicht bewegt. 

Um die Räder festzustellen, den Hebel mit der Unterseite des Fußes herunterdrücken. 

Um die Verriegelung aufzuheben, den Hebel von der Unterseite mit der Fußspitze wieder 
anheben. 

FLOWSTAND 

Montageanweisungen finden Sie in der Broschüre AQUARIUS® Flowstand – Anwenderanweisungen für die Montage auf der LABORIE Software-CD. 
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RESET-TASTE 

Die Reset-Taste betätigen, um das System anzuhalten. Dadurch werden alle beweglichen Komponenten, wie Pumpe und UPP, ausgeschaltet und der digitale Teil des 
Urodynamik-Prozessors zurückgesetzt. Das System ist so ausgelegt, dass es automatisch stoppt oder ein Reset durchführt, wenn die Firmware nach 5 Sekunden 
nicht reagiert.

LUFTBLASENDETEKTOR (OPTIONAL) 

Ein Luftblasendetektor ist am Hub (CHC) angebracht, um Luftblasen im Pumpenschlauch besser erkennen zu können. Um die Detektionsfunktion in 
der Software einzustellen, siehe Seite 141. 

1 = Schlauch von der Pumpe in der Vertiefung platziert 
2 = LED-Lampe: 

Grün = keine Luftblasen 
Rot = Luftblasen erkannt 

Um Fehler zu vermeiden, ist sicherzustellen, dass der Pumpenschlauch sich sicher und vollständig in der Vertiefung befindet.

1 

2 
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UPP-PULLER (OPTIONAL) 

Der batteriebetriebene UPP-Puller, der am Rollwagen oder am Puller-Ständer befestigt ist, kann bei der Durchführung von Untersuchungen des 
Urethradruckprofils (UPP) verwendet werden.  

Abbildung 9: UPP-Montage am Rollwagen Abbildung 10: UPP-Ständer 

Denken Sie daran, den UPP mit dem System zu verbinden. Weitere Informationen zum Anschluss finden Sie unter Hinzufügen eines Geräts zum 
System auf Seite 71. 

Der UPP-Puller besteht aus dem nasenförmigen Vorsprung (Nase), dem Motorkörper, dem Arm und dem Ständer. 
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NASE UND MOTORGEHÄUSE

Der Motorkörper (2) wird von einem 
Kreuzgelenk (7) gehalten, sodass das System 
in einem bevorzugten Winkel positioniert 
werden kann.  
Auf einer Seite des Kreuzgelenks befindet sich 
ein Kugelgelenkkopf (3), der losgedreht 
werden kann, sodass die Naseneinheit in 
unterschiedliche Richtungen bewegt und 
zurückgesetzt werden kann. Die 
Stromversorgung des Motors erfolgt über ein 
Kabel (1), das vom verstellbaren Arm 
ausgeht. Dieses Kabel wird in die Körperseite 
gesteckt. 

Der Katheter wird festgehalten und über den 
Nasenabschnitt gezogen. Er wird durch die 
Katheterführung (5) geführt und an der 
beweglichen Klemme (4) befestigt. Wenn der 
Antrieb eingeschaltet ist, wird der Katheter 
entlang des Nasenschlauchs (6) geschoben 
oder gezogen. Für Sterilisationszwecke 
können sowohl die Katheterführung als auch 
die bewegliche Klemme entfernt werden. 

Abbildung 11: UPP-Naseneinheit und Motorkörper 

1

3

4

2

6

5

7
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ARM UND STÄNDER 

Der verstellbare Arm enthält das elektrische Bedienfeld. Die 
Geschwindigkeitseinstellung des UPP wird im UDS-
Softwareprogramm eingestellt. Der Arbeitsbereich kann auf 
Geschwindigkeiten zwischen 0 bis 3 mm/s eingestellt werden. 

Abbildung 12: UPP-Arm und Ständer 
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TRANSDUCER-EINRICHTUNG UND -ANSCHLUSS 

UROFLOW-TRANSDUCER 

Nachdem der Uroflowmeter und das Zubehör aus ihrer Verpackung genommen wurden, den Uroflowmeter, Stuhl und Becher zur Überprüfung 
zusammenbauen. Durch die in den Uroflowmeter integrierte Bluetooth-Technologie hat der Patient eine optimale Intimsphäre während der Urinabgabe. 
Uroflowmeter, Becher, Miktionsstuhl und Trichter können in einem Raum installiert und der Computer und Drucker in einem anderen Raum aufgestellt 
werden, um dort die Daten zu erfassen und auszudrucken. 

Der Flowtransducer dient dazu, die Harnflussrate zu messen. Er wird zusammen mit UDS-Geräten verwendet, um Miktionsstörungen zu beurteilen. 

Es ist sehr wichtig, dass der Becher richtig auf dem Urocap™ V zentriert ist. Vergewissern Sie sich, dass Becher￼ und Trichter ausgerichtet sind, sich aber 
nicht berühren. 

1. Den Trichter auf den Kunststoffrahmen
des Miktionsstuhls setzen.

2. Den Uroflow-Transducer vorsichtig auf
den Boden stellen.

3. Bei Verwendung eines Urocap™ V, einen
graduierten Becher oben auf den
Transducer stellen. Bei Verwendung eines
Spinning-Disk-Flowtransducers den
Metallbecher unter den Auslass des
Flowtransducers platzieren.

4. Den Miktionsstuhl und Trichter über den 
Urocap™ V und Becher oder über den
Spinning-Disk-Flowtransducer stellen.

Abbildung 13: Urocap™ V unter dem 
Miktionsstuhl platziert 

Abbildung 14: Spinning-Disk-Flowtransducer 
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EINRICHTEN DER PUMPE 

Die Genauigkeit der Pumpe ist nicht gewährleistet, wenn der Schlauch des Pumpenkopfes mehr als einmal verwendet wird. Die Pumpe NICHT in einer 
Geschwindigkeit laufen lassen, die die Grenzwerte des Katheters übersteigt, und die Pumpe nicht bei hoher Geschwindigkeit mit einem Kontrastmittel 
betreiben. 
Um die Patientensicherheit während der normalen Anwendung zu gewährleisten, ist die Druckgrenze der Pumpe auf 150 cmH2O und die 
Volumengrenze auf 750 ml voreingestellt. 

1. Einen Beutel mit Kochsalzlösung am Infusionsständerhaken aufhängen und den Einstechdorn des Pumpenschlauchs in den Beutel einführen.
2. Die Leitung vollständig spülen.
3. Die Rollenklemme verwenden, um den Schlauch zu schließen und den Durchfluss zu stoppen.
4. Den Pumpenkopf öffnen. Den komprimierbaren Teil des Pumpenschlauchs von links nach rechts oben auf die Rollen setzen.
5. Den Pumpenkopf schließen.
6. Die Rollenklemme am Pumpenschlauch öffnen.

EINRICHTUNG DES ROAM™ DX FÜR DRUCK UND EMG 

Das EMG-Kabel in den mit E2 gekennzeichneten Anschluss des 
Roam™ DX einsetzen.  

Das P1-Kabel mit dem mit „1“ gekennzeichneten Anschluss am 
Roam™ DX, das P2-Kabel mit dem mit „2“ gekennzeichneten 
Anschluss verbinden und so weiter.  

• Wenn der ROAM™ DX am Patienten befestigt wird, sollte dieser entweder an einem Hüftgurt, Taillenriemen oder Trageband angebracht werden.
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• Alternativ kann der Roam™ DX auf einen Tisch/Tresen in der Nähe in Taillenhöhe des Patienten (oder höher) aufgestellt werden. Dies hilft zu
verhindern, dass Flüssigkeit entlang der Kabel in den Roam™ DX läuft, wenn der Patient Harn lässt.

Vor Beginn einer EMG-Untersuchung: 
▪ Die Elektroden werden an den 3 EMG-Verbindungsleitungen angebracht.

▪ Der Analbereich des Patienten sollte sauber, trocken und frei von Haaren sein.
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Nachdem die Haut des Patienten ordnungsgemäß vorbereitet 
wurde, können die Elektroden angebracht werden.  

• Zwei Elektroden werden perianal in der 10.00-Uhr- und
14.00-Uhr-Position (oder der 09.00-Uhr- und 15.00-Uhr-
Position) so nahe an der Anokutanlinie wie möglich und
gegenüberliegend platziert.

• Die dritte Elektrode wird an einem Knochenvorsprung
(wie z. B. dem Knie) oder in einem Fettgewebebereich 
der Oberschenkelinnenseite platziert. 

 Dabei sicherstellen, dass die Elektroden so nahe wie möglich 
am Analsphinkter positioniert sind, da die EMG-Aktivität ansonsten 
schwach sein wird. 

Abbildung 15: Platzierung der EMG-Elektroden. 

Es wird empfohlen, jede Elektrode mit einem zusätzlichen Stück chirurgischem Klebeband zu befestigen. Wenn sich die Elektroden ablösen,  die Haut 
abtrocknen und neues chirurgisches Klebeband anbringen. 

[DE]



LABORIE AQUARIUS XT/CT/LT/CTS Benutzerhandbuch AQS-UM01  40 

EINSTELLUNG DES DRUCKWANDLERS FÜR FLÜSSIGKEITSBASIERTES VERBRAUCHSMATERIAL 

Jede Kartusche aus ihrer Verpackung nehmen und die Schutzabdeckung auf der Rückseite und von den Enden der Steckverbinder entfernen. 

Es muss sichergestellt werden, dass die Verschlusskappe immer fest angebracht ist, wenn die Position des Absperrhahns geändert wird. 

Vergewissern Sie sich, dass während der Untersuchung KEINE LUFTBLASEN IM SYSTEM VORHANDEN SIND. 

Abbildung 16: Einrichtung des Druckwandlers 

Wenn Sie mehr als einen Druckwandler verwenden, wiederholen Sie das folgende Verfahren für jeden einzelnen. 
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1. Eine Druckwandlerkartusche an der Druckwandlerplatte anbringen. 
Die Seite mit dem 3-Wege-Absperrhahn des Schlauchs mit der TUB101-
Schnittstelle am unteren männlichen Luer-Anschluss der
Druckwandlerkartusche anbringen.

2. Die Katheteröffnung am anderen Ende des TUB101-Schnittstel-
lenschlauchs anbringen.

3. Eine mit Wasser oder Kochsalzlösung gefüllte Spritze an den 3-Wege-
Absperrhahn anschließen.

4. Die „OFF“-Position des Absperrhahns zum Katheter drehen (siehe
Abbildung 17 B).

5. Vergewissern Sie sich, dass die Leitung zwischen der Spritze und der
Druckwandlerkartusche offen ist. (Beispiel: Den Luer-Stecker
entfernen und/oder den Absperrhahn durch die Druck-
wandlerkartusche öffnen).

6. Die Druckwandlerkartusche mithilfe der Spritze ansaugen, um sie mit 
Wasser zu füllen, bis keine Luftblasen mehr zu sehen sind. 

7. Die Druckwandlerkartusche schließen (Beispiel: einen Luer-Stecker
auf die Druckwandlerkartusche setzen).

8. Die „OFF“-Position des Absperrhahns zum Druckwandler drehen ￼￼

Abbildung 17).).).
9. Den Katheter mithilfe der Spritze ansaugen lassen, um ihn mit Wasser

zu füllen (siehe Abbildung 17 C).
10. Die OFF-Position des Absperrhahns zur Spritze drehen (siehe

Abbildung 17 A).

Abbildung 17: Absperrhahn-Positionen 

Denken Sie daran! Die Druckwandler immer auf einer Höhe mit der Schambeinsymphyse des Patienten halten. 

zum Katheter 

zur Druckwandlerkartusche 

„Off“ zur Spritze 
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MESSWERTGEBER FÜR INFUSIONSVOLUMEN (OPTIONAL) 

1. Vergewissern Sie sich, dass das Kabel des Messwertgebers für
Infusion am Pumpenmodul angebracht ist.

2. Einen Beutel mit 1.000 ml steriler Kochsalzlösung in eine
Druckmanschette legen. Die Druckmanschette am Haken des
Messwertgebers für Infusion aufhängen.

3. Die Druckmanschette aufdehnen￼).
4. Eine Infusionsleitung mit Tropfkammer an Kochsalzlösungsbeutel

anschließen.

• Vergewissern Sie sich, dass die Infusionsleitung nicht festgezogen
o. ä. ist, da dann der Messwert des Messwertgebers nicht genau ist.

• Der Messwertgeber für Infusion ist für bis zu 1.000 ml sterile
Kochsalzlösung oder Wasser kalibriert. Wenn ein anderes
Kontrastmittel verwendet wird, wie z. B. Hypaque, ist eine
Rekalibrierung erforderlich.

• Der Beutel mit der Kochsalzlösung darf keine anderen
mechanischen Komponenten des Systems berühren (wie
Druckwandler usw.).

Um eine schnellere Durchflussrate zu erzielen, eine Infusions druck-
manschette verwenden.

Abbildung 18: Anschlüsse des Messwertgebers für Infusion 
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EINRICHTUNG DES KATHETERS 

Der folgende Abschnitt ist eine Anleitung für die Einrichtung und den Anschluss eines Katheters. 

Stellen Sie sicher, dass nur von LOBORIE gelieferte ein-, zwei- und dreilumige Katheter  für urodynamische Untersuchungen mit dem UDS verwendet 
werden.  

KEINE Foley-Katheter ￼￼￼￼ bei Patienten verwenden, die unter Blaseninfektionen oder Urethrastrikturen leiden. 

EINRICHTUNG DER FLÜSSIGKEITSGEFÜLLTEN KATHETER 

EINRICHTUNG DES BLASENKATHETERS 

Für die Aufzeichnung der Blasendrücke einen Doppellumenkatheter verwenden: 
1. Die Infusionsleitung am Blasenfüllanschluss des Katheters anschießen.

2. Den P1-Messschlauch am Blasenanschluss des Katheters anbringen.

Einen Dreilumenkatheter verwenden, um gleichzeitig den Urethradruck zu messen￼: 
1. Die Infusionsleitung am Blasenfüllanschluss des Katheters anschießen.

2. Den P1-Messschlauch am Blasenanschluss des Katheters anbringen.

3. Den P3-Messschlauch am Blasenanschluss des Katheters anbringen.

ZWEI-KATHETER-TECHNIK 

Um eine Miktionsuntersuchung durchzuführen, bei der der Patient mit einem angelegten Blasenkatheter Harn lässt, kann man zwei separate 
Katheter￼verwenden, einen schmalen/kleinen Katheter für die Druckmessung.  

Am Ende des Füllungsteils der Untersuchung, sollte der für die Infusion verwendete Katheter herausgenommen und der für die Druckmessung verwendete 
Katheter in seiner Position gelassen werden, sodass der Blasendruck während der Miktion gemessen werden kann. 
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ABDOMINALE (REKTALE) BALLONKATHETER 

Den abdominalen (rektalen) Ballonkatheter ￼  am Messschlauch anbringen; der Ballonkatheter sollte entlüftet und frei von Luftblasen sein. 

Einen Einlumenkatheter entlüften, sodass er frei von Luftblasen ist: 
1. Eine 20-ml-Spritze mit 10 ml steriler Flüssigkeit füllen.
2. Die Spritze am Ballonkatheter  anbringen.
3. Den Katheter vertikal in einer „U“-Form halten, mit beiden Enden nach oben

zeigend.
4. Den Spritzenkolben zurückziehen, um die Luft aus dem Rektalballon zu entfernen.
5. Auf den Spritzenkolben drücken, bis der Ballon sich mit Wasser gefüllt hat.
6. Schritte 4 und 5 wiederholen, bis alle Luftblasen aus dem Ballon entfernt sind und

er mit Wasser gefüllt ist.
7. Den Spritzenkolben zurückziehen, um den Ballon zu entleeren.
8. Die Spritze entfernen.
9. Den entlüfteten Messschlauch anschließen￼.

Einen Doppellumenkatheter entlüften, sodass er frei von Luftblasen ist: 
1. Die Spritze am längeren Anschluss anschließen.
2. Den Absauganschluss öffnen (der kürzere Anschluss).
3. Den Katheter spülen, bis sich keine Luftblasen mehr im Ballon befinden.
4. Eine Kappe auf den Absauganschluss aufsetzen.
5. Den Spritzenkolben zurückziehen, um den Ballon zu entleeren.
6. Das Ende des Katheters, das mit dem Messschlauch verbunden werden soll,

festhalten.
7. Die Spritze entfernen.
8. Den entlüfteten Messschlauch am Ballonkatheter anschließen.

Abbildung 19: Entlüften des abdominalen 
(rektalen) Einlumenballonkatheters 
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Einführen eines Ein- oder Doppellumenballonkatheters: 

1. Eine Spritze am Absperrhahn anbringen.

2. Den Rektalballon in den Patienten einführen.

3. Die „OFF“-Position des Absperrhahns zum
Druckwandler drehen).).).

4. Den Ballon mit 1,5 bis 3 ml Wasser füllen.

5. Die „OFF“-Position des Absperrhahns zur Spritze
drehen (B).

 A   B 
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EINRICHTEN DES T-DOC® AIR-CHARGED™ KATHETERS 

1. Den Patienten in eine Rechtsseitenposition oder in Semi-Lithotomie-Position bringen. Die Kabel
am Oberschenkel mithilfe von zwei (2) Velcro® Hüftgurten oder Klettband befestigen.

2. Den Beutel teilweise öffnen, um den farbigen Luer-Lock freizulegen.
3.

3. Prüfen, ob die Druckwandler-Schalter sich in der Position OPEN befinden.

4. Die Schutzkappen vom Katheter und Kabel entfernen.

5. Den Katheter am Kabel befestigen, dafür die Luer-Locks in eine enge Position zueinander
drehen. Mit dem nächsten Katheter fortfahren. Schritte 1-5 wiederholen, bis alle Katheter mit
den entsprechenden Kabeln verbunden sind.

6. Wenn alle Katheter angeschlossen sind, jede Verbindung sichern, indem Sie den Luer-Lock eine
weitere ¼-Drehung drehen, um sicherzustellen, dass die Verbindung eng und fest ist.
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7. Den Katheter mit einem wasserbasierten Gleitmittel beschichten und in den Patienten
einführen:

• Bei weiblichen Patienten: Den Blasenkatheter (Pves) einführen (8-10 cm, wenn ein
Einzelsensor-Katheter verwendet wird, oder 12-14 cm, wenn ein Doppelsensor-Katheter
verwendet wird). Den Abdominalkatheter (Pabd) vaginal in das vordere Scheidengewölbe 
unmittelbar hinter dem Gebärmutterhals einführen. Alternativ den Katheter in das Rektum 
in Höhe des Douglas-Raums einführen, 10-15 cm hinter möglicherweise vorhandenem 
Stuhl. 

• Bei männlichen Patienten: Den Blasenkatheter (Pves) 8 cm plus Penislänge einführen und mit
Klebeband am Penis befestigen. Den Abdominalkatheter (Pabd) oberhalb der Prostata 10-
15 cm über dem Rektalbereich einführen, vorzugsweise entlang der Vorderwand des 
Rektums. KEINE KRAFT ANWENDEN, WENN AUF WIDERSTAND GESTOSSEN WIRD. 

8. Maschinennullpunkt für alle Drücke.

9. Den Kabelschalter des Druckwandlers in die Position CHARGE schieben.
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EINRICHTEN DER FERNBEDIENUNG (OPTIONAL) 

TEIL 1: VORBEREITUNG DER FERNBEDIENUNG. 

1. Die Fernbedienung einschalten.

2. Settings auswählen.
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3. Bluetooth einschalten (wenn noch nicht aktiviert).

4. Fahren Sie mit Teil 2: Den PC vorbereiten.

TEIL 2: DEN PC VORBEREITEN 

Sie haben standardmäßig 2 Minuten, um die folgenden Schritte für die Vorbereitung des PC durchzuführen. Wenn die Zeit abgelaufen ist, müssen Sie die 
Schritte in Teil 1: Vorbereitung der Fernbedienung. fortfahren. 
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1. Mit der rechten Maustaste auf das Bluetooth-Symbol klicken
(meist neben der Systemuhr auf dem Desktop) und Open
Settings aus dem Kontextmenü auswählen.
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2. Die Option Allow Bluetooth devices to find this computer im
Fenster „Bluetooth Settings“ auswählen.

3. Auf OK klicken, um das Fenster zu schließen.
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4. Auf Start > Control Panel > System klicken, um das
Systemfenster zu öffnen.

5. Notieren Sie sich den Computernamen. Sie werden ihn
benötigen, um die Fernbedienung am PC anzuschließen.

1. Fahren Sie mit Teil 3: Einrichtung der Fernbedienung.
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TEIL 3: EINRICHTUNG DER FERNBEDIENUNG 

1. Auf der Fernbedienung auf das Symbol Remote Control
drücken.

Wenn das Gerät niemals zuvor mit dem UDS verbunden war, 
erscheint eine Warnmeldung. Wenn die Meldung erscheint, auf 
OK klicken, um sie zu schließen. 

2. Auf das Symbol „Application Settings Menu“ oben rechts auf
dem Bildschirm klicken.

3. Auf den Menüpunkt Remote Control Settings klicken.
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4. Auf die Schaltfläche Find BT Device unter „Remote Control 
Settings“ klicken.
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5. Warten, bis der Computername (den Sie sich in Schritt 5 auf
Seite 52 notiert haben) in der Liste erscheint.

6. Den Computernamen aus der Liste der Computer auswählen
(LABDD0001 in unserem Beispiel).

7. Die gewünschte PIN des Geräts in das Feld Type the device’s
required PIN eingeben. (Zum Beispiel: 1234). Notieren Sie sich
auch diese PIN-Nummer.
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8. Auf Done klicken, um das Software-Tastenfeld zu schließen.

9. OK klicken.
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Auf dem Bildschirm „Remote Control Settings“ erscheint der 
ausgewählte Computername. 

10. Kurze Zeit warten und dann auf die Sprechblase A Bluetooth
device is trying to connect klicken, wenn diese unten rechts auf
dem Desktop-Computer erscheint.
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11. An der Fernbedienung auf Save Settings im Bildschirm Remote
Control Settings klicken.

12. OK klicken.
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13. Auf die „Zurück“-Schaltfläche unten auf der Fernbedienung
klicken, um auf den Hauptbildschirm zurückzukehren.

14. Fahren Sie mit Teil 4: Abschließende PC-Einrichtung.

TEIL 4: ABSCHLIEßENDE PC-EINRICHTUNG 

1. Auf die Sprechblase A Bluetooth device is trying to
connect auf dem Desktop klicken.
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2. Die PIN-Nummer, die Sie in Schritt 7 auf Seite 55
notiert haben, auf dem Bildschirm Add a device 
eingeben.

3. Next klicken.

4. Auf die Bluetooth-Kopplung warten.
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5. Wenn die Mitteilung This device has been
successfully added to this computer erscheint, auf
Close klicken.

Die Einrichtung der Fernbedienung ist damit abgeschlossen. Auf Seite 243 erfahren Sie, wie Sie die Namen der Schaltflächen ändern und die Anzeige der 
Fernbedienung einstellen können. 
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GERÄTESTATUS UND LAMPENSIGNALE 

PUMPENHUB 

1 = Bluetooth-Statusanzeige: 

• Blau = verbunden

• Grün = System arbeitet, aber nicht verbunden

• Orange = Systemfehler

• Lampe aus = nicht verbunden

2 = Geräte-Statusanzeige: 

• Grün = verbunden

• Blinkend Grün = verbunden und abtastend

• Orange = Systemfehler

• Blinkend Orange = nicht verbunden

• Lampe aus = System aus

3 = Stopp-Taste: 

• Drücken, um die Pumpe anzuhalten

• Drücken und 5 Sekunden halten, um die Pumpe
zurückzusetzen
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1 = Anschluss des Messwertgebers für Infusion: Das 
Kabel des Messwertgebers in den/die Anschlüsse 
einstecken. 

2 = USB-Port: Das USB-Kabel vom UPP oder Urocap™ V 
in den Anschluss einstecken 

3 = BDT: Das Kabel vom Luftblasendetektor in diesen 
Anschluss einstecken 
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ROAM™ DX 

1 = Umschalttasten, um von Bildschirm zu Bildschirm oder Einstellung zu 
Einstellung zu wechseln 

2 = Start- und Stopptasten/Ein-Aus-Taste (OK/Stopp) 

3 = Batterie- und Bluetoothstatus 

4 = Meldungsbildschirm 

Umschalttasten 

Normalmodus = Wechsel von einem Bildschirm auf einen anderen. 
Änderung des Einstellungsmodus (Changing settings mode) (siehe Bildschirm-
beschreibungen auf den folgenden Seiten) = Wechseln von einer Zeile zu einer anderen. 

Änderung des Einstellungsmodus (siehe Bildschirmbeschreibungen auf den folgenden 
Seiten) = Erhöhen/Verringern des ausgewählten Werts oder durch die Optionen 
blättern. 

Start/Stopp/OK 

Manuell Aufwachen aus dem Ruhezustand. 
Für 5 Sekunden drücken, um die Änderung des Einstellungsmodus vorzunehmen. 
Einzeltastenbetätigung (Single push) = Verlassen des „Changing Settings“-Modus. 
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Für 5 Sekunden drücken, um das Gerät in den Ruhezustand zu bringen. 
Einzeltastenbetätigung (Single push) = Verlassen des „Changing Settings“-Modus. 

Status 

Stetig Grün = Externe Stromzufuhr angeschlossen, Batterie vollständig aufgeladen. 
Stetig Grün und Orange = Externe Stromzufuhr angeschlossen, Batterie lädt. 
Stetig Orange (keine Anzeige, keine Tastaturreaktion) = Externe Stromzufuhr 
angeschlossen, Batterie lädt, aber Batteriestand ist noch geringer als „Kritisch“. 
Warten, bis die Batterie vorgeladen ist. 
Blinkend Grün = Keine externe Stromversorgung. Batterie ist OK. 
Blinkend Orange = Keine externe Stromversorgung. Batterie fast leer. Sofort die 
externe Stromversorgung anschließen. 

OFF = Bluetooth-Kanal ist getrennt. 
ON = Bluetooth-Kanal ist verbunden. Jeder übertragene Block bewirkt das Blinken 
dieser LED. 

Meldungsbildschirme 

Drucksensor-Anschlussstatus (P1, P2, P3, usw.) 

• Wenn ein Feld leer ist, wurde für diesen Anschluss keine Funktion ausgewählt (siehe Set up/Modify auf Seite 125).

• E bedeutet, dass EMG für diesen Anschluss ausgewählt wurde.

• Der Scrollbalken zeigt die aktuelle Stärke des Drucksignals an.

• „Sterne“ zeigt die letzten Kalibrierungswerte dieses Anschlusses an: unten für niedrigen Wert und oben für hohen Wert. Wenn beide Sterne rechts am Rand
in einer Linie stehe, wurde der Anschluss noch nicht kalibriert.

• Die Sterne blinken, wenn das Gerät EMG- und Druckproben an das UDS sendet.

Port-Verbindung (USB oder Bluetooth) 

• PC Bond = Markierung bedeutet, dass das Gerät derzeit mit dem UDS verbunden ist. Dieses Symbol kann blinken, wenn das Gerät EMG- und Druckproben
an das UDS sendet.

• BT = Bluetooth-Adresse

• Batterie = Zeigt die aktuelle Batteriespannung (4,2 – voll; 3,6 – leer) und den Status des Ladegeräts an: Batterie voll aufgeladen, Batterie lädt oder
batteriebetrieben (keine externe Stromversorgung).

Systeminformation 

• Unit = Roam™ Seriennummer

• Ver = Firmware-Version
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UROCAP™ V 

BT (Bluetooth)  
Blau = verbunden 
Grün = System arbeitet, aber nicht verbunden 
Orange = Systemfehler 
Lampe aus = nicht verbunden 

Gerätestatus  
Grün = verbunden 
Blinkend Grün = verbunden und abtastend 
Orange = Systemfehler 
Blinkend Orange = nicht verbunden 
Lampe aus = System aus  

Stromversorgung  
Grün = Batterie voll aufgeladen und mit Ladegerät verbunden 
Blinkend Grün = Batterie in Ordnung 
Orange = Ladegerät verbunden und Batterie lädt; Batterie nicht 
vollständig aufgeladen 
Blinkend Orange = schwache Batterie, Zeit zum Wiederaufladen 
Lampe aus = Batterie leer, wieder aufladen 

Abbildung 20: Vorderseite des Urocap™ V 

Einschalttaste = dient dazu, den Uroflowmeter zu reaktivieren 

Reset-Taste = Drücken und 5 Sekunden oder länger gedrückt 

halten, um das Gerät in den Ruhezustand zu versetzen 

Abbildung 21: Unterseite des Urocap™ V 
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UPP 

Das Bedienfeld am UPP-Arm liefert während der Untersuchungen die folgenden Bedienelemente und Signale. 

Den Batteriestand des UPP während der Anwendung genau überwachen.

1 = Pfeile (Auf- und Abwärtspfeile): 

o UP drücken, um am Arm zu ziehen
o DOWN drücken, um den Arm zurückzubewegen

2 = UPP-Stopptaste: 

o Drücken, um UPP zu stoppen
o Drücken und 5 Sekunden oder länger gedrückt

halten, um das Gerät in den Ruhezustand zu
versetzen

3 = Batterie-Statusanzeige: 

o Grün = Batterie voll aufgeladen und mit Ladegerät
verbunden

o Blinkend Grün = Batterie in Ordnung
o Orange = Ladegerät verbunden und Batterie lädt;

Batterie nicht vollständig aufgeladen
o Blinkend Orange = schwache Batterie, Zeit zum

Wiederaufladen
o Lampe aus = Batterie leer, wieder aufladen

4 = Bluetooth-Statusanzeige: 

o Blau = verbunden
o Grün = System arbeitet, aber nicht verbunden
o Orange = Systemfehler
o Lampe aus = nicht verbunden

5 = Geräte-Statusanzeige: 

o Grün = verbunden
o Blinkend Grün = verbunden und abtastend
o Orange = Systemfehler
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o Blinkend Orange = nicht verbunden
o Lampe aus = System aus
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VERWENDUNG DES TOUCHSCREEN-MODULS 

Einrichtung von Geräteverbindungen, Durchführung der Kalibrierung und Einstellung der Pumpenbedienelemente mit dem Touchscreen am 
AQUARIUS®-Turm. 

  1  2  3 

4

 5  6  7  8  9 
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SYMBOL FUNKTION SYMBOL FUNKTION 

1 GERÄTEIDENTIFIKATION: Zeigt den Gerätetyp und den 
Verbindungsstatus an. 

 = Kabelverbindung 

 = Bluetooth-Verbindung 

6 KALIBRIERUNG: Klicken, um das Kalibrierverfahren für jedes 
Gerät zu öffnen.  
Weitere Informationen hierzu finden Sie auf Seite 88. 

2 GERÄTENAME und SERIENNUMMER. 7 PUMPENBEDIENELEMENTE: Klicken, um das 
Pumpeneinstellungsmenü zu öffnen. 
Weitere Informationen hierzu finden Sie auf Seite 77. 

3 STROMVERSORGUNG: Zeigt den Ein- und Ausschaltstatus des 
Geräts an. 

= Gerät eingeschaltet (ON) 

= Gerät ausgeschaltet (OFF) 

= Stromunterbrechung 

8 EINSTELLUNGEN: Klicken, um Geräte hinzuzufügen oder zu 
entfernen und Verbindungen zu konfigurieren.  
Weitere Informationen hierzu finden Sie auf Seite 69. 

4 BATTERIE: Zeigt den Batterieladestatus an 9 (optional) FERNBEDIENUNG angeschlossen.  
Weitere Informationen hierzu finden Sie auf Seite 48. 

5 PC-ANSCHLUSS: 

 = kabelgebundener PC-Anschluss 

 = kabelloser PC-Anschluss 

HOME Klicken, um auf den Hauptbildschirm zurückzukehren. 

Nur sichtbar, wenn Geräte hinzugefügt oder entfernt und 
Pumpenbedienelemente eingerichtet werden oder die 
Kalibrierung durchgeführt wird. 
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SYMBOL FUNKTION SYMBOL FUNKTION 

 = kein PC-Anschluss. Klicken, um auszuschalten 
(OFF) oder den Hub (CHC) erneut zu starten. 

VERWENDUNG DER TOUCHSCREEN-FUNKTIONEN 

HINZUFÜGEN EINES GERÄTS ZUM SYSTEM 

Befolgen Sie diese Schritte, um weitere Urocap™ V Uroflowmeter, UPP-Puller oder Roam™ DX Katheter-Schnittstellenvorrichtungen hinzuzufügen. 

Stellen Sie sicher, dass die UDS-Software geschlossen ist, wenn Geräte angeschlossen werden. 

Das System muss erneut gestartet werden, nachdem alle NGM-Geräte hinzugefügt wurden. 

1. Auf das Symbol für Einstellungen klicken.

2. Auf die Add Device Option klicken.
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3. Warten, bis die Gerätesuche beendet ist.

4. Auf das Gerät klicken, das dem System hinzugefügt werden
soll.

5. Wenn das ausgewählte Gerät orangefarben unterlegt wird,
auf Yes klicken, um es hinzuzufügen.
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6. Diesen Vorgang für weitere Geräte wiederholen.

ENTFERNEN EINES GERÄTS VOM SYSTEM 

1. Auf das Symbol für Einstellungen klicken.

2. Auf die Remove Device Option klicken.
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3. Die zu entfernenden Geräte anklicken und
dann auf Remove klicken.

4. Diesen Vorgang für weitere Geräte
wiederholen.

ANSCHLUSS VON GERÄTEN 

Vor dem Anschluss von Geräten sicherstellen, dass die UDS-Software geschlossen ist und nicht läuft, und dass das Gerät nicht via Bluetooth verbunden 
ist. 
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1. Auf das Symbol für Einstellungen klicken.

2. Auf die Option Configure Connections klicken.

3. Durch Verschieben den Verbindungstyp für die
aufgeführten Geräte auswählen.

Oder 
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4. Auf das Home-Symbol oben links im Bildschirm
klicken, um zurück auf den Hauptbildschirm zu
gelangen.

Die Geräte und ihr entsprechender Verbindungstyp 
werden jetzt angezeigt. 
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EINRICHTUNG DER PUMPENBEDIENELEMENTE 

Die Geschwindigkeit der Pumpe während eines UDS-Verfahrens kontrollieren oder die Pumpe ansaugen lassen, um jegliche Luftblasen aus dem Hub 
(CHC) zu entfernen. 

Vor dem Beginn Folgendes sicherstellen: 
• Die Pumpe ist kalibriert. 

• Die UDS-Software läuft und ein Untersuchungsverfahren mit Drücken ist ausgewählt.
• Luftblasendetektor für „Auto Pump Stop“ während des Ansaugens (Optional). 

1. Auf das Symbol für Pumpe klicken.

2. Die Play-Taste betätigen, um die Pumpe
zu starten.

3. Gegebenenfalls mithilfe der PLUS- und
MINUS-Tasten die Geschwindigkeit

erhöhen oder verringern.
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Vorbereitung der Pumpeneinstellungen 

1. Die Settings-Schaltfläche unten rechts auf
dem Pumpenbildschirm klicken, um den
Pump Settings-Bildschirm zu öffnen.

2. Auf dem Pump Settings Bildschirm den
Grenzwert für Luftblasenerkennung
oder die Volumenwarngrenze für die
Pumpe einstellen.

3. Auf das Bearbeitungsfeld klicken, um die
Werte einzugeben.

4. Im Bearbeitungsfeld Seconds die Zeit (in
Sekunden) eingeben, nach der die
Pumpe anhalten soll, wenn sie keine
Luftblasen mehr entdeckt.
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ANSCHLUSS DES PC/LAPTOPS AN DAS SYSTEM 

Ein wichtiger abschließender Schritt für die Einstellung der Geräteanschlüsse ist die Verbindung des PC/Laptops mit dem AQUARIUS-System. 

Abhängig vom AQUARIUS-Modell unterscheiden sich die in diesem Abschnitt genannten Bildschirme und Schritte von dem, was Sie in Ihrem System 
sehen. 

1. Auf dem Hauptbildschirm des Hubs (CHC) auf
das Symbol für Einstellungen klicken.

2. Zum Abschnitt Device Serial Number
scrollen, auf das leere Feld klicken und die
Seriennummer des Systems eingeben, wie sie
auf dem Gerätekennzeichnungsschild des
AQUARIUS angegeben ist (das Schild
befindet sich am unteren Bein des
Systemrollwagens).
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3. Nachdem die Seriennummer des Geräts
eingegeben wurde, auf Done klicken.

Die Nummer sollte in folgendem Format eingegeben werden: NAXX-1-YYYYYYYY, wobei: XX 
= der Systemmodelltyp von LT oder CT oder XT und YYYYYYYY = alles numerische 
Zeichen. Im Beispiel oben ist die eingegebene Seriennummer NALT-1-12345678. 

4. Auf Set klicken.
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5. Yes klicken, um zu bestätigen, dass die
Device Serial Number korrekt ist.

6. Wenn Sie die Verbindung mit dem
Computer herstellen wollen, auf Bluetooth
Discoverable und dann auf Yes im
„Permission request“-Bildschirm klicken.

7. Auf das Bluetooth-Symbol im Bena-
chrichtigungsfeld des PC klicken, um den PC
mit dem System zu verbinden.
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8. Im Fenster Add a device auf Add device
klicken, um nach dem AQUARIUS-System zu
suchen. Der Name des AQUARIUS-Systems
erscheint als XX-NAXX-YYYYYYYY, wobei: XX
= der Systemmodelltyp von LT oder CT oder
XT und YYYYYYYY = alles numerische
Zeichen.

Im folgenden Beispiel ist das ausgewählte 
System XT-NACT-1-12345679. 

9. Abhängig vom Modelltyp erscheint eine der
zwei Optionen:

a. Wenn es das LT-System ist, wird ein
Passkey automatisch erstellt, wie
hier dargestellt. Auf Pair klicken, um
fortzufahren.
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b. Wenn es das CT-, CTS- oder XT-
System ist, muss manuell ein
Passkey erzeugt werden. Auf Create
a pairing code for me klicken, um
fortzufahren.
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10. Nachdem der Passkey erstellt wurde, diesen
in das Feld auf dem Hub-Bildschirm
eingeben.

Bei LT-Systemen sicherstellen, dass der Code auf 
dem Hub (CHC) und dem Computer identisch ist. 
Erst dann fortfahren und dafür Yes auswählen. 
Danach Next klicken, um fortzufahren. 

CT-, CTS- oder XT-Systeme 

LT-Systeme 
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11. Nach Klicken auf Next kann das folgende
Fenster erscheinen. Das Fenster durch
Klicken auf das X oben rechts schließen.
Nehmen Sie in diesem Fenster keine Än-
derungen vor.

12. Wenn das folgende Fenster erscheint, um zu
bestätigen, dass die Bluetooth-Kopplung
zwischen dem AQUARIUS-System und dem
PC (Desktop/Laptop) abgeschlossen ist, auf
den Link Devices and Printers klicken, um
sicherzustellen, dass sie hinzugefügt wurde.
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Die Einrichtung des Hubs (CHC) ist damit abgeschlossen. 

1: Wenn Sie die Fehlermeldung(en) „Device driver 
software was not successfully installed for Bluetooth 
Peripheral Device“ sehen, dann ignorieren Sie diese 
bitte. Diese ist auf zusätzliche Bluetooth-Profile 
zurückzuführen, die für die Anwendung verfügbar sind, 
aber vom PC nicht erkannt oder verwendet werden. 
Dies hat keine Auswirkung auf die Funktionalität des 
Systems oder des Hubs (CHC). 
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2: Wenn Sie Ausrufezeichen neben „Bluetooth Pe-
ripheral Device” im „Device Manager“ sehen, ignorieren 
Sie diese bitte ebenfalls. Diese ist auf zusätzliche 
Bluetooth-Profile zurückzuführen, die für die 
Anwendung verfügbar sind, aber vom PC nicht erkannt 
oder verwendet werden. Dies hat keine Auswirkung auf 
die Funktionalität des Systems oder des Hubs (CHC). 
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KALIBRIERUNG 

• Während des Kalibriervorgangs dürfen keine USB-Geräte am Hub (CHC) angeschlossen oder entfernt werden.

• Führen Sie das Kalibrierverfahren in einem kontinuierlichen Prozess durch, um die korrekte Funktion und den Batteriestatus der Geräte
sicherzustellen.

KALIBRIERUNG VON FLOW UND VOLUMEN 

FLOW UND VOLUMEN MIT DEM UROCAP UROFLOWMETER KALIBRIEREN 

1. Auf das Symbol für Kalibrierung auf dem Hauptbildschirm klicken.

2. Auf das UC5-Gerät klicken.

3. Der Urocap gibt einen „Piepton“ ab, um zu signalisieren, dass er bereit für die Kalibrierung
ist.

4. Den Anweisungen auf dem Bildschirm folgen, um die Kalibrierung durchzuführen.
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FLOW UND VOLUMEN MIT DEM SPINNING-DISK-FLOWTRANSDUCER KALIBRIEREN 

1. Auf das Symbol für Kalibrierung auf dem Hauptbildschirm klicken.

2. Auf den Spinning-Disk-Flowtransducer klicken.

3. Den Anweisungen auf dem Bildschirm folgen, um die Kalibrierung durchzuführen.

Es ist nicht erforderlich, die Schaltfläche Next auf dem letzten Bildschirm anzuklicken. 
Nach 10 Sekunden ohne Flow beendet der Spinning-Disk-Flowtransducer automatisch 
die Kalibrierung. 

4. Nach Beendigung auf Home klicken, um auf den Hauptbildschirm zurückzukehren.
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KALIBRIERUNG VON DRUCK UND EMG 

Kalibrieren Sie die Druck- und EMG-Kanäle über den Roam™ DX. Stellen Sie dabei sicher, dass der Transducer mit dem Gerät verbunden und fest 
angeschlossen ist. 

DRUCK KALIBRIEREN 

Kalibrierungspunkte werden nur für luftgefüllte Katheter angezeigt. 

1. Auf das Symbol für Kalibrierung auf dem Hauptbildschirm klicken.
2. Auf Roam™ DX klicken, um das Gerät auszuwählen.

3. Durch Klicken den Wandlertyp auswählen, der mit dem System verwendet wird.

4. Auf die entsprechenden Felder für die zu kalibrierenden Wandler und dann Next klicken, um
fortzufahren.

Auf dem Bildschirm abwärts rollen, um die anderen Kontrollkästchen zu sehen (P4, P5). 
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5. 0 (Null) in das Kästchen „Low Load“ eingeben und dann auf Next klicken.

6. Mit der Kalibrierung fortfahren, dabei die Anweisungen auf dem Bildschirm befolgen, bis
„Calibration complete“ angezeigt wird.

7. Auf Return klicken, um zurück auf den Bildschirm Calibrate Pressure Transducers zu
gelangen.

8. Die Schritte 2 bis 7 für die anderen Druckwandlertypen wiederholen.
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EMG-KALIBRIERUNG 

1. Auf das Symbol für Kalibrierung auf dem Hauptbildschirm klicken.

2. Den Roam™ DX auswählen.

3. Auf Electromyography Calibration klicken.

4. Auf EMGR1 Transducer und danach auf Next klicken, um fortzufahren.

5. Die EMG-Leitungen kurzschließen. Der grüne Fortschrittsbalken verschiebt sich, wenn die

Leitungen bewegt werden.

6. Auf Next klicken.

7. Warten Sie dann auf den Abschluss der Kalibrierung.
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KALIBRIERUNG DER PUMPE 

Die Pumpe wird durch Zuweisung verschiedener Pumpensets kalibriert. Es sind maximal 10 Sets zugelassen. 

1. Auf das Symbol für Kalibrierung auf dem Hauptbildschirm klicken.

2. Den Hub durch Klicken auf HUB auswählen.

3. Auf Pump Calibration klicken, um die Option auszuwählen.
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4. Auf das leere Feld klicken und einen Kalibrierungsnamen eingeben. Dies kann zum Beispiel

Saline8f sein. Dieser Name ist für die korrekte Pumpeneinrichtung erforderlich, wie
auf Seite 139 beschrieben.

5. Auf Next klicken, um fortzufahren.

6. Die Pumpenrolle aus der Combobox auswählen.

7. Auf Next klicken.

8. Aus der Liste einen Urocap auswählen und dann auf Next klicken, um fortzufahren.
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9. Aus der Liste die korrekte Kathetergröße auswählen.

10. Auf Next klicken.

11. Die Flüssigkeitsdichte aus der Combobox auswählen und dann auf Next klicken, um

fortzufahren.

12. Next klicken, um mit dem Ansaugen zu beginnen.

Auf Skip klicken, um direkt zur Kalibrierung zu gehen. 

13. Auf OK klicken, um die Pumpe zu stoppen, und danach auf Next klicken, um
fortzufahren.
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14. Den Anweisungen auf dem Bildschirm folgen, um die Kalibrierung zu beenden.

Es gibt während der Kalibrierung 8 Kalibrierungsschritte. 
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KALIBRIERUNG DES MESSWERTGEBERS FÜR INFUSION 

1. Auf das Symbol für Kalibrierung auf dem Hauptbildschirm klicken.

2. Den Hub durch Klicken auf HUB auswählen.

3. Durch Klicken die Option Infusion Transducer Calibration auswählen.

4. Einen Messwertgeber auswählen und auf Next klicken.
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5. Den Low Load-Wert eingeben und dann auf Next klicken.

6. Mit der Kalibrierung fortfahren, dabei die Anweisungen auf dem Bildschirm befolgen, bis die
Kalibrierung beendet ist.

KALIBRIERUNG DES UPP-PULLERS (ZUGMECHANIK) 

Legen Sie sich vor Beginn der UPP-Kalibrierung ein Lineal und einen Bleistift zurecht. 

1. Auf das Symbol für Kalibrierung auf dem Hauptbildschirm klicken.
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2. Durch Klicken den UPP auswählen.

3. Den Anweisungen auf dem Bildschirm folgen, um die Kalibrierung durchzuführen.
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SYSTEMSTATUSMELDUNGEN 

Zeigt den aktuellen Status der mit dem System konfigurierten Gerätemodule an. 

System, Software angeschlossen und funktionierend. 

Es kann eine 1- bis 2-minütige Verzögerung vom Start der Software und der Herstellung 
der Verbindung mit dem System entstehen. 

Bluetooth-Error: 
Dies ist der Fall, wenn der Hub (CHC) versucht, eine Verbindung zum Gerätemodul via 
Bluetooth herzustellen, dies jedoch fehlschlägt. Das Gerät kann außerhalb des Bereich 
sein oder die Batterie ist leer. 

USB-Error: 
Dies ist der Fall, wenn der Hub (CHC) versucht, eine Verbindung zum Gerätemodul via USB 
herzustellen, dies jedoch fehlschlägt. Es kann sein, dass das USB-Kabel des Geräts nicht 
angeschlossen ist. 
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Communication Error: 
Dieser tritt ein, wenn der Hub (CHC) eine erfolgreiche Verbindung via Bluetooth oder
USB herstellt, aber die Kommunikation (Bond) mit der Firmware im Gerätemodul
fehlschlägt. Versuchen Sie, die Stromversorgung des Gerätemoduls wiederherzustellen. 

Sleeping (Geräte-Ruhestatus): 
Dies ist der Fall, wenn der Hub (CHC) das Gerät in den „Schlafmodus“ versetzt. Dies 
geschieht meist nach 2 Stunden Inaktivität. Nach 5 Minuten schaltet sich die LCD ab.
Wenn die UDS-Software läuft, setzt sie das Gerät in den Schlafmodus. 

Battery LOW Disconnect: 
Dies ist der Fall, wenn die Gerätebatterie sehr schwach ist und die Firmware eine
Trennung herbeiführt. Dies erfolgt nicht, wenn das USB-Ladegerät angeschlossen ist. Der 
Text läuft über den Bildschirm. 

Battery LOW: 
Dies ist der Fall, wenn die Gerätebatterie sehr schwach ist. Die Battiere aufladen. 

Battery SUSP: 
Dies ist der Fall, wenn die Batterie eine Temperatur über 45 °C erreicht oder die 
Stromversorgung nicht korrekt am Hub (CHC) angeschlossen ist.  
Den Roam™ DX von der Stromversorgung trennen und danach wieder anschließen. 
Wenden Sie sich an den technischen Support von LABORIE, wenn die Meldung 
weiterhin erscheint. 
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SOFTWARE-MERKMALE UND -FUNKTIONEN 

Auf das Symbol UDS V14 auf dem Desktop doppelklicken, um die UDS-Software zu 
starten. 

Denken Sie daran: Die Patienteninformationen müssen immer vor Beginn einer Untersuchung hinzugefügt werden. 
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DYNAMISCHE BEDIENFELDER 

Die UDS-Untersuchungen können so eingestellt werden, dass sich jedes Mal, wenn die Software gestartet wird, ein Standard-Bedienfeld öffnet. Auf 
Seite 229 finden Sie weitere Informationen über das Hinzufügen eines Bedienfelds. 

Nachdem die Patienteninformationen eingegeben worden sind, auf die gewünschte Untersuchungsschaltfläche klicken, um den voreingestellten Bildschirm zu 
öffnen. 
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Auf dem Pretest Bildschirm kann eine Überprüfung der korrekten Katheterplatzierung durchgeführt und die Druckreaktion überprüft werden, bevor mit 
einer Untersuchung begonnen wird. Es werden keine Daten aufgezeichnet, während dieser Bildschirm aktiv ist. 

• Auf Summ. Review klicken, um die zusammengefassten Ergebnisse der Untersuchung in diesem Stadium einzusehen.

• Auf Return to Test klicken, um zurück auf den Untersuchungsbildschirm zu gehen.

• Auf Main Menu klicken, um zum Hauptbildschirm zurückzukehren.
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ZOOM-SCHALTFLÄCHE IM BEDIENFELD 

Eine Zoom-Schaltfläche im Bedienfeld erstellen und verwenden, um einen bestimmten Abschnitt in einer grafischen Darstellung detaillierter sehen zu 
können. 

Eine Untersuchung muss mindestens 3 Minuten lang sein, damit die Zoom-Funktion korrekt funktioniert. 

1. Mit der Erstellung einer Zoom-Schaltfläche auf dem Bedienfeld beginnen (wenn dies noch nicht erstellt ist).
2. Auf Options > Control Panel Definition klicken und eine leere Fläche auf dem Bedienfeld suchen, um die Schaltfläche hinzuzufügen.
3. Den Namen unterhalb der Spalte Label und den Zoom-Wert unterhalb der Spalte Definition eingeben und die Zoom-Beschreibung aus der Liste in der

dritten Spalte auswählen.
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Zoom-Werte werden immer als 2X, 3X, 4X usw. eingestellt, was 2X = 200 %, 3X = 300 %, 4X = 400 % usw. entspricht. 

4. Auf OK klicken.
5. Die linke Maustaste drücken und gedrückt halten und den Cursor verschieben, um den entsprechenden Bereich in der UDS-Grafik hervorzuheben, der

gezoomt werden soll.

6. Auf Zoom auf dem Bedienfeld klicken.
Ergebnis: Der ausgewählte Bereich wird vergrößert und die Zoom-Schaltfläche auf Zoom Back gesetzt.

7. Auf Zoom Back klicken, um wieder in die normale Ansicht zurückzukehren.
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FILE-MENÜ 

FILE ist das erste Menü, das sich in der Menüleiste oben auf dem Bildschirm befindet. 

Open 

Die Open-Funktion im File-Menü öffnet die Patienten-Untersuchungen, die bereits erstellt worden sind.  
Bevor eine gespeicherte Datendatei  geöffnet wird, immer sicherstellen, dass alle derzeit laufenden Patienten-Untersuchungen gespeichert werden. 
Nachdem die Datei gespeichert ist, wird durch das Öffnen einer gespeicherten Datei automatisch die „alte“ Datei geschlossen. 

Eine gespeicherte Datei öffnen: 
1. In der Menüleiste auf File klicken.
2. Open wählen.

Ergebnis: Das Fenster Open Test öffnet sich.

3. Den Patienten und danach die zu öffnende Datei auswählen.
4. Auf Open Test klicken, um die Datei zu öffnen.
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Zahlen erscheinen immer vor Buchstaben, wenn eine Sortierung in aufsteigender Reihenfolge erfolgt. 

„SCHEDULED TESTS“ ÖFFNEN (OPTIONAL – FÜR I-LIST-SOFTWARE-ANWENDER) 

Die „Scheduled test“-Informationen, die dem lokalen Computer und/oder allen Computern an diesem Tag zugewiesen wurden, abfragen. 

• Nach Namen oder MRN suchen oder eine allgemeine Suche durchführen, um alle Untersuchungen in der i-LIST-Datenbank zu sehen.

• Eine Untersuchung aus der Liste auswählen und auf OK klicken, um fortzufahren.

Der Name des Patienten und die Arzt-Daten können nicht geändert werden. 
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SAVE AS 

Die Save As Funktion wird verwendet, um: 

• Eine Untersuchung das erste Mal zu speichern.

• Eine Untersuchung erneut unter einem anderen Dateinamen zu speichern.

• „Patient File Security“-Funktionen einzurichten (weitere Informationen hierzu finden Sie auf Seite 145.

Beachten Sie bei der Auswahl eines neuen Dateinamens die folgenden Punkte: 

• Der Dateiname sollte zuvor noch nicht verwendet worden sein.

• Der Dateiname darf keine Satzzeichen enthalten.

• Es ist wichtig, dass ein Ablagesystem eingerichtet wird, sodass die Untersuchungsdaten leicht erkannt und wiedergefunden werden können.

Einer Datei einen Namen zuweisen: 
1. In der Menüleiste auf File klicken.

2. Save As auswählen, um das Dialogfeld Save Test File zu öffnen.

Alle Patientendateien werden automatisch unter c:\data directory gespeichert. Zum Ändern des Verzeichnisses siehe „File Saving Directory“ auf Seite 
￼￼256. 

3. In das Innere des Textfelds klicken.
Ergebnis: Der Maus-Cursor wird zum Edit-Cursor.

4. Den gewünschten Dateinamen über die Tastatur eingeben.
Ergebnis: Die Dateierweiterung .DTA wird dem Dateinamen automatisch hinzugefügt.

5. Vergewissern Sie sich, wenn erforderlich, dass das Feld Encrypt Patient Information ausgewählt wird.
6. Den Dateityp, den Sie speichern möchten, aus der Liste „Save As Type“ auswählen.
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7. Auf Save klicken.

Ergebnis: Die Datei wird unter dem neuen Namen gespeichert.

AUSDRUCK DER UNTERSUCHUNG 

Sie können in diesem Fenster eine Auswahl der Informationen treffen, die Sie in einen gedruckten Bericht aufnehmen möchten. 

Wählen Sie das erste Mal, wenn Sie einen Bericht für eine bestimmte Untersuchungskonfiguration auswählen, Ihre bevorzugten Druckoptionen im 
Druckmenü aus und klicken Sie dann auf die Schaltfläche Apply. Jedes Mal, wenn diese Untersuchungskonfiguration ausgeführt wird, erfolgt ein 
automatischer Ausdruck des Berichts, wenn Sie auf PRINT auf dem Bedienfeld klicken. Das Druckmenü erscheint nicht mehr und der Ausdruck erfolgt 
jedes Mal mit Ihren bevorzugten Einstellungen. Über die Schaltfläche Font kann das Aussehen einiger der Punkte im gedruckten Bericht geändert 
werden. Nach Klicken auf die Font-Schaltfläche auf den Namen des Merkmals doppelklicken, bei dem eine Schriftart-Änderung durchgeführt wird. 
Schriftgröße und -art auswählen und auf OK klicken, um die Änderungen zu bestätigen. 

1. In der Menüleiste auf File klicken.

2. Print Study auswählen.
Ergebnis: Das Dialogfeld Print Options erscheint.

3. Sie können die Druckoptionen aus der nachstehenden Abbildung und der dazugehörigen Legende auswählen.
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Abbildung 22: Print Study Dialogfeld 
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Nummer Beschreibung Druckausgabe 

(1) Preferences Uroflow Report 1 Seite Bericht einer Miktionsuntersuchung 

PNTML Summary Ausdruck der PNTML (EVOX) Untersuchungen. Weitere Informationen finden Sie im PNTML 
(EVOX) Benutzerhandbuch. 

Tetra NIRS Summary In der AQUARIUS® UDS-Software nicht verfügbar. 

UDS Report Mehrseitiger, umfangreicher Untersuchungsbericht. 

Graph Pages Grafikseiten des UDS-Berichts. 

Report Pages Berichtseiten. 

(2) Address-o-graph 1-2-seitiger Bericht. 

Physical Exam. Abschnitt körperliche Untersuchung im Address-o-graph-Bericht. 

Standard Report Ausdruck aller zur Untersuchung gehörenden Informationen. 

(3) Miktionszusammenfassung Uroflow zusammenfassende Informationen. 

UPP Zusammenfassung UPP zusammenfassende Informationen. 

Event Summary (Ereignis-
Zusammenfassung) 

Zusammenfassung der Ereignis-Informationen. 

CHESS CHESS-Nomogramm-Informationen. 

URA1 ICS-Nomogramm-Informationen. 

WF Informationen zur Blasenfunktion. 

LinPURR Shafer-Nomogramm-Informationen. 

Diagnosis Informationen zur Patientendiagnose. 

Compliance Ausdruck von Compliancebericht-Informationen. 

History Informationen zur Patientenanamnese. 

ARM ARM Profile Summary ARM Zusammenfassungstabelle als Teil der Berichtseiten (ARM-Option). 

Pressure Profile Summary ARM Druckzusammenfassung als Teil der Berichtseiten (ARM-Option). 

Stationary Summary ARM „stationäre“ Zusammenfassung als Teil der Berichtseiten (ARM-Option). 

Pressure Variation Summary ARM Druckabweichungszusammenfassung als Teil der Berichtseiten (ARM-Option). 

Squeezing Summary ARM „Squeezing“-Zusammenfassung als Teil der Berichtseiten (ARM-Option). 
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Nummer Beschreibung Druckausgabe 

Rectal Volume Summary ARM Rektalvolumen-Zusammenfassung als Teil der Berichtseiten (ARM-Option). 

RAIR Summary ARM RAIR-Zusammenfassung als Teil der Berichtseiten (ARM-Option). 

Expulsion Summary ARM Expulsationszusammenfassung als Teil der Berichtseiten (ARM-Option). 

(4) STEPP N/A 

Eberhard UPP Statik- und Stresskurven und zusammenfassende Informationen als Teil der Ber-
ichtseiten. 

Pediatric Nomograms 
(optional) 

Diese Option steht nur zur Verfügung, wenn der Patient zwischen 3 und 16 Jahren alt ist. Sowohl 
der Bildschirm „Voiding Summary“ als auch die Option „Pediatric Nomogram“ müssen geöffnet 
sein, um diese Funktion zu aktivieren. 

Liverpool Nomogram 
(optional) 

Optionale Funktion für Uroflow-Verfahren. 

Siroky Nomogram (optional) Optionale Funktion für Uroflow-Verfahren. 

(5) Print Border Mit dieser Funktion wird die Grafik mit einer einfachen Grenzlinie eingerahmt. 

(6) Number of Copies Die Standardanzahl der zu druckenden Kopien ist „1“. 
Durch Klicken auf die Combobox kann die Anzahl der auszudruckenden Kopien geändert 
werden. 

(7) Grids Fine Kleine Rasterfelder in der Grafik. 

Coarse Große Rasterfelder in der Grafik. 

None Keine Rasterfelder. 

(8) Print Range Default Untersuchung von Anfang bis Ende. 

UPP Abschnitte Nur UPP-Segmente. 

Default and UPP Ausdruck beider Optionen. 

(9) Schaltflächen
„Apply“ und „Font“

Apply Auf diese Schaltfläche klicken, um eine Standardkonfiguration für den Ausdruck jeder 
Untersuchung einzustellen. 

Font Über die Schaltfläche Font kann das Aussehen einiger der Punkte im gedruckten Bericht 
geändert werden. Nach Klicken auf die Font-Schaltfläche auf den Namen des Merkmals 
doppelklicken, bei dem eine Schriftart-Änderung durchgeführt wird. Schriftgröße und -art 
auswählen und auf OK klicken, um die Änderungen zu bestätigen. 
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Nummer Beschreibung Druckausgabe 

10) Grafik-Skalierung 1-Page Graph Grafik wird auf einer Seite zusammengefasst. 

Standard Standard-Grafikseiten, die ohne Komprimierung oder Erweiterung ausgedruckt werden. 

Min/page Auswählbare Anzahl der Minuten pro Grafikseite. Mit dem Scrollbalken die gewünschte 
Anzahl der Minuten pro Seitenansicht einstellen. 

(11) Segmente Manuell können bis zu 8 Segmente oder Abschnitte der Grafik ausgewählt werden, die 
ausgedruckt werden sollen (im Gegensatz zur gesamten Grafik). 

(12) Preview Graph Segments Zeigt eine Vorschau eines Grafikausdrucks an. 

Informationen zur Druckeinstellung finden Sie auf Seite 116. 
1Griffiths et al. (1989) Neurourology and Urodynamics 8:17-27. 

*Es kann für Erstanwender des AQUARIUS® schwierig sein, den URA zu interpretieren. Der URA muss auf dem Bildschirm vor dem Ausdruck angezeigt
werden. Nachdem die Kurve angezeigt wurde, stehen die Optionen im Dialogfeld zur Verfügung.

BATCH PRINT 

Per Batch-Ausdruck können mehrere Verfahren zusammen ausgedruckt werden (zum Beispiel an einem bestimmten Tag oder in unterschiedlichen 
Zeiträumen).  

Zugriff auf „Batch Print“ für am gleichen Tag durchgeführte Untersuchungen: 
1. In der Menüleiste auf File klicken und Batch Print auswählen.

Ergebnis: Das Fenster Batch Print öffnet sich. 
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Abbildung 23: Batch Print Dialogfeld 
2. Auf Select Today’s klicken.

Ergebnis: Es erscheint ein Dialogfeld, in dem die Anzahl der Datendateien angezeigt wird, die ausgewählt worden sind.
3. Auf OK klicken.

Ergebnis: Die ausgewählte(n) Datei(en) erscheinen im „Print Files“ Feld unten auf dem Bildschirm.
4. Auf Printklicken.
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Zugriff auf „Batch Print“ für an früheren Tagen erstellte Dateien: 
1. In der Menüleiste auf File klicken.
2. Batch Print auswählen.

Ergebnis: Das Batch Print Dialogfeld öffnet sich.
3. Wählen Sie die auszudruckenden Daten durch Doppelklicken auf jede Datei oder durch Klicken auf eine Datei und klicken auf die

Schaltfläche Select aus.
Ergebnis: Die ausgewählte(n) Datei(en) erscheinen im „Print Files“-Feld unten auf dem Bildschirm.

4. Auf Printklicken.

Um den Druckauftrag für eine Datei abzubrechen, nachdem diese im Feld „Print Files“ ausgewählt wurde: 
1. Aus dem Feld Print Files auf die Datei klicken.
2. Remove klicken.

Ergebnis: Der Dateiname verschwindet aus dem Feld Print Files und erscheint wieder im Feld File List.

Die Option Re-Index wird nur benötigt, wenn eine Indexdatei korrupt ist (Korrupt bedeutet, dass die Datei beschädigt ist. Wenn die 
Datei korrupt ist, werden Sie durch eine Meldung aufgefordert, die Re-Index-Option zu verwenden). Mit dieser Option wird die 
Indexdatei erzeugt, die den Patientennamen, Kommentare, das Dateidatum und das Untersuchungsdatum zum schnellen 
Nachschlagen enthält. Die Indexdatei kann durch Reindizierung neu erstellt werden. 

Zugriff auf die Re-Index-Option: 
1. Auf Re-Index klicken.

Ergebnis: Das Re-Indexing Dialogfeld öffnet sich.
2. Auf OK klicken.

Ergebnis: Die Datei wird automatisch erneut indiziert.

DRUCKEINSTELLUNGEN 

1. In der Menüleiste auf File klicken.
2. Print Setup auswählen.

Ergebnis: Das Print Setup-Dialogfeld öffnet sich.

Um Folgendes zu ändern.... Dann... 

Drucker: Den entsprechenden Drucker aus der Druckernamen-Combobox auswählen. 
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Um Folgendes zu ändern.... Dann... 

Papiergröße: In das „Paper size“ Feld klicken. 
Die entsprechende Papiergröße auswählen. 

Papierquelle: Auf das „Source“-Feld klicken. 
Die entsprechende Papierquelle auswählen. 

Ausrichtung des Ausdrucks, 
sodass er vertikal gesehen 

werden kann: 

Auf Portrait klicken. 

3. Auf OK klicken.

Die Änderungen in der Druckereinstellung werden für den Druckvorgang der Untersuchung angewendet.  

Properties: Um die Optionen der Eigenschaften zu ändern, sehen Sie bitte in das Bedienungshandbuch des Druckers. 

ÜBER UDS CLIENT 

Das Dialogfeld About UDS Client zeigt die Kontaktinformationen für den Technischen Support von LABORIE und in der Urodynamik verwendete Formeln 
an. Es enthält auch die Software-Versionsnummer, ServerX-Versionsnummer, Firmware-Versionsnummer und VBN-Versionsnummern (falls zutreffend). 

Die Software-Versionsnummer ist die gleiche für einzelne und mehrere Anschlüsse. 

Es ist auch möglich, ein Fax-Deckblatt zu erstellen, das an die Support-Abteilung für Probleme gesandt werden kann, die Sie möglichweise mit den 
Geräten oder der Software haben. 

Zugriff auf „About UDS Client“ Informationen: 

1. In der Menüleiste auf File klicken.

2. About UDS Client auswählen.
In diesem Fenster erscheinen die Telefonnummer und die E-Mail-Adresse des technischen Supports von LABORIE.

[DE]



LABORIE AQUARIUS XT/CT/LT/CTS Benutzerhandbuch AQS-UM01  118 

Update 

Die Schaltfläche Update wird vom technischen Supportteam von LABORIE verwendet. 

Fax Cover 

Auf die Schaltfläche Fax Cover klicken, um das „Fax Cover sheet“-Fenster zu öffnen. 

In diesem Fenster können Felder mit allen Informationen ausgefüllt werden, die dem Supportteam von LABORIE helfen, das Problem zu identifizieren 
und eine Lösung zu liefern. Nachdem Sie die Informationen ausgefüllt haben, auf die Schaltfläche Print klicken, um das Deckblatt auszudrucken. Faxen Sie 
das Blatt nach dem Ausdruck unter der angegebenen Faxnummer an den LABORIE Support. 
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Der Bereich „Comments“ umfasst maximal 1024 Zeichen. 

IMPORT ASC 

Hiermit können der Import und das Öffnen von im ASCII-Format gespeicherten Untersuchungsdaten durchgeführt werden. 

IMPORT ICS 

Hiermit können der Import und das Öffnen von im ICS-Format gespeicherten Untersuchungsdaten durchgeführt werden. 

EXIT 

Mit der Funktion Exit wird die UDS-Software geschlossen. 

EDIT-MENÜ 

Das EDIT Menü wird verwendet, um ein Bild des Bildschirms zu markieren und zu kopieren, das in eine andere Windows-Anwendung für Berichte oder 
Präsentationen eingefügt wird. 

UNDO 

Mit der „Undo“ Funktion wird der ausgewählte (markierte) Bildblock gelöscht. Dieser Menüpunkt ist nur aktiviert, wenn ein Bildblock ausgewählt 
wurde. 

Die Markierung eines markierten Teils einer Untersuchung aufheben: 
Nach der Auswahl eines Bildblocks auf Undo aus dem Edit-Menü klicken. 
Ergebnis: Die Markierung des markierten Bereichs wird entfernt. 

COPY 

Nachdem ein Bildblock markiert wurde, kann er in die Zwischenablage kopiert werden, damit er in eine andere Windows-Anwendung eingefügt werden 
kann. 
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Die Zwischenablage ist ein temporärer Speicherbereich, der alle markierten Elemente aufnimmt, um die Daten aus einer Windows-Anwendung in eine 
andere zu übertragen. Diese markierten Elemente werden nicht auf dem Bildschirm angezeigt. 

Eine Untersuchung kopieren: 
1. Den zu kopierenden Bildblock markieren.

2. In der Menüleiste auf Edit klicken.

3. Copy auswählen.
Ergebnis: Der markierte Bildblock wird in die Zwischenablage kopiert, bis er in eine andere Anwendung eingefügt oder die Auswahl durch den
Undo-Befehl aufgehoben wird.

4. Sie können den markierten Bildblock in ein anderes Dokument in Word, PowerPoint, Notepad und so weiter einfügen.

MARK BLOCK 

Mit der „Mark Block“-Funktion wird ein Bildblock markiert (zum Beispiel eine Grafik oder ein Grafiksegment), sodass er in eine andere Anwendung kopiert 
und dort eingefügt werden kann, die von der Windows-Bildeinfügefunktion unterstützt wird (zum Beispiel: Microsoft Word, PowerPoint). Diese Funktion 
kann auch im Workstation-Modus verwendet werden.  

Die „Mark Block“-Funktion ist während der Durchführung einer Untersuchung nicht verfügbar. Die Untersuchung unterbrechen, um diese Funktion zu 
aktivieren. 

Einen Bildblock markieren: 
1. Eine gespeicherte Untersuchung öffnen oder das Verfahren unterbrechen, wenn es läuft.

2. In der Menüleiste auf Edit klicken und Mark Block auswählen.
Ergebnis: Der Cursor wechselt in ein „+“-Symbol.

3. Den + Cursor von der oberen linken Ecke des zu markierenden Bereichs zur unteren rechten Ecke ziehen.
Ergebnis: Dieser Bereich wird unterlegt und kann kopiert werden.
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Anweisungen zum Kopieren des markierten Bereichs finden Sie im Abschnitt Copy. 
Um eine Markierung aufzuheben, siehe Undo. 

UNDO SET ZEROES 

Mit der Funktion „Undo set zeroes“ werden die Einstellungen der vorherigen Set-Zeroes-Transaktion gelöscht. 

Set Zeroes einer Untersuchung aufheben: 
1. Auf Undo Set Zeroes aus dem File-Menü klicken.
2. Undo auswählen.

Ergebnis: Die vorherige „Set Zeroes“-Transaktion wird aufgehoben.
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ZOOM – AUSGEWÄHLTER BEREICH UND ZURÜCK 

Mit der Zoom-Schaltfläche erhalten Sie eine detailliertere Ansicht eines bestimmten Bereichs einer grafischen Darstellung. 

Eine Untersuchung muss mindestens 3 Minuten lang sein, damit die Zoom-Funktion korrekt funktioniert. 

1. Die linke Maustaste drücken und gedrückt halten und den Cursor verschieben, um den entsprechenden Bereich in der UDS-Grafik hervorzuheben, der
gezoomt werden soll.
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2. Auf Edit > Zoom Selected Area klicken.
Der ausgewählte Bereich wird vergrößert und ist jetzt im gesamten Grafikfenster zu sehen.

3. Den Bereich der gezoomten Grafik erneut hervorheben und Zoom Selected Area wählen, um ggf. mit dem Vergrößern fortzufahren.
oder
auf Edit > Zoom Back klicken, um zur Original-Grafik zurückzukehren.

Es ist möglich, eine Zoom-Schaltfläche zu erstellen, um mit einem Mausklick eine gewünschte Vergrößerung zu erzielen. Weitere Informationen hierzu 
finden Sie auf Seite 105. 
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CONFIG-MENÜ 

Durch Klicken auf den Titel des CONFIG Menüs werden die folgenden Menüpunkte aufgelistet: 

OPEN 

Die „Open“-Funktion im Config-Menü ist ähnlich dem Betätigen einer Schaltfläche auf dem Bedienfeld, um eine Untersuchungskonfigurationsdatei zu 
laden und ein Verfahren zu beginnen. 

Öffnen einer Konfiguration mithilfe der „Open“-Funktion: 

1. In der Menüleiste auf Config klicken.
2. Open wählen.

Ergebnis: Das Fenster Open Test File öffnet sich.
3. Die Untersuchungskonfigurationsdatei (z. B. CMG.cfg) auswählen und auf Open klicken.

Ergebnis: Die Untersuchungskonfiguration wird geladen und es kann mit dem Verfahren begonnen werden.

SAVE AS

Die „Save As“-Funktion im Config-Menü wird verwendet, um eine Konfiguration zu speichern oder neu zu definieren.

Denken Sie daran, ein neuer Dateiname soll keine Satzzeichen enthalten.

Es ist wichtig, dass ein Ablagesystem eingerichtet wird, sodass die Untersuchungsdaten leicht erkannt und wiedergefunden werden können. Zum
Beispiel: Eine Datei für Uroflow-Untersuchungen kann Uroflow.CFG oder CMG.CFG für Zystometrie genannt werden.
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Eine Konfiguration unter einem anderen Dateinamen speichern: 

Alle Untersuchungskonfigurationsdateien werden automatisch im Verzeichnis C:\CFG gespeichert. 

1. In der Menüleiste auf Config klicken und Save As auswählen.
Ergebnis: Das Dialogfeld Save Test File erscheint.

2. Den Dateinamen über die Tastatur eingeben. Das Encrypt Patient Information Kontrollkästchen markieren, wenn Sie die Patienteninformationen
verschlüsseln wollen.
Ergebnis: Die Dateierweiterung „.CFG“ steht für „Konfiguration“ und wird automatisch dem Konfigurationsdateinamen hinzugefügt.

3. Auf Save klicken.

Ergebnis: Die Datei wird unter dem neuen Namen gespeichert.

SET UP/MODIFY 

Über die Set up/Modify Menüpunkte können Sie: 

• Geräte mit einer Untersuchungskonfigurationsdatei verbinden

• Die Datenrate ändern

• Die Kanalreihenfolge ändern

• Die Kanalbezeichnung, Skala und Einheiten ändern

• Den Untersuchungsnamen ändern

• Kanäle hinzufügen

• und noch vieles mehr…. 
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Abhängig von der Softwarekonfiguration des Systems sind alle oder einige der Registerkarten sichtbar. 

Zugriff auf die Konfiguration: 
1. In der Menüleiste auf Config klicken und Set up/Modify auswählen.

Abbildung 24: Configuration-Fenster 
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Die Konfigurationsparameter werden in zwei Hauptkategorien unterteilt: 

• Kanalparameter – diese konfigurieren individuelle Kanäle

• Globale Parameter – diese passen das gesamte Untersuchungsformat an.

Bevor Sie eine neue Untersuchungskonfiguration speichern, können Sie mithilfe der Schaltfläche Clear Config alle Änderungen löschen, die Sie in diesem
Fenster vorgenommen haben, und erneut von vorn beginnen.

Im folgenden Abschnitt werden die Parameter beschrieben, die geändert werden können, sowie die Vorgehensweise, um diese Änderungen
durchzuführen. Nach jeder Änderung können Sie die Schaltfläche Apply betätigen, um die durchgeführten Änderungen zu übernehmen. OK drücken,
um die letzten Änderungen zu übernehmen und das Fenster zu schließen.

Wenn Sie die Größe der Spalten oder Reihen im Konfigurationsfenster ändern wollen, sodass Sie die Informationen in den Feldern leicht lesen können, den 
Mauszeiger auf die schattierten Bereiche entlang der oberen oder linken Seite des Fensters platzieren. Den Mauszeiger über die Zeilen zwischen den 
Spalten oder Reihen bewegen, bis er zu einem doppelseitigen Pfeil wird. Wenn er zu einem doppelseitigen Pfeil geworden ist, den Pfeil über die Spalten 
ziehen, um die Spaltengröße zu ändern, oder nach oben und unten ziehen, um die Zeilengröße zu ändern, bis Sie die richtige Größe der jeweiligen Spalte 
oder Reihe erzielt haben. Es ist erforderlich, diese Funktion jedes Mal durchzuführen, wenn Sie das Konfigurationsfenster öffnen, da diese Einstellung 
nicht gespeichert wird. 
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Geräte 

Abhängig vom System müssen die zum System gehörenden Geräte mit der neuen Untersuchungsdatei verbunden 
werden, wenn eine neue Untersuchungsdatei konfiguriert wird, um eine ordnungsgemäße Datenerfassung zu 
gewährleisten. 
Das Gerät aus der Liste für Roam™ DX- und Uroflowmeter-Geräte (Urocap oder Spinning-Disk-Flowtransducer) 
auswählen. 

Dies muss zuerst eingestellt werden, bevor irgendwelche anderen Einstellungen auf diesem Bildschirm 
vorgenommen werden. 

Wenn Geräte vom System entfernt oder diesem hinzugefügt werden, muss die „Configuration“-Registerkarte 
mit dem neu hinzugefügten oder entfernten Gerät aktualisiert werden. 
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Kurvenindex und Kanäle 

Die Standard-Transducerkonfiguration zeigt Folgendes an: Uroflow, Pves, Pabd, Pdet, EMG, IH2O 
und VH2O. Kanäle können entsprechend Ihres Bedarfs hinzugefügt oder entfernt werden. 

Einen Kanal hinzufügen: 

1. In das Channel Title Feld klicken und den gewünschten Wandler/Kanal auswählen, der
verwendet werden soll.

2. Schritt 1 wiederholen, bis alle erforderlichen Wandler ausgewählt worden sind.

3. Auf OK klicken.

4.
Einen Kanal entfernen: 

1. In das Feld klicken, das dem gewünschten Wandler entspricht.

2. „None“ aus der Liste unter der Spalte Channel Name auswählten, der dem Unter-
suchungskanal entspricht, den Sie entfernen möchten.

3. Auf OK klicken. Ergebnis: Die angegebenen Wandler werden aus der Grafik entfernt.
Bei Kurven prüfen, ob Display Curve im 

„Attributes“-Abschnitt ausgewählt wurde. Maximal 8 
Kurven können auf dem Bildschirm oder einem Ausdruck 
angezeigt werden. 

Channel Title 

Der Kanaltitel kann für einfache Identifizierungszwecke geändert werden, indem ein neuer 
Name in das Feld „Channel title“ im Dialogfeld „Configuration“ eingegeben wird.  
Wenn der Standardname „Flow“ zum Beispiel zu ungenau ist, kann er durch „Uroflow“ ersetzt 
werden.  

Änderung des Kanalnamens: 

1. In das Channel Title Feld klicken. Ergebnis: Der Kanaltitel wird unterlegt.

2. Den neuen Kanaltitel über die Tastatur eingeben.

3. Auf OK klicken. Ergebnis: Der neue Kanaltitel wird gespeichert und in der Grafik angezeigt.
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Scale-Min/Max 

Der Skalenbereich einer Untersuchungskurve kann festgelegt werden. 

Änderung der Maximum- und Minimum-Skala:

1. Auf das Feld Scale (Min) oder Scale (Max) eines Kanals klicken.

2. Den gewünschten Wert für Min und Max über die Tastatur eingeben. Ergebnis: Die Änderung des Skalenbereichs wird in der Grafik angezeigt.

Wenn der eingegebene vollständige Skalenwert ein geringerer Wert als der aufgezeichnete Spitzenwert ist, wird die Spitze (Peak) der Kurve abgeschnitten oder in die 
Kurve darüber erweitert, dies hängt vom Grafik-Clipping ab Weitere Informationen zum Grafik-Clipping finden Sie auf Seite ￼262. 

Einheiten 

Die Standardeinheiten für jeden Kanal können geändert werden. 

Änderung der Skaleneinheiten: 

1. Auf das Feld Units eines Kanals klicken.

2. Auf den Abwärtspfeil neben der Units Combobox klicken.

3. Die gewünschte Einheit auswählen. Ergebnis: Die Änderung der Einheit wird im Grafik-Kanal
angezeigt.
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Math Def. 

„Math Channels“ können verwendet werden, um Rechenoperationen zwischen einem oder mehreren 
Kanälen durchzuführen. Die „Math Cannels“ unterstützen Grundrechenoperationen (zum Beispiel 
Addition, Subtraktion, Multiplikation und Division) und den Parenthesen-Operator (). 
Zum Beispiel: 
Wenn Sie den Druckkanal mit der Bezeichnung Pves haben, der in cmH2O kalibriert ist und Sie den Druck in 
mmHg angezeigt haben möchten: Da 1 mmHg = 1,36 cmH2O können Sie die folgende mathematische 
Definition für den „Math 1 channel“ eingeben und die Einheiten des Math1-Kanals in mmHg ändern. 

Pves / 1,36 

Dabei beachten, dass die Kanalbezeichnung in der Math-Definition ganz genau der Bezeichnung des 
Kanals entsprechen muss, den Sie verwenden möchten. Außerdem können Sie die Operatoren kombinieren, 
um komplexe mathematische Ausdrücke zu erstellen, wie: 

((Pves+100) - Pabd) / 1,36 

Erstellen eines Math-Kanals:
1. Config und danach Set up/Modify auswählen.
2. Einen neuen Kanal auswählen.
3. Die Curve Index-Nummer auswählen.
4. Math 1 in der Spalte Channel Name auswählen.
5. Den Namen des Math-Kanals in die Spalte Channel Title eingeben.
6. Die Units auswählen.
7. Die Math Def eingeben.
8. Die Data Rate wie gewünscht bestätigen.
9. Display Curve in der Spalte Display Attributes auswählen, um die Kurve auf dem Bildschirm

anzuzeigen.
10. Auf Apply klicken.
11. Auf OK klicken, um das Fenster zu schließen.
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Datenrate 

Die Datenrate ist die Anzahl der Datenpunkte, die während des Aufzeichnungsprozesses pro Sekunde erfasst und abgespeichert werden. 
Variabler High-Rate-Samplingmodus II: Datenratenbegrenzung 10 bis 3000: Vielfaches von 10 
Variabler High-Rate-Samplingmodus III: Datenratenbegrenzung 10 bis 5000: Vielfaches von 10 

Eine höhere Datenrate bedeutet, dass die aufgezeichnete Kurve mehr Datenpunkte hat und daher präziser ist. Höhere Datenraten erfordern jedoch mehr 
Speicherplatz. Daher wird die maximale Dauer der Untersuchung verringert. 

Ändern des Textfelds mit der Datenrate: 

1. In das dem bestimmten Kanal entsprechenden Data Rate Feld klicken. Ergebnis: Es erscheint ein Data Rate Feld mit einer Liste der Datenraten.

2. Den gewünschten Wert aus der Liste auswählen. Ergebnis: Die neue Datenrate wird in der Grafik angezeigt.

3. Den Schritt für andere Kanäle wiederholen (nur High-Rate-Samplingmodus).

Anzeigeoptionen 

Display Attribute: Auswählen, um die Kanaldaten als Kurve in der Grafik oder im digitalen Fenster 
anzuzeigen. 
Curve Appearance: Mit dieser Funktion kann die Kanalfarbe individuell angepasst werden. Sowohl 
die Kanalkurvenfarbe als auch die Kanalinformationen werden in der neuen Farbe angezeigt (und 
so auf einem Farbdrucker ausgedruckt). 
Display Line Width: Mit dieser Funktion kann die Kanalkurve auf dem Display dicker (in Pixel) 
angezeigt werden. Auf das Feld unter der Spalte Display Line Width des Untersuchungskanals 
klicken und die gewünschte Linienbreite in Pixel eingeben. 
Print Line Width: Mit dieser Funktion kann die Linienbreite der Kanalkurve nur auf dem 
Ausdruck dicker (in Pixel) dargestellt werden. Auf das Feld unter der Spalte Print Line Width des 
Untersuchungskanals klicken und die gewünschte Drucklinienbreite in Pixel eingeben. 
Symmetry: Mit dieser Funktion kann eine Kanalkurve gespiegelt werden, um eine negativ 
gespiegelte Kurve zu erhalten. Auf das Feld unter der Spalte Symmetry des Unter-
suchungskanals klicken und Mirrored oder Simple auswählen. 
Interior: Mithilfe dieser Funktion kann die Fläche unter der Kurve mit der Kanalfarbe gefüllt 
werden.  

Use Filter 

Mithilfe dieser Funktion werden die Kurvenfilteroptionen ausgewählt. Sie können auswählen, keinen Filter oder einen Standard Filter, einen 2 Second Filter oder einen 
RealTime 2 Second Filter zu verwenden. Die Optionen „2 Second Filter“ und „RealTime 2 Second Filter“ können auf jeden Druckkanal angewendet werden und 
entfernen alle positiven und negativen Spitzen aus der Untersuchungskurve. 
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Display Original 

Mit dieser Option kann die Originalgrafik auch dann angezeigt werden, wenn Sie für die Grafik einen Filter ausgewählt haben. 

Printable 

Mit dieser Option können Sie die Grafik auf dem Ausdruck der Untersuchungsergebnisse sehen. 

i-LIST Channel

(nur für i-LIST Office Reporter Anwender) 
Auswahl der Kanäle, deren Daten in den i-LIST-Berichten erscheinen. 

EMG Slider 

Wenn eine Untersuchung ausgewählt wurde, die EMG beinhaltet, ist der EMG-Kanal auf dem 
Bildschirm mit einem Schieberegler daneben versehen. 
Anstatt die Werte manuell einzustellen, können die Max- und Min-Skalenwerte des EMG-Kanals 
mithilfe dieses Schiebereglers eingestellt werden. Der Regelbereich des Schiebereglers reicht 
von (-10 µV…+10 µV) bis (-1.000 µV...+1.000 µV). 
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Test Name und Graph Scrolling Speed 

Der Name der Untersuchung kann erstellt oder geändert werden, sodass leicht nach ihm 
gesucht und er wiedergefunden werden kann.  

Die Scrolling-Geschwindigkeit kann für alle Kurven eingestellt werden. Mit der Scrolling-
Geschwindigkeit wird die Auflösung der Kurven eingestellt. Es ist nur möglich, einen Wert 
zwischen 2 und 10 Pixel pro Sekunde einzustellen. Daher gilt: Je höher die Pixelzahl, desto höher 
die Auflösung. 

Den Untersuchungsnamen ändern*: 
1. Auf das Feld Test Name klicken und den aktuellen Untersuchungsnamen auswählen.

2. Den neuen Untersuchungsnamen eingeben und auf OK klicken.

-oder-

Den neuen Untersuchungsnamen eingeben und die Grafik-Scrollgeschwindigkeit (Graph 
Scrolling Speed) einstellen. 

Einstellen der Grafik-Scrollgeschwindigkeit: 
Auf das Feld „Graph Scrolling Speed“ klicken und die Anzahl der Pixel pro Sekunde für die Kurve 
eingeben. Auf OK klicken, um die Werte zu übernehmen. 

*HINWEIS für i-LIST-Anwender: Der Untersuchungsname ist
sehr wichtig, um eine korrekte Verknüpfung mit dem
Patienten-Datenbanksystem herzustellen. Bitte wenden Sie
sich an LABORIE, bevor Sie den Untersuchungsnamen ändern.

EINRICHTEN DES CH5- UND EMG1-KANALS 

Der CH5- und der EMG1-Kanal können nicht am gleichen Roam™ DX angeschlossen werden. Wenn ein Roam™ DX verwendet wird, kann nur der CH5- 
oder der EMG1-Kanal für die Untersuchung verwendet werden. 
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REGISTERKARTE „UPP“ 

Unter dieser Registerkarte kann die Geschwindigkeit der Zugmechanik (UPP-Puller) eingestellt oder die „UPP Distance Summary“ basierend auf der 
Distanz berechnet werden, die ein Katheter mit einem angebrachten Sensor gezogen wird. 

Vergewissern Sie sich vor dem Einrichten dieser Funktion, dass die UPP-Schaltfläche im Bedienfeld ausgewählt wurde. 

1. Den Distanzsensor/Katheter an Ch1 anschließen.

Vergewissern Sie sich, dass der Sensor zuvor kalibriert wurde. 

2. Die Option Distance Sensor Channel auswählen.

3. Ch1 aus der Liste auswählen.
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4. Auf OK klicken.

5. Eine UPP-Untersuchung durchführen und auf UPP Stop drücken, um die Untersuchung zu beenden.

6. Auf Info > UPP Summary klicken, um den „UPP Summary“-Bildschirm zu öffnen.

7. Auf Preview klicken, um die UPP-Plots anzuzeigen. HINWEIS: Die Schaltfläche „Preview“ steht nur zur Verfügung, wenn die Option „UPP Distance
Summary“ verwendet wird.
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8. Auf OK klicken, um den Bildschirm zu schließen.

9. Die Ergebnisse können ausgedruckt werden; hierfür auf File > Print Study klicken und dann die Option UPP Summary auswählen. (hier wird ein
Beispielausdruck gezeigt)
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Wenn Sie zurück zur UPP-Puller-Geschwindigkeit gehen möchten, auf die Schaltfläche Configure klicken und die Option UPP Puller Speed auswählen. 
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REGISTERKARTE „PUMP“ 

Unter dieser Registerkarte können die Parameter für die Pumpe eingestellt werden, wie Flüssigkeitsdichte und Auto-Pumpen-Aktivitäten. Die Pumpe 
auswählen, die während einer Untersuchung verwendet werden soll, und deren Einstellungen konfigurieren. 
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Merkmal Funktion 

Calculate VH2O from IH2O Wenn dieses Kästchen markiert ist, werden die VH2O-Werte von der Software automatisch basierend auf IH2O 
berechnet. 

Empty Infusion Bag Warning  (nur aktiviert, wenn „Calculate VH2O from IH2O“ nicht ausgewählt wurde) 
Wenn das Kästchen angekreuzt ist, stoppt die UDS-Software automatisch die Pumpe und zeigt die folgende 
Warnmeldung an: Infusion bag is empty! wenn der Messwertgeber für Infusion 5 ml oder weniger Flüssigkeit im 
Infusionsbeutel misst. 

Volume Channel Gibt den Infusionsvolumenkanal an 

Pressure Channel Gibt den für die Druckrückkopplung verwendeten Kanal an. HINWEIS: Dieser Kanal darf keinen Math-Kanal 
enthalten. 

Slow (Ratengeschwindigkeit) Legt die langsame Geschwindigkeit der Durchflussrate (Flowrate) fest 

Medium 
(Ratengeschwindigkeit) 

Legt die mittlere Geschwindigkeit der Durchflussrate fest 

Fast (Ratengeschwindigkeit) Legt die schnelle Geschwindigkeit der Durchflussrate fest 

Prime (Ratengeschwindigkeit) Legt die Ansauggeschwindigkeit der Durchflussrate fest 
HINWEIS: Mit der Ansaugratenfunktion läuft die Pumpe in der Geschwindigkeit, die im „Prime“-Feld im Bildschirm 
„Configure Pump“ eingestellt ist. Die Standardgeschwindigkeit ist 150 ml/min. 

Pressure￼ Stoppt die Pumpe, wenn der Druckkanal diesen Grenzwert überschreitet. VORSICHT: 150 cmH2O nicht überschreiten 

Volume Limit Stoppt die Pumpe, wenn der Volumenkanal diesen Grenzwert überschreitet. 
VORSICHT: 750 ml nicht überschreiten. 

Volume Warning Limit 
(Volumen-Warngrenzwert) 

Zeigt eine Warnmeldung an, wenn das infundierte Volumen den angegebenen Grenzwert erreicht. 

Infusion Bag Warning Limit Wenn der eingegebene Wert größer als Null ist, zeigt die UDS-Software die folgende Warnmeldung an, ohne die 
Pumpe zu stoppen: Infusion bag is nearing empty! wenn der Messwertgeber für Infusion einen Wert feststellt, der 
gleich oder geringer als der im Feld „Infusion Bag Warning Limit“ eingegebene aber größer als der Grenzwert für 
„Infusion Bag is empty“ ist. Standardmäßig ist der Grenzwert 5 ml. 

Auto Pump Option 
• Stop 
• Slow 
• Med 
• Fast 

Mit dieser Option startet die Pumpe bei Untersuchungsbeginn in der ausgewählten Pumpengeschwindigkeit. Stop 
auswählen, wenn Sie diese Option nicht verwenden möchten. 
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Merkmal Funktion 

Auto Pump Event Diese Option zeichnet automatisch Ereignisse auf, wenn die Pumpe läuft oder stoppt. Diese Option ist 
standardmäßig aktiviert. Die Markierung des Kästchens aufheben, um die Funktion zu deaktivieren. 

Pump Calibration Name: Die entsprechende Kalibrierungslinie aus der Dropdown-Liste auswählen. Der Name enthält alle während der 
Pumpenkalibrierung im Hub (CHC) abgegebenen Informationen.  

Luftblasendetektor 

Der Luftblasendetektor hilft, den Pumpenschlauch auf etwaiges Vorhandensein von 
Luftblasen zu überwachen. Wenn eine Luftblase im Schlauch festgestellt wird (wenn 
der Sensor feststellt, dass der Wert im Bubble Channel niedriger ist als der in diesem 
Abschnitt festgelegte Bubble Channel Limit), zeigt die Software eine Warnmeldung 
an und fragt, ob die Pumpe angehalten werden soll. 

Wenn während der Infusion eine Luftblase entdeckt wird, den Schlauch entlüften, 
zurücksetzen und es erneut versuchen.  

Den Luftblasendetektor einstellen: 
1. Auf Config > Set up/Modify und dann auf die Registerkarte Pump im
Configuration-Fenster klicken.
2. Im Bereich Bubble Detector die Option Always on wählen, um den Luft-
blasendetektor zu aktivieren, den Kanal einstellen, der die Druckänderung erkennen soll
und den Wert für Bubble Channel Limit eingeben.
3. Auf Apply und dann auf OK klicken.

Wenn eine Luftblase entdeckt wird, erscheinen die entsprechenden Bildschirme abhängig von den in dieser Registerkarte konfigurierten Einstellungen. 
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Einrichtung der Pumpe 

Vergewissern Sie sich, dass die Roam™ DX-, 
Uroflowmeter- und die Pumpen-Comboboxen für die 
entsprechenden Kanäle auf dem UDS-Konfigu-
rationsbildschirm ausgewählt sind. 
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• Einen „Pump Calibration Name“ auswählen.

• Die Werte in den Felder Slow, Medium und Fast 
eingeben.

• Auf OK klicken, um das Dialogfeld „Pump
Configuration“ zu schließen.

REGISTERKARTE „FILTER“ 

Unter dieser Registerkarte kann die Filterfrequenz eingestellt werden. Der niedrigste verfügbare Wert ist 0,5 Hz (Werte darunter bringen keine 
signifikanten Ergebnisse). 

REGISTERKARTE „UROFLOW“ 

Unter dieser Registerkarte können die Parameter für Uroflow, wie „Auto Voiding Summary“ und „Auto printing“ eingestellt werden. Weitere 
Informationen hierzu finden Sie auf Seite 188. 
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REGISTERKARTE „ARM“ 

Unter dieser Registerkarte können die Kanäle eingestellt werden, die den ARM-Messungen entsprechen. Es kann entweder eine Vierkanal-ARM-
Untersuchung oder eine Achtkanal-ARM-Untersuchung durchgeführt werden. Weitere Informationen zur Einrichtung und Durchführung von ARM-
Untersuchungen finden Sie auf Seite 286.  

Die Option Enable Reverse Pump auswählen, um die Schaltfläche „Reverse Pump“ auf dem Bedienfeld zu aktivieren. 

REGISTERKARTE „SECURITY“ 

Unter dieser Registerkarte können die Sicherheitsfunktionen eingestellt werden, um den Namen eines Patienten sowie Informationen wie 
Krankenaktennummer (MRN), Anamnese, Diagnose, Name des Arztes, Name des Krankenhauses und Kommentare zu schützen oder zu verschlüsseln. 
Wenn Verschlüsselung eingestellt wird, können die entschlüsselten Informationen nur über den Software-Key, der mit der Patientendatei verknüpft ist, 
eingesehen werden. 

Diese Sicherheitsfunktion muss eingestellt werden, bevor Sie mit einer Untersuchung beginnen, und es muss sichergestellt sein, dass auf Ihrem PC ein 
Software-Key installiert ist. 

Verschlüsselung der Patienteninformationen: 
1. Auf Config > Setup/Modify klicken.

2. Auf die Schaltfläche Security klicken.

3. Vergewissern Sie sich, dass das Feld Enable Encryption of Patient Information markiert ist.

4. Auf Add klicken, um die Seriennummer Ihres Software-Keys der sicheren Liste hinzuzufügen.
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5. Auf Apply klicken, um Ihre Auswahl zu speichern.

6. Führen Sie dann Ihre UDS-Untersuchung durch und speichern Sie die Untersuchungsdaten.

7. Vergewissern Sie sich, dass im Feld File > Save As Encrypt Patient Information markiert ist.

Wenn Sie die Patienteninformationen mit der ausgewählten Verschlüsselung gespeichert haben, können alle Informationen nur über den Software-Key
eingesehen werden, der auf dem PC installiert und mit der Untersuchungsdatei verknüpft ist. Wenn eine Person einen Software-Key verwendet, der nicht
mit der Datei verknüpft ist, sieht diese das Wort ENCRYPTED in allen Feldern des „Patient Info“-Fensters.
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Sie können auswählen, alle Datendateien (auch die bereits gespeicherten) mit einem neu hinzugefügten Serien-Key zu verschlüsseln. Die Option Update 
all the data files…. auswählen, um die Verschlüsselung auf alle Dateien anzuwenden. 

REGISTERKARTE „I-LIST EVENTS LINKING“ 

Ereignisse („Events“), die sich nicht unter I-LIST Events Linking befinden, können möglicherweise in einigen der ausgedruckten Berichte nicht 
erscheinen. 

Versuchen Sie Folgendes, um zu prüfen, ob ein Ereignis in der „Event Summary“ verfügbar ist: 

1. In der Software auf Config > Set up/Modify klicken.

2. Auf die Registerkarte I-LIST Events Linking klicken.

LIST Office Reporter zeigt nur die Ereignisse an, die in der Liste unter dieser Registerkarte erscheinen. Auch muss Annotation Alias genau dem 
entsprechen, was Sie auf der UDS-Untersuchung markieren, um unter Event Summary erscheinen zu können. 

Wenn ein Ereignis hinzugefügt werden soll, oder Sie die Software mit einer anderen Sprache als Englisch verwenden, ist es erforderlich, den 
Ereignisnamen in der Liste Annotation Alias auf der linken Seite hinzuzufügen oder zu übersetzen. Einmal auf den Event-Namen und dann nochmals 
darauf klicken, danach ggf. den Namen eingeben.  
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Zum Beispiel wird das Ereignis Strong Cough der Liste hinzugefügt. Wenn man dann auf die Schaltfläche Event im Bedienfeld klickt, erscheint das neu 
hinzugefügte Ereignis im Feld Event Annotation. 
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Auf Graph Segments klicken, um Breite, Höhe und Minuten pro Seite für die Berichte individuell anzupassen. 

Channels auswählen, um die Kanäle anzugeben, die auf dem Grafik-Segment erscheinen sollen. 
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REGISTERKARTE „COMPLIANCE“ 

Die Blasen-Compliance Funktion kann konfiguriert werden, indem manuell das/die Segment(e) ausgewählt oder die Compliance automatisch berechnet 
wird. Um das Compliance-Berechnungsfenster zu öffnen, die Registerkarte „Compliance“ unter Setup/Modify wählen ODER auf die Schaltfläche 
Configure im Fenster Compliance Measurement Range klicken (siehe Seite 207). 
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1. Die Kanäle angeben.

Standardmäßig wird die Volumenänderung vom VH2O-Kanal und die Druckänderung vom Pdet-Kanal berechnet. 

2. Auswahl der „Compliance Method“.

• Manual – manuelle Auswahl der Segmente. Das Registerkartenfenster „Compliance“ schließen. Auf Info oben in der Menüleiste und Compliance klicken,
um die Segmente manuell auszuwählen. Die Auto compliance Funktion ist nicht verfügbar, wenn Manual ausgewählt ist.

• Auto: Events – Die Ereignisse für die automatische Compliance-Berechnung auswählen.

• Auto: Infusion/100 ml – Infusionsvolumen von 100 ml werden als Referenzpunkte für die „Auto compliance calculation“ verwendet.

3. Die „Auto Compliance Calculation Method“ auswählen.
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• Incremental – Die Compliance wird zwischen den Ereignissen berechnet, die aus
der Selected Compliance Events Liste rechts auf dem Bildschirm ausgewählt
werden.

• Average from 0 – Die Compliance wird vom Nullzeitpunkt der Untersuchung b
zu den Ereignissen berechnet, die aus der Selected Compliance Events Liste
rechts auf dem Bildschirm ausgewählt werden.

• Average from PVR – Die Compliance wird von dem Punkt aus berechnet, an dem 
VH2O = PVR am Ende des Druck-/Flusstests (ml) eingegeben wird. 

• Average from Event – Das Untersuchungsereignis aus der Dropdown-Liste al
Referenzpunkt für die „Auto compliance“-Berechnung auswählen.

4. Auswahl der „Compliance Events“.

• Nur bei Anwendung mit „Auto compliance“-Methoden. Die relevanten Untersuchungsereignisse für die Berechnung der Blasen-Compliance auswählen.

Denken Sie daran, die Konfiguration durch Klicken auf Save As zu speichern, danach „Save“ klicken. 
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INFO MENÜ 

INFO ist das nächste Menü, das sich in der Menüleiste oben auf dem Bildschirm befindet. 

Patient Information 

Die Einzelheiten einer Patientendatei können über das Dialogfeld „Patient Information“ leicht hinzugefügt und abgefragt werden. 

Zugriff auf das Dialogfeld „Patient Information“: 
1. In der Menüleiste auf Info klicken.
2. Patient Info auswählen.

Ergebnis: Das „Patient Information“-Dialogfeld öffnet
sich.

3. In das Feld Patient klicken.
4. Den Namen des Patienten über die Tastatur

eingeben.
5. Schritte 3 und 4 wiederholen und die rele-

vanten Informationen in die richtigen Felder
eingeben.

6. Auf OK klicken.
Ergebnis: Die in das Dialogfeld „Patient
Information“ eingegebenen Daten werden
gespeichert und das Dialogfeld „Patient
Information“ schließt sich.

 oder 
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Bitte denken Sie bei der Eingabe von Informationen in das Dialogfeld „Patient Information“ an Folgendes: 

• Das Geburtsdatum des Patienten muss als Monat/Tag/Jahr, mit einer oder zwei Ziffern für den Monat oder Tag und vier Ziffern für das Jahr eingegeben werden.
Zum Beispiel: Die Daten eines am 8. September 1972 geborenen Patienten werden als 09/08/1972 oder 9/8/1972 eingegeben.

• Nachdem das Geburtsdatum eingegeben wurde, wird das Feld Age automatisch berechnet und ausgefüllt. Pädiatrische Patienten (im Alter von 16
Jahren und darunter) erfordern eine zusätzliche Konfiguration. Weitere Informationen hierzu finden Sie auf Seite 359.

Das Alter wird vom Tag der Geburt bis zum Tag der Untersuchung berechnet. 

• Das Geschlecht des Patienten muss korrekt ausgewählt werden, damit die entsprechende statistische Abweichung unter „Voiding Summary“ erscheint.
• Das Feld „Patient Name“ muss vollständig ausgefüllt sein, damit die entsprechende statistische Abweichung ausgedruckt werden kann. Geben Sie

Leerzeichen in das Feld Patient Name ein, wenn Sie keinen Namen eingeben möchten.
• Im Feld „MR#“ (Krankenaktennummer) werden die Krankenakten der Patienten nachverfolgt, insbesondere dann, wenn Namen mehr als einmal

erscheinen.
• In die Liste der Ärzte kann mehr als ein Arztname aufgenommen werden. Einen Namen eingeben und auf die Schaltfläche Add Doctor klicken. Um

Namen zu entfernen, auf Clear List klicken.
• Wenn eine Änderung bei einer der Patienteninformationen in diesem Fenster vorgenommen wird, ist es erforderlich, die CFG- und/oder DTA-Datei

erneut zu speichern, um diese Änderungen zu bestätigen.
• Die Patientennamen (Vor- und Nachname) dürfen nur eine Länge von bis zu 44 Zeichen haben.
• Krankenaktennummern dürfen keinen Schrägstrich (\) oder Vorwärtsschrägstrich (/) enthalten.

HISTORY

Eine kurze Patientenanamnese kann zusammen mit der Untersuchung gespeichert werden. Die Informationen im Feld „History“ sind zum späteren 
Nachschlagen leicht wiederauffindbar. 

1. In der Menüleiste auf Info klicken und History auswählen.
Ergebnis: Das History-Fenster öffnet sich.

2. Hier können hilfreiche Informationen über den Patienten eingegeben werden.
3. Auf OK klicken.

Ergebnis: Die Informationen werden gespeichert.

Auf die History-Funktion kann auch über das Dialogfeld Patient Information zugegriffen werden. 
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DIAGNOSIS

Die „Diagnosis“-Funktion besteht aus Anmerkungen zur Erkrankung eines Patienten, nachdem die Untersuchung durchgeführt wurde. Diese können 
zusammen mit der Untersuchung gespeichert werden, und die Informationen im Feld „Diagnosis“ sind zum späteren Nachschlagen leicht 
wiederauffindbar. 

1. In der Menüleiste auf Info klicken und Diagnosis auswählen.
Ergebnis: Das Feld „Diagnosis“ erscheint.

2. Informationen über den Patienten können hier über die Tastatur eingegeben werden.
3. Zum Verlassen auf OK klicken.

Ergebnis: Die Informationen werden gespeichert, wenn die Datei gespeichert wird.

Auf die „Diagnosis“-Funktion kann auch über das Dialogfeld „Patient Information“ zugegriffen werden. 

X-Y PLOT

Der X-Y Plot kann verwendet werden, um den Urethra-Widerstandsfaktor (urethral resistance factor, URA), die Blasenfunktion (bladder work funktion, 
WF), die Grafik des linearen passiven Urethrawiderstands (Linear Passive Urethral Resistance, LinPURR) und die CHESS-Funktion zu berechnen. 
Die Formeln zur Bestimmung des ICS-Nomogramms (URA) ￼i befinden sich im Anhang des Artikels. 

ICS-Nomogramm (URA) 

Mithilfe des ICS-Nomogramms oder URA￼l Widerstandsfaktor) Plots wird festgestellt, ob die Harnröhre eines Patienten obstruiert oder nicht obstruiert ist, 
indem Flow- und Detrusordruckkurven () einer Druck-/Flussuntersuchung auf der x- bzw. y-Achse grafisch dargestellt werden.). 

Ein Standard-Verzögerungsfaktor von 0,8 Sekunden wird verwendet, um etwaige Verzögerungszeiten zu berücksichtigen, bevor der Uroflow-Transducer 
bei einer Druckflussuntersuchung den Flow feststellt. Es dauert etwa 0,5 bis 1,0 Sekunden, bis der Urin durch die Harnröhre und in den Uroflow-Becher 
gelaufen ist. (Weitere Informationen finden Sie im Artikel von Dr. Griffith). 

Die URA-Kurve ist eine Kurvenberechnung, die auf dem mathematischen Modell der Gleichung basiert. Weitere Informationen entnehmen Sie bitte 
dem Artikel von Dr. Derek Griffiths. 
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Mathematische Gleichungen zur Berechnung der URA: 

URA Index: 

URA ￼

Der URA-Index ist der y-Schnittpunkt (Pdet Schnittpunkt) der folgenden Gleichung: 

Pdet￼￼  bei maximalem Flow 

Wobei: 

• d = 3,8 x 10

• Q = maximaler Flow

• Pdet = Detrusordruck

• Pdet* = Detrusordruck bei maximalem Flow

Anzeige des URA-Fensters: 

1. Auf Info > X-Y plot klicken

2. ICS Nomogram (URA) auswählen.

Ergebnis: Das URA Plot-Fenster öffnet sich.

• In der URA Plot-Abbildung ist die durchgezogene Kurve Flow vs. Pdet 
und die gepunktete Kurve URA.

• Um die URA-Option aufzuheben, im Fenster URA Plot Exit! wählen.

• Um die URA-Kurve anzuzeigen, URA auswählen.

Druck-Fluss-Kurve 

URA-Kurve 
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Festlegung des Analysebereichs: 

1. Auf Options! im Fenster URA plot klicken, um das Fenster X-Y 
Plot Options zu öffnen.

2. Auf die Schaltfläche Change klicken.

3. Den Segment-Analysebereich durch Ziehen des Mauszeigers von
links nach rechts über die Grafik auswählen.

4. Auf Confirm klicken.

5. Auf OK klicken.

Standardmäßig wird die gesamte Untersuchung in der Grafik
dargestellt und die Skala wird durch die Skala der Kanäle festgelegt
Diese Informationen werden im Fenster „X-Y Plot Options“
konfiguriert.
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Den Namen, Grenzwert oder die Skala eines Kanals  ändern: 

1. Auf Options! im Fenster URA plot klicken.

2. Auf das Textfeld mit dem zu ändernden Namen, Grenz- oder Skalenwert doppelklicken.

3. Die entsprechende Änderung eingeben.

4. Schritte 2 und 3 wiederholen, bis alle Parameteränderungen abgeschlossen sind.

5. Zum Verlassen auf OK klicken.

LinPURR

Die LinPURR-Grafikii basiert auf den Arbeiten von Dr. Werner Schäfer. Die Funktion LinPURR (Linear Passive Urethral Resistance) steht zur Verfügung,
nachdem eine Miktionsuntersuchung (Druck-Fluss) durchgeführt wurde. Eine LinPURR-Grafik definiert den Urethrawiderstand durch Vergleich von Flow
und Druck.

Öffnen der LinPURR-Grafik:
1. Ins Info-Menü gehen und X-Y Plot auswählen.

2. LinPURR auswählen.
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Um die LinPURR-Option aufzuheben, Exit! im Fenster LinPURR auswählen. 

Eine Komplementäranalyse der Druck-/Flussdaten kann mithilfe der Techniken von Dr. Schäfer in Kombination mit denen von Abrams/ Griffiths erfolgen. 
Diese Darstellung erfolgt auch im X-Y-Format, die Flow- und Pdet-Kanäle werden jedoch auf der Y-Achse bzw. der X-Achse dargestellt. 

Änderung der für die LinPURR-Grafik eingestellten Parameter: 
1. Aus dem LinPURR-Fenster auf Options klicken.
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2. Die Kanalparameter oder der Grafikbereich können mithilfe der folgenden Tabelle geändert werden:

Zum... Folgendes durchführen...

Ändern des Kanals: 1. Auf die Dropdown-Schaltfläche der Combobox neben den zu ändernden Kanalnamen klicken.
2. Den entsprechenden Kanal auswählen.

Ändern der Skala oder des Grenzwerts: 1. In das Innere des entsprechenden Textfelds doppelklicken.
2. Einen neuen Wert über die Tastatur eingeben.

Ändern des Grafikbereichs: 1. Auf die Schaltfläche „Change“ klicken.
2. Den neuen Bereich auswählen.

Aktivieren/Deaktivieren der Anzeigeoptionen*: Auf das Kontrollkästchen neben der entsprechenden Option klicken.

Anzeigefarbe: Die Schaltfläche „Change“ wählen. 
Auf die Schaltfläche „Color“ klicken. 

*Bei diesen Optionen handelt es sich um Unterscheidungsbereiche, um dem Arzt zu helfen, das Druck-/Flussereignis zu kategorisieren.

In der folgenden Liste werden diese Bereiche erklärt: 

• Pressure Flow CurvePdet￼ Kurve, aber in der LinPURR Kurve werden der Druckkanal in einer horizontalen Achse und der Flow-Kanal in einer vertikalen
Achse dargestellt.

• URA curve (URA-Kurve)Siehe hierzu Seite ￼155.

• URA Region Border (Bereichsgrenze): Diese Linien in der Grafik unterteilen die obstruierten, nicht obstruierten und nicht eindeutigen Bereiche.

• Detrusor ContractilityDie Detrusor-Kontraktionsfähigkeit wird in Form von 6 Bereichen dargestellt, die linksdiagonal wie folgt markiert sind: VW, W-,
W+, N-, N+ und S. Die Software überprüft den Datensatz, um die relative Stärke der Blase mit Pdet￼ und Flow als Faktoren zu bestimmen.

• Normalized Detrusor Contractility Die normalisierte Detrusor-Kontraktionsfähigkeit stellt den Druck dar, bei dem die minimale „normale“
Blasenleistung auf der Detrusor-Kontraktionsskala￼ erzielt wurde. Wenn der Wert 0 ist, wurde kein Mindestdruck erzielt.

• OBI Pressure Dieser Druck stellt den Punkt bei 50 % von Qmax + 2,4 ml/s dar.
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• LinPURR GradeUm eine LinPURR-Einstufung vorzunehmen, die zwei folgenden Datenpunkte verwenden:

o Pdet bei max. Flow

o Pdet bei min. Flow

Der LinPURR-Plot kann eine grobe Schätzung der relativen Einstufung zeigen (0 bis VI.) 
Die digitalen Parameter für LinPURR können aus dem Feld „LinPURR Summary“ eingesehen werden. 

Zugriff auf das Feld LinPURR Summary: 
1. Im Fenster LinPURR auf Summary klicken.

2. Die Informationen im Feld LinPUUR Summary können mithilfe der folgenden Tabelle geändert werden:

Zum... Dann...

Kanal- oder Druckwerte in den 
Feldern ändern: 

Auf das zu ändernde Textfeld doppelklicken und die neuen Informationen über die Tastatur eingeben. 

Änderung der LinPURR-
Einstufung oder Detrusor-
Kontraktionsfähigkeit: 

Die entsprechende Option auswählen. 

Die Informationen für den 
Ausdruck speichern: 

Auf Save Diagnosis klicken. 
Ergebnis: Die numerischen Ergebnisse der LinPURR-Berechnung erscheinen im Abschnitt „Info-Diagnosis“ der 
Software. 

• Auf Exit! klicken, um die LinPURR Summary zu verlassen.

• Die Exit!-Schaltfläche im Fenster LinPURR plot wählen, um das LinPURR Plot-Fenster zu schließen.
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Blasenfunktion (WF) 

Die Blasenfunktioniii basiert auf den Arbeiten von Dr. Derek Griffiths. Diese Funktion steht zur Verfügung, nachdem eine Miktionsuntersuchung (Druck-
Fluss) durchgeführt wurde. Mit ihr wird die Blasenfunktion (auch Blasenleistung genannt) berechnet, wofür Pdet, Flow und Blasenvolumen verwendet 
werden. 

Zugriff auf den WF Plot: 
1. Auf Info klicken.

2. X-Y plot auswählen.

3. WF auswählen.
Ergebnis: Der WF-Plot wird angezeigt und die gesamte Untersuchung wird auf dem Bildschirm dargestellt. Die Parameter können im Fenster WF
Configuration geändert werden.

• Exit! im Fenster WF Plot klicken, um das Fenster WF Plot zu verlassen.

Die Standardeinstellungen des WF-Plots über das „WF Configuration“-Fenster ändern:
1. Im WF-Fenster auf Options klicken.

2. Den Bereich ggf. über die Schaltfläche Change ändern.

3. Alle anderen Änderungen über die Tastatur eingeben.

4. Auf OK klicken.
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VtVolQ

Der „Inflow Channel‘ ist standardmäßig das infundierte Volumen (VH2O) und der „Outflow Channel“ ist das Miktionsvolumen (Volumen). 

Die Volumen sind meist in ihrem Wert gleich. Wenn ein Patient jedoch ein Harnrestvolumen in der Blase hat, sind die Volumen nicht gleich.  

Residual volume Der Unterschied zwischen Zufluss und Abfluss. Dieser wird automatisch berechnet und im Textfeld „Residual Volume“ angezeigt. 

Für diese Funktion verwendete mathematische Formeln werden hier aufgeführt. 

Bladder Power: 

• WF = (Einheiten:  W/mm2) 

Wobei: vdet =

In diesen Gleichungen verwendete Variable und Konstante werden hier aufgeführt: 

• Q = maximaler Flow

• Pdet = Detrusordruck
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• Vol = Blasenvolumen = infundiertes Volumen - Miktionsvolumen

• a = 25 cmH2O

• b = 6 mm/s oder 0,6 cm/s

• V = 10 ml

CHESS 

Die CHESS-Klassifikationiv basiert auf den Arbeiten von Dr. K. Hofner. Mit dieser Funktion wird eine zweidimensionale Darstellung basierend auf den 
unabhängigen Werten von Footpoint (pvoid min) und Curvature aus dem passiven Urethrawiderstandsverhältnis (PURR) angezeigt. Der CHESS-
Menüpunkt wird nur aktiviert, wenn es einen FLOW- und PDET-Druck gibt. 

Verwendung der CHESS-Funktion: 
1. Eine Untersuchung mit Flow-, Volumen- und Druckkanälen durchführen.
2. Die Untersuchung stoppen.
3. Auf Info > Event Summary klicken.

Ergebnis: Das Dialogfeld Event Summary wird angezeigt.
4. Auf Info > X-Y Plot > ICS Nomogram (URA) klicken.
5. Info > X-Y Plot > CHESS auswählen.

Ergebnis: Das Dialogfeld CHESS Classification Scheme öffnet sich.

6. Auf File > Print Study klicken. HINWEIS: Vergewissern Sie sich, dass URA und CHESS
markiert sind.

7. OK klicken, um die Untersuchung auszudrucken.

Siroky-Nomogramm 

Das Siroky-Nomogramm wurde entwickelt, um eine präzise und zuverlässige Indikation 
der Blasenauslassobstruktion zu liefern.v Die von LABORIE gelieferte UDS-Software wird 
Ihnen helfen, die Ergebnisse einer Uroflow-Untersuchung vor und nach der Therapie zu 
vergleichen. 
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Ansicht des Siroky-Nomogramms: 
1. Die UDS-Software starten und auf File > Open klicken, um eine gespeicherte Uroflow-Untersuchung zu öffnen.
2. Auf Info > X-Y Plot > Siroky Nomogram klicken.

Nach der Auswahl der „Siroky Nomogram“-Option öffnet sich ein Fenster, das die grafische Darstellung der durchschnittlichen (Average) und maximalen 
(Maximum) Flowraten enthält, wie von Siroky et al. entwickelt. 
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Das Siroky-Nomogramm bezieht sich nur auf erwachsene männliche Patienten. 

Sie können hier die durchschnittlichen und maximalen Flowraten für die jeweilige Untersuchung vergleichen. Die dargestellten Kreise in der Grafik 
zeigen, wo sich der Patient in der Kurve befindet. 

Nach Ansicht der Grafik können Sie auf das X in der oberen rechten Ecke klicken, um die Grafik zu verlassen und wieder in das UDS-Grafikfenster 
zurückzukehren. 
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Liverpool-Nomogramm 

Das Liverpool-Nomogramm wurde entwickelt, um eine präzise und zuverlässige Indikation für normale Uroflowraten zu liefern.vi Sie können die 
Harnflussrate eines Patienten vor und nach der Therapie mithilfe der LABORIE-Software und der integrierten Liverpool-Nomogramme vergleichen. 

Ansicht des Liverpool-Nomogramms: 
1. Die UDS-Software starten und auf File > Open klicken, um eine gespeicherte Uroflow-Untersuchung zu öffnen.
2. Auf Info > X-Y Plot > Liverpool Nomogram klicken.

Nach der Auswahl der „Liverpool Nomogram“-Option öffnet sich ein Fenster, das die grafische Darstellung der durchschnittlichen (Average) und
maximalen (Maximum) Flowraten enthält, wie von Siroky et al. entwickelt.

Das Liverpool-Nomogramm findet nur bei erwachsenen männlichen und weiblichen Patienten Anwendung. Abhängig vom Geschlecht des Patienten 
werden im Nomogramm-Fenster entweder die Durchschnittswerte für Männer oder Frauen angezeigt. 

Sie können hier die durchschnittlichen und maximalen Flowraten für die 
jeweilige Untersuchung vergleichen. Die dargestellten Kreise in der Grafik zeigen, 
wo sich der Patient in der Kurve befindet. 

Nach Ansicht der Grafik können Sie auf das X in der oberen rechten Ecke 
klicken, um die Grafik zu verlassen und wieder in das UDS-Grafikfenster 
zurückzukehren. 
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EVENT SUMMARY

Sie können während der gesamten Untersuchung Ereignisse hinzufügen, um aufzuzeichnen, was während des Verfahrens geschieht. 

Ereignisse werden automatisch gespeichert und angezeigt, wenn Sie die Markierungen registrieren. Eine Zusammenfassung dieser Ereignisse steht weiter unten zur 
Übersicht zur Verfügung.  

Ereignisse können über die „Event“-Schaltflächen auf dem Bedienfeld oder durch Klicken mit der rechten Maustaste auf das Grafikfenster hinzugefügt werden. Ein 
Event-Marker wird im Grafikfenster angezeigt.  
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Über das „Event Annotation“-Fenster 

• Das „Event Annotation“-Fenster enthält eine Liste der Ereignisse, die der Grafik hinzugefügt werden können.

• Auf das „Event Annotation“-Fenster kann auf zwei Weisen zugegriffen werden:
o Auf die Schaltfläche Event im Bedienfeld klicken.
ODER
o Mit der rechten Maustaste auf die Grafik klicken und die Option Insert Event auswählen.

• Wenn ein Ereignis bereits aufgeführt ist, auf den entsprechenden Namen klicken, um es der Grafik hinzuzufügen.

• Anpassen der Ereignisliste:
1. Auf Event im Bedienfeld klicken.
2. Um ein Ereignis von der Liste zu löschen, dieses auswählen und auf die Schaltfläche Remove klicken.
3. Um ein neues Ereignis in die Liste aufzunehmen, dieses in das Edit-Feld eingeben und auf die Schaltfläche Add

klicken.
4. Nachdem alle Ereignisse eingegeben wurden, auf Save klicken.
5. Vergewissern Sie sich, dass der Dateiname korrekt ist und klicken Sie dann auf Save.
6. Auf Close klicken, um die Liste zu schließen.

• Durch Klicken auf Sort kann die Liste alphabetisch sortiert werden.

• Auf die Auf- und Abwärtspfeile auf der rechten Seite klicken, um ein Ereignis in der Liste nach oben oder unten zu
bewegen.

Ansicht der „Event Summary“: 
1. Auf Info > Event Summary klicken.

Ergebnis: Die Ereignisse werden in chronologischer Reihenfolge aufgeführt.
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Änderung der Schriftart 

Wenn Sie das Aussehen des Inhalts des „Event Summary“-Fensters ändern möchten, können Sie Schriftart und -größe durch Klicken auf das Font-Menü 
auswählen. Hierdurch öffnet sich ein Font-Auswahlmenü, in dem Sie die Schriftart Ihrer Wahl einstellen können.  

Dies findet nur auf die Bildschirmanzeige Anwendung und nicht auf den ausgedruckten Hardcopy-Bericht. 

 „Event Annotation“ hinzufügen oder ändern 

1. Auf ein Ereignis und dann auf Annotate! klicken.
Ergebnis: Die Event Annotation (Ereignis-Anmerkung)
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2. Den Text in das Textfeld mithilfe der Tastatur eingeben oder aus der Liste auswählen.
3. Auf OK klicken.

Ergebnis: Das Textfeld Event Annotation schließt sich.

TIPP: Denken Sie daran, immer die CFG-Datei abzuspeichern, um die Änderungen unter „Event Annotation“ zusammen mit den Dateien
aufzubewahren.

Löschen von Ereignissen aus der „Event Summary“

1. Das Ereignis markieren. (Um mehrere Ereignisse zu markieren, die Strg-Taste gedrückt halten, während Sie auf die Ereignisse klicken.)
2. Auf Delete! klicken.

Ergebnis: Das Meldungsfeld Confirm Event Delete wird angezeigt.
3. Auf OK klicken.

Ergebnis: Das/die Ereignis(se) wird/werden aus der „Event Summary“ gelöscht.
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Ereignisse löschen oder umbenennen – Schnellverfahren 

Um ein Ereignis in einer Grafik zu löschen oder umzubenennen, auf das Ereignis mit der rechten Maustaste klicken und eine Option aus dem Menü 
auswählen. 

Angepasste Ereignisliste 

Mit dieser Funktion kann die Ereignisliste mithilfe der Schaltflächen Add, Remove und Save im Dialogfeld Event Annotation individuell angepasst werden. 
1. Die Untersuchungen auswählen, um die Änderung durchzuführen.

2. Auf die Schaltfläche Event im Bedienfeld klicken.

Ergebnis: Das Dialogfeld Event Annotation öffnet sich mit der Ereignisliste. 

3. Um ein Ereignis von der Liste zu löschen, dieses auswählen und auf die Schaltfläche Remove klicken.

4. Um ein neues Ereignis in die Liste aufzunehmen, dieses in das Edit-Feld eingeben und auf die Schaltfläche Add klicken.

5. Nachdem alle Ereignisse eingegeben wurden, auf Save klicken.
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Ergebnis: Das Dialogfeld Save Test File öffnet sich. 

6. Vergewissern Sie sich, dass der Dateiname korrekt ist und klicken Sie dann auf Save.

7. Auf Cancel klicken, um das Dialogfeld Event Annotation zu schließen.

„Permission to Void“-Ereignis 
Wenn Sie den maximalen Detrusor-Fülldruck (Max Pdet) zwischen dem Beginn einer Untersuchung und dem 
Zeitpunkt feststellen möchten, an dem der Patient Harn lässt, können Sie dieses spezifische Ereignis auf der Grafik 
markieren. „Permission to Void“ der Ereignisliste hinzufügen und das Ereignis während der Untersuchung 
markieren.  

Mit dem „Permission to Void“ Ereignismarker werden die Füllphasen- und Miktionsphasensegmente auf dem 
Bericht ausgedruckt, wenn Sie einen Ausdruck der Untersuchung wählen. 

Wenn ein Permission to Void Ereignis nach dem Ende eines Uroflow-Segments hinzugefügt wird (jeder Stopp wird 
automatisch als Ur auf der Grafik gekennzeichnet, um auf das Ende eines Segments hinzuweisen), erscheint eine 
Meldung, in der eine Bestätigung gefordert wird, um das vorherige Uroflow-Segment zu entfernen.  

Auf Yes klicken, um den Marker zu entfernen, oder auf „No“ klicken, um den Marker beizubehalten. 

Ereignis verschieben Im Fenster „Event Summary“ auf ein Ereignis doppelklicken, um es an den Punkt der Grafik zu verschieben, der dem 
jeweiligen Ereignis entspricht.  

TIPP: Denken Sie daran, immer die DTA-Datei abzuspeichern, um die Änderungen unter „Event Annotation“ 
zusammen mit den Dateien aufzubewahren. 
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Stress-Ereignisse 

Die Schaltflächen „Stress Test“ und „Stress Leak“ sorgen für präzise LPP-Berechnungen (LPP - Leak Point Pressure). 

• Denken Sie daran vor der Untersuchung den Leckpunktdetektor am Katheter anzubringen, mit dem der Druck gemessen wird.

• Auf die Schaltfläche Start Stress Test klicken, um das Stresstest-Berechnungssegment zu starten oder zu stoppen.

• Auf Stress Leak klicken, um während der Stresstest-Detektionsphase ein „Stress Leak“ hinzuzufügen.

• Ein Calculated LPP Ereignis wird der Grafik hinzugefügt, wenn der Stresstest beendet wird. Diese Berechnung ist die Änderung im Pves-Druck vom
Untersuchungsbeginn (wie bei „Start Stress Test“ gemessen) bis zum Zeitpunkt des Urinverlusts.

• Wenn eine Untersuchung beendet wird, erscheint ein Meldungsfeld mit Optionen, die ausgewählt werden können, um zwischen einem „Cough
Leak“ und einem „Valsalva Leak“ zu unterscheiden.

• Bei Klicken auf No wird ein „Peak with No Leak” Ereignis dem Spitzendruckwert im „Stress Test“-Segment hinzugefügt.

• Bei Klicken auf Yes wird ein Calculated LPP Ereignis auch automatisch dem Spitzendruckwert im „Stress Test“-Segment zusammen mit dem Stress
Leak Ereignis hinzugefügt.
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Um die Berechnungen zu sehen, auf Info > Event Summary klicken. 

Stressereignisse können auch ohne ein „Stress Test“-Ereignis aufgezeichnet werden. Dafür die Schaltflächen auf dem Bedienfeld wie folgt programmieren 
und während einer Untersuchung auf die entsprechende Schaltfläche klicken, wenn ein Ereignis aufgezeichnet werden soll. 
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TRSS-Ereignisse 

TRSS (Tone, Reflex, Sensation and Structure) Ereignisse können Untersuchungen hinzugefügt werden, die beendet oder gespeichert werden. 

1. Auf den Punkt einer Grafik klicken, an dem Sie ein TRSS-Ereignis hinzufügen möchten und dann auf Insert TRSS Event klicken.
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2. Die TRSS # auswählen.
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3. Den Bereich für das Hinzufügen des TRSS-Ereignisses durch Klicken mit der linken Maustaste auswählen und den Mauszeiger ziehen, um das Segment
für die TRSS-Berechnung auszuwählen. Den Mauszeiger freigeben, sobald der Bereich ausgewählt wurde.
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• Die TRSS Start und TRSS Stop Ereignisse werden der Grafik hinzugefügt und die TRSS-Ereigniswerte sind im Fenster Event Summary zu sehen.
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„Opening Time“-Ereignis 

„Opening Time“ bezieht sich auf den Zeitpunkt zwischen dem ersten Anstieg des Blasendrucks (Rise Pdet) und dem Uroflow-Beginn. 

Die mathematische Definition hierfür ist:  

Opening Time = Zeitpunkt des Flow-Beginns – Zeitpunkt des Pdet-Anstiegs 
o Das „Rise Pdet“-Ereignis wird automatisch zwischen die Ereignisse Permission To Void und Uroflow Start gesetzt.
o Das Ereignis wird auf den Pdet-Kanal gesetzt. Denken Sie daran, die Position des Ereignisses in der Grafik zu überprüfen. Es kann ggf. in einen anderen

Bereich der Grafik verschoben werden.

Nachdem das Ereignis der Grafik hinzugefügt wurde, aktiviert es automatisch die mit dem Ereignis verbundenen Berechnungen, und die Ergebnisse sind 
in den Berichten zu sehen. 

Im Bericht werden im Abschnitt Fillingphase Results die folgenden Informationen angezeigt: 

• Maximale zystometrische Kapazität (in ml): Der VH2O-Wert bei „Permission to Void“

• Inkontinenz während des Füllens (in ml): Der Wert des Volumenkanals bei „Permission to Void“

• Blasenfüllung (maximale zystometrische Kapazität – Inkontinenz während des Füllens) (in ml): Wert vom Blasenvolumen-Math-Kanal oder gleichwertige
Berechnung im Bericht.

Bitte beachten Sie, dass die physiologische Auslasszeit („opening time“) etwa eine Sekunde kürzer sein kann als der angezeigte Wert.
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„Event Line“-Farbe 

Um ein Ereignis in der Grafik hervorzuheben, kann eine farbige Linie hinzugefügt werden, um es leichter sichtbar zu machen. 

1. Eine Untersuchungsdatei öffnen, wenn noch keine offen ist.
2. Auf Options > Event Summary klicken, um das Fenster Event Summary  zu öffnen.
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3. Durch Klicken ein Ereignis aus der Liste auswählen, zum Beispiel das Ereignis First Sensation.
Das ausgewählte Ereignis wird automatisch in der Grafik hervorgehoben.

4. Das Fenster Event Summary schließen.

5. Mit der rechten Maustaste auf das Ereignis in der Grafik klicken, um das Kontextmenü zu öffnen.
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6. Change Event Color auswählen, um das Fenster „Color selection“ zu öffnen.
7. Auf das Farbfeld für die neue Farbe, zum Beispiel für eine Änderung von Blau zu Orange, und dann auf OK klicken.

Ergebnis: Die Linienmarkierung des Ereignisses wechselt zu der neu ausgewählten Farbe.

• Wie gewünscht mit der Änderung der Farben fortfahren.

• Bitte beachten Sie, dass, wenn mehrere identische Ereignisse in der Grafik sind, sich die Farbänderung auf alle diese identischen Ereignisse auswirkt.
Wenn es zum Beispiel drei Cough Ereignisse in der Grafik gibt und eines davon für die Farbänderung ausgewählt wird, werden die anderen zwei auch ihre
Farbe ändern.
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VOIDING SUMMARY-MENÜ 

Das Voiding Summary-Menü findet nur auf Untersuchungen Anwendung, die mit Uroflow-Informationen verbunden sind, wie Uroflowmetrie und Druck-Fluss-Verfahren. 
In dieser Zusammenfassung werden die Untersuchungsergebnisse eines Patienten mit den Normalwerten verglichen. Statistische Abweichungen werden mithilfe dieser 
Standards berechnet und sind ausschließlich für Vergleichszwecke bestimmt. Sie sollten nicht als alleinige Grundlage für eine Diagnose verwendet werden. 

Da dieser Vergleich auf dem Geschlecht des Patienten basiert, muss das Geschlecht korrekt in das Dialogfeld „Patient Information“ eingegeben 
werden. 

1. In der Menüleiste auf Info klicken und Voiding Summary auswählen.
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Bei Flow- und Volumenkanälen… Siehe… 

Vorhanden und die aktuellen Flow-Daten sind gültig: 

* BOOI, BCI und BE Referenz-Indexwerte (Definitionen siehe Seite
404)
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Bei Flow- und Volumenkanälen… Siehe… 

Nicht vorhanden oder aktuelle Flow-Daten sind ungültig: 

2. Eines der folgenden Verfahren durchführen:

Zum... klicken auf… 

Verlassen des Fensters „Voiding Summary“: OK 

Ändern des Kanals und der Konfigurationsparameter: 
Options. 
Ergebnis: Das Uroflow „Options“-Feld öffnet sich. 
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Die Software berechnet die zusammenfassenden Ergebnisse nur dann, wenn das Mindest-Miktionsvolumen 55 ml beträgt. 

„Voiding Summary“-Analyse 

Der „Voiding Summary“-Ausdruck liefert einen Vergleich mit den Nomogramm-Tabellen. Sie erscheinen sowohl für männliche als auch weibliche 
Patienten auf demselben Ausdruck. Der Vergleich zeigt einen prozentualen Unterschied zum Tabellenwert. Für die Berechnungen wird die folgende 
mathematische Formel verwendet: 

Peak Flow: 
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Time To Peak Flow: 
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Diese Prozentwerte sind in der Patientenstatistik des „Voiding Summary“-Ausdrucks zu finden. M% stellt die Werte für Männer und F% die Werte für 
Frauen dar. 

WARNHINWEIS: Der Vergleich mit normalen Parametern sollte nicht für diagnostische Zwecke verwendet werden. Es wird empfohlen, die Untersuchung 
zu wiederholen, wenn das Miktionsgesamtvolumen geringer als 55 ml ist. Normale Parameter sind unterhalb dieses Volumens nicht verfügbar. 
Statistische Werte können nicht erstellt werden, wenn das Volumen geringer als 55 ml oder höher als 555 ml ist.  

Die Parameter des Harnflusses wurden aus 150 Kurven von Personen im Alter zwischen 20 und 40 Jahren analysiert. Die Mindest-
Normalwert für ein bestimmtes Volumen scheint der sinnvollste Wert zu sein, mit dem die Patienten-Flowrate verglichen werden kann. 
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Uroflow Options 

Im Feld Uroflow Options kann Folgendes durchgeführt werden: 
• Anpassung der Art der Berechnung der Zusammenfassung.

• Durchführung von Änderungen der Kanalparameter￼.

Änderung der Parameter: 
1. Auf Options im Feld Voiding Summary klicken. 

Ergebnis: Das Uroflow Options Dialogfeld öffnet sich. 

2. Änderungen der Parameter im Dialogfeld „Urowflow Options“ können mithilfe des folgenden Diagramms und der Legende durchgeführt werden.
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Nummer Beschreibung 

(1) Standardkanäle: Flow, Volume und Pressure. 

(2) Range: Der Standardbereich ist vom Beginn bis zum Ende der Untersuchung. 

(3) 

Threshold Der minimale Flowratenwert, der für die Berechnung der Miktionszusammenfassung herangezogen wird. Alles, was unter 
diesem Grenzwert liegt, wird als Störgeräusch oder nicht signifikanter Flow betrachtet. Der minimale Flowratenwert, der für die 
Berechnung der Miktionszusammenfassung herangezogen wird. Alles, was unter diesem Grenzwert liegt, wird als Störgeräusch oder 
nicht signifikanter Flow betrachtet. 

(4) Enable Artifact RecognitionDas Kontrollkästchen markieren, um es zu aktivieren (Enable). 

(5) Artifact Recognition Threshold: Gibt die maximale akzeptable Änderung des Flows (Beschleunigung) an, die physiologisch möglich ist. 

(6) OEM Uroflow-Transducer: Hersteller des Originalerzeugnisses (für optionale, nicht von LABORIE stammende Uroflow-Transducer). 

(7) Auto Event Marking: Automatisches Hinzufügen von Ereignissen zur Grafik. 

(8) Auto Recording: Wenn „Auto Recording“ markiert ist, werden die Untersuchungen automatisch gestartet und gestoppt, wenn der 
Transducersensor Flüssigkeit im Becher feststellt. 

(9) Auto Voiding Summary: Eine automatische Uroflow-Aufzeichnungsoption, um nach Beendigung einer Untersuchung eine 
Miktionszusammenfassung anzuzeigen. Hierfür muss „Auto recording“ aktiviert sein. 

(10) 
Auto Patient Info Prompting Eine automatische Uroflow-Aufzeichnungsoption, um das Fenster „Patient Info“ anzuzeigen, wenn eine 
Untersuchung beendet wird.  

(11) Auto Filing: Eine automatische Aufzeichnungsoption, um eine Datei zu speichern, wenn eine Untersuchung beendet wird. 

(12) Auto Printing: Eine automatische Aufzeichnungsoption, um eine Datei zu drucken, wenn eine Untersuchung beendet wird. 

(13) Auto Display Print Option: Eine automatische Druckoption, um die Print-Option vor dem automatischen Ausdruck anzuzeigen. 

Änderung eines Kanals: 
1. Auf das „Channel“-Feld neben dem zu ändernden Kanal klicken.

Ergebnis: Eine Liste der Kanäle wird angezeigt.

2. Den entsprechenden Kanalnamen auswählen.
Ergebnis: Der ausgewählte Kanalname wird im „Channel“-Feld angezeigt.
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Normalerweise werden die Standardeinstellungen für Grenzwerte (Threshold) bei der Durchführung von Uroflowmetrie-Untersuchungen bei Patienten 

nicht geändert. Wenden Sie sich im Zusammenhang mit Änderungen der Standardeinstellungen an Ihren LABORIE-Vertreter. 

Die Berechnungskanäle können durch andere Kanäle ersetzt werden, solange die Definition der Einheiten übereinstimmt. Beispiel: „Flow” kann durch 
einen anderen Math-Kanal ersetzt werden, der eine korrigierte Flowrate darstellt. 

Änderung des Zeitbereichs: 
1. Auf Change klicken.

Ergebnis: Das „Uroflow Options“ Segmentauswahlfenster wird angezeigt.

2. Mit dem Mauszeiger auf das Uroflow-Segment klicken und über das Grafikfenster von Anfang bis Ende ziehen.
Ergebnis: Eine fette schwarze Linie verläuft oberhalb des Feldes und weist auf die Auswahl hin.

3. Die Maustaste dann wieder freigeben.
Ergebnis: Die Anfangs- und Endlinien des Segments werden aktualisiert.
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4. Eines der folgenden Verfahren durchführen:

Um… Klicken auf... 

Das ausgewählte Segment bestätigen: Confirm 

Das ausgewählte Segment annullieren: Cancel 

Ergebnis: Rückkehr in das Fenster „Uroflow Options“. 

Artifact Recognition 

Dies bezieht sich auf die Erkennung von nicht-physiologischen Transducer-Messwerten. 
Beispiel: Wenn ein Patient gegen den Transducer stößt, gibt die Kurve einen sehr hohen Spitzenwert an. Dieser ist „unnatürlich“ hoch und daher erkennt die UDS-
Software das Ereignis als Abweichung von dem, was sie als normalen Messwert einstuft. 

Artefakterkennung durch die Software aktivieren: 

• Das Feld Enable Artifact Recognition auswählen. Ergebnis: Es erscheint ein Häkchen im Feld, das darauf hinweist, dass die Software Artefakte
erfasst.

Unter „Threshold“ im Feld „Artifact recognition“ wird die Flow-Geschwindigkeit angegeben.  
Die Standard-Flowrate ist 45,0 ml/s/s. Diese Rate bedeutet, dass, wenn die Flow-Geschwindigkeit 45,0 ml/s/s überschreitet, dies als Artefakt betrachtet 
wird. Bei Erkennung eines Artefakts wird bei der „Voiding Summary“-Berechnung der nächste Datensatz ignoriert. 

Änderung des Beschleunigungsraten-Grenzwerts: 
1. Auf das Feld Artifact Recognition Threshold doppelklicken.

Ergebnis: Der Wert im Textfeld wird unterlegt.

2. Einen neuen Wert über die Tastatur eingeben.
Ergebnis: Die Software erkennt den neuen Wert im „Threshold“-Textfeld als die maximale Flowrate und sieht deren Überschreiten als Artefakt
an.

Um das „Uroflow Options“-Fenster zu verlassen, eine der folgenden Maßnahmen durchführen: 
Zum... klicken auf… 

Änderungen speichern: OK 

Änderungen annullieren: Cancel 
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Ergebnis: Das „Uroflow Options“-Fenster schließt sich, und es wird wieder das Fenster „Voiding Summary“ angezeigt. 
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Uroflow Auto Recording 

Die Funktion „Uroflow Auto Recording“ wird für Uroflow- oder Druck-Fluss-Untersuchungen verwendet. Durch die Funktion wird automatisch eine 
Untersuchung gestartet, ohne dass hierfür Schaltflächen betätigt werden müssen. 

Diese Funktion sorgt für Auto Start, Auto Stop und Auto Set Up für das nächste Verfahren. Diese Funktion wird durch Auswahl der „Auto Recording“-
Option aktiviert. Nachdem diese Funktion zur Verfügung steht, können andere anpassbare Optionen ausgewählt werden. Diese Optionen werden in der 
folgenden Reihenfolge durchgeführt: 

Optionen Immer eingeschaltet/ 
Auswählbar 

Beschreibung 

Auto Beaker Detection Immer eingeschaltet Nach Auswahl dieses Verfahrens wird ermittelt, ob sich ein Becher im Uroflow-Transducer 
befindet. Wenn kein Becher vorhanden ist, erscheint die Meldung Beaker lifted up in der 
Titelleiste. 

Auto Set Zeroes Immer eingeschaltet Wenn ein Becher acht aufeinanderfolgende Sekunden erkannt wird, erfolgt die Nullstellung 
automatisch. Wenn der Becher nach der Nullstellung angehoben wird, erfolgt ein erneuter 
Detektionsvorgang. 

Auto Start Immer eingeschaltet Die Untersuchung wird automatisch gestartet, wenn ein Volumenanstieg festgestellt wird, 
nachdem der Becher abgesetzt wurde. 

Auto Stop Immer eingeschaltet Die Untersuchung wird automatisch 50 Sekunden nach Flow-Ende gestoppt. 

Auto Patient Info 
Prompting 

Auswählbar Automatische Anzeige des „Patient Info“-Dialogfelds. 

Auto Calculation Immer eingeschaltet Automatische Berechnung der Miktionszusammenfassung. 

Auto Voiding Summary Auswählbar Automatische Anzeige des „Voiding Summary“-Fensters, wenn die 
Miktionszusammenfassung gültig ist. 

Auto Filing Auswählbar Automatische Abspeicherung der Untersuchung im Format JJMMDDxx.QTA 

Auto Printing Auswählbar Automatische Auswahl der Untersuchung zum Ausdrucken. 

Auto Display Print Option Auswählbar, wenn „Auto 
Printing“ aktiviert ist 

Automatische Anzeige des „Print Option“-Dialogfelds für Bestätigung/Anpassung. 

Auto Set up next test Immer eingeschaltet Automatische Veranlassung der nächsten Untersuchung. 
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Pädiatrisches Nomogramm (Optional) 

Die Pediatric Nomogramvii-Funktion ist über das „Voiding Summary“-Fenster zugänglich. Es basiert auf den Arbeiten von Dr. Churchill im Hospital for Sick 
Children in Toronto. Das Nomogramm ist ein Plot aus „Peak Flow“ vs. „Voided Volume“ und die mittlere Kurve stellt den Mittelwert dar. Die Flow-Daten 
des Patienten werden durch einen eingekreisten Punkt in der Grafik dargestellt. Daher ist eine normale Flow-Kurve alters- und geschlechtsbezogen. 

Diese Option steht nur zur Verfügung, wenn der Patient zwischen 3 bis 16 Jahren alt ist. 

Zugriff auf die pädiatrische Nomogramm-Funktion: 
1. Auf Pediatric Nomogram im Fenster Voiding Summary klicken.

Ergebnis: Das Fenster Pediatric Nomogram öffnet sich. 
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• Die Schriftart kann mithilfe der Font Menüpunkte geändert werden.
• Die Skalen können mithilfe der Options Menüpunkte geändert werden.
• Um das „Pediatric Nomogram“-Fenster zu verlassen, Exit! klicken.

UPP SUMMARY 

Nach Vorliegen der UPP-Daten￼ kann mit der Software eine UPP-Zusammenfassung (UPP summary) erstellt werden. 

UPP Starts und Stops werden als Ereignisse auf dem UDS-Bildschirm markiert. Wenn Sie mit dem Mauszeiger über ein UPP Start- oder Stopp-Ereignis 
gehen, zeigt ein ToolTip die Ereignisse an. Das Ereignis kann neu positioniert werden, indem auf die Linie geklickt und sie entlang der Grafik in eine neue 
Position gezogen wird. 
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Öffnen einer UPP-Zusammenfassung: 
1. In der Menüleiste auf Info klicken und UPP Summary auswählen.

Ergebnis: Das UPP Summary-Fenster öffnet sich. Jeder UPP Pull stellt ein Segment dar.

Das UPP Summary-Fenster enthält die folgenden Informationen: 

• Length: Länge der Urethra (funktionelle Länge)

• Start: Startzeit des Zugs (Pull)

• End: Endzeit des Zugs (Pull)

• Peak Pclo: Maximaler Urethraverschlussdruck

• Obstruction Zone Peak: Maximaler Druck bei beobachteter Obstruktion (weitere Informationen siehe Seite 199)

• Length of the Continence Zone: Distanz zwischen dem Blasenhals und dem höchsten Druckpunkt im Profil (Kontinenzzone)

• Area of the Continence Zone: Bereich unterhalb der Länge der Kontinenzzone

Weitere Informationen zur vorgenannten Schaltfläche und ihrer Funktion finden Sie auf Seite 136. 

Ein zu analysierendes Segment auswählen und ändern: 

1. Auf den Spaltentitel (Pull 1, Pull 2 usw.) eines UPP Pull klicken.
Ergebnis: Die Start- und Stopp-Zeiten werden in Grün hervorgehoben, und die Grafik auf dem Bildschirm bewegt sich in die Endposition des
ausgewählten UPP Pull.
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2. Auf die Schaltfläche „Auto Detect“ klicken, um den Start- und Endbereich automatisch anzupassen.

-oder-

Manuell eines der UPP Start- oder Stopp-Ereignisse auf dem UDS-Bildschirm verschieben.  

Ergebnis: Die Ereignisse werden auf dem Bildschirm und im „UPP Summary“-Fenster aktualisiert. 

Es ist möglich, bis zu acht Segmente für die UPP-Berechnung auszuwählen. 

Ändern der Puller-Geschwindigkeit￼:: 
1. Auf die Schaltfläche Configure klicken.

Ergebnis: Das Feld UPP Config öffnet sich.

2. Mit dem Cursor in das Textfeld klicken, das geändert werden soll.
3. Die neuen Daten eingeben.
4. Auf OK klicken.

Ergebnis: Das Dialogfeld UPP Config schließt sich.
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Einrichten des „Distance Sensor Channel“: 
Wenn die Zugmechanik (Puller) mit einem Sensor versehen ist, wird die Distanz, über die ein Katheter gezogen wird, automatisch berechnet und ist dann 
im Ausdruck sichtbar. 

1. Im Fenster UPP Summary über die Dropdown-Liste den Kanal auswählen, mit dem der Katheter verknüpft ist. (Beispiel: Ch3 wäre der Pura-Kanal).
2. Die UPP-Untersuchung durchführen.
3. Die Untersuchung stoppen.
4. Das Fenster UPP Summary öffnen.
5. Die Preview-Schaltfläche auswählen, um die UPP Plots anzuzeigen. Sie erhalten dadurch einen Überblick darüber, was auf dem Bericht ausgedruckt

wird.
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Ausdruck der UPP Summary: 
1. Auf File > Print Study klicken.

2. UPP Summary aus dem Preferences-
Bereich auf der linken Seite des
Fensters auswählen.

3. UPP Sections aus dem Print Range-
Bereich auswählen.

4. Die gewünschten Segmente aus-
wählen.

5. OK klicken, um den Ausdruck zu
erstellen.

Elemente in der UPP Summary 

Die Länge der Urethra (funktionelle Länge) ist in der UPP-Zusammenfassung enthalten. Die UDS-Software berechnet die Urethralänge, indem sie die 
Rückzugsrate mit der Periode des funktionellen Segments der Grafik multipliziert.  

Die empfohlene Rückzugsgeschwindigkeit beträgt etwa einen Millimeter pro Sekunde.

Obstruction Zone Peak (Spitzenwert der Obstruktionszone) 

Es ist möglich, den maximalen Druck an einem festgestellten Obstruktionspunkt einzustellen. Mit dieser Einstellung wird der Spitzendruckpunkt erneut 
berechnet. 

Einstellung der „UPP Obstruction Zone“: 
1. Mit der rechten Maustaste in einen UPP-Bereich klicken, um die Obstruktionszone einzustellen.

Ergebnis: Das Kontextmenü erscheint.
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2. UPP End Obstruction Zone auswählen.
Ergebnis: Die UPP-Obstruktionszone wird auf der Grafik als „Event Annotation“ im Format UPPXeObstruction markiert (wobei X die UPP-
Segmentnummer darstellt). Das ursprüngliche Spitzendruckereignis wird zwischen diesem Ereignis und dem UPP Stopp-Ereignis erneut berechnet und zum
UPP-Spitzendruck für die funktionelle Zone. Es wird auch ein neuer Spitzenwert hinzugefügt und Obstruction Zone Peak 1 genannt.
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Beide Peak-Ereignisse sind beweglich. „Obstruction Zone Peak“-Parameter werden in der UPP Summary dargestellt und auf dem UPP Summary-Bericht 
ausgedruckt. 

Erneutes Markieren von UPP-Segmenten 

Die UPP-Segmente sollten sich automatisch markieren, wenn die Schaltflächen Start Pull und Stop Pull auf dem Bedienfeld betätigt werden, um die UPP-
Untersuchung durchzuführen. Es werden drei spezifische Ereignisse für jeden durchgeführten Pull erstellt: UPP Start X, UPP Peak X und UPP Stop X 
(wobei X die Pull-Nummer ist). Für den ersten UPP Pull werden Ereignisse automatisch markiert: UPP Start 1, UPP Peak 1 und UPP Stop 1. 
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In einigen Fällen ist es möglicherweise erforderlich, die UPP-Segmente neu zu markieren. Hierfür ist Folgendes erforderlich: 
1. Die UPP-Segmente entfernen, die Sie ändern möchten:

a. Mit der rechten Maustaste auf die UDS-Grafik klicken, um das Kontextmenü zu öffnen.
b. Unten im Menü auf die Option UPP Segments klicken, um ein kleineres Menü zu öffnen, in dem alle UPP Pulls ausgeführt werden, die in der Grafik

markiert sind. Die Markierung des UPP Pulls, der neu markiert werden soll, aufheben; danach erscheinen die diesem UPP Pull entsprechenden
Ereignisse auf der Grafik (d. h. UPP 1), wie in den folgenden Abbildungen veranschaulicht ist.
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2. Erneutes Markieren des UPP-Segments: Den UPP Pull durch Klicken mit der linken Maustaste auf die UDS-Grafik vor dem UPP Pull, der markiert werden soll,
hervorheben, die linke Maustaste weiter gedrückt halten und den Mauszeiger bis zum Ende des UPP Pulls ziehen und dann loslassen. Der UPP Pull wird
jetzt schwarz unterlegt.
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3. Mit der rechten Maustaste auf den unterlegten Abschnitt der Grafik klicken, um das Kontextmenü zu öffnen.

4. Auf die Option UPP Segments unten im Menü klicken und dann ein nicht verwendetes UPP-Segment markieren (in unserem Beispiel wird UPP 1 erneut
markiert, da es in Schritt 1 entfernt wurde). Für diesen Pull werden jetzt die Ereignisse UPP Start, UPP Peak und UPP Stop der Grafik hinzugefügt.

neu ausgewähltes Segment 
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5. Prüfen, ob die UPP Summary (unter dem Info-Menü zu finden) nun mit der neu markierten UPP Pull-Information aktualisiert ist.

Die Neumarkierung ist abgeschlossen. 
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BLASEN-COMPLIANCE (OPTIONAL) 

Die Blasen-Compliance wird vom Füllstadium der Untersuchung an berechnet. Die Compliance-Funktion ist verfügbar, wenn eine CMG- oder 
Miktionsuntersuchung durchgeführt wurde. Mit der Compliance-Option können die Start- und End-Füllzeiten der Untersuchung ausgewählt und analysiert 
werden, um präzise Ergebnisse zu erzielen. Sie ermöglicht auch die Auswahl von bis zu drei Segmenten für jede Untersuchung. 
„Compliance“ kann auch für automatische Berechnungen konfiguriert werden. Weitere Informationen hierzu finden Sie auf Seite 150. 

Die Blasen-Complianceberechnung/-konfiguration kann nur mit englischsprachiger Software durchgeführt werden. Die Berechnungsergebnisse werden in 

ml/cmH2O ausgedrückt.

Die Blasen-Compliance wird berechnet als: 
ΔVH2O  Änderung im Blasenvolumen 
Δ Pdet    Änderung im Detrusordruck 

Zugriff auf die Blasen-Compliance-Funktion: 

1. In der Menüleiste auf Info klicken und Bladder Compliance auswählen.

Ergebnis: Das Fenster „Compliance Measurement Range“ öffnet sich. 

Jede Compliance-Messung wird durch ein Start- und Endsegment definiert. Die Segmente werden farblich unterschieden. 

Ein zu analysierendes Segment auswählen: 
1. Auf das Kontrollkästchen des zu analysierenden Segments klicken.
2. Den Mauszeiger auf dem Grafikfenster klicken und vom Start bis zum Ende eines Segments ziehen.

Ergebnis: Eine fette schwarze Linie verläuft oberhalb des Feldes und weist auf die Auswahl hin.

3. Die Maustaste dann wieder freigeben.
Ergebnis: Das „Ende“ des Segments wird ausgewählt. Der Zeitpunkt der Auswahl wird angezeigt.

Zum Ändern des ausgewählten Segments: Folgendes durchführen... 

Manuell: Schritte 2 bis 3 wiederholen. 

=
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Das Fenster „Compliance Measurement Range“ verlassen: 
Klicken auf… 

Die Auswahl aller Segmente aufheben und zur Grafik zurückkehren. Cancel 

Die Auswahl beibehalten und zur Untersuchung zurückkehren. 
Ergebnis: Die Compliance-Berechnung wird als Ereignis in der „Event Summary“ angezeigt. 

Confirm 

Zum Ändern des Volumen- oder Druckkanals: 

1. Auf Configure klicken.

Ergebnis: Das Compliance-Fenster öffnet sich. 

2. Mit dem Cursor in das Textfeld klicken, das geändert werden soll.

3. Die neuen Daten eingeben.

Ergebnis: Das Ereignis wird automatisch mit der berechneten Compliance markiert.

Der Compliance-Wert erscheint in der „Annotation“-Spalte der Event Summary.

Auto Compliance (optional)

Siehe Seite 150.
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UPP 

Diese Option enthält optionale Software-Funktionen wie Eberhard-Kurven und Druckübertragungsverhältnis (Pressure Transmission Ratio). 

Eberhard-Kurven (optional) 

Mit der Eberhard-Funktion wird das Statik- und Stress-UPP-Profil für weibliche Patienten gemessen. 

Diese Funktion in der UDS-Software basiert auf den Arbeiten von J. Eberhard und P. Lienhard.viii Ein vollständiges Exemplar dieses Artikel ist auf Anfrage 
erhältlich. 

Es müssen zuerst die folgenden Kriterien festgelegt werden, um die Werte korrekt berechnen zu können. 

• Vergewissern Sie sich, das Pves, Pura und Pclo auf die richtigen Kanäle verweisen.

• Die ausgewählte Position der Patientin überprüfen.

• Die Geschwindigkeit des UPP-Pullers überprüfen.

Zugriff auf die Eberhard-Kurven-Funktion:
1. Auf Info > UPP klicken.

2. Eberhard Curves auswählen.
Ergebnis: Das Fenster Eberhard Curve Options öffnet sich. 
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3. Die Static und Stress UPP-Bereiche der Grafik auswählen.

Static UPP:

a) Auf die Configure Schaltfläche im Bereich Static klicken, um das Fenster Range Selection zu öffnen.

b) Den Bereich für die Berechnung des statischen UPP Segments durch Klicken auf den Startpunkt des Bereichs in der Grafik auswählen, die linke
Maustaste gedrückt halten und den Mauszeiger über die Grafik ziehen, bis das Ende des Segments erreicht ist. Nachdem das Ende des
Segments erreicht ist, die Maustaste freigeben.
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Das Segment wird links und rechts durch rote Linien markiert und mit einer schwarzen Linie darüber versehen, um den ausgewählten Teil der 
Grafik hervorzuheben. 

Wenn das ausgewählte Segment nicht korrekt ist, auf Cancel klicken und ein neues Segment auswählen. 

c) Auf Confirm klicken.
Stress UPP:

a) Auf die Configure Schaltfläche im Bereich Stress klicken, um das Fenster Range Selection zu öffnen.

b) Den Bereich für die Berechnung des dynamischen UPP Segments durch Klicken auf den Startpunkt des Bereichs in der Grafik auswählen, die
linke Maustaste gedrückt halten und den Mauszeiger über die Grafik ziehen, bis das Ende des Segments erreicht ist. Nachdem das Ende des
Segments erreicht ist, die Maustaste freigeben.
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Das Segment wird links und rechts durch rote Linien markiert und mit einer schwarzen Linie darüber versehen, um den ausgewählten Teil der 
Grafik hervorzuheben. 

Wenn das ausgewählte Segment nicht korrekt ist, auf Cancel klicken und ein neues Segment auswählen. 

c) Auf Confirm klicken.

4. Auf OK klicken.
Ergebnis: Das Eberhard-Fenster öffnet sich und zeigt die Kurven zusammen mit Gesamturethralänge (Total Urethral Length), Drücken, funktioneller
Urethralänge (Functional Urethral Length) und Änderungsinformationen an.
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5. Auf Print! oben links im Fenster klicken, um eine Kopie der Kurvenergebnisse auszudrucken.

6. Auf Exit! klicken, um das Fenster zu schließen.
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Druckübertragungsverhältnis (PTR)  

Die Pves- und Pura-Druckübertragung ist abgeschlossen. (Beispielsweise ein UPP-Test) 

Die Druckübertragung ist ein Druckverhältnis, das von der Blase auf die Pves- und Pura-Kanäle der Urethra Druck „übertragen“ wird. 

Die PTR-Formel lautet: 

  Pura 
% PTR  =       x   100 % 

   Pves 

Wobei: 

•  Pura sich auf die Änderung des Urethradrucks „gegenüber Baseline“ während eines Hustenstoßes bezieht.

•  Pves sich auf die Änderung des Blasendrucks „gegenüber Baseline“ während eines Hustenstoßes bezieht.

Methoden zur Berechnung des PTR 

Es gibt drei Methoden zur Berechnung des PTR: 

• Basic PTR

Die „Basic PTR“ Funktion ist die einfachste Methode, um Hustenstöße zu erkennen, weil diese Funktion es ermöglicht, Berechnungen für alle
Hustenstöße während der Untersuchung zu erstellen.
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Zugriff auf „Basic PTR“: 
1. In der Menüleiste auf Info > UPP klicken und Pressure Transmission auswählen.

2. Auf Basic PTR und dann auf OK klicken.
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3. Vergewissern Sie sich, dass die gesamte Untersuchung als Segment ausgewählt wird.

4. Auf Confirm klicken.

Um das ausgewählte Segment zu ändern, eine der folgenden Optionen durchführen: 

Zum... Dann... 

Änderung des Segments durch die Software: Auf Auto Segment Detection klicken. 

Manuelle Änderung des Segments: Mit dem Mauszeiger klicken und über das Grafikfenster vom Anfang bis zum Ende des 
gewünschten Segments ziehen. 

Das System untersucht automatisch den Pves-Kanal￼O (Hustengrenzwert.) 2O (Hustengrenzwert.) 
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An diesen Punkten wird ein Ereignis automatisch markiert und das Druckübertragungsverhältnis wird berechnet. Das Druckübertragungsverhältnis wird 
in der Ereignis-Zusammenfassung angezeigt. 

Wenn in einer Untersuchung mehr als ein Hustenpunkt vorhanden ist, wird empfohlen, die Segmentauswahlfunktion zu verwenden. Diese ermöglicht 
die Auswahl von bis zu drei Segmenten der Untersuchung für die Berechnung des PTR. 

PTR auf UPP Segments 

Die Funktion PTR on UPP Segment ist nur verfügbar, wenn „UPP segments“ vorhanden ist. Hustenstöße werden nur für die UPP-Segmente der 
Untersuchung berechnet. 
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Zugriff auf UPP-Segmente: 
1. Auf Info > UPP klicken und Pressure Transmission auswählen.

Ergebnis: Das Fenster Pressure Transmission öffnet sich.

2. Auf UPP Segments und dann auf OK klicken.

Ergebnis: Das Fenster PTR Segment Selection öffnet sich mit allen ausgewählten UPP-Segmenten.

3. Das Kontrollkästchen des Segments markieren.

4. Segmente durch Klicken und Ziehen des Mauszeigers über das Grafikfenster ändern.

5. Die Maustaste dann wieder freigeben.

Ergebnis: Die Segmentzeiten werden aktualisiert. 

Um das ausgewählte Segment zu ändern, EINE der folgenden Optionen durchführen: 

Zum... Dann... 

Änderung des Segments durch die Software: Auf Auto Segment Detection klicken. 

Manuelle Änderung des Segments: Schritte 3 bis 5 wiederholen. 

Ergebnis: Das „Ende“ des Segments wird ausgewählt. 

Um das „PTR Segments Selection“-Fenster zu verlassen, eine der folgenden Maßnahmen durchführen: 

Zum... Klicken auf… 

Alle Segmente abwählen und in das Fenster Pressure Transmission zurückkehren: 
Cancel 

Die Auswahl beibehalten und zur Untersuchung zurückkehren: 
Ergebnis: Das Druckübertragungsverhältnis wird berechnet und als Ereignis in der Ereignis-Zusammenfassung 
angezeigt. 

Confirm 
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Manual PTR 

„Manual PTR“ ermöglicht die Anpassung der Hustenpunktauswahl. Es ermöglicht auch, ￼ den Pura-Spritzenwert zu vergrößern und entsprechend zu 
ändern. Dies ist die präziseste Methode, PTR zu berechnen.  

Zugriff auf „Manual PTR“: 
1. Auf Info > UPP klicken und Pressure Transmission auswählen.

Ergebnis: Das Fenster Pressure Transmission öffnet sich. 

2. Manual PTR im Fenster Pressure Transmission auswählen.

3. Auf OK klicken.

Ergebnis: Das Fenster Pressure Transmission schließt sich. 

4. Auf einen Spitzenwert im Pves- oder Pura-Kanal klicken.

Ergebnis: Es erscheint ein Fenster mit einer Nahansicht des Spitzenwerts und dem Wert von Peak, Base und Height.

Anpassung der Position von Peak, Base, Height und PTR:
1. Auf den kreisförmigen Griff links vom Hustenereignis klicken, der auf den Anfangspunkt des Peaks hinweist.

2. Den Griff in die von Ihnen gewünschte Anfangspunktposition ziehen.

Ergebnis: Der Anfangspunkt des Hustenereignisses ist geändert. Schritte 1 und 2 wiederholen, um den Endpunkt des Hustenereignisses zu ändern.
Peak, Base und Height werden automatisch neu berechnet.

3. Next klicken.

Ergebnis: Ein ähnliches Fenster erscheint für den anderen Kanal (Pves oder Pura). 

4. Schritt 2 ggf. wiederholen, um die Start-/Endpunkte anzupassen.

5. Auf OK klicken.

Ergebnis: Das Fenster schließt sich und das Druckübertragungsverhältnis wird als Ereignis in der Ereignis-Zusammenfassung angezeigt.

6. Auf OK klicken, um manuell einen anderen Hustenpunkt auszuwählen, oder auf Cancel klicken, um zur Untersuchung zurückzukehren.

ARM 4&8 (OPTIONAL)

Weitere Informationen hierzu finden Sie auf Seite 286.
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VIEW HOR. MENÜ 

Das VIEW HOR.-Menü ermöglicht das horizontale Vergrößern oder Verkleinern (Zoom in/out) der Untersuchung, wenn diese in Form einer Kurve￼ 
erscheint. Die Standard-Zoomgröße ist 1 X oder 100 %. 

TIPP: Die Zoomgröße kann auch durch Klicken auf die Popup-Liste unten rechts im UDS-Bildschirm eingestellt werden. 

Ändern der Zoomgröße: 
1. In der Menüleiste auf View Hor. klicken.

Ergebnis: Die Zoom Dropdown-Liste erscheint.
2. Auf eine der Einstellungen klicken. (Die entsprechende Zoomgröße mithilfe der folgenden Tabelle festlegen).

Ergebnis: Die Untersuchung wird automatisch auf die Größe der gewählten Einstellung geändert. Die ausgewählte Einstellung wird gespeichert,
wenn die Untersuchung gespeichert wird.

Einstellung Anzeige 

25 % 1/4 der Standard-Zoomgröße 

33 % 1/3 der Standard-Zoomgröße 

50 % 1/2 der Standard-Zoomgröße 

1X Standard-Zoomgröße 

2X Das Doppelte der Standard-Zoomgröße 

3X Das Dreifache der Standard-Zoomgröße 

4X Das Vierfache der Standard-Zoomgröße 

Full Screen Die ganze Untersuchung wird auf einem einzigen Bildschirm komprimiert 

Full Screen On Stop Die ganze Untersuchung wird auf einem einzigen Bildschirm komprimiert, wenn Stop geklickt wird. 
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Custom Zoom Custom-Feld für die gesamte Untersuchung auf einem Bildschirm ODER angepasste Zoom-Präferenz zwischen 1 
– 500 %.

OPTIONS MENÜ 

Das OPTIONS-Menü greift auf verschiedene Funktionen der Software zu und aktiviert sie. 

TEST RESTART 

Manchmal ist eine Neubeurteilung erforderlich, wenn ein Patient während einer Untersuchung hustet, niest oder gegen den Transducer stößt. Mit 
der „Restart“-Funktion wird ein Verfahren von Beginn der Untersuchung erneut begonnen.  

Um ein Untersuchungsverfahren von vorn zu beginnen: 
1. In der Menüleiste auf Options klicken.

2. Test Restart auswählen.

Ergebnis: Die Untersuchung wird zurückgesetzt und kann von vorn begonnen werden.

TEST PLAYBACK

Die „Playback“-Funktion ermöglicht, eine bereits gespeicherte Untersuchung zurückzuspielen, so als würde sie aufgenommen. Nach Beendigung der 
Untersuchung kann diese mithilfe der Playback-Funktion angesehen werden. Die Playback-Geschwindigkeit kann sich jedoch von der 
Aufzeichnungsgeschwindigkeit unterscheiden. 

Eine Untersuchung während der Durchführung ansehen: 

• Auf Options klicken und Test Playback auswählen. Ergebnis: Die Untersuchung wird von ihrem Beginn an und bis zum Ende des Verfahrens
abgespielt.
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Zum… Folgendes durchführen... 

Unterbrechen der Untersuchung: Auf Stop klicken. 

Fortsetzen des Playbacks: Test Playback klicken. 

Verlassen des Playback-Modus: 1. Auf Options klicken.
2. Test Playback auswählen.

UROFLOW AUTO START 

Eine andere Methode zum Starten einer Untersuchung mit dem AQUARIUS® ist die Auswahl der „Uroflow Auto Start“-Option. Sie aktiviert den 
Aufzeichnungsprozess, sobald AQUARIUS® den ersten Datenfluss feststellt. Diese Auswahl ist für Uroflowmetrie-Untersuchungen in den Fällen 
geeignet, in denen der Patient vor und während der Urinabgabe seine Intimsphäre benötigt. 

Einrichten von Auto Start für eine Uroflow-Untersuchung: 
1. In der Menüleiste auf Options klicken.

2. Uroflow Auto Start auswählen.
Ergebnis: Die Untersuchung beginnt, sobald Flüssigkeit im Becher detektiert wird.

CURSOR VALUE INDICATOR

Das „Cursor“-Fenster zeigt die genaue Position des Mauszeigers und die Werte jedes Kanals in dieser Position an. Diese Funktion ist besonders 
nützlich, um Ereignisse zu markieren und Untersuchungsdaten zu überprüfen.  

Zugriff auf den Cursor: 
In der Menüleiste auf Options klicken und Cursor Value Indicator auswählen. 
-oder-
Die F9-Taste auf der Tastatur drücken.
Ergebnis: Das Cursor-Fenster erscheint, ähnlich wie in dem hier gezeigten Beispiel.

Das Cursor-Fenster bewegen: 
1. Auf die Titelleiste im Cursor-Fenster klicken.
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2. Das Fenster in die gewünschte Position auf dem Bildschirm ziehen.

3. Die Maustaste dann wieder freigeben.

Ergebnis: Das Cursor-Fenster wird in die neue Position verschoben.

Aufheben der Cursor-Option: 
Auf Options klicken und Cursor Value Indicator auswählen. 

-oder-

Die F9-Taste auf der Tastatur drücken. 
Ergebnis: Das Cursor-Fenster wird geschlossen. 

DIGITAL VALUE INDICATOR 

Im „Digital Value“-Fenster werden die Daten der Kanäle mit digitalen Attributen angezeigt. Während alle Kanäle als Kurven ausgedruckt werden, können 
auf dem Bildschirm nur maximal acht Kanäle gleichzeitig dargestellt werden. Wenn mehr als acht Kanäle verwendet werden, können zusätzliche Kanäle 
digital oder als Overlay dargestellt werden. Digitale Kanäle werden im „Digital“-Fenster angezeigt, während Kurven von Overlay-Kanälen auf den 
Kanälen angezeigt werden, die sie überlagern. 

Einstellung der Digitalattribute der Kanäle: 
1. Auf Config > Set up/Modify klicken.

Ergebnis: Das Fenster Configure Test öffnet sich.

2. Das Display Digital Attribut in der Spalte Display Attribute auswählen.

3. Den Vorgang ggf. für andere Kanäle wiederholen.

4. Auf OK klicken.

Ein- und Ausschalten des „Digital“-Fensters: 
In der Menüleiste auf Options klicken und Digital Value Indicator auswählen. 

- oder -
Die F8-Taste auf der Tastatur drücken.
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ANZEIGE BEDIENFELD 

Über diesen Menüpunkt können Sie auswählen, ob Sie möchten, dass die Schaltflächen des Bedienfelds auf dem Bildschirm erscheinen oder nicht. Im 
Standardmodus werden diese Schaltflächen angezeigt. 

Um die Schaltflächen vom Bedienfeld 
zu entfernen, auf Options > Display 
Control Panel klicken. 

Ergebnis: Die Schaltflächen 
verschwinden. 

Um die Schaltflächenfunktion wieder 
herzustellen, auf Options > Display 
Control Panel klicken. 
Ergebnis: Die Schaltflächen erscheinen 
wieder auf dem Bedienfeld. 

EINSTELLUNGEN DES BEDIENFELDSEINSTELLUNGEN 

Der einfache Zugriff auf die Schaltflächen des Bedienfelds ist eine praktische Funktion der UDS-Software. Das Dialogfeld „Control Panel Settings“ ermöglich die 
Konfiguration des Bedienfelds mit verschiedenen Funktionsschaltflächen und ändert die Definitionen, die den Event-Schaltflächen zugewiesen sind.  

In jeder Reihe befinden sich sieben Schaltflächen. Die Anzahl der Reihen kann ggf. geändert werden. Eine Liste der Schaltflächenbezeichnungen und -definitionen finden 
Sie im letzten Abschnitt dieses Kapitels – Glossar der Bedienfeldbefehle auf Seite 236. 
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In jeder Reihe sind sieben Schaltflächen. Die letzten beiden Schaltflächen der ersten und zweiten Reihe sind für die Systemanwendung reserviert. Die 
restlichen Schaltflächen können programmiert werden. 

Konfiguration des Bedienfelds: 
1. In der Menüleiste auf Options klicken.

2. Control Panel Settings auswählen.

Ergebnis: Das Fenster Command erscheint und zeigt die erste Reihe der Schaltflächen des Bedienfelds an.

Zum Ändern von… Folgendes durchführen… 

Name der Funktionsschaltfläche: Auf das Textfeld Label der Schaltfläche doppelklicken. (Der eingegebene Text wird auf der Schaltfläche des 
Bedienfelds auf dem UDS Client-Bildschirm angezeigt). 
Den Namen der Funktionsschaltfläche über die Tastatur eingeben. 
Die Schritte 1 und 2 wiederholen, bis alle Funktionsschaltflächen entsprechend benannt wurden. 

Definition der Bezeichnung der 
Funktionsschaltfläche:  

Auf das entsprechende Textfeld unter der „Definition“-Spalte klicken. 
Die neue Definition über die Tastatur eingeben. 

Die Definition hängt vom Typ der Schaltfläche ab. Weitere Informationen hierzu finden Sie unter 
Glossar der Bedienfeldbefehle auf Seite 236. 

Die Schritte 1 und 2 wiederholen, bis die Definitionen für alle Elemente im Bedienfeld  ausgefüllt sind. 

Typ der Funktionsschaltfläche: Auf den Abwärtspfeil der entsprechenden Combobox rechts neben der Funktion jeder Schaltfläche klicken. 
Den entsprechenden Funktionsbefehlstyp auswählen. 
Die Schritte 1 und 2 wiederholen, bis der Typ aller Funktionsschaltflächen in der Reihe eingestellt ist. 

3. Mit dem Abwärtspfeil auf „Current Row“ klicken, um zur zweiten Reihe der Funktionsschaltflächen zu wechseln.

4. Auf OK klicken, wenn alle Schaltflächen vollständig konfiguriert sind.
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Die Einstellung des Bedienfelds, die vor dem Schließen der UDS-Software zuletzt verwendet wurde, wird als Standard-Bedienfeld gespeichert und 
automatisch geladen, wenn der UDS Client erneut gestartet wird. 

Der „Button Height“-Schieber kann verwendet werden, um die Größe der Schaltflächen auf dem Bedienfeld anzupassen. Durch Schieben nach rechts 
vergrößert sich das Bedienfeld. 

Mehrere Bedienfeldeinstellungen (Sets) und Hotkey-Konfiguration 

In der UDS-Software können mehrere Bedienfelder eingerichtet werden, sodass zwei oder mehrere Anwender die gleichen Geräte verwenden können, aber 
jeweils über ein individuell angepasstes Bedienfeld verfügen. Bis zu 16 Bedienfeldeinstellungen können zusätzlich zur Standard-Bedienfeldeinstellung 
eingerichtet werden. 
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Die Hotkey-Konfigurationsfunktion ermöglicht Ihnen, eine Tastenkürzel-Kombination für eine bestimmte Schaltfläche des Bedienfelds zu erstellen. 

Konfiguration von mehreren Bedienfeldeinstellungen: 
1. Auf Options > Control Panel Settings klicken.

Ergebnis: Es erscheint das Command-Feld des Bedienfelds.

2. Einen neuen Namen in das Feld Control Panel Set Name eingeben.

3. Die Schaltflächen des Bedienfelds Ihren Wünschen entsprechend anpassen.

4. Auf OK klicken, um die Bedienfeldeinstellung zu speichern.

Ergebnis: Die neuen Einstellungen werden gespeichert und können verwendet werden.

Für jeden Namen können maximal 15 Zeichen (einschließlich Leerzeichen) verwendet werden. 

Verwendung einer anderen konfigurierten Bedienfeldeinstellung: 
1. Auf Options > Control Panel Settings klicken.

Ergebnis: Es erscheint das Command-Feld des Bedienfelds.

2. Auf die Dropdown-Schaltfläche des Felds Control Panel Set Name klicken und den entsprechenden Namen auswählen.

3. Auf OK klicken.

Ergebnis: Das ausgewählte Bedienfeld erscheint.

Hinzufügen einer neuen Bedienfeldeinstellung durch Kopieren der Einstellungen einer bestehenden Bedienfeldeinstellung: 
1. Auf Options > Control Panel Settings klicken.

Ergebnis: Es erscheint das Command-Feld des Bedienfelds.

2. Auf die Dropdown-Schaltfläche des Felds Control Panel Set Name klicken und den zu kopierenden Namen auswählen.

Ergebnis: Die Einstellungen des ausgewählten Bedienfelds werden angezeigt.
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3. Den Namen der angezeigten Bedienfeldeinstellung mit einem neuen Namen überschreiben.

4. Gegebenenfalls weitere Änderungen in der Bedienfeldeinstellung vornehmen.

5. Auf OK klicken.

Ergebnis: Der neue Name und die neuen Einstellungen werden gespeichert und können verwendet werden.

Konfiguration der Hotkeys: 
1. Auf Options > Control Panel Settings klicken.

Ergebnis: Es erscheint das Command-Feld des Bedienfelds.

2. Auf die P-Schaltfläche neben der entsprechenden Schaltfläche des Bedienfelds klicken.
Ergebnis: Das „Properties“-Fenster öffnet sich.

3. Im Bereich Accelerators eine Tastenkombination auswählen, die einer bestimmten Funktion der Schaltfläche entspricht. In unserem Beispiel vergeben
wir ein Tastenkürzel aus STRG+R für die Schaltfläche First Sensation.

4. Auf OK klicken.

Die PLUS- (+), MINUS- (-) und GLEICH-Tasten (=) können ebenfalls für die Konfiguration der Hotkeys verwendet werden. 

Mit dieser Konfiguration können Sie wählen, entweder Strg+R zu drücken oder auf die Schaltfläche mit dem Namen First Sensation zu klicken, wenn eine 
„First Sensation“ aufgezeichnet werden soll. 

Sound konfigurieren: 
Jede Schaltfläche kann so konfiguriert werden, dass sie eine eindeutige Tonfolge abgibt, wenn sie angeklickt wird. 

Um die „Sound“-Funktion richtig nutzen zu können, muss in Ihrem PC eine Soundkarte installiert sein. 

Das „Properties“-Fenster durch Klicken auf die P-Schaltfläche neben der entsprechenden Schaltfläche des Bedienfelds öffnen. In unserem Fall ist der 
„First Sensation“-Schaltfläche eine Sounddatei zugeordnet. 
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1. Die Option Play sound when button clicked auswählen.
2. Browse klicken, um die Sounddatei zu finden, die für den Klick auf die Schaltfläche verwendet wird.
3. Die Datei auswählen und auf „Open“ klicken, um die Datei mit der Schaltfläche zu verbinden.
4. Auf OK klicken, um den Bildschirm zu verlassen.

Bedienfeld 

Aus der Liste eine Option auswählen, um ein Standard-Bedienfeld einzurichten, das jedes Mal erscheint, wenn die Schaltfläche angeklickt wird. 
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Der Schaltfläche des Bedienfelds ein Bild hinzufügen 

Der Schaltfläche kann ein Bild hinzugefügt werden, um sie so leicht von anderen Schaltflächen unterscheiden zu können. 

Einer Schaltfläche ein Bild hinzufügen: 
1. Auf Options > Control Panel Settings klicken.

2. Auf die P-Schaltfläche in der Zeile der Bedienfeld-Schaltfläche klicken, der das Bild hinzugefügt werden soll. In unserem Fall fügen wir der Uroflow
Schaltfläche ein Bild hinzu:

Auf diese Schaltfläche klicken 
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3. Im Properties-Fenster auf die Schaltfläche Browse im Bereich Image klicken, um das Bild zu suchen. In diesem Beispiel ist dies ein Bild des
Uroflowmeters.

4. Nachdem das Bild gefunden wurde, auf Open klicken, um den Bildnamen der leeren Zeile im Properties-Fenster hinzuzufügen.
5. Auf OK und dann nochmals auf OK klicken, um das Fenster zu schließen.

Das Bild erscheint jetzt auf der Schaltfläche des Bedienfelds.

Vorher  Nachher 

Auf diese Schaltfläche 
klicken 
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Anpassung der Farben und Schriftarten 

Auf die Schaltfläche Button Color im Command-Fenster klicken, um das Fenster Select Color zu öffnen. Sie können die Hintergrundfarbe und Schriftart für 
einzelne Schaltflächen des Bedienfelds sowie auch die Farbe der Schaltflächennamen auswählen.  

Nachdem Sie Ihre Auswahl getroffen haben, auf OK klicken, um sie zu speichern. Die ausgewählten Farben und Schriftarten werden nach Verlassen des 
Command-Fensters und Rückkehr auf den Haupt-UDS-Bildschirm angezeigt. 

Auswahl der Schaltflächenfarbe und/oder Schriftart: 
1. In das Innere des farbigen Felds unter der Spalte Text oder Button für den entsprechenden Schaltflächentyp klicken.

Ergebnis: Das „Color“-Fenster öffnet sich.
2. Die Farben für die Schaltfläche und/oder den Text auswählen.
3. Auf die F-Schaltfläche neben dem Schaltflächentyp unter der Font-Spalte klicken und die gewünschte Schriftart für die Schaltfläche aus dem „Font

Selection“-Fenster auswählen.
4. Auf OK klicken.

Sie können sich auch entscheiden, für alle Schaltflächen des Bedienfelds die gleiche Farbe und Schriftart auszuwählen. Dafür im All Buttons-Bereich unten 
im Fenster die zu ändernde Schaltflächeneigenschaft auswählen und dann auf das Rechteck neben der Eigenschaft klicken, um die Farbe oder Schriftart 
auszuwählen. 
Die ausgewählten Farben und Schriftarten werden nach Klicken auf OK, Verlassen des Command-Fensters und Rückkehr auf den Haupt-UDS-Bildschirm 
angezeigt. 

Area Under Curve 

Mit der Funktion Area Under Curve wird die Fläche unter der Kurve oberhalb eines bestimmten Grenzwerts für spezifizierte Grafiksegmente berechnet. 
Vor der Verwendung dieser Funktion müssen die Schaltflächen und Ereignisse Area Start und Area End für die Start- und Endpunkte der Berechnung 
konfiguriert werden. Die Schaltflächen des Bedienfelds können nur verwendet werden, wenn eine Untersuchung läuft, wohingegen die dem Feld Event 
Annotation hinzugefügten Ereignisse während einer laufenden Untersuchung oder nach Beendigung bzw. Abspeicherung einer Untersuchung verwendet 
werden können. 

Konfiguration der Schaltflächen Area Start und Area End für das UDS-Bedienfeld: 
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1. Auf Options > Control Panel Settings klicken.
Ergebnis: Es erscheint das Command-Feld des Bedienfelds.

*Die Schaltfläche Area Start wird im Format AS:(Druckkanal):(Grenzwert) eingestellt. In 

diesem Beispiel: AS:Pves:0 bedeutet, dass die Fläche unter der Pves-Kurve oberhalb eines
Grenzwerts von 0 berechnet wird.

2. Im Command-Feld die Schaltflächen Area Start* und Area End
mit den folgenden Informationen konfigurieren.

3. Auf OK klicken, um die Schaltflächen dem UDS-Bedienfeld
hinzuzufügen.

Konfiguration der Schaltflächen Area Start und Area End für das Feld „Event Annotation“: 
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1. Eine Untersuchung auswählen.
2. Auf die Event-Schaltfläche im Bedienfeld klicken, um das

Event Annotation-Feld zu öffnen.
3. Das „Area Start“-Ereignis im Format AS:(Druckkanal):

(Grenzwert) eingeben. In diesem Beispiel bedeutet
AS:Pves:0, dass die Fläche unter der Pves-Kurve oberhalb
eines Grenzwerts von 0 berechnet wird.

4. Auf Add klicken.

5. AE: eingeben (sicherstellen, dass ein Doppelpunkt [:] nach
dem AE eingegeben wird).

6. Auf Add klicken.
7. Auf Cancel klicken, um ins „Test Start“-Fenster zurückzukehren.

Berechnung der Fläche unter der Kurve während einer Untersuchung: 

1. Set Zeroes auswählen.
2. Auf Run klicken, um mit der Untersuchung zu beginnen.
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Soweit zutreffend, auf die Schaltfläche Area Start im Bedienfeld klicken, um den Anfangspunkt der Flächenberechnung festzulegen. 

Soweit zutreffend, auf die Schaltfläche Area End im Bedienfeld klicken, um den Endpunkt der Flächenberechnung festzulegen. 

Die Untersuchung beenden und auf Info > Event Summary klicken, um die Werte für Area Start und Area End zu prüfen. 

Berechnung der Fläche unter der Kurve für eine gespeicherte Untersuchung, nachdem diese beendet wurde: 
1. Wenn eine Untersuchung beendet wird oder eine gespeicherte Untersuchung offen ist, am Anfangspunkt der Flächenberechnung auf die Grafik

rechtsklicken und Insert Event auswählen.

2. Das Area Start-Ereignis auswählen AS:

3. Auf Annotate Event klicken.

4. Den Mauszeiger zum Endpunkt der Flächenberechnung bewegen und auf die Grafik rechtsklicken.

5. Insert Event auswählen.

6. Das Area End-Ereignis auswählen AE:

7. Auf Annotate Event klicken.
Ergebnis:Die berechnete Fläche wird der „Area End Event Annotation“ im Format AE: Pves: xxxx hinzugefügt, wobei xxxx die berechnete Fläche ist.

8. Auf Info klicken und Event Summary auswählen, um die Werte für Area Start und Area End zu prüfen.
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Glossar der Bedienfeldbefehle 

Vorgeschlagene 
Schaltflächenbezeichnung 

Definition Typ Kommentare 

First Sensation 
First Urge 
Capacity 
Valsalva 
Cough 
Area Start 
Area End 

First Sensation 
First Urge 
Capacity 
Valsalva 
Cough 
AS:Pves:0 
AE: 

Event 

Event - einmalig 

Markiert ein Ereignis mit der Definition Text als 
Event Annotation. 
Ein Ereignis, das nur einmal auftritt und jedes 
vorhandene aufgezeichnete Ereignis ersetzt.  

Uroflow 
CMG 
UPP 
Micturition 

Vollständiger Pfad der CFG-Datei 
    Beispiel: c:\cfg\ 

Config Öffnet eine .cfg-Datei 

Slow Fill 
Medium Fill 
Fast Fill 

XXX ml/min 
+YY ml/min

-ZZ ml/min

Reverse Slow Fill 
Reverse Medium Fill 
Reverse Fast Fill 

Start Pump 

Resume Pump § 

SF 
MF 
FF 

SP=XXX (wobei XXX in ml/min angegeben ist) 
SP+YY (wobei YY die inkrementelle Rate ist) 
SP-ZZ (wobei ZZ die dekrementelle Rate ist) 

RSF 
RMF 
RFF 

Pumprunstop 

PumpRunStopResume 

Pumpenbefehl Steuert die Pumpenfüllrate. 

Steuert die reverse Pumpenfüllrate† 

Dynamische Schaltfläche zum Starten/Stoppen der 
Pumpe bei mittlerer Füllgeschwindigkeit 

Verwendung zusammen mit Geschwindigkeits-
Steuertasten. Nachdem die „Stop Pump“-Schaltfläche 
betätigt wurde, wird die „Resume Pump“-
Schaltfläche aktiviert. 

Auto Start N/A Auto Start Richtet Uroflow Auto Start ein. 

Set Zeroes N/A Set Zeroes Setzt alle Kanäle auf Null. Einstellung des EMG-
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Vorgeschlagene 
Schaltflächenbezeichnung 

Definition Typ Kommentare 

Kanals auf Null siehe Seite 270. 

Pura = Pves    oder 
Pabd = Pves 

Kanal X = Kanal Y 
    Beispiel: Pura = Pves 

Equalize Setzt den Wert des linken Kanals auf den Wert des 
rechten Kanals. 

UPP Return 
UPP Pull 
UPP Stop 

IN (zieht den Puller so schnell wie möglich zurück; 
für Puller-Positionierung) 

PU (zieht mit Standard-UPP-Geschwindigkeit; 
stoppt, wenn die Spitze erreicht wird)  

ST (stoppt den Zug) 

UPP-Befehl* 

Weitere Infor-
mationen ent-
nehmen Sie bitte 
dem UPP-Puller-
Handbuch. 

Kontrolliert die Geschwindigkeit des UPP-Pullers. 

Start ICO2 

Stop ICO2 

ICO2=40 (Start der CO2-Infusion bei 40 ml/min) 

ICO2=0 (Stopp der CO2-Infusion) 

IC02 Befehl Pumpt Gas, um Blase mit CO2 zu füllen. 

Patient Info N/A Patienteninfo Öffnet das „Patient Info“-Fenster. 

Rest 
Slow Waves 
MSP 
Compliance 
Expulsion 
XXcc 

(rest) 
(waves) 
(max) 
(comp) 
(exp) 
(XXcc) 

ARM Steuert anorektale Manometrieverfahren. 
Weitere Informationen hierzu finden Sie auf Seite 
286. 

Resting Profile 
Squeezing Profile 
Squeeze 5 cm 
Squeeze 4 cm 
Squeeze 3 cm 
Squeeze 2 cm 
Squeeze 1 cm 
Rest 5 cm 
Rest 4 cm 
Rest 3 cm 
Rest 2 cm 

RE 
SQP 
ST5 
ST4 
ST3 
ST2 
ST1 
RT5 
RT4 
RT3 
RT2 

ARM 4&8 Steuert anorektale Manometrieverfahren, die mit 
Kathetern mit 4 oder 8 umlaufenden 
Drucksensoren durchgeführt werden.  
Weitere Informationen hierzu finden Sie auf Seite 
286.
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Vorgeschlagene 
Schaltflächenbezeichnung 

Definition Typ Kommentare 

Rest 1 cm 
10 cc 
20 cc 
30 cc 
40 cc 
50 cc 
60 cc 
70 cc 
80 cc 
90 cc 
100 cc 
110 cc 

RT1 
10cc 
20cc 
30cc 
40cc 
50cc 
60cc 
70cc 
80cc 
90cc 
100cc 
110cc 
HINWEIS: genauso eingeben, kein Leerzeichen 
zwischen der Zahl und „cc“ eingeben. 

Single 
Burst 
Manual 

Peak Image 

Single Capture 
Burst Capture 
Manual Burst 

Peak Burst 

Bild-Event 

Bild-Event - 
einmalig 

Peak-Bild-Event 

Definiert Schaltflächen für die Verwendung mit 
UDS-Videosoftware. 

Weitere Informationen entnehmen Sie bitte dem 
Benutzerhandbuch Ihres Videosystems. 

Initialize Default Values 
Load File 
Save File 
Draw/Remove Calc Curves 
Interpretational Help 
Patient Info 
Global Values 
Bladder Settings 
Sphincter Settings 
Urethra Settings 
Select a View 
Animation-Kontrollfeld 
Change Aspect Ratio 
Curve Adjustments 
Other Options 

(vbninitialize) 
(vbnloadfile) 
(vbnsavefile) 
(vbndrawremovecurves) 
(vbninterpretationalhelp) 
(VBNPatientFile) 
(VBNGlobalValues) 
(VBNBladder) 
(VBNSphincter) 
(VBNUrethra) 
(vbnchangeview) 
(vbncontrolanimation) 
(vbnaspectratio) 
(vbncurveadjustments) 
(vbnotheroptions) 

VBN 

Weitere 
Informationen 
entnehmen Sie 
bitte dem VBN-
Abschnitt dieses 
Handbuchs. 

Optionale Funktion für Blasenmodeling. Steuert die 
Funktionen der VBN-Funktion.  
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Vorgeschlagene 
Schaltflächenbezeichnung 

Definition Typ Kommentare 

Transfer to VBN 
Close VBN Windows 

(vbnimportfile) 
(vbnclose) 

Weitere Einzelheiten siehe i-LIST-
Handbücher 

Voreingestellte Definitionen i-LIST Config

i-LIST Event
(optional)

i-LIST-Befehl

i-LIST-Bild-Event

i-LIST-Event,
einmalig

Konfiguration für i-LIST-Software. 

Speichert Ereignis in der i-LIST-Software. 

Sendet Befehl an i-LIST 

Speichert Ereignis in der i-LIST-Software. 

Speichert Ereignis in der i-LIST-Software. 

Einzelheiten entnehmen Sie bitte 
dem Evox-Handbuch 

Voreingestellte Definitionen Evozierte 
Potenziale 

N/A 

Plot Voreingestellt, mit Auswahl nach Konfiguration 
der Schaltfläche 

Plot Auf die Plot-Schaltfläche klicken, um die Nomo-
gramme zu öffnen, die für die durchgeführte 
Untersuchung Anwendung finden. 

Stress Test Stress Test Stresstest-Befehl Für Stress-Harnverlusttests. Weitere Informationen 
hierzu finden Sie auf Seite 176. 

Hauptmenü Main Load CP (Laden des 
Bedienfelds) 

Richtet das Standard-Bedienfeld für jeden Start der 
UDS-Software ein. 

Summ. Review PFReview Load CP (Laden des 
Bedienfelds) 

Ansicht des „Summary results“-Bedienfelds, um die 
laufende Untersuchung zu überprüfen. 
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Vorgeschlagene 
Schaltflächenbezeichnung 

Definition Typ Kommentare 

Zoom 2x 
3x 
4x 

Zoom Vergrößert den hervorgehobenen Bereich einer 
Grafik, wenn darauf geklickt wird. 

None Annullieren der Bedienfeld-Schaltfläche 

1: *Zu zusätzlichen UPP-Befehlen gehören: 

• PU XX (zieht den UPP-Puller XX Millimeter in der Standard-UPP-Geschwindigkeit; PU 15 zieht z. B. den UPP 15 mm in der Standardgeschwindigkeit)

• PUH XX (zieht den UPP-Puller XX Millimeter so schnell wie möglich; wird für die Positionierung des UPP-Pullers verwendet)

• PUH XX (holt den UPP-Puller XX Millimeter so schnell wie möglich zurück; wird für die Positionierung des UPP-Pullers verwendet)

Mit dem Klick auf eine Schaltfläche kann der Puller so eingestellt werden, dass er automatisch stoppt oder in voreingestellten Intervallen zieht. Wenn ein
UPP-Befehl in der Dropdown-Liste ausgewählt wird und die Definition entweder PU oder IN ist, erscheint ein Popup-Feld, in dem das Intervall
ausgewählt werden kann, in dem der Puller stoppt.

Auf OK klicken, um das Intervall einzustellen. 

 † In der „Reverse Fill pump“-Funktion läuft die Pumpe rückwärts und wird bei ARM-Verfahren verwendet, wenn man den großen Ballon 
schnell füllen und dann wieder leeren will, der verwendet wird, um den Empfindungsprovokationstest durchzuführen. (Wenn die Pumpenbefehle als ff, 
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mf und sf programmiert werden, können rff, rmf und rsf hinzugefügt werden. Wenn die Befehle als fast fill, medium fill und slow fill programmiert 
werden, kann der Rückwärtsfluss als reverse fast fill, reverse medium fill und reverse slow fill programmiert werden. WICHTIG! „Reverse Fill“ ist keine 
Funktion, mit der die Blase entleert werden soll! Sie wird ausschließlich für das Entleeren des großen Ballons während des ARM-Verfahrens 
verwendet! 

  Definition der angezeigten Plots: 
1. Plot aus der Dropdown-Liste im „Command“-Fenster auswählen.
2. Auf die Plus-Schaltfläche (+) klicken, um das Auswahlfeld zu öffnen.

3. „All“ auswählen und auf „OK“ klicken.

4. Das Wort Plot unter der „Label“-Spalte eingeben, um die Schaltfläche zu benennen.
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5. Auf OK klicken, um die Schaltfläche auf dem Bedienfeld einzustellen.

Wenn auf die Resume Pump-Schaltfläche geklickt wird, wird erneut mit dem Füllen in der zuletzt verwendeten Rate begonnen. 

SCHALTFLÄCHENSOUND AKTIVIEREN 

Standardmäßig sind Schaltflächentöne und -befehle in der Software hörbar. Um die Töne stummzuschalten, auf Options > Enable Button Sounds 
klicken, um die Option abzuwählen.  
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Auf Options > Enable Button Sounds klicken, um die Töne auf Wunsch wieder einzuschalten. 

REMOTE CONTROL DESIGNER 

Über diese Registerkarte können die Schaltflächen für die von LABORIE gelieferte Fernbedienung konfiguriert oder geändert werden. Informationen zur 
Einrichtung finden Sie auf Seite 48. 

Vergewissern Sie sich, dass die Fernbedienung eingeschaltet und mit dem PC und Hub verbunden ist. 

Den Namen einer Schaltfläche ändern: 

1. Auf Config > Set up/Modify klicken und einen Test 
Type auswählen.

2. Auf OK klicken.
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3. Auf Options > Control Panel Settings klicken.

4. Aus der Control Panel Set Name Liste ein Bedienfeld 
auswählen, um dieses mit der Fernbedienung zu 
konfigurieren (zum Beispiel UDS Panel 1), dann auf OK 
klicken, um das Bedienfeld auf den Hauptbildschirm zu
laden.
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5. Auf Options > Remote Control Designer klicken, um
den Remote Control Designer Bildschirm zu öffnen.
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6. Auf die Schaltfläche im Remote Control Bildschirm 
klicken, die geändert wird (zum Beispiel, um die Event-
Schaltfläche zu ändern, auf Event klicken.

7. Im Bildschirm Name Chooser die neue Schaltfläche
auswählen, durch die die vorherige ersetzt wird (in
diesem Beispiel auf Stress Test als Ersatz klicken).
Danach auf OK klicken.
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Die Änderungen sind im „Remote Control“-Bild-
schirm wie hier dargestellt sichtbar: 

[DE]



LABORIE AQUARIUS XT/CT/LT/CTS Benutzerhandbuch AQS-UM01  248 

8. Auf der Fernbedienung die LABORIE Remote Control
App öffnen, um die Änderungen anzuzeigen.

Wenn der Name einer Schaltfläche zu lang ist, 
wird er gekürzt. 
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Eine Schaltfläche entfernen: 

1. Auf Options > Remote Control Designer klicken, um
den Remote Control Designer Bildschirm zu öffnen.

2. Im Name Chooser Bildschirm auf die zu entfernende
Schaltfläche klicken (zum Beispiel, die Schaltfläche
Reporter).

3. Auf OK klicken.
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Die Schaltfläche wird jetzt vom Bildschirm entfernt. 

4. Auf OK klicken, um den Designer-Bildschirm zu
schließen.

5. Auf der Fernbedienung die LABORIE Remote Control
App öffnen, um die Änderungen anzuzeigen.

Auf der Anzeige der Fernbedienung ist die Schaltfläche
nun entfernt.
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Konfiguration des Fernbedienungsdisplays: 

o Befolgen Sie für die Einstellung der Bildschirmausrichtung und des Displays der Fernbedienung die folgenden Schritte.

1. Auf der Fernbedienung die LABORIE Remote Control
App öffnen.

2. Auf die Schaltfläche Remote Control Settings unten auf
dem Display klicken.
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3. Im Remote Control Settings Display sicherstellen, dass die
Auto-Option im Bereich Screen Orientation ausgewählt
wurde.

4. Zur Bestätigung auf Save Settings und OK klicken.
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5. Danach auf Back klicken, um auf den Hauptbildschirm
zurückzukehren.
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Verwendung der Fernbedienung während einer Untersuchung: 

1. Die UDS-Software starten.
2. Auf das Remote Control-Symbol auf dem Bildschirm des

Hubs (CHC) klicken.

3. Run anklicken.

Die UDS-Softwaregrafik wird auf dem Bildschirm 
angezeigt. Die Schaltflächen werden automatisch sowohl 
auf dem Hub-Bildschirm als auch auf der Fernbedienung 
aktualisiert. 
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4. Vom Bildschirm des Hubs (CHC) auf eine Event-
Schaltfläche klicken (zum Beispiel First Sensation), um
das Ereignis in die Untersuchung aufzunehmen.

5. Stop auf der Fernbedienung drücken. Dadurch wird das Verfahren beendet und die Schaltflächen werden automatisch sowohl auf dem Hub-
Bildschirm als auch auf der Fernbedienung aktualisiert. 

6. Die Schaltflächen der Fernbedienung können wie erforderlich weiter während der Untersuchung verwendet werden.
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FILE SAVING DIRECTORY (DATENSPEICHERVERZEICHNIS) 

Mit der Option „File Saving Directory“ können Sie das Speicherverzeichnis/den Ordner für das Abspeichern der UDS-Datendateien auswählen. 

Änderung des Speicherverzeichnisses: 

1. In der Menüleiste auf Options klicken und File Saving Directory auswählen.
Ergebnis: Das Fenster Change Data Directory öffnet sich.

2. Auf Browse klicken und ein neues Verzeichnis auswählen.
3. Auf OK klicken, um das „Browse for Folder“-Fenster zu schließen.
4. Auf die Schaltfläche Create Dir. klicken, um das neue Verzeichnis zu bestätigen.
5. Auf OK klicken, um das „Change Data Directory“-Fenster zu schließen.

EXPORT DATA (DATENEXPORT)

Die Option „Export Data“ ermöglicht den Export von Kurvendaten in ein Textdateiformat, das in einem anderen Softwareprogramm verwendet werden kann. 

1. In der Menüleiste auf Options klicken.

2. Export Data auswählen.

Ergebnis: Das Export-Fenster öffnet sich mit dem Standard-
Exportdateinamen (xxxx.out) und der gesamten ausgewählten
Untersuchung.
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3. Um den Dateinamen zu ändern, einen Namen für die Textdatei in das
entsprechende Verzeichnis über die Tastatur eingeben.

4. Um den Bereich zu ändern, in das Export Data-Feld klicken und die
entsprechenden Werte für den Zeitpunkt eingeben, an dem die Daten
exportiert werden sollen.

5. Auf Export klicken.

Ergebnis: Die Textdatei wird erstellt und kann in ein anderes Soft-
wareprogramm importiert werd

EVENT DISPLAY OPTIONS 

Mit „Event Display Options“ können Sie Ereignisse und Peaks (Spitzenwerte)￼ individuell anpassen. 

Änderung der Markierung von Ereignissen und Peaks in einer Kurve: 

1. In der Menüleiste auf Options klicken.
2. Event Display Options auswählen.

Ergebnis: Das Feld „Event Display Options“ öffnet sich.

[DE]



LABORIE AQUARIUS XT/CT/LT/CTS Benutzerhandbuch AQS-UM01  258 

3. Sehen Sie sich die folgende Tabelle an:

Um Folgendes zu ändern... auf dieses Kästchen klicken... und Sie sehen... 

Markierung der Ereignisse: 1. Guideline Eine gepunktete Linie 

2. Annotation Abbreviation Die ersten zwei Buchstaben der „Event Annotation“ 

3. Channel Values Der Wert dieses Ereignisses auf jedem Kanal 

Peaks sind markiert: 1. Guideline Eine gepunktete Linie 

2. Annotation Abbreviation Die ersten zwei Buchstaben der „Event Annotation“ 

3. Channel Values Der Wert dieses Ereignisses auf jedem Kanal 

4. Auf OK klicken.

Ergebnis: Das Feld „Event Display Options“ wird geschlossen und das Erscheinungsbild der Kurven und Peaks￼ wird aktualisiert.

Auswahl von Hintergrundfarben für Ereignisse 

Um einen Bereich der Grafik für Uroflow- oder UPP-Ereignisse während einer Untersuchung hervorzuheben, können die Auto Start-/ Stopp-
Ereignisse für Uroflow-Untersuchungen und UPP Start-/Stopp-Ereignisse für UPP-Untersuchungen farbig dargestellt werden. 
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1. Auf die Schaltfläche Select Background Color of Paired Events klicken, um den Bildschirm „Event Properties“ für die Farbauswahl zu öffnen.

2. In der Liste Select Paired Event UPP oder Uroflow und den Anzeigebereich für diese Event-Option auswählen.
3. Auf die Schaltfläche Select Color klicken, um den Farbauswahlbildschirm zu öffnen.
4. Die Farbe auswählen, mit der der Bereich hervorgehoben wird, der die Ereignisse enthält.
5. Nach Auswahl der Farbe auf Close und dann auf OK klicken, um das Fenster „Event Display Options“ zu schließen.
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Während der Untersuchung werden auf der Grafik die hervorgehobenen Bereiche angezeigt, in denen die Ereignisse auftreten. 

UPP Start UPP Stopp 
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AUTO MARK PEAKS (AUTOMATISCHE PEAKMARKIERUNG) 

Die „Mark Peaks“-Funktion markiert automatisch Peak-Ereignisse für alle Kanäle, wenn die Untersuchung beendet wird. 

1. Auf Options > Auto Mark Peaks klicken, um „Mark Peaks“ zu aktivieren.
Ergebnis: Nach der Durchführung und Beendigung einer Untersuchung wird ein Peak-Ereignis für jeden Kanal hinzugefügt.

2. Auf Options > Auto Mark Peaks klicken, um die „Mark Peaks“-Funktion zu deaktivieren.

AUTO INFUSION EVENT (AUTO-INFUSIONSEREIGNIS)

Das Auto Infusion Event fügt automatisch Ereignisse basierend auf dem in den Körper des Patienten infundierten Volumen ein.

Aktivierung der „Auto Infusion Event“-Funktion:
1. In der Menüleiste auf Options klicken.

2. Auto Infusion Event auswählen.

3. Mit der Untersuchung beginnen und die Pumpe starten.
Ergebnis: Ein Ereignis wird alle 100 ml infundierter Flüssigkeit markiert.

Deaktivieren des „Auto Infusion Event“  

Auf Options > Auto Infusion Event klicken. 

Weitere Informationen zur Anzeige von Ereignissen finden Sie im Abschnitt Event Summary auf Seite 168. 
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GRAPH CLIPPING (GRAFIK-CLIPPING) 

Mit der Option „Graph Clipping“ werden der obere und untere Teil einer Kurve abgeschnitten, wenn diese die Anzeigeskalen des Anzeigebereichs eines 
Kanals überschreiten. Die Option ist standardmäßig deaktiviert und die Kurven können über den Anzeigebereich eines Kanals hinausgehen. 

Die Höhe der Kurve wird durch den Kanal-Skalenbereich festgelegt. 

Aktivierung der „Graph Clipping“-Option: 
1. In der Menüleiste auf Options klicken.

2. Graph Clipping auswählen.

Ergebnis: Die Kurven erscheinen flach, wenn sie den Skalenbereich des Kanals überschreiten.

Auf Options > Graph Clipping klicken, um die „Graph Clipping“-Option zu deaktivieren.

SMART TRACING

Mit dieser Funktion können die Kurven ähnlich einem Farbdisplay angezeigt werden. Linien, in denen sich Daten wiederholen, werden in einer dunkleren
Farbe angezeigt. Diese Funktion ist hilfreich, wenn eine lange Untersuchung in einem kleinen Anzeigebereich komprimiert wird.

RESIZE OVERFLOW SCREEN (ÜBERLAUFBILDSCHIRM ANPASSEN)

Hält die Grafiklinien in den Grafikkanälen.

IMAGE OVERLAY (BILDÜBERLAGERUNG) (OPTIONAL)

Dies ist eine optionale Funktion in der UDS-Software. Mit „Overlay“ auch „Image Overlay“ kann ein Live-Videobild erstellt werden, das unter der Grafik auf
dem UDS-Bildschirm angezeigt wird. Diese Funktion steht mit der Video-Option der Software zur Verfügung.
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CHANGE INFUSION BAG (INFUSIONSBEUTEL WECHSELN) 

Mit diesem Element kann ein Infusionsbeutel während einer CMG- oder Miktionsuntersuchung ausgewechselt werden. Das System erkennt 
automatisch, wenn der Infusionsbeutel leer oder verstopft ist und zeigt eine Meldung an, wie hier dargestellt, und wartet auf Anweisungen für das 
weitere Vorgehen.  

Wenn Sie sich jedoch entscheiden, den Beutel zu wechseln, bevor Sie vom System diese Warnmeldung erhalten, müssen Sie die Option Change Infusion 
Bag im Options-Menü auswählen. 

Manuelles Auswechseln eines Infusionsbeutels während einer Untersuchung: 
1. Auf Options > Change Infusion Bag klicken.

Ergebnis: Die Pumpe stoppt und die Grafik wird weiter angezeigt. Es erscheint ein Meldungsfeld, in dem Sie aufgefordert werden, den Infusionsbeutel zu
wechseln.

2. Auf OK klicken.
3. Den Beutel austauschen und den Infusionsschlauch wieder anschließen.
4. OK klicken, um die Untersuchung fortzuführen.

Ergebnis: Die Pumpe führt ihre normale Aktivität weiter fort.

AUDIO

Diese Option enthält die Audio-Einstellungen und Event Playback-Funktionen.

Audio Settings (nur optionale Sound-Funktion)

Dieser Menüpunkt steht nur zur Verfügung, wenn die Soundfunktion aktiviert ist. Mit ihr können die Sound-Aufnahmeparameter geändert werden.

Änderung der Sound-Aufnahmeparameter:
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1. Auf Options > Audio > Audio Settings klicken.
2. Die entsprechenden Änderungen durchführen.
3. Auf OK klicken.

Event Playback (nur optionale Sound-Funktion)

Dieser Menüpunkt wird verwendet, um das Audio-Playback für Sound-Events ein- und auszuschalten.

VBN

Diese Option enthält die VBN-Einstellungen und VBN-Overlay-Funktionen.

VBN Settings

Wenn bei Ihnen VBN mit unserer Software aktiviert ist, können Sie die verwendete Kathetergröße einstellen, sodass die VBN-Wiedergaben (Renderings)
korrekt sind.

1. Auf Options > VBN > VBN Settings klicken, um das VBN Settings-Fenster zu öffnen.

2. Die Kathetergröße eingeben (zwischen 0 und 15) und auf OK klicken.

VBN – Normal Curve Overlay (Normale Kurvenüberlagerung)

Dies ist eine normalisierte Flow-Kurve, die nach einer Uroflow- oder Druck-/Fluss-Untersuchung auf der Flow-Kurve eines Patienten überlagert wird. Sie
dient als Basis für einen Vergleich zwischen der normalen Flow-Kurve (gemäß Geschlecht und Miktionsvolumen des Patienten) und der tatsächlichen
Flow-Kurve des Patienten. Die Übereinstimmung mit der normalen Kurve ist im schattierten Bereich unterhalb der Kurve sichtbar.
Die normale Flow-Kurve wird erneut berechnet, wenn es eine Geschlechtsänderung im „Patient Info“-Bildschirm gibt.
Standardmäßig ist die Kurve sichtbar, wenn diese Option im Options-Menü ausgewählt wird.
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Um die Kurve zu auszublenden, auf Options > VBN >VBN – Normal Curve Overlay klicken.  

Wenn VBN – Normal Curve Overlay im Menü ausgewählt wird, ist das Kästchen daneben mit einem Häkchen markiert. 

I-LIST (OPTIONAL – NUR FÜR I-LIST-SOFTWAREANWENDER)

Die UDS-Software übermittelt die Daten zur i-LIST Message Queue. 

• Mit der rechten Maustaste auf die Grafik klicken und den Menüpunkt Export to i-LIST auswählen.

• Auf den Namen des zu exportierenden Ereignisses klicken.

[DE]



LABORIE AQUARIUS XT/CT/LT/CTS Benutzerhandbuch AQS-UM01  266 

• Die Untersuchungsdatei speichern. Die UDS-Software übermittelt die Dateien automatisch an den i-LIST-Server.

Überprüfung, ob die Dateiübertragung erfolgreich war:

• Auf Options > i-List > MSMQ Monitor klicken,

• Wenn das Fenster i-List MSMQ Monitor angezeigt wird, auf Options > Enable MSMQ Logging klicken.

• Eine Meldung über die erfolgreiche Übertragung und den Empfang ist im Fenster i-List MSMQ Monitor zu sehen.
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PUMP MENU (PUMPENMENÜ) 

Das PUMP-Menü ist das nächste Menü, das sich in der Menüleiste oben auf dem Bildschirm befindet. 

CONFIGURE PUMP (PUMPE KONFIGURIEREN) 

Die Option „Configure Pump“ ermöglicht Ihnen, die Pumpenoptionen nach Ihren Präferenzen anzupassen. 

Mit der Ansaugratenfunktion läuft die Pumpe in der Geschwindigkeit, die im „Prime“-Feld im Bildschirm „Configure Pump“ eingestellt ist. Die 
Standardgeschwindigkeit ist 150 ml/min. 

Konfiguration der Pumpe: 
1. Configure Pump aus dem Pump-Menü auswählen.

Ergebnis: Der „Configure Pump“-Bildschirm erscheint.

Merkmal Funktion 

Volume Channel Gibt den Infusionsvolumenkanal an 

Pressure Channel Gibt den für die Druckrückkopplung verwendeten Kanal an. 

Slow (Ratengeschwindigkeit) Legt die langsame Geschwindigkeit der Durchflussrate (Flowrate) fest 

Medium (Ratengeschwindigkeit) Legt die mittlere Geschwindigkeit der Durchflussrate fest 

Fast (Ratengeschwindigkeit) Legt die schnelle Geschwindigkeit der Durchflussrate fest 

Prime (Ratengeschwindigkeit) Legt die Ansauggeschwindigkeit der Durchflussrate fest 

Pressure￼ 
Stoppt die Pumpe, wenn der Druckkanal diesen Grenzwert überschreitet. VORSICHT: 150 cmH2O nicht 
überschreiten. 

Volume Limit 
Stoppt die Pumpe, wenn der Volumenkanal diesen Grenzwert überschreitet. 
VORSICHT: 750 ml nicht überschreiten. 

Volume Warning Limit (Volumen-
Warngrenzwert) 

Akzeptable Mindestgesamtblasenkapazität 

Auto Pump Option Mit dieser Option startet die Pumpe bei Untersuchungsbeginn in der ausgewählten Pumpengeschwindigkeit. 
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Merkmal Funktion 

• Stop, Slow, Med, Fast Stop auswählen, wenn Sie diese Option nicht verwenden möchten. 

Auto Pump Event 
Diese Option zeichnet automatisch Ereignisse auf, wenn die Pumpe läuft oder stoppt. Diese Option ist 
standardmäßig aktiviert. Die Markierung des Kästchens aufheben, um die Funktion zu deaktivieren. 

2. OK zum Bestätigen ODER Cancel wählen, um die Option ohne Speichern der Änderungen zu verlassen.

PRIME PUMP (PUMPE ANSAUGEN LASSEN)

Durch das Ansaugen der Pumpe werden alle Luftblasen aus dem Schlauch entfernt, die falsche Druckmesswerte hervorrufen könnten.

SLOW FILL

Diesen Menüpunkt auswählen, um die Pumpe in der langsamen Geschwindigkeit laufen zu lassen, die im „Configure Pump“-Fenster eingestellt wurde.

MEDIUM FILL

Diesen Menüpunkt auswählen, um die Pumpe in der mittleren Geschwindigkeit laufen zu lassen, die im „Configure Pump“-Fenster eingestellt wurde.

FAST FILL

Diesen Menüpunkt auswählen, um die Pumpe in der schnellen Geschwindigkeit laufen zu lassen, die im „Configure Pump“-Fenster eingestellt wurde.

STOP PUMP

Diesen Menüpunkt auswählen, um die Pumpe zu stoppen.

Volume Warning Limit (Volumen-Warngrenzwert)

Der Volumen-Warngrenzwert wird im pädiatrischen „Uro-Modus“ verwendet, der auf Patienten im Alter unter 16 Jahren Anwendung findet. Dieser
Grenzwert ist die maximale Flüssigkeitsmenge, die einem Patienten gemäß der Blasenkapazität in einem bestimmten Alter infundiert werden kann.

Der Volumen-Warngrenzwert wird durch die akzeptable Gesamtblasenkapazität (Acceptable Total Bladder Capacity, ATBC) bestimmt.

ATBC = 16 x (Alter des Kindes in Jahren) + 70 ml.

Die Pumpe erhält die Informationen für die Berechnung der ATBC aus den in das Dialogfeld „Patient Information“ eingegebenen Daten.
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Wenn das infundierte Volumen den im Feld „Volume Warning Limit“ angegebenen Grenzwert überschreitet, erscheint eine Meldung. 

Nachdem die Warnmeldung angezeigt wurde, stoppt die Pumpe nicht automatisch. Sie muss manuell gestoppt werden. 

Die ATBC wird automatisch berechnet und kann nicht geändert werden. 

SERVERX-MENÜ (OPTIONAL) 

Das SERVERX-Menü ist das nächste Menü, das sich in der Menüleiste oben auf dem Bildschirm befindet. 

RESET CONNECTION (VERBINDUNG ZURÜCKSETZEN) 

Die „Reset Connection“-Funktion setzt die Verbindung zur Hardware zurück. Sie sollte nicht während einer Untersuchung verwendet werden. Sie ist nur 
für die Verwendung durch qualifiziertes technisches Servicepersonal bestimmt. 

SHOW SERVERX WINDOW 

Die „Show ServerX Window“-Funktion darf nur von qualifiziertem technischen Servicepersonal verwendet werden. 

CHOOSE BLUETOOTH UDS-94 

Dieser Menüpunkt wird verwendet, um auszuwählen, welches AQUARIUS®-System mit der Software verbunden wird. Die Software verbindet sich 
automatisch mit demselben AQUARIUS®-System, wenn sie das nächste Mal läuft. 

Das anzuschließende System auswählen: 
1. Server X > Choose Bluetooth Server UDS-94 auswählen.

Ergebnis: Das Fenster „Select a Bluetooth Server“ öffnet sich und sucht nach allen Bluetooth-Geräten innerhalb des Bereichs.
2. Den Namen des AQUARIUS®-Systems aus der Liste auswählen.
3. Nach Aufforderung die PIN-Nummer LMTUDS94BT eingeben (alles in Großbuchstaben).
4. Auf OK klicken.
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CONNECTION TYPE (VERBINDUNGSTYP) 

Die Option auswählen, die der Verbindung entspricht, die in den Touchscreen-Einstellungen eingestellt wurde. Wenn der Verbindungstyp geändert wird, 
muss er auch in der Touchscreenmodul-Software geändert werden. 

Wenn eine Verbindung geändert wird (wenn z. B. von USB auf Bluetooth oder umgekehrt umgeschaltet wird), die Software schließen und erneut starten, 
um die Änderung zu aktivieren. 

VIDEO 

Startet die Video-Funktionen der UDS-Software. Weitere Informationen entnehmen Sie bitte dem Saturn-Handbuch. 

SET ZEROES! MENÜ 

Set Zeroes ist ein Menü, das sich in der Menüleiste oben auf dem Bildschirm befindet. Es wird empfohlen, alle Druckwandler vor der Durchführung einer 
Untersuchung auf Null zu setzen. 
 „Nulldruck ist der Wert, der aufgezeichnet wird, wenn ein Druckwandler drucklos (offen gegen Atmosphäre) ist, wenn er von Schläuchen oder Kathetern 
getrennt ist oder wenn das offene Ende eines angeschlossenen, flüssigkeitsgefüllten Schlauchs sich auf der gleichen vertikalen Ebene wie der 
Druckwandler befindet. Nur dann kann das „Nullsetzen“ oder der „Abgleich“ erfolgen.“ix  

Der EMG-Kanal muss über dieses Menü immer auf Null gesetzt werden. 

Um die Druckwandler auf Null zu setzen, eine der folgenden Maßnahmen durchführen: 
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Um Folgendes zu tun… Klicken auf… 

Alle Druckwandler auf Null setzen: Set Zeroesaus der Menüleiste und dann auf All klicken. 

Einzelne Druckwandler auf Null 
setzen: 

1. In der Menüleiste auf Set Zeroes klicken. 

2. Auf die Schaltfläche mit der Bezeichnung des 
entsprechenden Druckwandlers klicken. 

3. Auf Exit klicken. 

Druckwandler auf einen 
bestimmten Wert einstellen: 

1. In der Menüleiste auf Set Zeroes klicken. 

2. Auf Advanced klicken. 
Ergebnis: Das „Set Zeroes“-Fenster zeigt einen 
Nummernblock und eine Liste der Kanäle an. 

3. 

Die Schaltfläche Advanced kann nur ausgewählt 
werden, wenn die Grafik angehalten wird. 

4. Auf die Schaltfläche neben dem Kanal klicken, der 
geändert werden soll. 

5. Den Wert, auf den der Kanal gesetzt werden soll, im 
Nummernblock eingeben. 

6. Apply. 
Ergebnis: Der Kanal ändert sich auf den angegebenen Wert 
oder den nächstmöglichen Wert. 

Ergebnis: Der/die Wandler wird/werden auf Null gesetzt und die Untersuchungen können starten. 
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DRUCKWANDLERTYP 

Den Wandlertyp, der mit dem System verwendet wird, vor Beginn einer Untersuchung auswählen, um eine korrekte Datenerfassung sicherzustellen. 
Vergewissern Sie sich, dass das System für den ausgewählten Wandlertyp kalibriert wurde. 

Denken Sie daran, nur einen Wandlertyp mit dem Roam™ zu verwenden. Wählen Sie entweder luft- oder wassergefüllt für alle Untersuchungen aus. 

Ein „Tranducer Type“-Ereignis wird den Beginn der Grafik hinzugefügt, wenn auf Run geklickt wird. 
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ERWEITERUNG IHRES SYSTEMS 
Diese Version der UDS-Software enthält spezielle Funktionen, die Ihnen abhängig von der jeweiligen Konfiguration Ihrer Tätigkeiten zur Verfügung 
stehen können.  

Der folgende Abschnitt erhält Informationen und Anweisungen zu den VBN- und ARM-Funktionen (ARM - anorektale Manometrie) der UDS-
Software. 

Um eine optionale Funktion für Ihre Software anzufordern, wenden Sie sich bitte an Ihren LABORIE-Vertreter oder den Kundendienst. 
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VBN 

VBN ist ein mathematisches Modell der unteren Harnwege und basiert auf der Forschung und den Standards, die von den Mitgliedern der 
International Continence Society aufgestellt wurden. VBN ist ein leistungsfähiges und nicht invasives Tool, um die Spätfolgen/ Nebenwirkungen von 
Operationen und/oder verordneten Behandlungen zu prognostizieren. 
Die Ihnen zur Verfügung stehenden Funktionen sind abhängig von den in Ihrem System installierten VBN-Optionen. 

NORMAL CURVE OVERLAY (NORMALE KURVENÜBERLAGERUNG) 

Sie können die normale Flow-Kurve (Q) berechnen und diese mit der aktuellen Flow-Pves-Kurve des Patienten vergleichen, indem Sie die normale 
Kurve über die Kurve des Patienten legen. 

1. Auf File > Open klicken, um eine Druck-/Fluss-Datei (.dta-Datei) oder eine Datei zu öffnen, die einen Flow/Q-Kanal hat.

2. Auf Options >VBN – Normal Curve Overlay klicken.

• Wenn VBN – Normal Curve Overlay im Menü ausgewählt wird, ist das Kästchen daneben mit einem Häkchen markiert.
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Nachdem Normal Curve Overlay ausgewählt wurde, wird eine blaue Kurve, die den normalen, geschlechtsabhängigen Flow des Patienten darstellt, über 
die aktuelle Flow-Kurve des Patienten gelegt. 

3. F9 drücken, um das Cursor-Feld zu aktivieren. Die Maus über die blaue berechnete Kurve und die tatsächlich gemessene Kurve des Patienten bewegen.

Sie sollten den Unterscheid zwischen dem Harnfluss des Patienten und dem normalen Fluss an diesem Punkt sehen, wenn der Mauszeiger über die Grafik
bewegt wird.

4. Mit der linken Maustaste auf das Feld Flow Channel (unterhalb des ml/s-Texts) klicken, um die Kanalbezeichnung auf den normalen Flow-Kanal
(CALQ) zu ändern.

o Die Bezeichnung sollte Blau werden und CALQ lauten, mit einer Peak-Flow-Messung in ml/s. Dieser Peak-Flow sollte dem Wert des höchsten
Punkts in der normalen Flow-Kurve entsprechen.
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5. Noch einmal mit der linken Maustaste auf das Feld klicken, um das „Flow Channel“-Feld von CALQ zurück auf Flow zu setzen.

o Sie können die Untersuchung auch mit der Option „Normal Curve Overlay“ aktiviert zurückspielen und die Untersuchung ansehen, wenn die
Überlagerung dargestellt wird.

6. Auf Options >VBN – Normal Curve Overlay klicken, während dies ausgewählt wird, um die überlagerte Kurve zu deaktivieren.

VBN FULL UND VBN ANIMATION

Sie können ein simuliertes Modell der menschlichen Blase und eine Animation dessen anzeigen, was die Blase mit normalem Druck und Flow 
basierend auf solchen Faktoren wie Geschlecht, Kathetergröße (soweit vorhanden) und anderen Kräften tun könnte. Die mit der VBN verbundenen 
Schaltflächen sind bereits in das System geladen.  

VBN Full und VBN Animation Only Versionen haben sehr ähnliche Funktionen, mit der Ausnahme, dass die VBN Animation-Version keine Grafikfenster 
enthält. Alle Funktionen, die ein Grafikfenster erfordern, werden daher in der VBN Animation-Version der Software nicht verwendet. 

Zugriff auf das Bedienfeld: 
1. Auf Options > Control Panel Definition klicken.
2. VBN aus der Dropdown-Liste Control Panel Set Name auswählen.
3. Auf OK klicken.
4. Auf die Schaltfläche Transfer to VBN auf dem Bedienfeld klicken, um das VBN-Bedienfeld zu öffnen.

VBN-BEDIENFELD 

Wenn das VBN-Bedienfeld geladen ist, sollten Sie drei Schaltflächenreihen sehen können. 

INITIALIZE DEFAULT VALUES (STANDARDWERTE INITIALISIEREN) 

Auf diese Schaltfläche klicken, um VBN-bezogene Variablen für vordefinierte Standardwerte zu initialisieren und einige der VBN-Fenster und -
Bedienelemente zu öffnen. Welche Bedienelemente sich öffnen, hängt davon ab, welches Fenster-Layout Sie in Ihrer Version gespeichert haben. 
Wenn Sie Ihr eigenes individualisiertes Fenster-Layout noch nicht abgespeichert haben, öffnet sich ein Standard-Layout.  
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Load File 

Auf diese Schaltfläche klicken, um eine zuvor gespeicherte Datei im CAS-Format zu laden; dies ist das von VBN verwendete Dateiformat, um 
Untersuchungen zu speichern. 

Save File 

Auf diese Schaltfläche klicken, um die aktuelle VBN-Untersuchung im CAS-Format zu speichern, sodass sie später mithilfe der Schaltfläche Load File 
abgerufen werden kann. 

Transfer to VBN 

Wenn Sie eine Druck-/Fluss-Datei (.dta-Datei) aus der UDS-Software geöffnet haben (File >Open), können Sie diese Untersuchungsdaten in die VBN-
Komponente des Programms übertragen, indem Sie diese Schaltfläche betätigen. 

Draw/Remove Calculated Curves 

Auf diese Schaltfläche klicken, um die Anzeige der berechneten Druck- und Flow-Kurven auf etwaige offene Kurvenfenster umzuschalten. 
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Interpretational Help 

Das Fenster Interpretational Help ist in VBN ein wichtiges Fenster. 

Es dient dazu, die automatischen Interpretationsfunktionen der VBN zu steuern. Mit dieser 
Funktion versucht die Software automatisch, die berechneten Druck- und Flow-Kurven über die 
gemessenen kalkulierten Druck- und Flow-Kurven zu legen, indem sie verschiedene VBN-Variable 
anpasst. Sie erstellt dann eine oder mehrere Lösungen, in denen die Kurven zueinander passen.  

Die Schaltfläche Together betätigen - die Software beginnt damit, die Kurven aufeinander 
anzupassen. Sie können die Berechnungen in jedem offenen Grafik- oder Animationsfenster 
beobachten, während der Computer die verschiedenen Variablen-Kombinationen testet. 
Nachdem der Vorgang abgeschlossen ist, erscheint ein Ergebnisfenster mit den entsprechenden 
Lösungen. 

Wenn Lösungen gefunden wurden, ändert sich der Solution-Wert auf 1. Wenn mehr als eine Lösung 
gefunden wurde, können die Schaltflächen -1 und +1 verwendet werden, um zwischen den 
verschiedenen Lösungen zu navigieren. 

Patienteninfo 

Auf die Schaltfläche Patient Info klicken, um Patienteninformationen für die aktuelle 
Untersuchung einzugeben oder zu überprüfen. 

Das Geschlecht des Patienten kann durch Klicken auf die Schaltfläche Mr. oder Mrs. ausgewählt 
werden. Die von der VBN-Software während der vielen Berechnungen verwendeten 
Gleichungen hängen vom Geschlecht des Patienten ab, es ist also wichtig, dass diese Auswahl 
absolut korrekt ist. 
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Global Values 

Das Fenster Global Values kann offen gelassen werden, wenn andere VBN-Funktionen 
durchgeführt werden.  

In diesem Fenster können einige Messwerte (z. B. das Entleerungsvolumen) beobachtet und mit 
den von der VBN-Software errechneten Werten verglichen werden. Dies ist insbesondere in 
Kombination mit der „Interpretational Help“-Funktion nützlich, da man vergleichen kann, wie 
nahe die berechneten Werte für jede Lösung den Originalwerten sind. 

Bladder 

Auf diese Schaltfläche klicken, um das Bladder-Dialogfeld zu öffnen. 

Dies kann für die Anpassung von Variablen verwendet werden, die sich auf die Blase auswirken, 
wie Ausgangsvolumen, Detrusorkraft und so weiter. Einige dieser Werte werden automatisch 
angepasst, wenn „Interpretational Help“ für die Lösungsfindung verwendet wird. In diesem 
Fenster kann auch das Ausgangsvolumen in der Blase eingegeben werden, das eine signifikante 
Auswirkung auf die Berechnung hat. 

Detrusor Force: Eine höhere Detrusorkraft verringert die Zeit, die ein Patient zum Harnlassen 
benötigt, vorausgesetzt, dass ihm dies überhaupt möglich ist. 
Initial Volume: Die Größe der Blase im Animation-Fenster sollte sich abhängig von Aus-
gangsvolumen ändern. Ein größeres Ausgangsvolumen bedeutet auch, dass der Patient mehr Zeit 
für die Blasenentleerung benötigt. 
Time Of Break und Quality: Der Patient sollte nicht in der Lage sein, viel länger als in der unter 
„Time of Break” eingestellten Zeit (in Sekunden) seine Blase zu entleeren. Wie viel mehr Zeit der 
Patient für die Blasenentleerung über diesen Punkt hinaus benötigt, hängt von der Einstellung 
unter „Quality“ ab. 
Neck/Detrusor Coupling: Kein zu beobachtender Effekt für Animation. 
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Sphincter 

Auf diese Schaltfläche klicken, um das Sphincter-Dialogfeld zu öffnen. 
Wird verwendet, um den Sphinkter betreffende Variable anzupassen. Einige dieser Werte werden 
automatisch angepasst, wenn „Interpretational Help“ für die Lösungsfindung verwendet wird. 
Pre excitation: Wenn die Werte hoch genug sind, hängt die Miktion nicht davon ab. Bei 
unzureichenden Werten ist die Funktion des Sphinkters beeinträchtigt, es wird also keine 
Kontinenz erzielt. 
Opening Time: Der Bereich der Urethra, den die Sphinkterkraft beeinflusst, wird sich nicht vor 
Ablauf dieser Zeitspanne öffnen. In diesem Bereich sind subsonische und sonische Kräfte 
festzustellen, bis der Sphinkter sich geöffnet hat. 
Excitation: Kann sich darauf auswirken, wie lange der Patient für die Blasenentleerung benötigt, 
hängt jedoch auch von anderen Einstellungen ab. 

Urethra 

Auf diese Schaltfläche klicken, um das Urethra-Fenster zu öffnen. 
Wird verwendet, um die Harnröhre betreffende Variable anzupassen. Einige dieser Werte werden 
automatisch angepasst, wenn „Interpretational Help“ für die Lösungsfindung verwendet wird. Aus 
diesem Fenster kann die Größe des Katheters (in French-Einheiten) ausgewählt werden, der in die 
Harnröhre eingeführt wird. Dies hat eine große Auswirkung auf die Berechnungen. 
Neck Disease: Eine sehr niedrige Einstellung (zum Beispiel: 0,1) erhöht die Zeit, die der Patient für 
die Blasenentleerung benötigt. Man kann die sonischen/subsonischen Kräfte in der Nähe des 
Blasenhalses beobachten. Keine Auswirkung ist größer als 0,2. 
Neck Pressure (nur Männer): Wenn dieser Wert erhöht wird, erhöht sich der Druck auf den 
Blasenhals, wodurch sich dann die Zeit verlängert, die der Patient zum Wasserlassen benötigt. 
Prostrate Pressure (nur Männer): Wenn dieser Wert erhöht wird, erhöht sich der Druck der 
Prostata, wodurch sich dann die Zeit verlängert, die der Patient zum Wasserlassen benötigt. 
Ura Comp. (Nur Frauen): Wenn dieser Wert erhöht wird, verlängert sich die Zeit, die die Patientin 
für die Blasenentleerung benötigt. 
Urethra Area (nur Frauen): Wirkt sich auf die Größe der Urethra aus. Wirkt sich auch auf die Zeit 
aus, die die Patientin für die Blasenentleerung benötigt. 
Probe: Legt die Größe der Sonde (falls zutreffend) fest, die in die Harnröhre des Patienten 
eingeführt wird. Ein roter Balken ist im Animation-Fenster zu sehen. Eine Sonde verlängert die Zeit 
erheblich, die der Patient für das Wasserlassen benötigt. 
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Select a View 

Auf diese Schaltfläche klicken, um das Fenster Select a View zu öffnen.  
Normal klicken, um das normale Grafikfenster auszuwählen, oder Separate P and Q auswählen, 
um ein Grafikfenster zu öffnen, das die Druckkurven und die Flow-Kurven auf zwei verschiedenen 
Grafiken anzeigt.  
Animation auswählen, um das Fenster „Animation“ zu öffnen. 

Wenn Sie nur die Animation-Version der VBN verwenden, stehen die ersten zwei Schaltflächen 
nicht zur Verfügung. 

In diesen zwei Grafikfenstern werden mehrere gemessene und berechnete Kurven angezeigt. Die 
Kurven haben jeweils eine entsprechende Bezeichnung, die mit ihrer Farbe übereinstimmt. In 
beiden Grafiken zeigt die oberste immer Kurven an, die sich auf die Detrusor- und Sphinkterkräfte 
beziehen. Im Fenster Separate P and Q werden die Druck- und Flow-Kurven in zwei 
verschiedenen Grafiken angezeigt. Sie können die verschiedenen Grafiken mithilfe des 
Scrollbalkens ansehen. 

Normal 

Separate P and Q 
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Animation-Fenster 

Das Animation-Fenster zeigt ein simuliertes Modell der Blase für den aktuellen Patienten an. 

Anpassungen an Variable, wie Prostatadruck, Kathetergröße, Ausgangsvolumen und Geschlecht 
des Patienten sind in diesem Fenster direkt zu sehen.  

Wenn eine Animation zurückgespielt wird, zeigt dieses Fenster die aktuelle Flowrate und die Zeit 
an, die bis zu diesem Stadium der Animation verstrichen ist. Bei einem Animationsplayback 
verringert sich die Blasengröße nach und nach, vorausgesetzt, dass der Patient während dieser 
onSimulation in der Lage ist, Wasser zu lassen. Die Sonic und Supersonic Kräfte im Inneren der 
Harnröhre werden während des Animationsplaybacks ebenfalls hervorgehoben. 

Animation-Kontrollfeld 

Auf diese Schaltfläche klicken, um das Animation Control-Fenster zu öffnen. 

Das Animationsplayback kann mithilfe der Schaltflächen in diesem Fenster gesteuert werden. Die 
Schaltfläche Stop auswählen, um die Animation auf das Anfangsstadium zurückzusetzen, dann 
Play klicken, um mit dem Playback zu beginnen. Während der Animation kann die Pause-
Schaltfläche verwendet werden, um das Playback im gewünschten Moment zu unterbrechen. 
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Aspect Ratio 

Auf diese Schaltfläche klicken, um das Aspect Ratio Kontrollfenster zu öffnen. 

Mithilfe dieser Bedienelemente kann das Abbildungsverhältnis der X- und Y-Achse auf den 
Grafikfenstern angepasst werden. Verwenden Sie diese Bedienelemente, wenn die Kurven 
außerhalb des Bereichs sind und die Grafikgrenzen überschreiten. Mithilfe dieser Bedienelemente 
kann auch der Beginn der Exzitation eingestellt werden: 0 Sekunden oder 40 Sekunden. 
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Curve Adjustments 

Auf diese Schaltfläche klicken, um das Curve Adjustments-Fenster zu öffnen.  
In diesem Fenster können in Kombination mit dem normalen Grafikfenster Anpassungen der 
Kurven vorgenommen werden.  
Um eine Kurve direkt auf der Grafik zu ziehen, die gewünschte Kurve aus diesem Fenster 
auswählen, dann mit der linken Maustaste auf das normale Grafikfenster klicken, um eine Linie 
vom Beginn der Grafik bis zu diesem Punkt zu ziehen. Sie können auch die rechte Maustaste 
verwenden, um Kurven vom Ende der Grafik bis zu dem von Ihnen angeklickten Punkt zu löschen.  
Mithilfe der Move Curve-Pfeile kann die ausgewählte Kurve in die Richtung gezogen werden, in die 
der Pfeil zeigt. Dadurch wird die Auswirkung dargestellt, die der abdominale Druck auf sie hat.  
Mit der Affinity-Option können Sie alle y-Werte einer ausgewählten Kurve mit dem gewünschten 
Wert multiplizieren. Auf die Schaltfläche Delete klicken, um eine komplette Kurve aus der Grafik 
zu löschen und die Schaltfläche Undo Delete betätigen, um eine vorherige Löschung aufzuheben. 
Die gemessenen Gesamtwerte sollten sich basierend auf dem Ausgangsvolumen der Blase 
unterscheiden. Die anderen Parameter haben ihren Standardwert. Wenn Sie Werte in den 
Fenstern ändern, sollten Sie feststellen, dass sich die Werte im Fenster „Global Values“ ebenfalls 
ändern, um so die anderen Änderungen zu reflektieren, die Sie vornehmen. 

Other Options 

Auf diese Schaltfläche klicken, um das Other Options-Fenster zu öffnen. 
Sie können hier verschiedene Gesetze aktivieren oder deaktivieren, die für die VBN-Berechnungen 
verwendet werden. Einige dieser Gesetze wirken sich darauf aus, welche Berechnungen für die 
„Interpretational help“ verwendet werden. 
Aus diesem Fenster kann auch die Dicke der auf den Grafikfenstern angezeigten Kurven 
angepasst werden. Die Schaltflächen Save und Restore können verwendet werden, um das 
aktuelle Fensterlayout zu speichern, oder ein zuvor gespeichertes Fensterlayout wieder 
herzustellen. 
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Close VBN Windows 

Klicken Sie auf diese Schaltfläche, um alle VBN-bezogenen Fenster zu schließen, die gleichzeitig geöffnet sind. Dies ist nützlich, wenn Sie VBN nicht 
weiter verwenden, aber mit einem anderen Teil der UDS-Software weiterarbeiten möchten. 
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ANOREKTALE MANOMETRIE (ARM) 

Das anorektale Manometriesystem (ARM-System) von LABORIE wird verwendet, um die Leistung des anorektalen Mechanismus zu quantifizieren. 
Anorektale Funktionstests können nützliche Informationen über die Pathophysiologie von Erkrankungen liefern, die sich auf Kontinenz und 
Defäkation auswirken oder anorektale Schmerzen hervorrufen. 

VERWENDUNGSZWECK 

LABORIEs ARM-System ist dafür indiziert, physikalische Parameter, wie Drücke und EMG des letzten Stücks des Verdauungstrakts (Enddarm) im Hinblick 
auf Urodynamik, Inkontinenz und Beckenboden zu messen. 

ZIELPOPULATION 

Das Hauptanwendungsgebiet der anorektalen Manometrie (ARM) ist die Unterstützung bei der Diagnose von anorektalen Erkrankungen und die 
Beurteilung von Anomalien des Schließmuskelmechanismus. Die ARM hat bei der Diagnose der folgenden Erkrankungen und Fälle bei Männern, 
Frauen und Kindern Anwendbarkeit gezeigt. 

• Fäkale Inkontinenzx,xi,xii

o Hierbei werden die verschiedenen Typen unterschieden, einschließlich:

▪ Pudendusnerv-Neuropathiexiii

▪ Sphinkterläsionenxiii

▪ Überlaufinkontinenzxiii

o Kann bei Diabetes mellitus auftretenxiv

• Obstipationx,xi,xii

o Chronisch oder anderweitigxv,xvi,xvii

• Prä- und postoperative Versorgung* bei jeglichen Verfahren, die den Sphinkterapparat betreffenxii,xiii

o Fissur- und Fistelreparatur

o Koloanale Anastomosen
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o Pouch-Operation

o Sphinkterverengung

• Funktionell-obstruktive Schwierigkeiten bei der Defäkation einschließlichxiii :

o Paradoxe Kontraktion des Musculus puborectalis

o Anismus

o Spastisches Beckenbodensyndrom

o Megarektum

o Rektale Trägheit

o Interner Rektumprolaps

• Beurteilung von Patienten vor dem Biofeedback-Training der Entleerungs- und Kontinenzmechanismen und Erleichterung dieses
Trainingsxii

• Darmsymptome, die durch systemische neurologische Erkrankungen hervorgerufen werden, wie Multiple Sklerosexviii und Schlaganfällexix

• Angeborene Anomalien wie die Hirschsprung-Krankheitxx und Analatresiexxi

• Enkopresisxxii

• Kollagengefäßerkrankung (wie Sklerodermie)xxiii

• Trauma (durch Unfall, Geburtstrauma oder operative Verletzung)xxiv

• Funktionelle anorektale Schmerzenxii,xxv

KONTRAINDIKATIONEN 

Das ARM-System ist bei jedem Patienten mit einer oder mehreren der folgenden Erkrankungen/Zustände kontraindiziert: 

• Unkooperativer Patient

• Magen-Darm-Blutungen

• Koma
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*WARNHINWEIS: Die anorektale Manometrie muss mit großer Sorgfalt durchgeführt werden, insbesondere im frühen postoperativen Zeitraum
nach einem chirurgischen Rektumeingriff oder bei solchen jungen und alten Patienten, die sich möglicherweise nicht ausdrücken können oder kein Gefühl 
für ihre inneren Wahrnehmungen haben, da bei diesen Personen das Risiko der Darmperforation besteht. Mit großer Vorsicht muss auch bei den Patienten 
vorgegangen werden, die sich aufgrund eines Rektumkarzinoms einer Operation und/oder Strahlentherapie unterzogen habenxxvi xxvii xxviii xxix xxx (Anhang 
B – I: (16/-20) Park et al. (2008) empfehlen eine sorgfältige digitale Rektumuntersuchung vor der ARM, um unerwartete, anomale anorektale Läsionen 
erkennen zu können. Diese ist bei Patienten mit Rektumchirurgie in der Anamnese erforderlich. Außerdem sollte die Messung des maximal tolerierten 
Volumen im postoperativen Zeitraum unterlassen werden.  

 WARNHINWEIS: Gemäß dem vorstehenden Warnhinweis besteht für bestimmte Personen möglicherweise ein höheres Risiko für eine 
Darmperforation während der anorektalen Manometrie, die eine operative Korrektur erfordert. Schwerwiegende Komplikationen können bei jeder 
Operation auftreten, diese sollten in Erwägung gezogen und dem Patienten mitgeteilt werden, wenn seine Eignung für eine anorektale 
Manometrieuntersuchung beurteilt wird.  

EINRICHTUNG DES SYSTEMS 

Das ARM-System in der folgenden Reihenfolge einschalten: 

✓ Aquarius-Systemturm

✓ Drucker und Monitor

✓ PC

✓ UDS-Software

• Ein Nichtbeachten dieser Reihenfolge könnte dazu führen, dass Geräte nicht ordnungsgemäß erkannt werden.
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DURCHFÜHRUNG DER ARM MIT LUFTGEFÜLLTEN KATHETERN 

• Den Sensorballon bei allen Untersuchungen NICHT über 450 ml füllen. Bei pädiatrischen Patienten die Füllmenge von 300 ml nicht überschreiten.

• Der Katheter kann für Ballonexpulsionstests verwendet werden.

• Auf den Katheter KEINEN Zug ausüben und NICHT aus dem Patienten herausziehen während der Ballon gefüllt ist, da sich der Ballon dann vom Katheter
lösen könnte.

Ausrüstung für ARM-Untersuchungen

Standardausrüstung Optionales Zubehör 

• ARM luftgefüllte Radialkatheter mit 4 Kanälen mit Rektalballon 
(CAT003 (4-Drucksensoren))

• Spritze, von der Einrichtung bereitzustellen

• Vier oder acht Druckwandler/Kabel

• Desktop-PC oder Laptop

• Starter-Set, Pumpenschlauch, Katheter, Becher usw. (unterschiedlich 
gemäß Systemeinrichtung)

• Software-CD mit der ARM-Software (ARM100) und den 
Benutzerhandbüchern

• EMG-Einheit und Oberflächenelektroden [CAB155, CAB154 oder CAB153 (EMG-Kabel) 
mit ELE200 oder ELE428 oder ELE370 und ELE365 (EMG-Elektroden)] 

• Zugmechanik (UPP-Puller)

• Von LABORIE gelieferter Desktop oder Laptop-Computer

• Desktop-Drucker mit USB-Druckerkabel

• USB Serial Converter (nur Direktkabeloption)

• RS-232 Nullmodemkabel (nur Direktkabeloption)

Wenden Sie sich für die Bestellung von Ersatzzubehör an Ihren LABORIE-Vertreter. 
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Einrichtung und Anschluss von Katheter und Druckwandler 

1. Informationen zur Einrichtung des Roam™ DX, EMG und des Pumpenschlauchs finden Sie auf siehe Seite 37.
2. Die farbcodierten Druckwandlerkabel an die luftgefüllten Katheter mit der folgenden Konfiguration anschließen: Jeder direktionale Sensor ist farblich

gekennzeichnet, und diese Farbe entspricht der Druckwandler/Kabelverbindung und erleichtert die Identifikation.

 Gelbes P1-Kabel an HINTEREN (gelb) Katheteranschluss 

 Blaues P2-Kabel an RECHTEN (blau) Katheteranschluss 

 Grünes P3-Kabel an VORDEREN (grün) Katheteranschluss und 

 Oranges P4-Kabel an LINKEN (orange) Katheteranschluss 
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• Die schwarze Linie auf dem Katheter weist auf die „posteriore“ Ausrichtung hin. Diese Linie sollte genau in gleicher Höhe mit der Wirbelsäule des
Patienten sein. Wenn der Patient auf der linken Seite liegt, ist die Linie auf seinen Rücken gerichtet.

3. Vergewissern Sie sich, dass alle Druckwandler in der OPEN Position sind.

Abbildung 25: Ansicht vom distalen (äußersten) Ende. Der posteriore Kanal (P1) ist in einer Höhe mit der schwarzen Linie auf dem 
Katheter. 

4. Jeden Ballon/Sensor vorsichtig zusammendrücken und dann freigeben, um Luft zu entfernen. HINWEIS: Dies ist nicht der große Rektalballon,
sondern es handelt sich um die vier kleinen Sensoren, die sich direkt neben dem Rektalballon befinden.

5. Auf dem Software-Bedienfeld auf Set Zeros klicken.

6. Den Druckwandler in die Position CHARGE schalten.

P4 P2 

P3 

P1 
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DURCHFÜHRUNG DER ARM MIT FLÜSSIGKEITSGEFÜLLTEN SYSTEMEN 

Standardausrüstung Optionales Zubehör 

Für ein flüssigkeitsgefülltes Schwerkraftsystem: 

• ARM wasserperfundierte 4- oder 8-Kanal-Katheter mit Ballon [CAT006 (4
Drucksensoren) CAT008 (8 Drucksensoren)]

• Druckkartusche* (DIS125)

• Messschlauch (TUB101 oder TUB102)

• Druckmanschette (DIS302)

• Spritze, von der Einrichtung bereitzustellen

• Infusionsbeutel

• Infusionsleitung

• Desktop- oder Laptop-Computer

• Ausrüstung mit eingebauter Pumpe

• Vier oder acht Druckwandler/Kabel

• Starter-Set (Nova-Druckdom, Absperrhähne, Schläuche, Pumpenschlauch,
Katheter, Becher usw.; variiert je nach Systemkonfiguration)

*Abhängig vom System einen Nova-Druckdom (DIS103) anstelle einer 
Druckkartusche (DIS125) verwenden.

Für ein flüssigkeitsgefülltes System mit druckkonstanter Pumpe: 

• Spritze, von der Einrichtung bereitzustellen

• EMG-Einheit und Oberflächenelektroden [CAB155, CAB154 oder CAB153 (EMG-
Kabel) mit ELE200 oder ELE428 oder ELE370 und ELE365 (EMG-Elektroden)]

• UPP Silent Drive mechanischer Puller (UPP1001)

• Desktop-Drucker mit USB-Druckerkabel

• USB Serial Converter (nur Direktkabeloption)

• RS-232 Nullmodemkabel (nur Direktkabeloption)
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• 1 l destilliertes Wasser, von der Einrichtung bereitzustellen

• 3-Wege-Absperrhahn (DIS431)

• Druckkartusche (DIS125 oder DIS103)

• Luer-Lock-Stecker (DIS104)

• Messschlauch (TUB101 oder TUB102)

• ARM wasserperfundierte 4- oder 8-Kanal-Katheter mit Ballon CAT006 

• (4 Drucksensoren) CAT008 (8 Drucksensoren)

• Pumpe, 8-Kanal-Kapazität (PUM010)

• Desktop- oder Laptop-Computer

• Ausrüstung mit eingebauter Pumpe

• Vier oder acht Druckwandler/Kabel

• Starter-Set (Nova-Druckdom, Absperrhähne, Schläuche, Pumpenschlauch,
Katheter, Becher usw.; variiert je nach Systemkonfiguration) 

Wenden Sie sich für die Bestellung von Ersatzzubehör an Ihren LABORIE-Vertreter. 

TRANSDUCER-EINRICHTUNG UND -ANSCHLUSS 

Einrichtung des flüssigkeitsgefüllten Druckwandlers mit Schwerkraftsystem 

Die Geräteeinrichtung des Schwerkraftsystems besteht aus drei Teilen. Es ist erforderlich, die Infusionsbeutel, die Druckwandler und den Katheter 
einzurichten, um ein vollständiges Schwerkraftzufuhrsystem zu erhalten. 

Die Infusionsbeutel 

1. Vier (bei Messung von 4 Drücken) oder 8 (bei Messung von 8 Drücken*) mit Kochsalzlösung oder sterilem Wasser gefüllte Infusionsbeutel mit Manschette
oben am Infusionsständer befestigen.

2. Eine Infusionsleitung an jedem Kochsalzlösungsbeutel anbringen.

Die Rollenklemmen beim Punktieren der Beutel geschlossen lassen.

3. Jede Druckmanschette auf ein Minimum von 300 mmHg aufpumpen.
4. Jede Infusionsleitung entlüften.
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Abbildung 26: IV-Beuteleinrichtung für 4 Drücke 

• Es wird empfohlen, die PUM010-Pumpe zu verwenden, wenn Sie ein System mit acht Drucksensoren einsetzen.

Einrichtung des Druckwandlers mit Druckwandlerkartuschen

Siehe Seite 36.

Einrichtung des flüssigkeitsgefüllten Katheters mit Schwerkraftsystem

1. Jeden Katheteranschluss mit dem entsprechenden Druckmessschlauch verbinden. P1 zum Beispiel mit dem vom P1-Druckwandler kommenden
Messschlauch verbinden.

2. Den Tropf jeder Infusionsleitung auf 1 Tropfen alle 2-3 Sekunden einstellen, um die Leitung gespült zu halten, und die Katheterspitze auf einer Höhe mit der
Druckwandlerplatte halten.

3. Auf Set Zeroes klicken.
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Abbildung 27: Diagramm für flüssigkeitsgefüllte Katheter Ansicht vom distalen (äußersten) Ende; 
P1 ist in einer Höhe mit der blauen Linie. 

EMG-Einrichtung 

Siehe Seite 37. 

Einrichtung des Pumpenschlauchs (optional) 

Siehe Seite 37. 
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DURCHFÜHRUNG DER ARM MIT ELEKTRONISCHEN KATHETERN 

Standardausrüstung Optionales Zubehör 

• ARM radiale 4- oder 8-Kanal-Katheter mit Ballon [CAT928
(4 Drucksensoren) CAT916 (8 Drucksensoren)]

• Rektalballon (CAT752)

• Spritze, von der Einrichtung bereitzustellen 

• Chirurgisches Nahtmaterial, um den Ballon zu befestigen (von der
Einrichtung bereitzustellen)

• Desktop- oder Laptop-Computer

• Ausrüstung mit eingebauter Pumpe

• Vier oder acht Druckwandler/Kabel

• Starter-Set, Pumpenschlauch, Katheter, Becher usw. (unterschiedlich 
gemäß Systemeinrichtung)

•

• EMG-Einheit und Oberflächenelektroden [CAB155, CAB154 oder CAB153 (EMG-
Kabel) mit ELE200 oder ELE428 oder ELE370 und ELE365 (EMG-Elektroden)] 

• UPP Silent Drive mechanischer Puller (UPP1001)

• Desktop-Drucker mit USB-Druckerkabel

• USB Serial Converter (nur Direktkabeloption)

• RS-232 Nullmodemkabel (nur Direktkabeloption)

•

EINRICHTUNG DES KATHETERS 

1. Die Kabel mit den elektronischen Kathetern mittels Lemo-Kabeln verbinden; das S1-Kabel an P1, das S2-Kabel an P2, das S3-Kabel and P3 und so weiter
anschließen, bis alle Verbindungen hergestellt sind.

Abbildung 28: Ansicht vom distalen Ende. P1 ist in einer Höhe mit der Nummerierung auf dem Katheter. 

2. Den elektronischen Katheter in eine flache Wasserschale platzieren, dabei darauf achten, das elektronische Gehäuse des Katheters nicht einzutauchen.

3. Den Katheter mindestens 5 Minuten im Wasser lassen, da sich die elektronischen Sensoren vor der Verwendung stabilisieren müssen.

4. Die Sensoren nur unmittelbar unter der Wasseroberfläche halten.

[DE]



LABORIE AQUARIUS XT/CT/LT/CTS Benutzerhandbuch AQS-UM01  297 

5. Auf Set Zeroes klicken.

6. Die Katheter in der Wasserschale lassen, bis sie platzierbereit sein.

EMG-Einrichtung

Siehe Seite 37.

Einrichtung des Pumpenschlauchs (optional)

Siehe Seite 37.

DURCHFÜHRUNG VON UNTERSUCHUNGEN MIT DEM ARM-SYSTEM

Wichtige Hinweise zu den Untersuchungsverfahren 

• Vor dem Einführen des Katheters muss die Rektumampulle frei von jeglichen Fäkalrückständen sein. Einige Ärzte empfehlen, dass Patienten mit
Verstopfung ein Klistier verwenden sollten, bevor sie zur Untersuchung kommen.

• Den Patienten in die Linksseitenposition bringen, wobei Knie und Hüften gebeugt oder so gut wie möglich im 90-Grad-Winkel gelagert sind. Vor allem
muss der Patient bequem liegen und bereit und in der Lage sein, zu kooperieren.

• Nur radiale Katheter mit 4 oder 8 Kanälen sind für die Verwendung mit der ARM-Software zugelassen. Wenn Sie lineare Katheter verwenden, müssen
Anpassungen der Software vorgenommen werden. Wenden Sie sich für weitere Informationen an Ihren LABORIE-Vertreter.
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Häufig verwendete Untersuchungskonfigurationen 

Name der 
Untersuchung 

Channel Title Skala Math-Definition Datenrate Anzeige 
Attribut 

ARM4 P1 (oder posterior) 
P2 (oder rechts) 
P3 (oder anterior) 
P4 (oder links) 
Math1 (Durchschnitt) 

150 mmHg 
150 mmHg 
150 mmHg 
150 mmHg 
150 mmHg 

Null 
Null 
Null 
Null 
(P1+P2+P3+P4)/4    oder 
(Posterior+Rechts+Anterior+Links)/4 

10 Punkte/s 
10 Punkte/s 
10 Punkte/s 
10 Punkte/s 
10 Punkte/s 

Kurve 
Kurve 
Kurve 
Kurve 
Kurve 

ARM8 P1 (oder posterior) 
P2 (oder rechts posterior) 
P3 (oder rechts) 
P4 (oder rechts anterior) 
P5 (oder anterior) 
P6 (oder links anterior) 
P7 (oder links) 
P8 (oder links posterior) 
Math1 

150 mmHg 
150 mmHg 
150 mmHg 
150 mmHg 
150 mmHg 
150 mmHg 
150 mmHg 
150 mmHg 
150 mmHg 

Null 
Null 
Null 
Null 
Null 
Null 
Null 
Null 
(P1+P2+P3+P4+P5+P6+P7+P8)/8 usw. 

10 Punkte/s 
10 Punkte/s 
10 Punkte/s 
10 Punkte/s 
10 Punkte/s 
10 Punkte/s 
10 Punkte/s 
10 Punkte/s 
10 Punkte/s 

Kurve 
Kurve 
Kurve 
Kurve 
Kurve 
Kurve 
Kurve 
Kurve 
Kurve 

ARM4 mit EMG ARM4 Konfiguration plus: 
EMG 

-300 µV bis
+300 µV

Null 100 Punkte/s Kurve, gespiegelt und 
gefüllt 

ARM8 mit EMG ARM8 Konfiguration plus: 
EMG 

-300 µV bis
+300 µV

Null 100 Punkte/s Kurve, gespiegelt und 
gefüllt 

ARM4 mit 
integrierter 
LABORIE-Pumpe 

ARM4 Konfiguration plus: 
IH2O 
VH2O 150 ml/min 

600 ml 
Null 
Null 

10 Punkte/s 
10 Punkte/s 

Digital 
Digital 

ARM8 mit 
integrierter Pumpe 

ARM8 Konfiguration plus: 
IH2O 
VH2O 150 ml/min 

600 ml 
Null 
Null 

10 Punkte/s 
10 Punkte/s 

Digital 
Digital 
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DURCHFÜHRUNG VON ARM-UNTERSUCHUNGEN MIT EINEM RADIALEN KATHETER 

Mit der ARM-Software von LABORIE können acht unterschiedliche Untersuchungen durchgeführt werden: 

i) Resting Profile (Ruheprofil)

ii) Squeezing Profile (Squeezingprofil)

iii) Pushing Profile (optional) (Pushingprofil)

iv) Stationary Rest und Stationary Squeeze (Stationär Ruhe und stationär Squeeze/Kneifen)

v) Stationary Rest, Stationary Squeeze und Stationary Push (Stationär Ruhe, stationär Squeeze/Kneifen und stationär Push/ Drücken)

vi) RAIR (rektoanaler Inhibitionsreflex)

vii) Rectal Volume/Rectal Sensation (Rektalvolumen/Rektalempfindung)

viii) Expulsion

STARTEN DER ARM-SOFTWARE 

Die Schaltflächen und Befehle der ARM-Software sind in der UDS-Software vorgeladen. 
Zugriff auf die ARM-Befehle in der UDS-Software: 

1. Auf Options > Control Panel Settings klicken.
Ergebnis: Das „Command“-Fenster wird angezeigt

2. Auf die Liste Control Panel Set Name klicken und ARM 4&8 auswählen.

3. Auf OK klicken.
Ergebnis: Auf dem Bedienfeld werden die mit den ARM-Untersuchungen verbundenen Schaltflächen angezeigt.
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Das Bedienfeld Ihrer Software kann möglicherweise anders aussehen, als die hier gezeigten Beispiele (wie Farben, Schaltflächengröße usw.). Um das 
Aussehen der Schaltflächen zu ändern, auf die Schaltfläche Button Color im Command-Fenster klicken und die Auswahl für die jeweilige Anzeige treffen. 

4. Auf die Schaltfläche ARM klicken, um die Untersuchungskonfiguration anzuzeigen.

RESTING PROFILE (RUHEPROFIL)

1. Vorsichtig einen gut gleitfähig gemachten Katheter 6 cm über die Anokutanlinie hinaus einführen, mit Kanal 1 (S1) in der geeigneten und bevorzugten
Dorsalposition. Hierfür die Markierung auf dem Katheter als Richtlinie benutzen.

2. Wenn eine mechanische Zugvorrichtung (Puller) verwendet wird, das distale (äußerste) Ende des Katheters mithilfe der Puller-Führungen an der
Zugmechanik befestigen.

Das Ruheprofil kann ohne die Verwendung eines Pullers durchgeführt werden. In diesem Fall muss der Katheter manuell in einer Geschwindigkeit von 
etwa 1 mm/s zurückgezogen werden, um sicherzustellen, dass die Drücke korrekt mit der Katheterposition korrelieren. 

3. Lassen Sie den Patienten mehrere Minuten mit eingeführtem Katheter und für die Untersuchung positioniert ausruhen. Der Ruhedruck ist der
Ausgangswert, mit dem alle Drücke während der ARM-Untersuchung verglichen werden. Es ist unbedingt erforderlich, dass der Patient sich während der
Untersuchung entspannen kann, sodass die tatsächlichen Ruhedrücke aufgezeichnet werden können. Der Patient sollte so viel Zeit erhalten, wie nötig
ist.

Der Patient muss während der Untersuchung so entspannt wie möglich sein und sollte sich während des Rückzugs des Katheters nicht bewegen, nicht 
sprechen und nicht husten. 

4. Resting auf dem Bedienfeld klicken, um den Beginn des Ruheprofils zu markieren.
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5. Auf dem Bedienfeld auf Pull klicken. Der Puller beginnt, den Katheter langsam in einer eingestellten Rate von 1 mm/s zurückzuziehen.

Hinweis für den Arzt: Es ist nicht erforderlich, dass Sie die Bedienelemente für den Puller verwenden, wenn Sie den Katheter manuell zurückziehen. 
Wenn Sie den Katheter manuell zurückziehen, sollte dies sehr langsam geschehen; es sollte etwa 60 Sekunden dauern, um von 6 cm auf 0 cm zu gelangen 
(oder bis zu dem Punkt, an dem Sie die Sensoren sehen können). Entfernen Sie den Katheter nicht vollständig aus dem Körper. 

6. Auf die Schaltfläche Stop Pull klicken, wenn die Sensoren die Anokutanlinie passiert haben.
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7. Erneut auf Resting auf dem Bedienfeld klicken, um das Ende des Ruheprofils zu markieren.

Die Ruheprofil-Untersuchung sollte mindestens zweimal durchgeführt werden, um ein Druckmuster zu bestätigen. 

8. Um ein zweites Ruheprofil zu erstellen, den Katheter aus den Puller-Führungen herausnehmen und ihn erneut manuell in die ursprüngliche Startposition 6 cm
über die Anokutanlinie hinaus einführen. Auf Return auf dem Bedienfeld klicken, um den Puller für das nächste Profil einzurichten.

Der Puller DARF NICHT für das Wiedereinführen des Katheters verwendet werden, da dies zu einer Verletzung des Patienten führen kann. Die RETURN-
Schaltfläche auf dem Bedienfeld nur verwenden, um die Puller-Führung wieder nahe an der Spitze der Zugmechanik zu positionieren. 
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9. Das distale (äußerste) Ende des Katheters mithilfe der Puller-Führungen an der
Zugmechanik befestigen und die vorstehenden Schritte wiederholen, um ein
zweites Ruheprofil zu erstellen.

10. Belassen Sie den Katheter an Ort und Stelle, wenn Sie mit dem Squee-
zingprofil fortfahren.
ODER
Ziehen Sie den Katheter vorsichtig heraus, wenn Sie die Untersuchung
beendet haben.

Abbildung 29: Beispieldaten eines Ruheprofils 

SQUEEZING PROFILE (SQUEEZINGPROFIL) 

1. Vorsichtig einen gut gleitfähig gemachten Katheter 6 cm über die Anokutanlinie hinaus einführen, mit Kanal 1 (S1) in der geeigneten und bevorzugten
Dorsalposition. Hierfür die Markierung auf dem Katheter als Richtlinie benutzen.

2. Das distale (äußerste) Ende des Katheters mithilfe der Puller-Führungen an der Zugmechanik befestigen.

Hinweis für den Arzt: Wenn Sie den Katheter manuell zurückziehen, sollte dies sehr langsam geschehen; es sollte etwa 60 Sekunden dauern, um von 
6 cm auf 0 cm (1 mm/s) zu gelangen (oder bis zu dem Punkt, an dem Sie die Sensoren sehen können). Entfernen Sie den Katheter nicht vollständig aus 
dem Körper. 

3. Fordern Sie den Patienten während des gesamten Katheterrückzugs zur Kontraktion auf (Kneifdruck).

4. Squeezing auf dem Bedienfeld klicken, um den Beginn des Squeezingprofils zu markieren.

5. Pull auf dem Bedienfeld klicken, um mit dem Zurückziehen des Katheters zu beginnen.

Es ist nicht erforderlich, dass Sie die Bedienelemente für den Puller verwenden, wenn Sie den Katheter manuell zurückziehen. 
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6. Auf die Schaltfläche Stop Pull klicken, wenn die Sensoren die Anokutanlinie passiert haben.

7. Squeezing auf dem Bedienfeld klicken, um das Ende des Squeezingprofils zu markieren.

Die Squeezingprofil-Untersuchung sollte mindestens zweimal durchgeführt werden, um ein Druckmuster zu bestätigen. 
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8. Um ein zweites Squeezingprofil zu erstellen, den Katheter aus den Puller-Führungen herausnehmen und ihn
erneut manuell in die ursprüngliche Startposition 6 cm über die Anokutanlinie hinaus einführen.

Der Puller DARF NICHT für das Wiedereinführen des Katheters verwendet werden, da dies zu 
einer Verletzung des Patienten führen kann. Die RETURN-Schaltfläche auf dem Bedienfeld nur 
verwenden, um die Puller-Führung wieder nahe an der Spitze der Zugmechanik zu positionieren. 

9. Das distale (äußerste) Ende des Katheters mithilfe der Puller-Führungen an der Zugmechanik befestigen und die
vorstehenden Schritte wiederholen, um ein zweites Profil zu erstellen.

10. Belassen Sie den Katheter an Ort und Stelle, wenn Sie mit der Stationary Rest- und Squeeze-Untersuchung
fortfahren.

- ODER -

Ziehen Sie den Katheter vorsichtig heraus, wenn Sie die Untersuchung beenden.

Abbildung 30: Beispieldaten eines 
Squeezingprofils 

PUSHING PROFILE 

1. Vorsichtig einen gut gleitfähig gemachten Katheter 6 cm über die Anokutanlinie hinaus einführen, mit Kanal 1 (S1) in der geeigneten und bevorzugten
Dorsalposition. Hierfür die Markierung auf dem Katheter als Richtlinie benutzen. Detaillierte Diagramme finden Sie in der Kathetereinrichtung auf Seite
290.

2. Wenn eine mechanische Zugvorrichtung (Puller) verwendet wird, das distale Ende des Katheters mithilfe der Puller-Führungen an der Zugmechanik
befestigen.

Das Pushingprofil kann ohne die Verwendung eines Pullers durchgeführt werden. In diesem Fall muss der Katheter manuell in einer Geschwindigkeit von 
etwa 1 mm/s zurückgezogen werden, um sicherzustellen, dass die Drücke korrekt mit der Katheterposition korrelieren. 

3. Fordern Sie den Patienten während des gesamten Katheterrückzugs zum Pressen auf.
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4. Pushing auf dem Bedienfeld klicken, um den Beginn des Pushingprofils zu markieren.

5. Auf dem Bedienfeld auf Pull klicken. Der Puller beginnt, den Katheter langsam in einer eingestellten Rate von 1 mm/s zurückzuziehen.

Hinweis für den Arzt: Es ist nicht erforderlich, dass Sie die Bedienelemente für den Puller verwenden, wenn Sie den Katheter manuell zurückziehen. 
Wenn Sie den Katheter manuell zurückziehen, sollte dies sehr langsam geschehen; es sollte etwa 60 Sekunden dauern, um von 6 cm auf 0 cm zu 
gelangen (oder bis zu dem Punkt, an dem Sie die Sensoren sehen können). Entfernen Sie den Katheter nicht vollständig aus dem Körper. 

6. Auf die Schaltfläche Stop Pull klicken, wenn die Sensoren die Anokutanlinie passiert haben.

7. Erneut auf Pushing auf dem Bedienfeld klicken, um das Ende des Pushingprofils zu markieren.
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Die Pushingprofil-Untersuchung sollte mindestens zweimal durchgeführt werden, um ein Druckmuster zu bestätigen. 

8. Um ein zweites Pushingprofil zu erstellen, den Katheter aus den Puller-Führungen herausnehmen und ihn erneut manuell in die ursprüngliche
Startposition 6 cm über die Anokutanlinie hinaus einführen. Auf Return auf dem Bedienfeld klicken, um den Puller für das nächste Profil einzurichten.

DER PULLER DARF NICHT FÜR DAS WIEDEREINFÜHREN DES KATHETERS VERWENDET WERDEN. Dies kann zu einer Verletzung des Patienten führen. 
Die RETURN-Schaltfläche auf dem Bedienfeld nur verwenden, um die Puller-Führung wieder nahe an der Spitze der Zugmechanik zu positionieren. 

9. Das distale (äußerste) Ende des Katheters mithilfe der Puller-Führungen an der Zugmechanik befestigen und die vorstehenden Schritte wiederholen,
um ein zweites Pushingprofil zu erstellen.

10. Belassen Sie den Katheter an Ort und Stelle, wenn Sie mit der Stationary Rest- und Squeeze-Untersuchung fortfahren.
-ODER- 

Ziehen Sie den Katheter vorsichtig heraus, wenn Sie die Untersuchung beendet haben. 

STATIONARY REST AND SQUEEZE UNTERSUCHUNG 

Die stationäre Ruhedruck- und Kneifdruck-Untersuchung wird meist zusammen durchgeführt, sie können jedoch auch als separate Untersuchungen 
erfolgen. 
Vorsichtig einen gut gleitfähig gemachten Katheter 6 cm über die Anokutanlinie hinaus einführen, mit Kanal 1 (S1) in der geeigneten und bevorzugten 
Dorsalposition. Hierfür die Markierung auf dem Katheter als Richtlinie benutzen. Detaillierte Diagramme finden Sie im Abschnitt der 
Kathetereinrichtung. 
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Wenn Sie mit der „Stationary Rest and Squeeze“ Untersuchung 6 cm hinter der Anokutanlinie beginnen möchten, befolgen Sie die folgenden Schritte, bevor 
die Untersuchung beginnt: 

i. Aus der Menüleiste auf Options und Control Panel Definition auswählen.
Ergebnis: Das Feld Command erscheint und zeigt die erste Reihe der Schaltflächen des Bedienfelds an.

ii. Mit dem Abwärtspfeil neben Current Row klicken und zu einer Reihe blättern, die leere Schaltflächen aufweist. Sie können bei Bedarf eine vollkommen
neue Reihe von Schaltflächen hinzufügen, indem Sie die Anzahl im Feld neben Number of Rows ändern.

iii. In die Spalte Label 6 cm Rest eingeben.

iv. In die Spalte Definition SR6 eingeben.

v. Mit dem Abwärtspfeil auf die dritte Spalte klicken und ARM auswählen.

vi. Suchen Sie ggf. nach einer weiteren freien Schaltfläche.

vii. In die Spalte Label 6 cm Squeeze eingeben.

viii. In die Spalte Definition ST6 eingeben.

ix. Mit dem Abwärtspfeil auf die dritte Spalte klicken und ARM auswählen.

x. Das Properties-Fenster durch Klicken auf die PLUS (+) Schaltfläche neben der entsprechenden Schaltfläche des ARM-Bedienfelds öffnen.

xi. Automatically insert STOP event after auswählen und einen Wert in Sekunden eingeben. Der Standardwert ist 10 Sekunden.

xii. Um eine Schattierung zwischen Start- und Stopp-Ereignissen einzufügen, auf show region for the ARM event und dann in das Feld Select Color klicken, um die
Farbe auszuwählen.
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xiii. Auf OK klicken, um die Auswahl zu bestätigen.

xiv. Auf OK klicken.
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Ergebnis: Die zwei neuen Schaltflächen, die Sie gerade programmiert haben, erscheinen im Bedienfeld. 

1. Lassen Sie den Patienten mehrere Minuten mit eingeführtem Katheter und für die Untersuchung positioniert ausruhen, um die Ruhedrücke zu messen.

2. Bitten Sie den Patienten, sich zu entspannen, und klicken Sie auf die Schaltfläche 5 cm Rest um den Beginn der 5 cm Ruheperiode zu markieren. (Wenn Sie die
Untersuchung mit 6 cm hinter der Anokutanlinie beginnen, klicken Sie stattdessen auf die Schaltfläche 6 cm Rest).
Ergebnis: Die Schaltfläche beginnt zu blinken und ein schattierter Bereich verläuft über der Grafik. Nach 10 Sekunden markiert die Software automatisch
das Ende der Ruheperiode. Die Schaltfläche blinkt nicht mehr und die Schattierung verschwindet.

3. Fordern Sie den Patienten auf, 10 Sekunden lang so starken Kneifdruck (Squeeze) wie möglich auszuüben. Bei Beginn des Kneifens auf die Schaltfläche 5 
cm Squeeze klicken (oder auf 6 cm Squeeze, wenn 6 cm hinter der Anokutanlinie begonnen wurde). Fordern Sie den Patienten auf, den Kneifdruck so lange
aufrechtzuerhalten, bis die Schattierung auf der Grafik erscheint.

Ergebnis: Nach 10 Sekunden markiert die Software automatisch das Ende der Squeeze-Periode. Die Schaltfläche blinkt nicht mehr und die Schattierung 
verschwindet. Der Patient sollte jetzt mit dem Kneifen aufhören. 

4. Auf dem Bedienfeld auf die Schaltfläche Pull 1 cm klicken, um den Katheter 1 cm zurückzuziehen.
-ODER- 

Den Katheter manuell 1 cm herausziehen.  
Ergebnis: Die Katheterspitze sollte sich jetzt 4 cm (oder 5 cm) von der Anokutanlinie entfernt befinden. 
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Fahren Sie mit der Untersuchung fort, indem Sie die Schritte in den 1 cm Abständen befolgen, wie im Bedienfeld programmiert. Wenn Sie 6 cm hinter der 
Anokutanlinie beginnen, fahren Sie fort, indem Sie den Katheter in die Positionen 5 cm, 4 cm, 3 cm, 2 cm und 1 cm bewegen. Die verbleibenden Schritte in 
diesem Abschnitt beschreiben die Vorgehensweise, wenn die Untersuchung 5 cm hinter der Anokutanlinie beginnen. 

5. Lassen Sie den Patienten mindestens 30 Sekunden lang ausruhen.

6. Bitten Sie den Patienten, sich zu entspannen, und klicken Sie auf die Schaltfläche 4 cm Rest um den Beginn der 4 cm Ruheperiode zu markieren. Die
Schaltfläche beginnt zu blinken und ein schattierter Bereich verläuft über der Grafik.
Ergebnis: Nach 10 Sekunden markiert die Software automatisch das Ende der Ruheperiode. Die Schaltfläche blinkt nicht mehr und die Schattierung
verschwindet.

7. Fordern Sie den Patienten auf, 10 Sekunden lang so starken Kneifdruck (Squeeze) wie möglich auszuüben. Bei Beginn des Kneifdrucks auf die
Schaltfläche 4 cm Squeeze klicken. Fordern Sie den Patienten auf, den Kneifdruck so lange aufrechtzuerhalten, wie die Schattierung auf der Grafik
erscheint.
Ergebnis: Nach 10 Sekunden markiert die Software automatisch das Ende der Squeeze-Periode. Die Schaltfläche blinkt nicht mehr und die Schattierung
verschwindet. Der Patient sollte jetzt mit dem Kneifen aufhören.

8. Auf dem Bedienfeld auf die Schaltfläche Pull 1 cm klicken, um den Katheter 1 cm zurückzuziehen.
- ODER -

Den Katheter manuell 1 cm herausziehen.  
Ergebnis: Die Katheterspitze sollte sich jetzt 3 cm von der Anokutanlinie entfernt befinden. 
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9. Bitten Sie den Patienten, sich zu entspannen, und klicken Sie auf die Schaltfläche 3 cm Rest um den Beginn der 3 cm Ruheperiode zu markieren. Ergebnis: Die
Schaltfläche beginnt zu blinken und ein schattierter Bereich verläuft über der Grafik. Nach 10 Sekunden markiert die Software automatisch das Ende der
Ruheperiode. Die Schaltfläche blinkt nicht mehr und die Schattierung verschwindet.

10. Fordern Sie den Patienten auf, 10 Sekunden lang so starken Kneifdruck (Squeeze) wie möglich auszuüben. Bei Beginn des Kneifdrucks auf die
Schaltfläche 3 cm Squeeze klicken. Fordern Sie den Patienten auf, den Kneifdruck so lange aufrechtzuerhalten, wie die Schattierung auf der Grafik
erscheint.
Ergebnis: Nach 10 Sekunden markiert die Software automatisch das Ende der Ruheperiode. Die Schaltfläche blinkt nicht mehr und die Schattierung
verschwindet.

11. Auf dem Bedienfeld auf die Schaltfläche „Pull 1 cm“ klicken, um den Katheter 1 cm zurückzuziehen.

ODER

Den Katheter manuell 1 cm herausziehen.

Ergebnis: Die Katheterspitze sollte sich jetzt 2 cm von der Anokutanlinie entfernt befinden.

12. Bitten Sie den Patienten, sich zu entspannen, und klicken Sie auf die Schaltfläche 2 cm Rest um den Beginn der 2 cm Ruheperiode zu markieren.
Ergebnis: Die Schaltfläche beginnt zu blinken und ein schattierter Bereich verläuft über der Grafik. Nach 10 Sekunden markiert die Software automatisch
das Ende der Ruheperiode. Die Schaltfläche blinkt nicht mehr und die Schattierung verschwindet.

13. Fordern Sie den Patienten auf, 10 Sekunden lang so starken Kneifdruck (Squeeze) wie möglich auszuüben. Bei Beginn des Kneifdrucks auf die
Schaltfläche 2 cm Squeeze klicken. Fordern Sie den Patienten auf, den Kneifdruck so lange aufrechtzuerhalten, wie die Schattierung auf der Grafik
erscheint. Nach 10 Sekunden markiert die Software automatisch das Ende der Ruheperiode. Die Schaltfläche blinkt nicht mehr und die Schattierung
verschwindet.

14. Auf dem Bedienfeld auf die Schaltfläche Pull 1 cm klicken, und der Puller zieht den Katheter 1 cm zurück.
ODER

Den Katheter manuell 1 cm herausziehen.
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Ergebnis: Die Katheterspitze sollte sich jetzt 1 cm von der Anokutanlinie entfernt befinden. 

15. Bitten Sie den Patienten, sich zu entspannen, und klicken Sie auf die Schaltfläche 1 cm Rest um den Beginn der 1 cm Ruheperiode zu markieren. Die
Schaltfläche beginnt zu blinken und ein schattierter Bereich verläuft über der Grafik. Nach 10 Sekunden markiert die Software automatisch das Ende der
Ruheperiode. Die Schaltfläche blinkt nicht mehr und die Schattierung verschwindet.

16. Fordern Sie den Patienten auf, 10 Sekunden lang so starken Kneifdruck (Squeeze) wie möglich auszuüben. Bei Beginn des Kneifdrucks auf die Schaltfläche
1 cm Squeeze klicken. Fordern Sie den Patienten auf, den Kneifdruck so lange aufrechtzuerhalten, wie die Schattierung auf der Grafik erscheint. Nach 10
Sekunden markiert die Software automatisch das Ende der Ruheperiode. Die Schaltfläche blinkt nicht mehr und die Schattierung verschwindet. Der
Patient sollte jetzt mit dem Kneifen aufhören.

17. Belassen Sie den Katheter an Ort und Stelle, wenn Sie mit einer anderen Untersuchung fortfahren (wie RAIR oder Rektalvolumen). Die Katheterposition
hängt von der Untersuchung ab, die als nächstes durchgeführt wird.

- ODER -

Ziehen Sie den Katheter vorsichtig heraus, wenn Sie die Untersuchung beendet haben.
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Abbildung 31: Beispieldaten einer „Stationary Rest and Squeeze“ Untersuchung. In diesem Beispiel wird nur der Druck beginnend bei 4 cm 
von der Anokutanlinie anstatt von 5 cm Entfernung gemessen. Durch die alternierenden Farben werden die Bereiche von Rest und 

Squeeze hervorgehoben. 

STATIONARY REST, SQUEEZE, PUSH UNTERSUCHUNG 

Vorsichtig einen gut gleitfähig gemachten Katheter 6 cm hinter der Anokutanlinie einführen, mit Kanal 1 (S1) in der geeigneten und bevorzugten 
Dorsalposition. Hierfür die Markierung auf dem Katheter als Richtlinie benutzen. Detaillierte Diagramme finden Sie im Abschnitt der Kathe-
tereinrichtung. 

Wenn Sie mit der „Stationary Rest and Squeeze“ Untersuchung 6 cm hinter der Anokutanlinie beginnen möchten, befolgen Sie die folgenden Schritte, bevor 
die Untersuchung beginnt: 

i. Aus der Menüleiste auf Options und Control Panel Definition auswählen.
Ergebnis: Das Feld Command erscheint und zeigt die erste Reihe der Schaltflächen des Bedienfelds an.
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ii. Mit dem Abwärtspfeil neben Current Row klicken und zu einer Reihe blättern, die leere Schaltflächen aufweist. Sie können bei Bedarf eine
vollkommen neue Reihe von Schaltflächen hinzufügen, indem Sie die Anzahl im Feld neben Number of Rows ändern.

iii. In die Spalte Label 6 cm Rest eingeben.

iv. In die Spalte Definition SR6 eingeben.

v. Mit dem Abwärtspfeil auf die dritte Spalte klicken und ARM auswählen.

vi. Suchen Sie nach einer weiteren freien Schaltfläche.

vii. In die Spalte Label 6 cm Squeeze eingeben.

viii. In die Spalte Definition ST6 eingeben.

ix. Mit dem Abwärtspfeil auf die dritte Spalte klicken und ARM auswählen.

x. Suchen Sie nach einer weiteren freien Schaltfläche.

xi. In die Spalte Label 6 cm Push eingeben.

xii. In die Spalte Definition ST6 eingeben.

xiii. Mit dem Abwärtspfeil auf die dritte Spalte klicken und ARM auswählen.

xiv. Das Properties-Fenster durch Klicken auf die PLUS (+) Schaltfläche neben der entsprechenden Schaltfläche des ARM-Bedienfelds öffnen.

xv. Automatically insert STOP event after auswählen und einen Wert in Sekunden eingeben. Der Standardwert ist 10 Sekunden.

xvi. Um eine Schattierung zwischen Start- und Stopp-Ereignissen einzufügen, auf show region for the ARM event und dann in das Feld Select Color
klicken, um die Farbe auszuwählen.
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xvii. Auf OK klicken, um die Auswahl zu bestätigen.

i. Auf OK klicken.
Ergebnis: Die zwei neuen Schaltflächen, die Sie gerade programmiert haben, erscheinen im Bedienfeld.

1. Lassen Sie den Patienten mehrere Minuten mit eingeführtem Katheter und für die Untersuchung positioniert ausruhen, um die Ruhedrücke zu messen.

2. Bitten Sie den Patienten, sich zu entspannen, und klicken Sie auf die Schaltfläche 5 cm Rest um den Beginn der 5 cm Ruheperiode zu markieren. (Wenn Sie die
Untersuchung mit 6 cm hinter der Anokutanlinie beginnen, klicken Sie stattdessen auf die Schaltfläche 6 cm Rest).
Ergebnis: Die Schaltfläche beginnt zu blinken und ein schattierter Bereich verläuft über der Grafik. Nach 10 Sekunden markiert die Software automatisch
das Ende der Ruheperiode. Die Schaltfläche blinkt nicht mehr und die Schattierung verschwindet.
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3. Fordern Sie den Patienten auf, 10 Sekunden lang so starken Kneifdruck (Squeeze) wie möglich auszuüben. Bei Beginn des Kneifens auf die Schaltfläche 5 cm
Squeeze klicken (oder auf 6 cm Squeeze, wenn 6 cm hinter der Anokutanlinie begonnen wurde). Fordern Sie den Patienten auf, den Kneifdruck so lange
aufrechtzuerhalten, bis die Schattierung auf der Grafik erscheint.

Ergebnis: Nach 10 Sekunden markiert die Software automatisch das Ende der Squeeze-Periode. Die Schaltfläche blinkt nicht mehr und die Schattierung 
verschwindet. Der Patient sollte jetzt mit dem Kneifen aufhören. 

4. Fordern Sie den Patienten auf zu drücken, um einen Versuch, den Darm zu entleeren, zu imitieren. Bei Beginn des Drückens auf die Schaltfläche 5 cm
Push klicken (oder auf 6 cm Push, wenn 6 cm über die Anokutanlinie hinaus begonnen wird).

Ergebnis: Die Software markiert automatisch das Ende der Push-Periode. Die Schaltfläche blinkt nicht mehr und die Schattierung verschwindet. Der Patient 
sollte jetzt mit dem Drücken aufhören. 

5. Auf dem Bedienfeld auf die Schaltfläche Pull 1 cm klicken, um den Katheter 1 cm zurückzuziehen.
-ODER- 

Den Katheter manuell 1 cm herausziehen.  

Ergebnis: Die Katheterspitze sollte sich jetzt 4 cm (oder 5 cm) von der Anokutanlinie entfernt befinden. 
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Fahren Sie mit der Untersuchung fort, indem Sie die Schritte in den 1 cm Abständen befolgen, wie im Bedienfeld programmiert. Wenn Sie 6 cm hinter der 
Anokutanlinie beginnen, fahren Sie fort, indem Sie den Katheter in die Positionen 5 cm, 4 cm, 3 cm, 2 cm und 1 cm bewegen.  
Die verbleibenden Schritte in diesem Abschnitt beschreiben die Vorgehensweise, wenn die Untersuchung 5 cm hinter der Anokutanlinie beginnen. 

6. Lassen Sie den Patienten mindestens 30 Sekunden lang ausruhen.

7. Bitten Sie den Patienten, sich zu entspannen, und klicken Sie auf die Schaltfläche 4 cm Rest um den Beginn der 4 cm Ruheperiode zu markieren. Die
Schaltfläche beginnt zu blinken und ein schattierter Bereich verläuft über der Grafik.
Ergebnis: Nach 10 Sekunden markiert die Software automatisch das Ende der Ruheperiode. Die Schaltfläche blinkt nicht mehr und die Schattierung
verschwindet.

8. Fordern Sie den Patienten auf, 10 Sekunden lang so starken Kneifdruck (Squeeze) wie möglich auszuüben. Bei Beginn des Kneifdrucks auf die
Schaltfläche 4 cm Squeeze klicken. Fordern Sie den Patienten auf, den Kneifdruck so lange aufrechtzuerhalten, wie die Schattierung auf der Grafik
erscheint.
Ergebnis: Nach 10 Sekunden markiert die Software automatisch das Ende der Squeeze-Periode. Die Schaltfläche blinkt nicht mehr und die Schattierung
verschwindet. Der Patient sollte jetzt mit dem Kneifen aufhören.

9. Fordern Sie den Patienten auf, zu drücken. Bei Beginn des Drückens auf die Schaltfläche 4 cm Push klicken.
Ergebnis: Die Software markiert automatisch das Ende der Push-Periode. Die Schaltfläche blinkt nicht mehr und die Schattierung verschwindet. Der Patient
sollte jetzt mit dem Drücken aufhören.
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10. Auf dem Bedienfeld auf die Schaltfläche Pull 1 cm klicken, um den Katheter 1 cm zurückzuziehen.
- ODER -

Den Katheter manuell 1 cm herausziehen.  
Ergebnis: Die Katheterspitze sollte sich jetzt 3 cm von der Anokutanlinie entfernt befinden. 

11. Bitten Sie den Patienten, sich zu entspannen, und klicken Sie auf die Schaltfläche 3 cm Rest um den Beginn der 3 cm Ruheperiode zu markieren. Ergebnis: Die
Schaltfläche beginnt zu blinken und ein schattierter Bereich verläuft über der Grafik. Nach 10 Sekunden markiert die Software automatisch das Ende der
Ruheperiode. Die Schaltfläche blinkt nicht mehr und die Schattierung verschwindet.

12. Fordern Sie den Patienten auf, 10 Sekunden lang so starken Kneifdruck (Squeeze) wie möglich auszuüben. Bei Beginn des Kneifdrucks auf die
Schaltfläche 3 cm Squeeze klicken. Fordern Sie den Patienten auf, den Kneifdruck so lange aufrechtzuerhalten, wie die Schattierung auf der Grafik
erscheint.
Ergebnis: Nach 10 Sekunden markiert die Software automatisch das Ende der Ruheperiode. Die Schaltfläche blinkt nicht mehr und die Schattierung
verschwindet.

13. Fordern Sie den Patienten auf, zu drücken. Bei Beginn des Drückens auf die Schaltfläche 3 cm Push klicken.
Ergebnis: Die Software markiert automatisch das Ende der Push-Periode. Die Schaltfläche blinkt nicht mehr und die Schattierung verschwindet. Der Patient
sollte jetzt mit dem Drücken aufhören.

14. Auf dem Bedienfeld auf die Schaltfläche Pull 1 cm klicken, um den Katheter 1 cm zurückzuziehen.
- ODER -

Den Katheter manuell 1 cm herausziehen.  

Ergebnis: Die Katheterspitze sollte sich jetzt 2 cm von der Anokutanlinie entfernt befinden. 

15. Bitten Sie den Patienten, sich zu entspannen, und klicken Sie auf die Schaltfläche 2 cm Rest um den Beginn der 2 cm Ruheperiode zu markieren.
Ergebnis: Die Schaltfläche beginnt zu blinken und ein schattierter Bereich verläuft über der Grafik. Nach 10 Sekunden markiert die Software automatisch
das Ende der Ruheperiode. Die Schaltfläche blinkt nicht mehr und die Schattierung verschwindet.

16. Fordern Sie den Patienten auf, 10 Sekunden lang so starken Kneifdruck (Squeeze) wie möglich auszuüben. Bei Beginn des Kneifdrucks auf die
Schaltfläche 2 cm Squeeze klicken. Fordern Sie den Patienten auf, den Kneifdruck so lange aufrechtzuerhalten, wie die Schattierung auf der Grafik
erscheint. Nach 10 Sekunden markiert die Software automatisch das Ende der Ruheperiode. Die Schaltfläche blinkt nicht mehr und die Schattierung
verschwindet.

17. Fordern Sie den Patienten auf, zu drücken. Bei Beginn des Drückens auf die Schaltfläche 2 cm Push klicken.
Ergebnis: Die Software markiert automatisch das Ende der Push-Periode. Die Schaltfläche blinkt nicht mehr und die Schattierung verschwindet. Der Patient
sollte jetzt mit dem Drücken aufhören.

18. Auf dem Bedienfeld auf die Schaltfläche Pull 1 cm klicken, und der Puller zieht den Katheter 1 cm zurück.
ODER 
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Den Katheter manuell 1 cm herausziehen.  
Ergebnis: Die Katheterspitze sollte sich jetzt 1 cm von der Anokutanlinie entfernt befinden. 

19. Bitten Sie den Patienten, sich zu entspannen, und klicken Sie auf die Schaltfläche 1 cm Rest um den Beginn der 1 cm Ruheperiode zu markieren. Die
Schaltfläche beginnt zu blinken und ein schattierter Bereich verläuft über der Grafik. Nach 10 Sekunden markiert die Software automatisch das Ende der
Ruheperiode. Die Schaltfläche blinkt nicht mehr und die Schattierung verschwindet.

20. Fordern Sie den Patienten auf, 10 Sekunden lang so starken Kneifdruck (Squeeze) wie möglich auszuüben. Bei Beginn des Kneifdrucks auf die
Schaltfläche 1 cm Squeeze klicken. Fordern Sie den Patienten auf, den Kneifdruck so lange aufrechtzuerhalten, wie die Schattierung auf der Grafik
erscheint. Nach 10 Sekunden markiert die Software automatisch das Ende der Ruheperiode. Die Schaltfläche blinkt nicht mehr und die Schattierung
verschwindet. Der Patient sollte jetzt mit dem Kneifen aufhören.

21. Fordern Sie den Patienten auf, zu drücken. Bei Beginn des Drückens auf die Schaltfläche 1 cm Push klicken.
Ergebnis: Die Software markiert automatisch das Ende der Push-Periode. Die Schaltfläche blinkt nicht mehr und die Schattierung verschwindet. Der Patient
sollte jetzt mit dem Drücken aufhören.

22. Belassen Sie den Katheter an Ort und Stelle, wenn Sie mit einer anderen Untersuchung fortfahren (wie RAIR oder Rektalvolumen). Die Katheterposition
hängt von der Untersuchung ab, die als nächstes durchgeführt wird.

- ODER -

Ziehen Sie den Katheter vorsichtig heraus, wenn Sie die Untersuchung beendet haben. 
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Abbildung 32: Beispieldaten einer „Stationary Rest, Squeeze and Push“ Untersuchung. 
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RAIR (REKTOANALER INHIBITIONSREFLEX) 

Es gibt zwei verschiedene Techniken zur Durchführung des RAIR mithilfe der Bedienfeldfunktionen der Software. 

TECHNIK NR. 1: 
1. Legen Sie sich eine 60 ml Spritze zurecht, die am Füllanschluss des Katheters angebracht ist.
2. Vorsichtig einen gut gleitfähig gemachten Katheter in den Patienten einführen. Der Katheter sollte bis zu dem Punkt eingeführt werden, wo der

Bereich des höchsten Ruhedrucks [HPZ] zuvor aufgezeichnet wurde, bzw. bis etwa 3 cm. Wenn der HPZ z. B. bei 2 cm aufgezeichnet wurde, den Katheter
bis zum 2-cm-Marker platzieren. 

Der Katheter sollte mit einem an der Spitze angebrachten Ballon versehen sein. Der Ballon muss beim Einführen vollständig leer sein. 

3. Auf 10 cc auf dem Bedienfeld klicken, um den Beginn des Ereignisses zu markieren.

4. 10 ml Luft in den Ballon injizieren und diese 10 ml Luft sofort wieder entleeren. HINWEIS: Die Luft sollte innerhalb von 5 Sekunden nach dem
Injizieren wieder entfernt sein.

5. Wieder auf 10 cc klicken, um den Stopp zu markieren.
Ergebnis: Sie werden durch ein Popup-Fenster aufgefordert anzugeben, ob RAIR vorhanden oder nicht vorhanden ist, wie unten dargestellt. Das
entsprechende Ergebnis eingeben.
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Wenn RAIR nicht vorhanden ist, diese Schritte mit größeren Luftmengeninkrementen wiederholen, z. B. 20 ml, 30 ml und so weiter. 

Abbildung 33: Beispielergebnisse für eine RAIR-Untersuchung 

6. Belassen Sie den Katheter an Ort und Stelle, wenn Sie mit der Rektalvolumen-Untersuchung fortfahren.
- ODER -

Ziehen Sie den Katheter vorsichtig heraus, wenn Sie die Untersuchung beendet haben.
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TECHNIK NR. 2: 

1. Auf RAIR im Bedienfeld klicken.

2. Das Volumen auswählen, mit dem die Untersuchung durchgeführt wird.

3. 10 ml Luft in den Ballon injizieren und diese 10 ml Luft sofort wieder entleeren.

Die Luft sollte innerhalb von 5 Sekunden nach dem Injizieren wieder entfernt sein. 
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4. Wieder auf RAIR klicken, um den Stopp zu markieren.
Ergebnis: Sie werden durch ein Popup-Fenster aufgefordert anzugeben, ob RAIR vorhanden oder nicht vorhanden ist, wie unten dargestellt. Das
entsprechende Ergebnis eingeben.

• Wenn RAIR nicht vorhanden ist, Schritte 3-6 mit größeren Luftmengeninkrementen wiederholen, z. B. 20 ml, 30 ml und so weiter.

Abbildung 34: Beispielergebnisse für eine RAIR-Untersuchung 

5. Belassen Sie den Katheter an Ort und Stelle, wenn Sie mit der Rektalvolumen-Untersuchung fortfahren.
- ODER -
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Ziehen Sie den Katheter vorsichtig heraus, wenn Sie die Untersuchung beendet haben. 

REKTALVOLUMEN MIT FLÜSSIGKEIT UND EINER SPRITZE 

Wenn der Rektalballon manuell mit einer Spritze gefüllt wird, können Sie von der Software aufgefordert werden, die „First Sensation“, „Urge“ und „Max 
Tolerance“ Volumen einzugeben, sobald diese festgestellt werden. 

Anorectal Summary (Anektorale Zusammenfassung) - Volumen 

1. Eine 60-ml-Luer-Lockspritze mit lauwarmem Wasser füllen und am Füllanschluss des Katheters anbringen.

2. Vorsichtig einen gut gleitfähig gemachten Katheter in den Patienten einführen. Der Katheter sollte weit über die Anokutanlinie hinaus eingeführt werden (etwa
6 cm über den Anus hinaus), wo der Bereich des höchsten Drucks zuvor aufgezeichnet wurde. Der Ballon sollte im Inneren des Rektums positioniert
werden.

Der Katheter sollte mit einem an der Spitze angebrachten Ballon versehen sein. Der Ballon muss beim Einführen vollständig leer sein. 

3. Den Rektalballon nach und nach mit Flüssigkeit füllen.

HINWEIS FÜR DEN ARZT: Wenn Sie den Griff am Spritzenkolben lösen, fließt ein wenig von der infundierten Flüssigkeit zurück in die Spritze. Bitte notieren Sie 
sorgfältig das Volumen in der Spritze. 

4. Wenn der Patient das erste Empfinden eines Völlegefühls hat, auf First Sensation auf dem Bedienfeld klicken und nach Aufforderung das infundierte
Volumen eingeben.

5. Mit dem schrittweisen Befüllen des Rektalballons fortfahren.

6. Wenn der Patient einen Stuhldrang verspürt, auf Urge auf dem Bedienfeld klicken und nach Aufforderung das infundierte Volumen eingeben.

7. Mit dem schrittweisen Befüllen des Rektalballons fortfahren.

8. Wenn der Patient sagt, dass er nicht mehr halten kann, die Pumpe stoppen und auf Max Tolerance auf dem Bedienfeld klicken und nach Aufforderung
das infundierte Volumen eingeben.

9. Belassen Sie den Katheter an Ort und Stelle, wenn Sie mit der Expulsionsstudie fortfahren. Wenn Sie mit der Expulsionsstudie fortfahren, den Ballon nicht
entleeren und den Absperrhahn in die OFF-Position drehen.

ODER 
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Die Spritze zurückziehen, um den Ballon zu entleeren und den Katheter vorsichtig herausziehen, wenn Sie mit den Untersuchungen fertig sind. 

Rektalvolumen mit Flüssigkeit und der integrierten LABORIE-Pumpe 

1. Infusionsbeutel mit Wasser in Raumtemperaturwärme befüllen und Pumpenschlauch anbringen. Den Pumpenschlauch mit dem Füllanschluss des
Katheters verbinden.

2. Vorsichtig einen gut gleitfähig gemachten Katheter in den Patienten einführen.

• Der Katheter sollte mit einem an der Spitze angebrachten Ballon versehen sein. Der Ballon muss beim Einführen vollständig leer sein.

• Der Katheter sollte so eingeführt werden, dass der Rektalballon sich im Rektum befindet. Der Katheter sollte weit über die Anokutanlinie hinaus
eingeführt werden (etwa 6 cm über den Anus hinaus), wo der Bereich des höchsten Drucks zuvor aufgezeichnet wurde. Der Ballon wird im Inneren
des Rektums positioniert.

3. Die Pumpe mithilfe der Software-Bedienelemente bedienen.

4. Den Rektalballon nach und nach mit Flüssigkeit füllen.

5. Wenn der Patient das erste Empfinden eines Völlegefühls hat, auf First Sensation auf dem Bedienfeld klicken.

6. Mit dem schrittweisen Befüllen des Rektalballons fortfahren.

7. Wenn der Patient einen Stuhldrang verspürt, auf Urge auf dem Bedienfeld klicken.

8. Mit dem schrittweisen Befüllen des Rektalballons fortfahren.

9. Wenn der Patient sagt, dass er nicht mehr halten kann, die Pumpe stoppen und auf Max Tolerance auf dem Bedienfeld klicken.

10. Belassen Sie den Katheter an Ort und Stelle, wenn Sie mit der Expulsionsstudie fortfahren. Wenn Sie mit der Expulsionsstudie fortfahren, den Ballon
nicht entleeren und den Absperrhahn in die OFF-Position drehen.

11. Die Rückwärtspumpenfunktion verwenden, um Flüssigkeit aus dem Rektalballon zu entfernen, bevor der Katheter entfernt wird.
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Expulsionsstudie 

Hinweis für den Arzt: Sie können dem Patienten erlauben, den Ballon in der linken Seitenlage auszustoßen oder in eine sitzende Position auf 
einem Toilettenstuhl zu wechseln.  

1. Wenn der Ballon noch nicht während der rektalen Empfindungsstudie gefüllt wurde und der Absperrhahn am Katheter geschlossen ist, den Rektalballon
mithilfe einer Spritze auf ein standardisiertes Volumen für den Expulsionstest füllen (50 ml werden empfohlen).

2. Auf Expulsion klicken, um mit der Untersuchung zu beginnen.

3. Vergewissern Sie sich, dass der Patient sich wohl fühlt und fordern Sie ihn auf, den Ballon auszustoßen.

4. Nach etwa 1 Minute auf Expulsion klicken, um die Untersuchung zu beenden.

Wenn der VH2O-Kanal in der Konfigurationsdatei der Untersuchung nicht vorgegeben ist, müssen Volumen und Reaktion in das sich öffnende 
Meldungsfeld eingegeben werden. Wenn der VH2O-Kanal hinzugefügt und in der Konfigurationsdatei der Untersuchung vorgegeben ist, wird das Volumen 
automatisch am angegebenen VH2O-Kanal abgelesen und die Reaktion wird im Meldungsfeld angezeigt. 

5. Das Ergebnis eingeben (ob der Patient den Ballon ausstoßen konnte oder nicht) und welches Volumen verwendet wurde.

6. Wenn der Patient den Ballon nicht ausgestoßen hat, wird empfohlen, etwas Volumen zu entfernen und den Patienten aufzufordern, erneut zu
versuchen, den Ballon auszustoßen.

7. Die Untersuchung ist beendet, wenn der Katheter ausgestoßen wurde. Wenn der Patient nicht in der Lage ist, den Ballon auszustoßen auch wenn das
gesamte Volumen entfernt wird, den Katheter vorsichtig bewegen.

DIE UNTERSUCHUNG IST BEENDET. 
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ARM 4 UND ARM 8 UNTERSUCHUNGSERGEBNISSE 

Nachdem eine Untersuchung durchgeführt wurde, können Sie die Ergebnisse zur Interpretation, Analyse und Ausdruck ansehen. 
Die folgenden Zusammenfassungen stehen für ARM4 und ARM8 zur Verfügung: 

Anorectal Summary • Diese Zusammenfassung fasst alle durchgeführten anorektalen Manometrieuntersuchungen zusammen.  

• Diese Zusammenfassung kann verwendet werden, um Daten vor der Berichterstellung anzuzeigen und auszuwählen. 

ARM Resting Profile • Zusammenfassung der Druckdaten für ein Ruheprofil.  

• Enthält auch eine Zusammenfassung der Pushing-Daten. 

• 3D-Profilerstellung. 

ARM Squeezing Profile • Zusammenfassung der Druckdaten für ein Squeezingprofil. 

• 3D-Profilerstellung. 

ARM Stationary Rest (1) • Zusammenfassung der Druckdaten für jede stationäre Ruheposition (6 cm, 5 cm, 4 cm, 3 cm, 2 cm und 1 cm). 

• Bezieht sich auf das erste Set der stationären Ruhedruckdaten. 

ARM Stationary Rest (2) • Zusammenfassung der Druckdaten für jede stationäre Ruheposition (6 cm, 5 cm, 4 cm, 3 cm, 2 cm und 1 cm).  

• Bezieht sich auf das erste Set der Ruhedruckdaten und ermöglicht dem Anwender, zwei Positionen gleichzeitig 
anzuzeigen. 

ARM Stationary Squeeze (1) • Zusammenfassung der Druckdaten für jede stationäre Squeeze-Position (6 cm, 5 cm, 4 cm, 3 cm, 2 cm und 1 cm).  

• Bezieht sich auf das erste Set der stationären Kneifdruckdaten. 

ARM Stationary Squeeze (2) • Zusammenfassung der Druckdaten für jede stationäre Squeeze-Position (6 cm, 5 cm, 4 cm, 3 cm, 2 cm und 1 cm).  

• Bezieht sich auf das erste Set der Kneifdruckdaten und ermöglicht dem Anwender, zwei Positionen gleichzeitig 
anzuzeigen. 

ARM Push Profile • Zusammenfassung der Druckdaten für ein Pushingprofil. 

• 3D-Profilerstellung. 

ANORECTAL SUMMARY 

1. Auf Info > ARM 4 & 8 klicken.

2. Anorectal Summary auswählen.
Ergebnis: Das Fenster Anorectal Summary öffnet sich.
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Profil 

• Rest / Squeeze Length to Max Pressure (cm): Die Entfernung in Zentimetern von der Position des Untersuchungsbeginns bis zum Erreichen des max.
Drucks.

• Rest / Squeeze Anal Canal Length (cm): Gesamtlänge des Analkanals in Zentimetern (die Gesamtdistanz zwischen Anfang und Ende der
Untersuchung).

• Rest / Squeeze Max Pressure (mmHg): Maximale Ruhe- und Kneifdrücke (Mittel, Mind., Max. usw.) in mmHg.

• Rest / Squeeze HPZ (High Pressure Zone): Sphinkterlänge in Zentimetern, wobei der Druck höher als der (Max Pressure*2/3) des Segments ist.

Den Threshold 
eingeben. Der 
Standardwert ist 
0 (Null). 

Das Feld Add to Report aus-
wählen, um die Daten dieses 
Abschnitts dem Abschlussbericht 
hinzuzufügen (diese werden auch 
an i-LIST™ Office Reporter 
übermittelt. 
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• Rest / Squeeze HPZ (High Pressure Zone) Area: Die Summe der Fläche unterhalb der Druckkurve, wobei der Druck höher als der (Max Pressure*2/3
des Segments ist (die Fläche des HPZ wird in cm*mmHg berechnet).

• Mean Pressure = Durchschnittlicher Druck in der gesamten Zone mit hohem Druck (von START bis STOP).

• Anal Canal Length: Länge des Analkanals in Zentimetern.

• Anal Canal Mean Pressure = Durchschnittlicher Druck in der Anal Canal Length Zone.

• Anal Canal Area = Anal Canal Mean Pressure multipliziert mit der Anal Canal Length (Area in the Anal Canal Length Zone)

•

HINWEIS BEZÜGLICH DER BERECHNUNGEN: 

• Der Mittelwert (Mean) ist die Gesamtsumme der berechneten Werte jedes Kanals dividiert durch die Anzahl der bei der Untersuchung verwendeten
Kanäle.

o Formel: Mean =  SUM(Yn) ÷  Gesamtanzahl der bei der Untersuchung verwendeten Kanäle
Wobei: Yn der berechnete Wert des Kanals ist; n für die Kanalnummer (zwischen 1 und 8) steht.

• Die SD (Standardabweichung) ist die Quadratwurzel der Summe des berechneten Wertes jedes Kanals minus dem Mittelwert hoch zwei, und dann
dividiert durch die Gesamtanzahl der Kanäle minus 1.

o Formel: SD = √
SUM(Yn− Mean)2

(Gesamtanzahl der bei der Untersuchung verwendeten Kanäle −1)

Wobei: Yn der berechnete Wert des Kanals ist; n für die Kanalnummer (zwischen 1 und 8) steht, und Mean der Wert aus der Spalte Mean ist.
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Stationary 

• Stationary Summary - Kreisdiagramm

o Werte außerhalb des Kreises: Maximale Kneifdruckwerte an dieser Position (mmHg).

o Werte innerhalb des Kreises: Maximale Ruhe-Druckwerte an dieser Position (mmHg).
o Höchster Spitzen-Ruhedruck: Höchstwert im Durchschnittskanal für Spitzen-Ruhedruck.
o Höchster Spitzen-Kneifdruck: Höchstwert im Durchschnittskanal für Spitzen-Kneifdruck.

o Höchster Spitzen-Kneif-Anstiegsdruck: Höchstwert im Durchschnittskanal für Spitzen-Anstiegsdruck.
o Rest Anal Canal Length (cm) = Zeigt die Länge des Analkanals an. Wenn der Wert bei Beginn der Messung höher als der ACL-Grenzwert ist, wird 1 cm

der Analkanallänge in Ruhe (Rest Anal Canal Length) hinzugefügt.
o Squeeze Anal Canal Length (cm) = Zeigt die Länge des Analkanals an. Wenn der Wert bei Beginn der Messung höher als der ACL-Grenzwert ist, wird 1 cm

der Analkanallänge bei Kneifdruck (Squeeze Anal Canal Length) hinzugefügt.
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• Pressure Variations: Wird verwendet, um das Vorhandensein von Werten in Verbindung mit langsamen und ultra-langsamen Wellen (slow/ ultra-slow
waves) zu detektieren oder zu berechnen.

o Auf die Schaltfläche Select Region klicken und den Bereich der Grafik auswählen, wo langsame Wellen vorhanden sind.

o Average Amplitude: Der durchschnittliche Druckwert des ausgewählten Bereichs in mmHg.

o Average Frequency: Die Frequenz der Druckwellen in Zyklen/Min.

• Stationary Resting Summary: Zeigt alle Werte im Zusammenhang mit den Ruhedruckdaten abhängig von der Position und dem spezifischen
Sensor/Lumen an.

o Rest Mean Pressure: Durchschnittlicher Druck während der stationären Ruheperiode.
o Rest Duration: Gesamtzeit vom Start bis zum Stopp der stationären Ruheperiode.
o Rest HPZ (High Pressure Zone): Die Summe der Fläche unterhalb der Druckkurve, wobei der Druck höher als der (Max Pressure*2/3) des Segments

während der stationären Ruheperiode ist.

o Rest Peak: Spitzendruck während der stationären Ruheperiode.

• Stationary Squeezing Summary: Zeigt alle Werte im Zusammenhang mit den Kneifdruckdaten abhängig von der Position und dem spezifischen Sensor/Lumen
an.

o Area: Gesamtfläche unterhalb der Kurve in min*mmHg.

o Peak: Maximaler Kneifdruck in mmHg.

o FRI (Fatigue Rate Index): Wert in Minuten, der verwendet wird, um eine Korrelation mit der Ermüdungsrate des Sphinkters herzustellen. Wird
berechnet als Differenz zwischen dem maximalen Kneif- und dem maximalen Ruhedruck (mmHg) dividiert durch den Anstieg einer Linie der
bestangepassten Squeeze-Kurve (mmHg / min).

• Stationary Pushing Summary: Zeigt alle Werte im Zusammenhang mit den Pushing-Druckdaten abhängig von der Position und dem spezifischen Sensor/Lumen
an.

o Push Mean Pressure: Durchschnittlicher Druck während der stationären Pushing-Periode.

Push Peak: Spitzendruck während der stationären Pushing-Periode. 
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Rectal Volume 

Das Feld Add to Report auswählen, um die Daten dieses Abschnitts dem Abschlussbericht hinzuzufügen (diese werden auch an i-LIST™ Office Reporter 
übermittelt. 

• First Sensation: Der Wert in ml, bei dem der Patient die erste rektale Distension verspürte.

• Urge: Der Wert in ml, bei dem der Patient den ersten Stuhldrang verspürte.

• Max Tolerance: Der Wert in ml, bei dem der Patient meinte, dass er eine weitere rektale Distension nicht mehr tolerieren kann.

• Compliance: (NUR möglich, wenn der Rektumdruck gemessen wird und nur in ausgewählten Systemen verfügbar. Um die Funktion zu aktivieren,
zuerst die Reihe „Rectal Pressure“ im Kanal-Mappingabschnitt abbilden). Compliance in mmHg, ist die durchschnittliche Druckänderung (mmHg)) als
Folge einer Änderung des Volumens (ml) von „First sensation“ bis „Max tolerance“. HINWEIS: Compliance-Messungen sind mit T-DOC® Air-Charged™-
Kathetern nicht möglich.
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RAIR 

• RAIR: Ermöglicht dem Anwender, auszuwählen, ob RAIR bei einem bestimmten
Volumen vorhanden oder nicht vorhanden ist.

• Volume: Ermöglicht dem Anwender auszuwählen, welche RAIR-Untersuchung er
ansehen möchte, und diese mit einem Bericht auszudrucken.

• Simple vs. Detailed RAIR:

o Simple RAIR: RAIR-Untersuchung bei der nur festgestellt wird, ob RAIR vorhanden
ist oder nicht.

o Detailed RAIR: Umfasst die einfache RAIR-Untersuchung mit den nachstehenden
detaillierten Daten.

• Reference Resting Pressure: Druck in mmHg, bei dem die RAIR-Untersuchung
beginnt.

• Excitation:

o Linear Change: Druckanstieg in % (basierend auf Verwendung des Referenz-
Ruhedrucks als 100 %) während des ersten Druckanstiegs im Zusammenhang mit
der RAIR-Untersuchung.

o Latency: Zeitspanne, nach der die Exzitationsreaktion nach der Ereignisinitiierung
auftritt.

• Inhibition:

o Linear Change: Druckanstieg in % (basierend auf Verwendung des Referenz-Ruhedrucks als 100 %) während des ersten großen Druckabfalls oder der
Druckinhibition im Zusammenhang mit der RAIR-Untersuchung.

o Latency: Zeitspanne, nach der die Inhibitionsreaktion nach der Ereignisinitiierung auftritt.

• Pop-up window to input RAIR Present/Absent after test: Hier auswählen, ob das „RAIR Present/Absent“ Popup-Fenster nach einer Untersuchung
angezeigt werden soll.

• Das Feld Add to Report auswählen, um die Daten dieses Abschnitts dem Abschlussbericht hinzuzufügen (diese werden auch an i-LIST™ Office Reporter
übermittelt.
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Expulsion 

• Volume: Das Volumen in ml auswählen, mit dem die Untersuchung durchgeführt wurde.

• Ergebnis: Auswählen, ob der Ballon vom Patienten ausgestoßen wurde oder nicht.

• Das Feld Add to Report auswählen, um die Daten dieses Abschnitts dem Abschlussbericht hinzuzufügen (diese werden auch an i-LIST™ Office Reporter
übermittelt.

ARM RESTING-, SQUEEZING- ODER PUSHING-PROFIL 

1. Auf Info > ARM 4&8 klicken.
2. Resting Profile, Squeezing Profile oder Pushing Profile auswählen.

Ergebnis: Das Fenster ARM Resting Profile öffnet sich und zeigt nur die Druckzusammenfassung an. 

In den folgenden Diagrammen:  
1 = Schaltflächen, um das Fenster zu schließen oder die Zusammenfassung und ein 3D-Bild auszudrucken.  
2 = Durchschnittliche Druckkurve.  
3 = Steuertasten für 3D-Profil.  
4 = Querschnittsdiagramm des 3D-Bilds.  
5 = 3D-Darstellung des Druckprofils. Auf das Bild klicken, um die Querschnittsdaten auf der rechten Seite zu sehen. 

[DE]



LABORIE AQUARIUS XT/CT/LT/CTS Benutzerhandbuch AQS-UM01 337 

6 = Zusammenfassung des Druckprofils. Für das Restingprofil ist jeder angezeigte Druck ein durchschnittlicher Druck alle 5 mm; für das Squeezingprofil 
erfolgt die Anzeige der Druckzusammenfassung und des 3D-Plots für jede Position; für das Pushingprofil erfolgt die Anzeige der Druckzusammenfassung 
und des 3D-Plots für jede Position. 
7 = Zeigt bei Auswahl den 3D-Plot an. Informationen zu den Schaltflächen zur Steuerung des 3D-Plots finden Sie auf Seite 340. 

Abbildung 35: Beispiel eines ARM Ruheprofils - 4-Kanal ARM 

[DE]



LABORIE AQUARIUS XT/CT/LT/CTS Benutzerhandbuch AQS-UM01  338 

Das Beispiel des ARM Ruheprofils zeigt eine Druckzusammenfassung und eine 3D-Profildarstellung für das erste Ruheprofil. Um die Ergebnisse eines zweiten 
Profils anzuzeigen, Events Summary (Info > Events Summary) öffnen und die Ereignisse löschen, die das erste Profil kennzeichnen. 

Abbildung 36: Beispiel für eine ARM Squeezing-Untersuchung 
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Abbildung 37: Beispiel für eine ARM Pushing-Untersuchung 
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3D-Profil Steuertasten 

Steuertasten für Rotation 

Steuertasten für Position 

Steuertasten für Vergrößern/Verkleinern 

Erhöhung und Verringerung der Rotationsgeschwindigkeit 

Darstellung der 3D-Abbildung als Polygonnetz. Um auf das 3D-Vollbild zurückzukehren, 
erneut klicken. 
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AUSDRUCK DER ARM-UNTERSUCHUNGSERGEBNISSE 

AUSDRUCK DER UNTERSUCHUNGSERGEBNISSE ÜBER DIE UDS-SOFTWARE 

Wählen Sie die ARM-Elemente aus, die in den Hardcopy-Bericht aufgenommen werden sollen, wenn eine Untersuchungsdatei in der UDS-Software 
geöffnet wird. Wenn Sie eine bestimmte Untersuchung durchgeführt haben, wie z. B. RAIR, schlägt die Software standardmäßig vor, die dazugehörige 
RAIR-Zusammenfassung auszudrucken. Wenn Sie keine bestimmte Untersuchung durchgeführt haben, gibt es keine dazugehörige Druckoption. 

1. Auf File > Print klicken.
Ergebnis: Das Dialogfeld Print Options erscheint.

2. Sie können die Druckoptionen aus der nachstehenden Abbildung und der dazugehörigen Legende auswählen.

[DE]



LABORIE AQUARIUS XT/CT/LT/CTS Benutzerhandbuch AQS-UM01  342 

ARM Profile Summary 

Pressure Profile Summary 

Stationary Summary 

[DE]



LABORIE AQUARIUS XT/CT/LT/CTS Benutzerhandbuch AQS-UM01  343 

Pressure Variation 
Summary 

Squeezing Summary 

Rectal Volume Summary 
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RAIR Summary 

Expulsion Summary 
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Pushing Summary 

3. Die Zusammenfassungen auswählen, die Sie in den Ausdruck mit aufnehmen möchten.

4. Auf OK klicken.

Weitere Informationen zu den Bedeutungen der Normalwerte, die im Ausdruck enthalten sind, finden Sie im Anhang dieses Handbuchs.
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AUSDRUCK DER UNTERSUCHUNGSERGEBNISSE ÜBER I-LIST OFFICE REPORTER 

Nachdem eine Untersuchung durchgeführt und beendet wurde, auf die Schaltfläche Reporter in der UDS-Software klicken, um die mit den 
Untersuchungsdaten erzeugten Berichte zu öffnen und auszudrucken. 

Um den Bericht auszudrucken, auf das Druckersymbol  in der Werkzeugleiste der i-LIST Office Reporter Software klicken. 
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Um eine gespeicherte Untersuchungsdatei auszudrucken, die Datei im Fenster File > Open der UDS-Software öffnen und dann auf die Schaltfläche 
Reporter auf dem Bedienfeld klicken, um die i-LIST Office Reporter Software zu öffnen. 

UMFASSENDE ARM-BERICHTE 

Über die i-LIST Office Reporter Anwendung kann ein vollständiger Untersuchungsbericht erstellt werden. Die Option ARM Report – Comprehensive in 
der Liste der Berichte auswählen, um diese Art von Bericht zu erhalten. 
In diesem Bericht finden Sie Elemente wie: 

• Narrative Zusammenfassung der Untersuchungen

• Grafiken der Untersuchungsergebnisse

• Tabellen mit den Durchschnittswerten

• Einen Grafikausdruck der Untersuchung mit Ereignis-Plots

• Eine EMG-Beurteilungsgrafik

• Etwaige Informationen zur Pudendusnerv-Latenz

• Ultraschallbilder

• Antworten zu Fragebögen, die vor dem Test ausgefüllt wurden

INDIVIDUELLE ANPASSUNG DER ARM-UNTERSUCHUNG 

Um eine Untersuchung zu ändern oder eine neue zu erstellen, auf Config > Setup/Modify klicken, um das Fenster Configuration zu öffnen. 

Teil 1: Kanäle für ARM-Untersuchungen einrichten 

i. Vier oder acht Druckkanäle konfigurieren.
ii. Einen Math-Kanal als Durchschnitt für alle Druckkanäle konfigurieren.
iii. Die Druckeinheiten sind cmH2O, mmHg oder mmHg’. Die Druckkanäle werden standardmäßig in mmHg’ angezeigt. Auf der folgenden Seite

finden Sie Einzelheiten dazu, wie Sie jede Einheit kalibrieren und anwenden.
iv. EMG-Kanal/Kanäle konfigurieren (optional).
v. IH2O und VH2O konfigurieren (optional).
vi. Alle anderen Einstellungen können die Standardeinstellungen bleiben.
vii. Auf Apply klicken und mit der Einrichtung der ARM-Registerkarte fortfahren.
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Abbildung 38: Beispiel: Einrichtungskonfiguration des ARM-Kanals für vier Drücke, EMG und integrierte LABORIE-Pumpe. 

Einheiten für ARM-Untersuchungen 

Die folgenden Kalibriereinheiten können verwendet werden: 

Einheiten für ARM-
Untersuchungen 

Beschreibung 

cmH2O Druckwandler in cmH2O kalibrieren und die Daten in cmH2O anzeigen. 

mmHg 
Druckwandler in mmHg mittels einer cmH2O zu mmHg Umwandlung kalibrieren. Die Daten werden in mmHg angezeigt. 
HINWEIS: 100 mmHg = 136 cmH2O 

mmHg’ Druckwandler in cmH2O kalibrieren und Daten in mmHg mittels der Software-Umwandlungseinheit mmHg’ anzeigen. 
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Teil 2: Einrichtung der ARM-Registerkarte 

Die Kanäle auswählen, die den ARM-Messungen entsprechen, die während der Untersuchungen aufgezeichnet werden. Diese Registerkarte wird 
verwendet, um Zusammenfassungen der Untersuchungsergebnisse zu erstellen, die hier getroffenen Auswahlen sind daher wichtig für eine präzise 
Berichterstellung. 

Abbildung 39: Beispiel einer ARM-Konfiguration für vier Drücke 
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„Enable Reverse Pump“ für die Ballonfüllung 

Wenn die Pumpe verwendet wird, die Option Enable Reverse Pump auf der ARM-Registerkarte auswählen, um die Schaltfläche „Reverse Pump“ auf dem 
Bedienfeld zu aktivieren. Die Schaltfläche „Reverse Pump“ kann im Dialogfeld Control Panel Settings konfiguriert werden. Informationen zu den 
Optionen für die Schaltflächenkonfiguration finden Sie unter Glossar der ARM 4&8 Bedienfeldbefehle auf Seite 356. Wenn die „Reverse Pump“-
Schaltfläche auf dem Bedienfeld geklickt wurde, erscheint eine Warnmeldung, um die Fortsetzung des Verfahrens zu bestätigen.  

Warnmeldung, die angezeigt wird, wenn das Kontrollkästchen 
„Enable Reverse Pump“ nicht markiert ist und die „Reverse 
Pump“-Schaltfläche auf dem Bedienfeld angeklickt wird. 

Warnmeldung, die angezeigt wird, wenn das Kontrollkästchen „Enable 
Reverse Pump“ markiert ist und die „Reverse Pump“-Schaltfläche auf 
dem Bedienfeld angeklickt wird. 

Auf Yes oder No klicken, um die Rückwärtspumpe entweder zu starten oder zu stoppen. HINWEIS: Die Rückwärtspumpenfunktion dient nur dazu, den 
Rektalballon vor der Entfernung des Katheters zu entleeren. Verwenden Sie die Rückwärtspumpenfunktion nicht für andere Zwecke. 
Ein „Start Infusion“- und „Stop Infusion“-Ereignis wird ebenfalls der Grafik hinzugefügt, wenn die Rückwärtspumpe gestartet und gestoppt wird. 

Teil 3: Konfiguration des Bedienfelds für ARM-Untersuchungen 

1. In der Menüleiste auf Options klicken.

2. Control Panel Settings auswählen.

Ergebnis: Das Feld Command erscheint und zeigt die erste Reihe der Schaltflächen des Bedienfelds an. 
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3. Auf den Pfeil neben Control Panel Set Name klicken und ARM 4&8 auswählen.

Abbildung 40: Auswahl des Bedienfelds für ARM 

Die letzten beiden Schaltflächen der ersten und zweiten Reihe sind für die Systemanwendung reserviert. Die restlichen Schaltflächen können nach Ihrem 
Bedarf programmiert werden. 

ARM Event Properties 

Jede ARM-Schaltfläche hat ein Start- und ein Stopp-Ereignis. Einige der ARM-Schaltflächen können so konfiguriert werden, dass nach einer festgelegten 
Zeit ein Stopp erfolgt und die Bereiche zwischen den Start- und Stopp-Ereignissen schattiert werden. 

1. Das Properties-Fenster durch Klicken auf die PLUS (+) Schaltfläche neben der entsprechenden Schaltfläche des ARM-Bedienfelds öffnen.
2. Automatically insert STOP event after auswählen und einen Wert in Sekunden eingeben. Der Standardwert ist 10 Sekunden.
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3. Um eine Schattierung zwischen Start- und Stopp-Ereignissen einzufügen, auf show region for the ARM event und dann in das Feld Select Color klicken, um die
Farbe auszuwählen.

Abbildung 41: Einrichtung der ARM-Eigenschaften 

4. Auf OK klicken, um die Auswahl zu bestätigen.

Fahren Sie nach dieser Einstellung mit der Einrichtung der Puller-Schaltflächen fort (wenn Sie die Zugmechanik verwenden) oder starten Sie die ARM-
Untersuchung.  

SCHALTFLÄCHEN FÜR DIE MECHANISCHEN UPP-PULLER ERSTELLEN (OPTIONAL) 

Wenn Sie den mechanischen UPP-Puller (UPP1001) von LABORIE verwenden, müssen die Schaltflächen entsprechend programmiert werden, damit die 
Zugmechanik während der ARM-Untersuchung verwendet werden kann. 

1. Wenn keine freien Schaltflächenplätze mehr vorhanden sind, eine Schaltflächenreihe hinzufügen, indem Sie die Anzahl im Feld Number of Rows
ändern. Wenn Sie schon drei Schaltflächenreihen haben, die Anzahl auf vier ändern. Wenn Sie vier Reihen haben, die Anzahl auf fünf ändern und so
weiter.

2. Mit dem Abwärtspfeil neben „Current row” die neu erstellte Reihe auswählen.

3. In das Label-Feld klicken und Pull eingeben. Dadurch wird der Katheter aus dem Patienten in einer festgelegten Geschwindigkeit zurückgezogen. 

4. In der gleichen Reihe in das Feld Definition PU eingeben.

5. In der gleichen Reihe, im dritten Feld UPP Command mit dem Abwärtspfeil rechts neben dem Feld auswählen.
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6. Auf die PLUS-Schaltfäche klicken,  um eine festgelegte Distanz einzustellen, um den Puller zu stoppen. 
7. Danach in die nächste Zeile gehen und Pull 1 cm in das Label-Feld und PU 10 in das Definition-Feld eingeben und dann UPP Command in der Liste

klicken. Durch Klicken auf diese Schaltfläche wird der Puller angewiesen, den Katheter 1 Zentimeter (10 mm) zurückzuziehen.
8. Danach in die nächste Zeile gehen und Stop Pull in das Label-Feld und ST in das Feld Definition eingeben und dann UPP Command in der Liste klicken.

Durch Klicken auf diese Schaltfläche wird das Zurückziehen des Katheters gestoppt.
9. In die nächste Zeile gehen und Return in das Label-Feld und IN in das Definition-Feld eingeben, danach UPP Command wählen. Durch Klicken auf diese

Schaltfläche wird die Pullerführung vorwärts bewegt.

Die Einrichtung sieht nach Beendigung ähnlich wie das hier abgebildete Fenster aus. 

10. Auf OK klicken.

11. Fahren Sie mit der Einrichtung für die Sensation-Ereignisse fort.
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First Sensation, Urge und Max Tolerance Ereignisse erstellen 

Wenn der Rektalballon manuell mit einer Spritze gefüllt wird, werden Sie von der Software aufgefordert, die Volumen bei „First Sensation“, „Urge“ und 
„Max Tolerance“ einzugeben. 

1. Die Schaltfläche ARM im Bedienfeld auswählen.

2. Auf Run klicken und die Untersuchung ein paar Augenblicke laufen lassen.

3. Auf die Schaltflächen First Sensation, Urge und Max Tolerance klicken.

4. Auf Stop klicken.

 Wenn der VH2O-Kanal in der Konfigurationsdatei der Untersuchung nicht vorgegeben ist, die manuelle Eingabeoption für das infundierte 
Volumen wie folgt einstellen. Auf Info > ARM 4&8 > Anorectal Summary klicken und die Registerkarte Rectal Volume auswählen. Die Option Input volume 
immediately after inserting events auswählen (wie unten abgebildet) und auf OK klicken, um sicherzustellen, dass ein Meldungsfeld erscheint, das zur 
Eingabe des Volumens auffordert, wenn First Sensation, Urge oder Max Tolerance Ereignisse ausgewählt wird.  
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Auf OK klicken. Auf Config > Save As klicken, um die Datei zu benennen und dies zu einer Standardeinstellung zu machen. 
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GLOSSAR DER ARM 4&8 BEDIENFELDBEFEHLE 

Vorgeschlagene 
Schaltflächenbezeichnung 

Definition Typ 

First Sensation 
First Urge 
Max Tolerance 

Erste Empfindung 
Stuhldrang 
Maximale Toleranzgrenze 

Event 
Markiert ein Ereignis mit der Definition Text als Event Annotation. 

ARM 4 Radial 
ARM 8 Radial 

Vollständiger Pfad der CFG-Datei 
Beispiel: c:\cfg\ 

Config 
Öffnet eine .cfg-Datei 

Set Zeroes N/A Set Zeroes 
Setzt alle Kanäle auf Null. 
UPP Command (Steuert die Pullergeschwindigkeit) 

Return IN (zieht den Puller so schnell wie möglich zurück; für 
Puller-Positionierung) 

IN XX (holt den UPP-Puller so schnell wie möglich XX Millimeter zurück; 
wird für die Positionierung des UPP-Pullers verwendet) 

Pull PU (zieht mit Standard-UPP-Geschwindigkeit; stoppt, 
wenn die Spitze erreicht wird) 

PU (zieht den Puller so schnell wie möglich zurück; für Puller-Posi-
tionierung) 

Pull X cm PU XX PU XX (zieht den UPP-Puller XX Millimeter in der Standard-UPP-
Geschwindigkeit; PU 15 zieht z. B. den UPP 15 mm in der Stan-
dardgeschwindigkeit zurück) 

Stop Pull ST (stoppt den Zug) 

Patient Info N/A Patienteninfo 
Öffnet das „Patient Info“-Fenster. 

Resting 
Squeezing 
Pushing 
6 cm Push 
5 cm Push 
4 cm Push 
3 cm Push 
2 cm Push 
1 cm Push 
6 cm Squeeze 
5 cm Squeeze 
4 cm Squeeze 
3 cm Squeeze 
2 cm Squeeze 
1 cm Squeeze 

RE (Ereignis für Ruheprofil) 
SQP (Ereignis für Squeezingprofil) 
PUSH (Ereignis für Pushingprofil) 
SP6 (Ereignisse für stationäre Untersuchung) 
SP5  
SP4 
SP3 
SP2 
SP1 
ST6 
ST5 (Ereignisse für stationäre Untersuchung) 
ST4 
ST3 
ST2 
ST1 

ARM 
Steuert anorektale Manometrieverfahren, die mit Kathetern mit 4 oder 8 
umlaufenden Drucksensoren durchgeführt werden.  
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Vorgeschlagene 
Schaltflächenbezeichnung 

Definition Typ 

6 cm Rest 
5 cm Rest 
4 cm Rest 
3 cm Rest 
2 cm Rest 
1 cm Rest 
10 cc 
20 cc 
30 cc 
40 cc 
50 cc 
60 cc 
70 cc 
80 cc 
90 cc 
100 cc 
110 cc 
RAIR 
Expulsion 
Pushing 

SR6 
SR5 (Ereignisse für stationäre Untersuchung) 
SR4 
SR3 
SR2 
SR1 
10cc (Ereignisse für RAIR-Untersuchungen) 
20cc 
30cc 
40cc 
50cc 
60cc 
70cc 
80cc 
90 cc 
100cc 
110cc 
RAIR 
E 
PUSH 

Slow Fill 
Medium Fill 
Fast Fill 
XXX ml/min 
+YY ml/min
-ZZ ml/min

Reverse Slow Fill 
Reverse Medium Fill 
Reverse Fast Fill 

SF 
MF 
FF 
SP=XXX (wobei XXX in ml/min angegeben ist) 
SP+YY (wobei YY die inkrementelle Rate ist) 
SP-ZZ (wobei ZZ die dekrementelle Rate ist) 

RSF 
RMF 
RFF 

Pumpenbefehl 
Steuert die Pumpenfüllrate. 

Steuert die reverse Pumpenfüllrate† 

† In der „Reverse Fill pump“-Funktion läuft die LABORIE-Pumpe rückwärts und wird bei ARM-Verfahren verwendet, um den großen Ballon, der 
verwendet wird, um Reaktionen basierend auf den Empfindungen der Rektumfüllung hervorzurufen, schnell zu füllen und dann wieder zu leeren. 
Abhängig von der von Ihnen verwendeten Softwareversion können, wenn die Pumpenbefehle als ff, mf und sf programmiert werden, rff, rmf und rsf 
hinzugefügt werden. Wenn die Befehle als fast fill, medium fill und slow fill programmiert werden, kann der Rückwärtsfluss als reverse fast fill, reverse 
medium fill und reverse slow fill programmiert werden.  
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„Reverse Fill“ ist keine Funktion, mit der die Blase während einer urodynamischen Untersuchung entleert werden soll! Sie wird ausschließlich für 
das Entleeren des großen Ballons während des ARM-Verfahrens verwendet! 
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SOFTWARE-EINRICHTUNG FÜR PÄDIATRISCHE PATIENTEN 

INFORMATIONEN ZU PÄDIATRISCHEN PATIENTEN 

Wenn Sie Informationen für einen Patienten im Alter von 16 Jahren oder jünger eingeben, passt sich das Patienteninformationsfenster automatisch an, 
sodass die notwendigen Informationen hinzugefügt werden können. 

• EBC: Blasenkapazität – dargestellt in Millilitern. Die Berechnung erfolgt automatisch mit der Formel: 30 x (Alter
+ 1).

• ATBC: Akzeptable Gesamtblasenkapazität. Dieser Grenzwert ist die maximale Flüssigkeitsmenge, die einem
Patienten gemäß der Blasenkapazität in einem bestimmten Alter infundiert werden kann. Wird mit dieser
Formel berechnet: ATBC = 16 x (Alter des Kindes in Jahren) + 70 mlxxxi.

• Height: Die Körpergröße in Zentimetern eingeben.

• Weight: Das Körpergewicht in Kilogramm eingeben.

• Surface Area: Oberflächenbereich der Blase, wird in Quadratmetern angezeigt. Die Berechnung erfolgt
automatisch basierend auf Körpergröße und -gewicht.

• MPUR: Maximale physiologische Harnflussrate: Wird in Millilitern pro Minute angezeigt. Die Berechnung erfolgt
automatisch basierend auf Körpergröße und -gewicht des Patienten.

• Fill Rate: Die Füllrate der Pumpe. Weitere Informationen zu den Pumpenfüllraten für pädiatrische Patienten
finden Sie auf Seite 360.
o Current Pump Speed: Ermöglicht die Auswahl einer langsamen, mittleren oder schnellen Füllrate.
o Use MPUR (10% of EBC) for pump speed und Use ½ MPUR (5% of EBC) for pump speed: Automatische

Einstellung der idealen Pumpenfüllrate basierend auf dem MPUR-Wert.
o Sq.Root Bladder Volume: Automatische Einstellung der idealen Pumpenfüllrate basierend auf dem EBC-

Wert.

Um pädiatrische Pumpeneinstellungen zu aktivieren, zuerst die Konfigurationsdatei (.cfg) der Untersuchung auswählen und dann die 
Patienteninformationen eingeben. Dann können MPUR und Sq Root Bladder Volume Füllraten für die Untersuchung ausgewählt werden. 
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VOLUME WARNING LIMIT (VOLUMEN-WARNGRENZWERT) 

Der Volumen-Warngrenzwert wird im pädiatrischen „Uro-Modus“ verwendet, der auf Patienten im Alter unter 16 Jahren Anwendung findet. Dieser 
Grenzwert ist die maximale Flüssigkeitsmenge, die einem Patienten gemäß der Blasenkapazität in einem bestimmten Alter infundiert werden kann. 
Der Volumen-Warngrenzwert wird durch die akzeptable Gesamtblasenkapazität (Acceptable Total Bladder Capacity, ATBC) bestimmt. 

ATBC = 16 x (Alter des Kindes in Jahren) + 70 ml.xxxii 

Die Pumpe erhält die Informationen für die Berechnung der ATBC aus den in das Dialogfeld „Patient Information“ eingegebenen Daten. 
Wenn das infundierte Volumen den im Feld „Volume Warning Limit“ angegebenen Grenzwert überschreitet, erscheint eine Meldung. 

Nachdem die Warnmeldung angezeigt wurde, stoppt die Pumpe nicht automatisch. Sie muss manuell gestoppt werden. 

Die ATBC wird automatisch berechnet und kann nicht geändert werden. 
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DURCHFÜHRUNG VON UDS-UNTERSUCHUNGEN MIT DEM AQUARIUS-SYSTEM 

UROFLOW-UNTERSUCHUNGEN 

Eine Uroflow-Untersuchung ist eine Messung der Geschwindigkeit, in der Urin aus dem Körper herausfließt. Sie kann mit der automatischen 
Aufzeichnungsmethode der UDS-Software oder mit manueller Steuerung der Software durchgeführt werden. 

DURCHFÜHRUNG EINER UROFLOW-UNTERSUCHUNG MIT EINEM UROCAP™ V 

Vergewissern Sie sich vor Beginn der Untersuchung, dass die Batterie des Urocap™ V vollständig aufgeladen ist. 

Automatische Methode 

1. Vergewissern Sie sich, dass der Computer eingeschaltet, das Gerät angeschlossen und der Drucker eingeschaltet ist.

2. Die UDS-Software starten und auf dem Bedienfeld auf die Schaltfläche Uroflow entsprechend dem Urocap™ V klicken.

• Diese Uroflow-Schaltfläche kann angepasst und auf Ihrem Bedienfeld anders bezeichnet werden.

• Das Verbindungssymbol neben den während der Untersuchung verwendeten Geräten ist während der Untersuchung nicht zu sehen.

3. Die Patienteninformationen eingeben.

4. Die entsprechende Konfigurationsdatei (.cfg) für eine Uroflow-Untersuchung mit aktivierter Autoaufzeichnungsoption auswählen.

5. Auf die Uroflow-Schaltfläche klicken, die dem Urocap™ V auf dem Bedienfeld entspricht.

6. Vergewissern Sie sich, dass Auto Recording Mode in der blauen Titelleiste über der Grafik angezeigt wird.

7. Den Urocap™ V anstoßen, um sicherzustellen, dass er reagiert.

8. Das Programm beginnt automatisch mit der Datenverarbeitung, wenn der Transducer die ersten Urintropfen feststellt. Sie können auch
auf die Run-Schaltfläche klicken, um die Untersuchung zu beginnen.

9. Fordern Sie den Patienten auf, seine Blase zu entleeren. Wenn möglich, sollten Sie dabei den Raum verlassen, um die Intimsphäre des
Patienten zu wahren.
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Während der Miktion NICHT DEN BECHER BERÜHREN.

Die Grafik stoppt automatisch 50 Sekunden nach Beendigung der Blasenentleerung. 

10. Der Patient kann jetzt nach Wunsch katheterisiert oder es kann ein Blasenscanner verwendet werden, um eine Messung des
Nachentleerungsrestvolumens zu erhalten.

11. Wenn der Uroflow Summary Bildschirm sich öffnet, den PVR-Wert eingeben und OK klicken.

12. Auf Save klicken, um die Datei zu speichern, oder auf Reporter klicken, um einen Untersuchungsbericht anzuzeigen und auszudrucken.

13. Den Becher leeren. Er kann sorgfältig gereinigt und wiederverwendet werden.

Manuelle Methode 

1. Vergewissern Sie sich, dass der Computer eingeschaltet, das Gerät angeschlossen und der Drucker eingeschaltet ist.

2. Die UDS-Software starten und auf dem Bedienfeld auf die Schaltfläche Uroflow entsprechend dem Urocap™ V klicken.

• Diese Uroflow-Schaltfläche kann angepasst und auf Ihrem Bedienfeld anders bezeichnet werden.

• Das Verbindungssymbol neben den während der Untersuchung verwendeten Geräten ist während der Untersuchung nicht zu sehen.

3. Die Patienteninformationen eingeben.

4. Die entsprechende Konfigurationsdatei (.cfg) für eine Uroflow-Untersuchung mit aktivierter Autoaufzeichnungsoption auswählen.

5. Auf die Uroflow-Schaltfläche klicken, die dem Urocap™ V auf dem Bedienfeld entspricht.

6. Den Urocap™ V anstoßen, um sicherzustellen, dass er reagiert.

7. Auf Set Zeroes auf dem Bedienfeld und dann auf Run klicken, um mit der Untersuchung zu beginnen.

8. Fordern Sie den Patienten auf, seine Blase zu entleeren. Wenn möglich, sollten Sie dabei den Raum verlassen, um die Intimsphäre des
Patienten zu wahren.

Während der Miktion NICHT DEN BECHER BERÜHREN.
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9. Nach Beendigung der Blasenentleerung auf die Stop-Schaltfläche klicken.

10. Der Patient kann jetzt nach Wunsch katheterisiert oder es kann ein Blasenscanner verwendet werden, um eine Messung des
Nachentleerungsrestvolumens zu erhalten.

11. Auf die Schaltfläche Summ. Review auf dem Bedienfeld klicken, um die zusammenfassenden Uroflow-Ergebnisse zu sehen. Dann auf
Return to Test klicken, um fortzufahren.

12. Das Restvolumen nach der Blasenentleerung im Feld PVR eingeben und OK klicken.

13. Auf Save oder auf Reporter klicken, um einen Untersuchungsbericht anzuzeigen und auszudrucken.

14. Wenn das Feld Save Test File erscheint, auf die Save-Schaltfläche im Feld klicken.

15. Den Becher leeren. Er kann sorgfältig gereinigt und wiederverwendet werden.

EINE UROFLOW-UNTERSUCHUNG MIT EINEN SPINNING-DISK-FLOWTRANSDUCER DURCHFÜHREN 

1. Vergewissern Sie sich, dass Spinning-Disk-Flowtransducer an einer Wandsteckdose angeschlossen ist.

2. Vergewissern Sie sich, dass der Computer eingeschaltet, das Gerät angeschlossen und der Drucker eingeschaltet ist.

3. Die UDS-Software starten und auf dem Bedienfeld auf die Schaltfläche Uroflow entsprechend dem Spinning-Disk-Flowtransducer
klicken.

• Diese Uroflow-Schaltfläche kann angepasst und auf Ihrem Bedienfeld anders bezeichnet werden.

• Das Verbindungssymbol neben den während der Untersuchung verwendeten Geräten ist während der Untersuchung nicht zu sehen.

4. Die Patienteninformationen eingeben.

5. Vergewissern Sie sich, dass die obere rechte Schaltfläche des Bedienfelds grün ist und „Run“ anzeigt.

6. Vergewissern Sie sich auch, dass die LED-Lampe im Kontrollfeld des Transducers grün ist und blinkt.

7. Erklären Sie dem Patienten, dass mit der Untersuchung dann begonnen wird, wenn er dafür bereit ist. Das Programm beginnt automatisch
mit der Datenverarbeitung, wenn der Spinning-Disk-Flowtransducer die ersten Urintropfen feststellt. Sie können auch auf die Run-
Schaltfläche klicken, um die Untersuchung zu beginnen.
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8. Fordern Sie den Patienten auf, seine Blase zu entleeren. Wenn möglich, sollten Sie dabei den Raum verlassen, um die Intimsphäre des
Patienten zu wahren.

9. Die Grafik stoppt automatisch 50 Sekunden nach Beendigung der Blasenentleerung. Sie können auch auf „Stop“ drücken, um die
Untersuchung zu beenden.

10. Der Patient kann jetzt nach Wunsch katheterisiert oder es kann ein Blasenscanner verwendet werden, um eine Messung des
Nachentleerungsrestvolumens zu erhalten.

11. Wenn der Uroflow Summary Bildschirm sich öffnet, den PVR-Wert eingeben (soweit dieser gemessen wurde) und OK klicken.

12. Auf Save klicken, um die Datei zu speichern, oder auf Reporter klicken, um einen Untersuchungsbericht anzuzeigen und auszudrucken.

13. Den Becher leeren. Er kann sorgfältig gereinigt und wiederverwendet werden.

CMG- ODER MIKTIONSUNTERSUCHUNG (DRUCK-FLUSS) 

Mit einer CMG-Untersuchung (Zystometrogramm) soll festgestellt werden, ob die Blase und das umgebende Gewebe korrekt funktionieren. Bei der CMG-
Untersuchung wird die Blase gefüllt und der Detrusordruck Pdet = Pves – Pabd (der Unterschied zwischen dem Druck im Inneren der Blase (Pves) und der 
Druck im Abdomen (Pabd)) berechnet. 

• Denken Sie bitte daran, alle Druckwandler zu kalibrieren, bevor Sie die Untersuchung durchführen.

• Ärzte sollten in der Verwendung der geeigneten aseptischen Technik während der beabsichtigten Anwendung des Geräts erfahren und
qualifiziert sein.

EINE CMG-/MIKTIONSUNTERSUCHUNG MIT LUFTGEFÜLLTEN KATHETER DURCHFÜHREN 

1. Sorgen Sie dafür, dass die für die Untersuchung benötigten Hilfsmittel vorhanden sind (Katheter, Becher, Miktionsstuhl, Trichter,
Druckwandler/Transducer usw.).

2. Vergewissern Sie sich auch, dass Roam™ DX und Urocap™ V angeschlossen sind und die Batterie vollständig aufgeladen ist. Wenn ein
Spinning-Disk-Flowtransducer verwendet wird, sicherstellen, dass dieser an einer Wandsteckdose angeschlossen ist.

3. Den Computer und den Drucker einschalten.

4. Fordern Sie den Patienten auf, sich hinzulegen und zu entspannen, um die Untersuchung durchzuführen.

5. Positionieren Sie die Katheter im Patienten.

Informationen zur Katheter- und EMG-Elektrodeneinrichtung finden Sie auf Seite 46. 

6. Die Katheter sichern.
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7. Die Katheter mit den Kabeln verbinden und an die Anschlüsse am Roam™ DX anschließen.

8. Die UDS -Software starten und auf die Schaltfläche CMG/PF im Bedienfeld klicken.

Das Verbindungssymbol neben den während der Untersuchung verwendeten Geräten ist während der Untersuchung nicht zu sehen. 

9. Die Patienteninformationen eingeben.

10. Die Infusionsleitung von der Pumpe am Fülllumen des Blasenkatheters anschließen.

11. Vergewissern Sie sich, dass alle Ladevorrichtungen in der OPEN Position sind.

12. Auf die Schaltfläche Zero All im Bedienfeld klicken. Dann auf Set Zeroes in der Hauptmenüleiste und auf den EMG-Kanal klicken, um das
EMG auf Null zu setzen.

13. Die Druckwandler in die Position CHARGE schalten. Es werden jetzt die tatsächlichen internen Drücke aufgezeichnet. Wenn Sie zwei Drücke
während einer CMG- oder Druck-Fluss-Untersuchung aufzeichnen, sollten Pves und Pabd ziemlich gleich und Pdet sollte Null oder nahe Null
sein.

14. Fordern Sie den Patienten auf zu husten, um die Katheterpositionierung zu bestätigen. Wenn gleichzeitig zwei Drücke aufgezeichnet
werden, zeigt der Hustenstoß auf beiden Kanälen einen ähnlichen Ausschlag.

Wenn Pabd höher also Pves ist, versuchen, den Pabd-Katheter neu zu positionieren. Fordern Sie den Patienten auf, erneut zu husten, wenn die 
Neupositionierung nicht funktioniert, um zu bestätigen, dass beide Drücke entsprechend reagieren. 

15. Auf die Schaltfläche Run im Bedienfeld klicken.

16. Auf die Schaltfläche Pump Start klicken, um die Pumpe zu starten und mit der Blasenfüllung zu beginnen.

17. Die relevanten Ereignisse markieren (zum Beispiel: First Sensation, First Desire und so weiter. Klicken Sie hierfür auf die Schaltflächen mit
der entsprechenden Bezeichnung auf dem Bedienfeld). Fordern Sie den Patienten auf, Feedback zu seiner Empfindung oder einem
Harndranggefühl zu geben.

18. Auf Capacity auf dem Bedienfeld klicken, wenn die Füllung beim Patienten abgeschlossen ist und dann auf Pump Stop klicken.

19. Auf die Schaltfläche Permit to Void klicken und den Patienten auffordern, sich in den Miktionsstuhl zu entleeren (mit den noch platzierten

Kathetern).

20. Wenn er fertig ist, auf die Stop-Schaltfläche und dann auf Save klicken, um die Untersuchungsdatei zu speichern.

21. Drucken Sie die Ergebnisse der Untersuchung auf Wunsch aus.

22. Katheter, EMG-Elektroden und Pumpenschlauch entfernen und gemäß den Verfahren des Krankenhauses/der Klinik entsorgen.
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23. Den Becher leeren. Er kann sorgfältig gereinigt und wiederverwendet werden.

EINE CMG-/MIKTIONSUNTERSUCHUNG MIT FLÜSSIGKEITSGEFÜLLTEN KATHETER DURCHFÜHREN 

1. Sorgen Sie dafür, dass die für die Untersuchung benötigten Hilfsmittel vorhanden sind (Katheter, Becher, Miktionsstuhl, Trichter,
Druckwandler/Transducer usw.).

2. Vergewissern Sie sich auch, dass Roam™ DX und Urocap™ V angeschlossen sind und die Batterie vollständig aufgeladen ist. Wenn ein
Spinning-Disk-Flowtransducer verwendet wird, sicherstellen, dass dieser an einer Wandsteckdose angeschlossen ist.

3. Den Computer und den Drucker einschalten.
4. Fordern Sie den Patienten auf, sich hinzulegen und zu entspannen, um die Untersuchung durchzuführen.
5. Positionieren Sie die Katheter im Patienten.

Informationen zum Entlüften von flüssigkeitsgefüllten Kathetern finden Sie auf Seite 43. 

6. Die UDS-Software starten auf dem Bedienfeld auf CMG oder Micturition klicken.

Das Verbindungssymbol neben den während der Untersuchung verwendeten Geräten ist während der Untersuchung nicht zu sehen. 

7. Die Patienteninformationen eingeben.
8. Vergewissern Sie sich, dass die Druckwandler ansprechen, indem Sie auf die 100 mm Hg-Taste auf der Druckwandlerkartusche drücken.

100 mm Hg = 136 cmH2O. 

9. Set Zeroes! auswählen, wenn sich die Druckwandlerkartuschen auf Blasenhöhe befinden und drucklos sind (offen gegen Atmosphäre).
10. Die Druckwandler gegen die Atmosphäre schließen und zum Patienten hin öffnen. Es werden jetzt die tatsächlichen internen Drücke

aufgezeichnet. Wenn Sie zwei Drücke während einer CMG- oder Druck-Fluss-Untersuchung aufzeichnen, sollten Pves und Pabd ziemlich
gleich und Pdet sollte Null oder nahe Null sein.

11. Fordern Sie den Patienten auf zu husten, um die Katheterpositionierung zu bestätigen. Wenn gleichzeitig zwei Drücke aufgezeichnet
werden, zeigt der Hustenstoß auf beiden Kanälen einen ähnlichen Ausschlag.
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Wenn Pabd höher also Pves ist, versuchen, den Pabd-Katheter neu zu positionieren. Fordern Sie den Patienten auf, erneut zu husten, wenn die 
Neupositionierung nicht funktioniert, um zu bestätigen, dass beide Drücke entsprechend reagieren. 

12. Auf die Schaltfläche Run im Bedienfeld klicken.
13. Auf die Schaltfläche Pump Start klicken, um die Pumpe zu starten und mit der Blasenfüllung zu beginnen.
14. Die relevanten Ereignisse markieren (zum Beispiel: First Sensation, First Desire und so weiter. Klicken Sie hierfür auf die Schaltflächen mit

der entsprechenden Bezeichnung auf dem Bedienfeld). Fordern Sie den Patienten auf, Feedback zu seiner Empfindung oder einem
Harndranggefühl zu geben.

15. Auf Capacity auf dem Bedienfeld klicken, wenn die Füllung beim Patienten abgeschlossen ist und dann auf Pump Stop klicken.

16. Auf die Schaltfläche Permit to Void klicken und den Patienten auffordern, sich in den Miktionsstuhl zu entleeren (mit den noch platzierten

Kathetern).
17. Wenn er fertig ist, auf die Stop-Schaltfläche und dann auf Save klicken, um die Untersuchungsdatei zu speichern.
18. Drucken Sie die Ergebnisse der Untersuchung auf Wunsch aus.
19. Katheter, EMG-Elektroden, Druckschlauch, Wandlerkartuschen und Pumpenschlauch entfernen und gemäß den Verfahren des

Krankenhauses/der Klinik entsorgen.
20. Den Becher leeren. Er kann sorgfältig gereinigt und wiederverwendet werden.

UPP-UNTERSUCHUNGEN 

Eine UPP-Untersuchung wird durchgeführt, um die Länge der Urethra und den Druck innerhalb der Urethra zu messen. Es kann ein optionaler UPP-Puller 
(Zugmechanik) zusammen mit der UDS-Software verwendet werden, um eine UPP-Untersuchung durchzuführen. 

Der UPP-Puller ist nur für das Zurückziehen des Katheters bestimmt! 

• Denken Sie bitte daran, alle Druckwandler zu kalibrieren, bevor Sie die Untersuchung durchführen.

• Ärzte sollten in der Verwendung der geeigneten aseptischen Technik während der beabsichtigten Anwendung des Geräts erfahren und
qualifiziert sein.
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EINE UPP-UNTERSUCHUNG MIT LUFTGEFÜLLTEN KATHETER DURCHFÜHREN 

1. Vergewissern Sie sich, dass der UPP-Puller voll aufgeladen und am System
angeschlossen ist. Wenn er angeschlossen ist, wird am Hub das Verbindungssymbol
angezeigt.

2. Fordern Sie den Patienten zur Untersuchung auf.

3. Die UDS-Software starten und auf dem Bedienfeld auf UPP klicken.

• Wenn die UPP-Schaltfläche nicht zu sehen ist, auf Options > Control Panel Settings klicken und die PressureFlowUPP
Bedienfeldeinstellung wählen.

• Das Verbindungssymbol neben den während der Untersuchung verwendeten Geräten ist während der Untersuchung nicht zu sehen.

4. Die Patienteninformationen eingeben.

5. Einen Dreilumenkatheter in die Blase des Patienten einführen. Gegebenenfalls am anderen Ende des Katheters die erforderlichen
Anschlüsse für Druck und Pumpe herstellen.

6. Vergewissern Sie sich, dass alle Druckwandler in der
OPEN Position sind.

7. Auf die Schaltfläche Zero All im Bedienfeld klicken. Dann auf Set Zeroes in der Hauptmenüleiste und auf den EMG-Kanal klicken, um
das EMG auf Null zu setzen.

8. Die Druckwandler in die Position CHARGE schalten. Es
werden jetzt die tatsächlichen internen Drücke
aufgezeichnet.

9. Auf Run im Bedienfeld klicken.
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10. Wenn erforderlich, das gewünschte Volumen mithilfe der Pumpe in die Blase infundieren.

11. Danach die Pumpe stoppen.

12. Auf Start Pull klicken (oder F6 auf der Tastatur betätigen), und der UPP-Puller beginnt, den Katheter in der voreingestellten
Geschwindigkeit aus der Blase des Patienten zurückzuziehen.

Wenn Sie keinen UPP-Puller verwenden, den Katheter mit langsamer und gleichmäßiger Geschwindigkeit manuell zurückziehen. 

13. Wenn der Pura-Sensor des Katheters vollständig draußen ist, Stop Pull klicken (oder F6 betätigen).

14. Return für den Rückzug des nächsten Katheters wählen und den Katheter wieder einführen.

Der Katheter muss manuell eingeführt werden, hierfür darf nicht der UPP-Puller verwendet werden. 

15. Wenn er fertig ist, auf die Stop-Schaltfläche und dann auf Save klicken, um die Untersuchungsdatei zu speichern.

16. Drucken Sie die Ergebnisse der Untersuchung auf Wunsch aus.

17. Katheter, EMG-Elektroden und Pumpenschlauch entfernen und gemäß den Verfahren des Krankenhauses/der Klinik entsorgen.

EINE UPP-UNTERSUCHUNG MIT WASSERGEFÜLLTEN KATHETER DURCHFÜHREN 

1. Vergewissern Sie sich, dass der UPP-Puller voll aufgeladen und am System
angeschlossen ist. Wenn er angeschlossen ist, wird am Hub das Verbindungssymbol
angezeigt.

2. Vergewissern Sie sich, dass die Druckwandlerkartuschen und die Druckmessschläuche entlüftet sind.

3. Fordern Sie den Patienten zur Untersuchung auf.

4. Die UDS-Software starten und auf dem Bedienfeld auf UPP klicken.

• Wenn die UPP-Schaltfläche nicht zu sehen ist, auf Options > Control Panel Settings klicken und die PressureFlowUPP
Bedienfeldeinstellung wählen.

• Das Verbindungssymbol neben den während der Untersuchung verwendeten Geräten ist während der Untersuchung nicht zu sehen.
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5. Die Patienteninformationen eingeben.

6. Einen Dreilumenkatheter in die Blase des Patienten einführen. Gegebenenfalls am anderen Ende des Katheters die erforderlichen Anschlüsse
für Druck und Pumpe herstellen.

7. Vergewissern Sie sich, dass die Druckwandler ansprechen, indem Sie auf die 100 mm Hg-Taste auf der Druckwandlerkartusche drücken.

8. Die Nulleinstellung mit dem Tropf der Infusionsleitung auf 1 Tropfen alle 2-3 Sekunden vornehmen.

9. Auf Run im Bedienfeld klicken.

10. Wenn erforderlich, das gewünschte Volumen mithilfe der Pumpe oder dem Messwertgeber für Infusion in die Blase infundieren.

11. Wenn Sie fertig sind, die Pumpe stoppen oder die Rollenklemme an der Infusionsleitung schließen, d. h. die Pumpenleitung und nicht die
UPP-Tropfleitung schießen.

12. Auf Start Pull klicken (oder F6 auf der Tastatur betätigen) und beginnen, den Katheter aus der Blase des Patienten zurückzuziehen. Wenn
Sie den UPP-Puller verwenden, beginnt dieser, den Katheter in der voreingestellten Geschwindigkeit aus der Blase des Patienten
zurückzuziehen.

13. Wenn der Pura-Sensor des Katheters vollständig draußen ist, Stop Pull klicken (oder F6 betätigen).

14. Return für den Rückzug des nächsten Katheters wählen und den Katheter wieder einführen.

15. Wenn er fertig ist, auf die Stop-Schaltfläche und dann auf Save klicken, um die Untersuchungsdatei zu speichern.

16. Drucken Sie die Ergebnisse der Untersuchung auf Wunsch aus.

17. Katheter, EMG-Elektroden, Druckschlauch, Wandlerkartuschen und Pumpenschlauch entfernen und gemäß den Verfahren des
Krankenhauses/der Klinik entsorgen.
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FEHLERSUCHE/-BESEITIGUNG UND SERVICE 

Wenden Sie sich unter 1-800-333-1039 oder per E-Mail an service@laborie.com an das Serviceteam von LABORIE, wenn die Probleme weiter bestehen. 

Symptom(e) Mögliche Ursache(n) Überprüfung/Korrekturmaßnahme(n) 

ALLE GERÄTE 

Keine Reaktion der 
Geräte? 

Kein Strom an der 
Steckdose? 

System an einer bekannterweise funktionierenden Steckdose anschließen. 

Beschädigtes Netzkabel? System ausstecken und Kontakt zu LABORIE aufnehmen, um ein Ersatznetzkabel zu erhalten. 

Netzkabel nicht korrekt 
angeschlossen? 

Sicherstellen, dass das Netzkabel fest und sicher mit dem Unterteil des Systems und der 
Steckdose verbunden ist. 

Geräte nicht mit Software 
verbunden? 

Geräte mit dem System verbinden. 

Falscher Verbindungstyp? Sicherstellen, dass der korrekte Verbindungstyp (entweder Bluetooth oder USB) im 
Untermenü Connection Type ausgewählt ist. Siehe Seite 270. 

Computer oder Drucker 
lassen sich nicht 
einschalten? 

Kein Strom an der 
Steckdose? 
Beschädigtes Netzkabel? 
Netzkabel nicht korrekt 
angeschlossen? 

Sicherstellen, dass die Steckdose Strom führt, die Netzkabel nicht beschädigt und an beiden 
Enden sicher befestigt sind. 

USB ist verbunden, es 
leuchtet aber nur die 
orangefarbene Batterie-
LED und es ist kein Bild 
auf dem Bildschirm und 
keine Reaktion von der 
Tastatur? 

Batterie leer? Bis zu 30 Minuten warten, bis die Batterie ausreichend für eine Systemreaktivierung 
aufgeladen ist. 
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Symptom(e) Mögliche Ursache(n) Überprüfung/Korrekturmaßnahme(n) 

Es besteht keine 
externe 
Stromverbindung und 
der ROAM™ kann nicht 
via OK-Schaltfläche 
oder Bluetooth-
Verbindung aktiviert 
werden? 

Batteriespannung 
unterhalb des 
Aktivierungslevels? 

Bis zu 30 Minuten warten, bis die Batterie ausreichend für eine Systemreaktivierung 
aufgeladen ist. 

Gerät zeigt teilweise 
Aufladung an, obwohl 
die Batterie vollständig 
geladen ist (d. h. sie war 
länger als 5 Stunden im 
Ladegerät)? 

Neustart erforderlich? Das gesamte System neu starten. 

EMG 

EMG Messwerte zu 
hoch/niedrig? 

EMG Kanalskala nicht 
optimiert? 

Skala im laufenden Betrieb anpassen, dafür auf die Skalenwerte klicken und neue Werte 
eingeben. 

Elektroden sind feucht 
oder haften allgemein 
nicht an? 

Den Bereich ggf. rasieren und trocken wischen. Ausreichend abkleben, um die Feuchtigkeit 
draußen zu halten. 

Elektrode abgelöst? Elektrode wieder anbringen. 

Wasser/Urin über die 
Elektroden gelaufen? 

Bereich mit einem Tuch abtrocknen und die Elektroden austauschen. 
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Symptom(e) Mögliche Ursache(n) Überprüfung/Korrekturmaßnahme(n) 

Keine Spitzenreaktion 
im EMG und 
Ausgangswert ist flach? 

Elektroden erfassen nicht 
die richtige 
Muskelgruppe?  

Entweder eine oder beide Messelektroden (die an den roten Leitungen befestigt sind) 
bewegen, um sie enger zueinander zu bringen. 

EMG-Reaktion ist zu 
hoch und Kanal 
gesättigt? 

Elektroden erfassen nicht 
die richtige 
Muskelgruppe? 

Entweder eine oder beide Messelektroden (die an den roten Leitungen befestigt sind) 
bewegen, um sie weiter voreinander zu entfernen. 

DRÜCKE 

Druck reagiert nicht? Position der Katheter? Position prüfen und ggf. anpassen. 

Katheter nicht fest mit 
Kabel verbunden? 

Verbindungen prüfen und ggf. anpassen. 

Nulleinstellungen nicht 
korrekt vorgenommen? 

Nulleinstellung erneut vornehmen. 

Katheter geknickt? Katheter gegebenenfalls austauschen. 

Verwendung von 
wasserbasiertem 
Verbrauchsmaterial? 

Leitungen spülen und Nulleinstellung wiederholen. Sicherstellen, dass alle Absperrhähne in 
der richtigen Position sind. 

PUMPE 

Pumpe läuft nicht? Pumpe nicht kalibriert? Pumpe kalibrieren. 

Pumpen-Druckgrenzwert 
erreicht? 

P1 (Pves) auf Null zurücksetzen. Blasenkatheter auf Knicke überprüfen. 

Volumengrenzwert 
überschritten? 

VH2O-Kanal wieder auf Nullwert setzen und erneut versuchen. 

Pumpenkalibrierung nicht 
korrekt? 

Versuchen, die Pumpe erneut zu kalibrieren. 

Pumpenrate auf 1 ml/min 
eingestellt? 

UDS-Software schließen und eine Minute warten. Dann die Software erneut starten. 
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Symptom(e) Mögliche Ursache(n) Überprüfung/Korrekturmaßnahme(n) 

Einstellungen der 
pädiatrischen Pumpe 
nicht korrekt? 

Der Einstellungsschalter 
der pädiatrischen Pumpe 
auf Erwachsene gesetzt? 

Um die Pumpenraten korrekt für pädiatrische Patienten einzustellen, diese Schritte 
befolgen. 

• Eine Zystometrie-Untersuchung öffnen (oder eine andere Untersuchungsdatei mit
einer Pumpe).

• Die Patienteninformationen für den pädiatrischen Patienten eingeben.

• Körpergröße und Körpergewicht eingeben, um den berechneten MPUR-Wert zu
sehen.

• Die Option Use MPUR for pump speeds im Abschnitt Fill Rate auswählen.

• Auf Save klicken.

• Yes klicken.

• Auf Run und danach auf Start Pump auf dem Bedienfeld klicken.

• Au Info und dann auf Patient information klicken.

• Auf OK klicken.

• Erneut Use MPUR for pump speeds auswählen.
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Symptom(e) Mögliche Ursache(n) Überprüfung/Korrekturmaßnahme(n) 

• OK klicken, um die korrekten MPUR-Geschwindigkeiten für die Untersuchungen zu
laden.

Einrichtung der Pumpe bei Software-Start: 

• UDS-Software öffnen.

• Auf CFG klicken.

• Patienteninformationen eingeben, um die korrekten Pumpenraten zu laden.

UROCAP™ V 

Uroflowmeter-Signal 
zeigt Vibrations- und/ 
oder Zackenmuster? 

Kunststoffbecher berührt 
den Flow-Trichter? 

Uroflowmeter erneut positionieren und prüfen. 

Patient hat Uroflowmeter 
mit den Füßen berührt? 

Patienten auffordern, sich während der Untersuchung ruhig zu verhalten. 

Boden ist wackelig? Auf einen festen Untergrund wechseln. 

Falsche Flow- oder 
Volumenmesswerte? 

Becher nicht korrekt in der 
Uroflowmeterschale 
platziert? 

Becherposition anpassen. 

Trichter berührt den 
Becher? 

Miktionsstuhl oder Uroflowmeter ausrichten. 

Verwendeter Becher nicht 
korrekt? 

NUR von Laborie gelieferte Becher verwenden. 

Fehlermeldung auf dem 
Bildschirm lautet: 
„Calibration 
Failure…(Flow out of 
range.)“ 

Wasser zu schnell in den 
Becher gelassen? 

Wasser langsam und mit gleichmäßiger Geschwindigkeit einlassen. 

Mehr als 500 ml in den 
Becher gelassen? 

500 ml Wasser müssen in den Becher gelassen werden. 

Fehlermeldung auf dem 
Bildschirm lautet: 
“Calibration Failure… 
(Volume delta out of 

Weniger als 500 ml in den 
Becher gelassen? 

500 ml Wasser müssen in den Becher gelassen werden. 
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Symptom(e) Mögliche Ursache(n) Überprüfung/Korrekturmaßnahme(n) 

range.)” 

BLUETOOTH-VERBINDUNG 

Keine 
Verbindungsherstellung 
via Bluetooth? 

Verbindung 
unterbrochen? 

Die Entfernung zwischen Gerät und Computer verringern. Der maximale Abstand zwischen 
dem Prozessor und dem Computer kann bis zu 10 Meter betragen).  

Physikalische Barrieren wie Wände, Pfosten, Türen oder Menschen dazwischen vermeiden. 

Keine Bluetooth-
Verbindung bei 
Inbetriebnahme? 

Verbindung 
unterbrochen? 

• Auf die Bluetooth-Taste klicken, um das Gerät zu reaktivieren und eine Verbindung
herzustellen.

• 5 Minuten warten.

• Wenn durch die Tastenbetätigung keine erneute Verbindung hergestellt werden kann, die
Reset-Taste des Systems am Turm betätigen, um das gesamte System erneut zu starten.

• Nach dem Neustart warten, bis alle Verbindungen wieder hergestellt sind.

Keine Verbindung zum 
PC via Touchscreen? 

Verbindung 
unterbrochen? 

• Zuerst alle Bluetooth-Geräte über den Touchscreen trennen.

• Die Software erneut starten und eine Verbindung zum PC herstellen. Informationen zum
Anschluss an den PC finden Sie auf Seite 79.

• Alle Bluetooth-Geräte wieder über den Touchscreen anschließen.

EREIGNISSE (EVENTS) 

Auf der Grafik ist ein 
„Transducer change” 
Ereignis markiert? 

Kabel am Gerät ange-
schlossen/getrennt? 

Dieses Element wird auf der Grafik markiert, um zu helfen, das Ereignis von einem 
tatsächlichen Signal zu unterscheiden, das während der Untersuchung eingeht. Es ist auch 
markiert, wenn der ROAM™ Dx durch einen Auto-Recovery-Prozess geht. 
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Symptom(e) Mögliche Ursache(n) Überprüfung/Korrekturmaßnahme(n) 

SOFTWARE-FEHLERMELDUNGEN 

I-LIST Reporter

Fehlermeldung: 
Fehlercode: „66a (Can't 
install KB2160841)” 
erscheint? 

.NET Framework-Datei 
muss repariert werden 

• Auf Start > Control Panel > klicken und dann auf Add or Remove Programs doppelklicken
– ODER-– auf Start > Control Panel > Programs > Programs and Features klicken.

• In der sich öffnenden Liste auf die Datei Microsoft .NET Framework 4 Client Profile
rechtsklicken und dann Change ODER Uninstall/Change auswählen.

• Auf Repair klicken, um die Datei zu reparieren und bevor Sie fortfahren warten, bis die
Reparatur beendet ist.

• Den Computer erneut starten.

UDS-Bericht nicht an i-
LIST Office Reporter 
übermittelt? 

Vergewissern Sie sich, dass 
i-LIST MsgQListener in 
Betrieb ist. 

• Alle offenen Programme schließen.

• Vergewissern Sie sich, dass i-LIST Message Queue Listener in Betrieb ist, dafür auf Start >
Programs > Laborie > i-LIST MsgQListener klicken.

• Den Computer neu starten und versuchen, einen Bericht an i-LIST Office Reporter zu
senden. Wenn dies keinen Erfolg hat, die nachstehende Lösung ausprobieren.

Installation von Windows-
Updates 

• Alle offenen Programme schließen.

• Auf Start > Control Panel klicken und dann auf Windows Updates doppelklicken - ODER -
auf Start > All Programs > Windows Updates klicken. Wenn Updates für die Installation
vorhanden sind, diese installieren und den Computer dann erneut starten.

• Danach versuchen, einen Bericht an i-LIST Office Reporter zu senden. Wenn dies keinen
Erfolg hat, die nachfolgende Lösung versuchen, um die .NET-Datei zu reparieren.

Reparatur der .NET 
Framework-Datei 

• Auf Start > Control Panel > klicken und dann auf Add or Remove Programs doppelklicken
– ODER – auf Start > Control Panel > Programs > Programs and Features klicken.

• In der sich öffnenden Liste auf die Datei Microsoft .NET Framework 4 Client Profile
rechtsklicken und dann Change ODER Uninstall/Change auswählen.

• Auf Repair klicken, um die Datei zu reparieren und warten, bis die Reparatur beendet ist.

• Den Computer neu starten und dann versuchen, einen Bericht an i-LIST Office Reporter zu
senden.
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Fehlermeldung erscheint nach dem Neustart des 
Systems und gibt an, dass Geräte nicht gefunden 
werden: 

• Nicht irgendwo auf den Bildschirm klicken. Warten, bis die Meldung verschwunden ist.
Mit der üblichen Anwendung fortfahren, wenn die Meldung verschwunden ist.

PC 

PC lässt sich nicht 
einschalten? 

Stromunterbrechung 
aufgrund von 
Stromausfall? 

• Das Netzkabel aus dem externen Netzteil ziehen.

• Die Einschalttaste am Computer drücken und 5 Sekunden gedrückt halten.

• Warten, bis sich die Lampen über dem Netzteil ausschalten.

• Das Netzkabel wieder in das externe Netzteil stecken.

• Die Einschalttaste am Computer betätigen, um den PC wieder einzuschalten.
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DRUCKER 

Drucker-LED leuchtet 
nicht? 

Drucker-Netzkabel 
herausgezogen? 

Druckerkabel einstecken und es erneut versuchen. 

Drucker nicht 
eingeschaltet? 

Drucker durch Drücken auf die Einschalttaste anschalten. 

Fehler-LED am Drucker 
leuchtet dauernd oder 
blinkt? 

Drucker ohne Papier? Druckerpapier nachlegen. 

Druckerabdeckung offen? Druckerabdeckung schließen. 

Drucker ohne Druckfarbe? Druckerkartuschen auswechseln. 

Papierstau oder 
Zuführungsfehler im 
Drucker? 

Papierproblem beheben und dann auf Papiervorschubtaste drücken. 

LUFTBLASENDETEKTOR 

Rote Lampe am Sensor 
leuchtet, obwohl keine 
Luftblasen zu sehen 
sind 

Pumpenschlauch nicht 
korrekt eingeführt? 

Sicherstellen, dass der Pumpenschlauch fest in der Einkerbung am Sensor platziert ist. 
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BEDIENFELD 
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Script-Schaltflächen 
(Uroflow Summary, 
Summary Review usw.) 
funktionieren nicht 
mehr? 

Programmdatei für die 
Formatierung der 
Schaltflächen nicht korrekt 
eingerichtet? 

Das für die Formatierung der Script-Schaltflächen verwendete 
Programm muss das Format AutoHotKey.ahk verwenden. Um 
zu prüfen, ob das Programm korrekt ist, diese Schritte 
befolgen: 

• Zu C:\UDS120 gehen und das HK-Verzeichnis öffnen.

• Sicherstellen, dass die Symbole für Dateiformat auf die
AutoHotKey-Anwendung eingestellt sind, wie rechts
dargestellt.

Fortsetzung auf der nächsten Seite 

• Wenn dies nicht der Fall ist, d. h. die Symbole zum
Beispiel im Notepad-Format sind (wie hier darge-
stellt), müssen die Symbole auf die AutoHotKey-
Anwendung geändert werden.

• Auf eine beliebige Zeile rechtsklicken und Properties
auswählen.

• Im Bereich Opens with auf die Schaltfläche Change
klicken und die AutoHotKey Unicode Anwendung im
sich öffnenden Fenster auswählen und dann OK
klicken.

Im Bereich Opens with wird dann die AutoHotKey-Anwendung angezeigt. 
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• Auf OK klicken.

TOUCHSCREEN 

Touchscreen am Turm 
„eingefroren“? 

Die Reset-Taste am Hub (CHC) 5 Sekunden lang drücken, um das System zurückzusetzen. 
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SOFTWARE-LIZENZVEREINBARUNG FÜR ENDANWENDER 

Lizenzen und Geschäftsbedingungen für LABORIE-Produkte und -Dienstleistungen sind wie folgt zu finden: 

Lizenzvereinbarung für Endanwender: http://www.laborie.com/eula/ 

Geschäftsbedingungen: http:// http://www.laborie.com/terms-and-conditions/ 
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AMHANG 

ANHANG A. SYSTEMSPEZIFIKATIONEN 

GERÄTESPEZIFIKATIONEN 

Für einen ordnungsgemäßen Betrieb erfordert das Gerät Netzstrom - 110 VAC oder 240 VAC. 

AQUARIUS® Rollwagen AQUARIUS® CT ROLLWAGEN: EINZELDISPLAY 
L = 90,0 cm 
B = 66,0 cm 
H = 120,0 cm  
AQUARIUS® CT ROLLWAGEN: DUAL-DISPLAY 
L = 90,0 cm 
B = 88,0 cm* 
H = 120,0 cm 
*Dies ist die Arbeitsbreite, kann beim Passieren von Türen gedreht werden.

AQUARIUS® XT TURM 
L = 60,0 cm 
B = 66,0 cm 
H = 120,0 cm 

AQUARIUS® XT PC-ROLLWAGEN: EINZELDISPLAY 
L = 90,0 cm 
B = 66,0 cm 
H = 120,0 cm 
AQUARIUS® XT PC-ROLLWAGEN: DUAL-DISPLAY 
L = 90,0 cm 
B = 88,0 cm* 
H = 120,0 cm 
*Dies ist die Arbeitsbreite, kann beim Passieren von Türen gedreht werden.

AQUARIUS® LT 
L = 81,0 cm 
B = 66,0 cm 
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H = 120,0 cm 

AQUARIUS® CTS 
L = 90,0 cm 
B = 66,0 cm 
H = 120,0 cm 

Betriebsbedingungen Temperaturen: 15 °C bis 35 °C 
Feuchtigkeit: 30 % bis 75 % relative Feuchtigkeit (nicht kondensierend) 
Druck: 700 hPa bis 1.014 hPa 

Transport- und Lagerbedingungen Temperatur: -10 °C bis 50 °C 
Feuchtigkeit: 20 % bis 80 % relative Feuchtigkeit (nicht kondensierend) 
Druck: 700 hPa bis 1014 hPa 

Pumpenhub 
Art.-Nr. PMP1000 

Ausgangskanäle: 2 Infusion / 1 Luftblasen / 1 USB Typ A / 1 USB Typ B 

 Roam™ DX 
Art.-Nr. RMX1000 

Abmessungen: 14 cm L x 9,3 cm B x 3,9 cm H 
Gewicht: 0,27 kg 
Druckbereich: -50 bis +350 cmH2O; EMG-Bereich: 0 bis 1.000 µV 
Ausgangskanäle: 4 Druck / 1 EMG / 1 Druck/EMG 
Abtastrate (jeder Kanal): Druck = 50 Hz max.; EMG = 5000 Hz max. / 10 – 100 Hz (Schritte von 10 Hz) 

Urocap™ V 
Art.-Nr. TRA1002 

Abmessungen: 16,0 cm L x 16,0 cm B x 6,6 cm H 
Gewicht: 0,43 kg 
Durchflussbereich: 0 bis 50 ml/s; Volumenbereich: 0 bis 1.000 ml 
Ausgangskanäle: Flow; Volumen 
Abtastrate: Flow = 100 Hz max.; Volumen = 100 Hz max. 

UPP (Arm und Ständer) 
Art.-Nr. UPP1001 und UPP1000 

Abmessungen: 59,7 cm L x 59,7 cm B x 90,4 cm H 
/ Armverlängerung: 76 cm 
Luxo: Verlängerung 91,5 cm / Gewicht: 1,5 kg 
Geschwindigkeit: 0 bis 3 mm/s 
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Maximalbelastung von 
Druckerablage und 
Workstationablage 

20 Lbs. 9 kg 

Spinning-Disk-Flowtransducer 
Art.-Nr. 9034K0103  

Breite*: 400 mm 
Tiefe*: 485 mm 
Höhe*: 735-925 mm 
Gewicht*: Weniger als 3,5 kg 
Kabellänge*: 310 cm 
Anzahl Kanäle: 1 
Stromversorgung: Stromverbrauch: max 1,0 A; Eingang: 24 V DC/1,0 A; Ausgang: Tacho 
Genauigkeit: Siehe Genauigkeit des Hauptgeräts. 
Lagerung / Transport: 

• Temperatur -40° bis +70 °C

• Feuchtigkeit 10 % bis 100 rF (einschließlich Kondensation)

• Luftdruck 700 Pa bis 1.060 Pa
Betriebsbedingungen: 

• Temperatur +10 °C bis +40 °C

• Feuchtigkeit 30 % bis 75 %

• Luftdruck 700 Pa bis 1.060 Pa
Becherfüllvolumen: Stahlbecher 1,5 l; weißer Becher 1 l 

*Werte inkl. Ständer

T-DOC® Air-Charged™-Katheter

Betriebsbedingungen 15C bis 40C 

Lagertemperatur: -25C bis +50C

Anorektale Manometrie (ARM) 

Untersuchungsmöglichkeiten Stationär Ruhe und Squeeze  
Pushing 
Rektalvolumen 
Rektoanaler Inhibitionsreflex (RAIR) 
Ballonexpulsion 
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Berechnungen Rektum-Compliance (ml/mmHg) 
RAIR-Inhibitions- und Exzitationscharakteristika 
Ruhe-, Durchschnitts- und Max. Druck (mmHg) 
Ermüdungsratenindex (min) 
Analkanallänge (cm) oder Hochdruckzone (cm) 
Ultra Slow-Wellenanalyse 
Druckbereichsfunktionen 

Katheter T-DOC Air-charged™ -> 4-Kanal, radial
Unisensor elektronisch -> 4-Kanal, radial -> 8-Kanal, radial
MUI wasserperfundiert -> 4-Kanal, radial -> 8-Kanal, radial
Rektaldruckmessung für bestimmte Optionen erhältlich

Genauigkeit Druck: +/- 5 %  
EMG: +/- 6 %  
Volumen bei Verwendung des Messwertwandlers für Infusion: +/- 10 % 

KLASSIFIZIERUNGEN UND GELTENDE RICHTLINIEN 

Klassifizierungen Anwendungsteil Klasse I Typ BF 

Betriebsart: Kontinuierlich 
Gerät ist nicht für die Verwendung bei Vorhandensein einer entflammbaren anästhetischen Mischung mit Luft, 
Sauerstoff oder Distickstoffoxid geeignet. 

Geltende Richtlinien und Normen Richtlinien: 
Food and Drug Administration Code of Federal Regulations 21 CFR 820 „Quality System Regulation.“ 
Europäische Medizinprodukterichtlinie 93/42/EWG 
SOR/98-282 Health Canada Medical Device Regulations 

Normen:  
EN ISO 13485 (EU) 
EN ISO 13485 
CAN/CSA ISO 13485 (Kanada) 
EN ISO 14971 
EN 60601-1 
EN 60601-1-2 
EN 60601-1-6 
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EN 62304  
EN 62366  
EN ISO 15223-1 
EN ISO 7010 
EN 1041  
UL 60601-1  
CAN/CSA C22.2 No. 601.1-M90 
CAN/CSA C22.2 No. 60601-1 
ANSI/AAMI ES 60601-1:2005 

Die neuesten produktbezogenen Normen entnehmen Sie bitte der EG-Konformitätserklärung. 

Spinning-Disk-Flowtransducer 

Klassifizierungen Schutzgrad gegen Stromschlag: 
Typ BF (Body Floating, Körperbezug mit Stromfluss): Das Anwendungsteil bietet einen bestimmten Schutzgrad gegen 
Stromschlag, insbesondere hinsichtlich der erlaubten Leckstrommenge. 
Das Anwendungsteil ist mechanisch isoliert (Floating). 

Nicht für die direkte Anwendung am Herzen bestimmt. 

Schutzgrad gegen schädliches Eindringen von Wasser: IP33 

Sicherheitsgrad bei Vorhandensein entflammbarer Anästhetika: Dieses Gerät ist nicht für die Verwendung mit 
brennbaren Mischungen aus Anästhetika und Luft, Wasser oder Distickstoffoxid bestimmt. Gefahr der elektrischen 
Zündung. 

Betriebsart: Kontinuierlicher / intermittierender Betrieb. 

ANWENDUNGSTEILE TYP BF 

• EMG/CMG

• Druckwandler
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ANHANG B. SYMBOLE UND BESCHILDERUNG/ETIKETTIERUNG 

LABORIE Unternehmenslogo 
CE Kennzeichen - Europäisches 

Konformitätssymbol 
SGS-Zertifizierung - nach US-

amerikanischen und kanadischen 
Sicherheitsnormen zertifiziert. 

Herstellungsdatum Hersteller 

Gebrauchsanweisung 
beachten Benutzerhandbuch lesen 

Bevollmächtigter Vertreter in der 
Europäischen Union 

Katalognummer Seriennummer 

Elektrogerät der Klasse II Anwendungsteil Typ BF 
Verwendbar bis 

Steril Mit Ethylenoxid sterilisiert 

Wechselstrom 

Gleichstrom Hochfrequenz (HF) übertragendes 
Gerät 

Nicht im Restmüll entsorgen. 
Entsprechend den örtlichen 
Bestimmungen entsorgen. 

Nur für den Einmalgebrauch - 
Nicht wiederverwenden 

Richtung des Pumpenflusses Trocken lagern 
Charge - Batchcode 

Stop-/Resettaste des Geräts: 
Zum Zurücksetzen drücken und 3 

Sekunden gedrückt halten. 
Drücken und 5 Sekunden oder 
länger gedrückt halten, um das 

Gerät in den Ruhezustand zu 
versetzen. 

Sicherheitsschild, Nicht Drücken 
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Hochfrequenz (HF) 
übertragendes Gerät 

Sicherheitsschild, sichere 
Arbeitslast (Ablage) 

Sicherheitsschild, Sitzen 
verboten

Sichere Arbeitslast des 
Systems 

Sicherheitsschild, sichere 
Arbeitslast (CTS-Ablage)

Schutzleiter, Erdung 
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PRODUKTSCHILDER 

• Gerätekennzeichnungsschilder sind entweder am Rollwagenstandbein oder an der Seite des LIT-Gehäuses zu finden.

• Jedes Schild enthält einige der oder alle folgenden Informationen:
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ANHANG C. ELEKTROMAGNETISCHE VERTRÄGLICHKEIT (EMV) 

Dieses Gerät wurde geprüft und entspricht den Einschränkungen für: 

IEC 60601-1-2:2007 (Ed. 3.0) Medizinische elektrische Geräte – Teil 1-2: Allgemeine Festlegungen für die Sicherheit einschließlich der wesentlichen 
Leistungsmerkmale – Ergänzungsnorm: Elektromagnetische Verträglichkeit – Anforderungen und Prüfungen 

IEC 61000-3-2:2009  Grenzwerte für Oberschwingungsströme (Geräte-Eingangsstrom = 16 A je Leiter) 

IEC 61000-3-3:2008 Begrenzung von Spannungsänderungen, Spannungsschwankungen und Flicker in öffentlichen Niederspannungs-
Versorgungsnetzen für Geräte mit einem Bemessungsstrom = 16 A je Leiter, die keiner Sonderanschlussbedingung 
unterliegen. 

IEC 61000-4-2:2008 Prüf- und Messverfahren - Prüfung der Störfestigkeit gegen die Entladung statischer Elektrizität 

IEC 61000-4-3:2010 Prüf- und Messverfahren - Prüfung der Störfestigkeit gegen hochfrequente elektromagnetische Felder. Ausgabe 3.2. 

IEC 61000-4-4:2012 Prüf- und Messverfahren - Prüfung der Störfestigkeit gegen schnelle transiente elektrische Störgrößen/Burst. 

IEC 61000-4-5:2005 Prüf- und Messverfahren - Prüfung der Störfestigkeit gegen Stoßspannungen 

IEC 61000-4-6:2003+A1:2004+A2:2006 Prüf- und Messverfahren - Störfestigkeit gegen leitungsgeführte Störgrößen, induziert durch hochfrequente Felder. 

IEC 61000-4-8:2009 Prüf- und Messverfahren - Prüfung der Störfestigkeit gegen Magnetfelder mit energietechnischen Frequenzen. 

IEC 61000-4-11:2004 

Prüf- und Messverfahren - Prüfungen der Störfestigkeit gegen Spannungseinbrüche, Kurzzeitunterbrechungen und 
Spannungsschwankungen 

CISPR 11:2010 Industrielle, wissenschaftliche und medizinische Geräte - Funkstörungen - Grenzwerte und Messverfahren. 

CISPR 22:2008 Einrichtungen der Informationstechnik - Funkstöreigenschaften - Grenzwerte und Messverfahren 

Um eine Trennung der Bluetooth-Verbindung zu verhindern, Funkstörungen durch andere Geräte oder Ausrüstung, wie Mikrowellen, WLAN, kabellose/drahtlose Technologie auf 2,4 GHz 
beschränken. 

1. Diese Einschränkungen dienen dem angemessenen Schutz gegen störende elektromagnetische oder andere Interferenzen bei den meisten Installationen. Es wird jedoch keinerlei Garantie dafür 
übernommen, dass bei einer bestimmten Installation keine Interferenzen vorkommen. Sollte dieses Gerät zu störenden elektromagnetischen oder anderen Interferenzen führen, was durch Ein- 
und Ausschalten des Geräts geprüft werden kann, wird der Benutzer dazu angehalten, die Interferenzen mithilfe einer der folgenden Maßnahmen zu unterbinden:

• Neuausrichtung oder Neupositionierung des AQUARIUS®-Geräts. 

• Erhöhung des Abstands zwischen dem AQUARIUS®-Gerät und der betreffenden Ausrüstung. 

• Anschließen der nicht-medizinischen Systemausrüstung an einen anderen Stromkreis als den, an den das AQUARIUS®-Gerät angeschlossen ist.

• Bitten Sie ggf. den Händler oder erfahrenes technisches Personal um Hilfe.
WARNHINWEIS! Änderungen, die von LABORIE nicht ausdrücklich genehmigt wurden, können die Betriebserlaubnis des Geräts erlöschen lassen. 

2. Dieses Gerät entspricht Teil 15 der FCC-Vorschriften. Der Betrieb unterliegt den folgenden beiden Bedingungen: (1) Dieses Gerät darf keine schädlichen Interferenzen verursachen, und (2) dieses 
Gerät muss empfangende Interferenzen aufnehmen können, auch Interferenzen, die eventuell einen unerwünschten Betrieb verursachen.

3. Dieses Gerät enthält: FCC ID: PVH0946 IC: 5325A-0946. 
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ANHANG D. HÄUFIG VERWENDETE UNTERSUCHUNGSKONFIGURATIONEN 

Untersuchungs- 
Name 

Kanal 
Titel 

Skala Math-Definition 
Daten 
rate 

Anzeige 
Attribut 

Uroflowmetrie 
Flow 40 ml/s Null 5 Punkte/s Grafisch 

Volumen 600 ml Null 5 Punkte/s Grafisch 

Zystometrie 
mit 

EMG 

Pves 100 cmH2O Null 5 Punkte/s Grafisch 

EMG 400 (keine) Null 5 Punkte/s Grafisch 

IH2O 200 ml/min Null 5 Punkte/s Grafisch 

VH2O 1.000 ml Null 5 Punkte/s Grafisch 

Advanced 
CMG 

Pves 100 cmH2O Null 4 Punkte/s Grafisch 

Pabd 100 cmH2O Null 4 Punkte/s Grafisch 

Pdet 100 cmH2O PvesPabd 4 Punkte/s Grafisch 

EMG 400 (keine) Null 4 Punkte/s Grafisch 

IH2O 200 ml/min Null 4 Punkte/s Digital 

VH2O 1.000 ml Null 4 Punkte/s Digital 

Einfach 
Druck/Fluss 

Pves 100 cmH2O Null 3 Punkte/s Grafisch 

Flow 40 ml/s Null 3 Punkte/s Grafisch 

Volumen 1.000 ml Null 3 Punkte/s Grafisch 

Advanced 
Druck/Fluss 

Pves 100 cmH2O Null 3 Punkte/s Grafisch 

Pabd 100 cmH2O Null 3 Punkte/s Grafisch 

Pdet 100 cmH2O PvesPabd 3 Punkte/s Grafisch 

Flow 40 ml/s Null 3 Punkte/s Grafisch 

Volumen 1.000 ml Null 3 Punkte/s Digital 

IH2O 200 ml/min Null 3 Punkte/s Digital 
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Untersuchungs- 
Name 

Kanal 
Titel 

Skala Math-Definition 
Daten 
rate 

Anzeige 
Attribut 

VH2O 1.000 ml Null 3 Punkte/s Digital 

EMG 400 (keine) Null 3 Punkte/s Grafisch 

UPP 

Pura 150 cmH2O Null 5 Punkte/s Grafisch 

Pves 150 cmH2O Null 5 Punkte/s Grafisch 

Pclo 150 cmH2O PuraPves 5 Punkte/s Grafisch 
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ANHANG E. GLOSSAR DER BEGRIFFE UND ABKÜRZUNGEN 

FÜR URODYNAMISCHE UNTERSUCHUNGEN VERWENDETE BEGRIFFExxxiii 

Anmerkungen in Kursivschrift weisen auf eine Nutzung hin, die speziell für LABORIEs Urodynamik-Untersuchungsprotokolle Anwendung findet. 

• Abdominaler Druck: (Pabd) der die Blase umgebende Druck, wird gewöhnlich über das Rektum oder die Vagina gemessen.
o Standardkanal in CMG- oder Druck-/Fluss-Untersuchungen, gemessen in cmH2O.

• Abdominaler Leak Point Pressure: (ALPP) der intravesikale Druck, bei dem es zu Flüssigkeitsverlust aus der Blase kommt, der durch erhöhten
abdominalen Druck aufgrund von Anstrengung oder Husten hervorgerufen wird. Ein ALPP von weniger als 60 cmH2O wird als intrinsische
Sphinkterinsuffizienz betrachtet. Ein ALPP höher als 90 cmH2O kann auf eine hypermobile Urethra hinweisen und zeigt ein geringes Risiko für eine
intrinsische Sphinkterinsuffizienz.

o Standard-Annotation im Event-Menü, häufig auf dem Bedienfeld.

• Akontraktiler Detrusor (vormals areflektische Blase): Nichtvorhandensein der Detrusor-Kontraktion bei urodynamischer Beurteilung.

• Fläche unter der Kurve: Eine Berechnung der Fläche innerhalb der Kurve eines Urethradruckprofils.

• Blasendruck: (Pves, intravesikaler Druck) Druck innerhalb der Blase.
o Standardkanal in CMG-, Druck-/Fluss- oder UPP-Untersuchungen, gemessen in cmH2O.

• Kalibrierung: „Überprüfung der Kalibrierung“ - Überprüfung der Genauigkeit der Messungen.

• Rekalibrieren: Ein Verfahren, um die Genauigkeit der Messungen zu korrigieren oder zu verbessern.

• Kapazität: Notation des Gefühls, wenn der Patient meint, den Drang zum Wasserlassen nicht mehr unterdrücken zu können. Dies ist der
Zeitpunkt, an dem der Patient die Freigabe erhält, seine Blase zu entleeren („Permission to void“).

o Standard-Annotation im Event-Menü, häufig auf dem Bedienfeld.

• Verschlussdruck: (Pclo) Der berechnete Wert, der den Unterschied zwischen dem Urethradruck und dem Blasendruck angibt. Pura–Pves = Pclo.
Ein Pclo von weniger als 20 cmH2O wird als intrinsische Sphinkterinsuffizienz betrachtet.

o Standardkanal in einer UPP-Untersuchung, gemessen in cmH2O.

• Zystometrogramm: (CMG) Die grafische Aufzeichnung der Blasendrücke. Wird am häufigsten in allgemeinen Urodynamik-Untersuchungen
verwendet.

o Zum Standard gehören Pves, Pabd, Pdet, EMG und Anzeige von infundiertem Volumen und Infusionsrate.
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• Detrusor: Die Muskelschicht um die Blase herum.

• Detrusor Leak Point Pressure (DLPP): Detrusordruck, bei dem es zu Harnverlust kommt.
o Bei Nichtvorhandensein entweder einer Detrusorkontraktion ODER eines erhöhten abdominalen Drucks.
o Am häufigsten bei neurologisch beeinträchtigten Patienten mit z. B. einer Wirbelsäulenverletzung zu beobachten. Ein DLPP höher als

40 cmH2O kann zur Schädigung des oberen Harntrakts führen.

• Detrusorüberaktivität: Charakterisiert durch unwillkürliche Detrusorkontraktion während der Füllphase der Urodynamik – entweder spontan
oder provoziert.

• Detrusorüberaktivität mit Inkontinenz: Inkontinenz infolge der unwillkürlichen Detrusorkontraktion.

• Detrusordruck: (Pdet) Der berechnete Druck, der die Komponente des intravesikalen Gesamtdrucks wiedergibt, der vom Detrusormuskel
erzeugt wird. Pves-Pabd = Pdet.

o Standardkanal in CMG- oder Druck-/Fluss-Untersuchungen, gemessen in cmH2O.

• Elektromyogramm: Die Messung der Nervenaktivität – wird in der Urodynamik verwendet, um die Sphinktermuskelaktivität zu kontrollieren.

• Enuresis: Unwillkürlicher Harnverlust, meist untergliedert als Enuresis nocturna, was unwillkürlicher Harnverlust während des Schlafs bedeutet.

• Füllphase (Einlagerungsphase): Häufig verwendet, um den CMG-Teil einer Urodynamik-Untersuchung zu beschreiben, diese Phase endet vor
der Blasenentleerung.

• Füllrate: Die Empfehlung der ICS liegt höher als die vorhergesagte maximale Füllrate (berechnet als Körpergewicht in kg geteilt durch 4).
Zwischen 10-100 ml/min definiert, liegt die typische Füllrate bei der Urodynamik bei Erwachsenen bei 50-60 ml/min.

o Üblicherweise als Digitalkanal während CMG- oder Druck-/Fluss-Untersuchungen angezeigt und gemessen in ml pro Minute.

• Erster Harndrang (First desire to void): In der Urodynamik das Gefühl, bei dem der Patient im nächsten geeigneten Moment wasserlassen
würde, die Miktion aber hinausgezögert werden kann.

o Standard-Annotation im Event-Menü, häufig auf dem Bedienfeld.

• Erstes Füllungsgefühl (First sensation of filling): In der Urodynamik das Gefühl, wenn der Patient das erste Mal die Blasenfüllung verspürt. Die
berichtete Empfindung von „Kälte“ (als Folge der infundierten Flüssigkeit mit Raumtemperatur) wird üblicherweise nicht als die „First
Sensation“ betrachtet.

o Standard-Annotation im Event-Menü, häufig auf dem Bedienfeld.

• Häufigkeit: Eine Erkrankung, wenn ein Patient zu häufig am Tag Harn lassen muss.

• Funktionelle Profillänge: Die Länge der Urethra, entlang derer der Harnröhrendruck den Blasendruck übersteigt.
o Berechnet innerhalb eines UPP-Segments, angezeigt als Länge der Kontinenzzone in mm.

• Harnverzögerung: Schwierigkeiten, die Blasenentleerung einzuleiten.
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• Idiopathische Detrusorüberaktivität (vormals „Detrusorinstabilität”): Inkontinenz aufgrund einer unwillkürlichen Detrusorkontraktion ohne
definierte Ursache.

• Inkompetenter Verschlussmechanismus der Harnröhre: Wenn die Harnröhre Harnabgang zulässt, ohne dass es zu einer Detrusorkontraktion
kommt.

• Inkontinenz: Der unwillkürliche Verlust von Urin. Kann unterteilt werden in: Stressinkontinenz, Dranginkontinenz, Mischinkontinenz (sowohl
Stress also auch Drang), Enuresis nocturna und situationsbedingte Inkontinenz.

• International Continence Society: (ICS) „Das primäre Interesse der International Continence Society ist die Untersuchung der Harnspeicher- 
und Entleerungsfunktion des unteren Harntrakts, die Diagnose und Behandlung der Funktionsstörung des unteren Harntrakts und die
Förderung der Forschung auf den Gebieten Pathophysiologie, Diagnosetechniken und Behandlung.“ Diese Gruppe erstellt Standards für
urodynamische Untersuchungen, die von Labories Medical Technologies ULC-Schulungsprogrammen befolgt werden.

• Intravesikaler Druck: (Pves) Der innerhalb der Blase gemessene Druck. Bitte beachten Sie, dass der Druck innerhalb der Blase aus zwei Quellen
stammen kann – Druck aus dem Körper (Pabd) und Druck aus dem die Blase umgebenden Muskel (Pdet). Vormals „intravesikaler Gesamtdruck“
genannt.

o Standardkanal in CMG-, Druck-/Fluss- oder UPP-Untersuchungen, gemessen in cmH2O.
• Intrinsische Sphinkterinsuffizienz: (ISD) Liegt im Allgemeinen bei einem maximalen Urethraverschlussdruck von weniger als 20 cmH2O oder einem

ALPP von weniger als 60 cmH2O vor.

• Leak Point Pressure: (LPP, ALPP, VLPP, CLPP) Der intravesikale Druck, bei dem ein unwillkürlicher Harnabgang bei erhöhtem abdominalen Druck
und nicht vorhandener Detrusorkontraktion festgestellt wird. Beispiel: Bei der Urodynamik festgestellter Harnabgang, wenn der Patient
aufgefordert wird, zu husten oder sich zu bücken. Dies kann mit dem Modifikator A für Abdominal, V für Valsalva oder C für Cough (Husten)
markiert werden, dies sind jedoch alle „Leak point pressures“.

o Der Druck wird in cmH2O angegeben.
• Symptome des unteren Harntrakts: (LUTS) Zu diesen können häufige Blasenentleerung, Harndrang, Inkontinenz, Nokturie, wiederkehrende

Harnwegsinfektionen und vieles andere gehören.

• Maximale zystometrische Kapazität: (Kapazität) Das Volumen, bei dem der Patient meint, den Drang zum Wasserlassen nicht mehr
unterdrücken zu können. Dies ist in der Urodynamik in der Regel der Zeitpunkt, an dem der Patient die Freigabe erhält, seine Blase zu entleeren
(„Permission to void“).

o Gemessen in ml. Standard-Annotation im Event-Menü, häufig auf dem Bedienfeld.
• Maximaler Urethraverschlussdruck: (MUCP) Der maximale Unterschied zwischen dem Urethradruck und dem intravesikalen Druck. In der

Urodynamik wird dieser am Pclo-Kanal gemessen und kann unabhängig oder während eines Urethradruckprofils aufgezeichnet werden.
o Gemessen in cmH2O.

• Maximaler Urethradruck: (MUP) Maximaler Druck des gemessenen Profils.
o Gemessen in cmH2O.

[DE]



LABORIE AQUARIUS XT/CT/LT/CTS Benutzerhandbuch AQS-UM01  403 

• Miktionsuntersuchung: Eine Druck-Fluss-Untersuchung. Diese Untersuchung umfasst Druckmessungen wie Pves und Pabd sowie Uroflow-
Messungen. Dies ermöglicht die Dokumentation des Zusammenhangs zwischen dem beim Miktionsereignis erzeugten Druck und der sich daraus
ergebenden Flowrate und des Flowmusters.

• Neuropathische Detrusorüberaktivität (vormals Hyperreflexie): Detrusorüberaktivität bei Vorhandensein einer neurologischen Erkrankung.
• Nokturie: Erkrankung, wenn Patienten nachts ein- oder mehrmals aufstehen müssen, um Wasser zu lassen.

• Enuresis nocturna: Erkrankung, wenn der Patient während des Schlafs Harnverlust hat.
• Normale Detrusorfunktion: Ermöglicht die Blasenfüllung mit geringer oder keiner Druckänderung, ohne unwillkürliche Kontraktionen trotz der

Provokation.

• Freigabe zur Blasenentleerung (Permission to void): Vorgenommene Anmerkung zum Zeitpunkt der berichteten Blasenfüllkapazität; gemäß ICS-
Empfehlung zu dokumentieren, wenn der Patient die Freigabe zum Wasserlassen erhält. Dies hilft dabei, zwischen unwillkürlichen
Kontraktionen und solchen zu unterscheiden, die willentlich gemacht werden, um die Blasenentleerung einzuleiten.

• Phasische Detrusorüberaktivität: Eine charakteristische Wellenform, die zur Inkontinenz führen kann oder nicht. Nachentleerungsvolumen:
(Post-void Residual, PVR) Das Urinvolumen, das nach dem Miktionieren in der Blase zurückbleibt.

• Druck-Fluss-Untersuchung: (Miktionsuntersuchung) Eine urodynamische Untersuchung, die Druckmessungen wie Pves und Pabd sowie
Uroflow-Messungen umfasst. Dies ermöglicht die Dokumentation des Zusammenhangs zwischen dem beim Miktionsereignis erzeugten Druck
und der sich daraus ergebenden Flowrate und des Flowmusters.

o Zum Standard gehören: Pves, Pabd, Pdet, EMG, Flow, Miktionsvolumen und Digitalanzeige von infundiertem Volumen und
Infusionsrate.

• Pumpenraten: Bei Betrieb der Pumpe die Rate, in der die Flüssigkeit während der urodynamischen Untersuchung in die Blase infundiert wird.
o Empfehlungen hierzu siehe „Füllrate“.

• Sensation (Empfindung): In der Urodynamik die vom Patienten berichteten Empfindungen während der Untersuchung, wie „First Sensation“,
„First Desire“, „Strong Desire“ und Gefühl des Erreichens der Blasenkapazität.

o Diese Empfindungen werden als Anmerkungen im Event-Menü und üblicherweise im Bedienfeld aufgezeichnet.
• Stressharninkontinenz: (SHI) Das Symptom des Harnabgangs in Verbindung mit einer Anstrengung, häufig bei Husten oder Niesen. Dies wird als

Beschwerde betrachtet, es sei denn, sie wird durch Urodynamik nachgewiesen, und wird dann Urodynamik-Stressinkontinenz genannt (vormals
echte Stressinkontinenz genannt).

• Starker Harndrang (Strong desire to void): Wird beschrieben als der anhaltende Drang, Harn zu lassen, ohne Angst vor Harnverlust zu haben.
• Subtraktionsdruck: Bezieht sich im Allgemeinen auf den Unterschied zwischen dem intravesikalen Gesamtdruck und dem abdominalen Druck –

Pdet.
o Pves-Pabd = Pdet.

• Terminale Detrusorüberaktivität: Eine einzelne unwillkürliche Detrusorkontraktion bei voller Blasenkapazität, die nicht unterdrückt werden
kann und zur Inkontinenz und meist zur vollständigen Blasenentleerung führt.
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• Gesamtprofillänge: Wird im Allgemeinen nicht als nützlicher Parameter betrachtet. Dies ist die Länge der Harnröhre, gemessen vom
Eintrittspunkt des Sensors in die Harnröhre bis zu dem Punkt, an dem der Sensor aus dem Körper austritt.

• Ungehemmt: Handlung ohne bewusste Einschränkung - wird häufig verwendet, um eine Blasenkontraktion zu beschreiben, die der Patient
nicht unterdrücken kann.

• Urethra: Die Röhre, die von der Blase bis zum Ausgang aus dem Körper führt.

• Urethradruck: (Pura) Der Druck, der erforderlich ist, um eine geschlossene Harnröhre zu öffnen.
o Gemessen in cmH2O.

• Urethradruckprofil: (UPP oder UDP) Die über die Gesamtlänge der Harnröhre gemessenen Drücke. Sie werden gemessen, indem der Katheter in
einer langsamen, bekannten Rate zurückgezogen wird (Empfohlen wird: 1 mm/s) Dies erfolgt am genauesten mit einer mechanischen
Zugvorrichtung (Puller).

o Zum Standard gehören: Pves, Pura und Pclo.

• Urethra-Relaxationsinkontinenz: Harnverlust aufgrund der Relaxation der Harnröhre ohne Vorhandensein eines erhöhten abdominalen Drucks
oder einer Detrusorkontraktion.

• Harndrang: Ein plötzliches dringendes Bedürfnis, Wasser zu lassen.
o Wenn darüber während der urodynamischen Untersuchung berichtet wird, kann eine Anmerkung erfolgen.

• Dranginkontinenz: Symptom der Inkontinenz in Verbindung mit einem starken und dringenden Bedürfnis, Wasser zu lassen.

• Urodynamik-Stressinkontinenz: (vormals echte Stressinkontinenz genannt) Der unwillkürliche Harnabgang bei erhöhtem abdominalen Druck ohne
Vorhandensein einer Detrusorkontraktion.

• Valsalva: Der Versuch, bei geschlossener Glottis gewaltsam auszuatmen - wird häufig verwendet, um den intraabdominalen Druck zu erhöhen.
o Wird verwendet, um Stressinkontinenz zu provozieren, kann als VLPP notiert werden.

• Miktionsphase (Entleerungsphase): Wird häufig verwendet, um den Teil einer urodynamischen Untersuchung zu beschreiben, in dem sowohl
Drücke als auch Flow-Parameter bei einem Miktionsereignis aufgezeichnet werden, dies würde sofort auf die „Füllphase“ folgen.

BERECHNUNGEN 

• BOOI = pdetQmax – 2Qmaxxxxiv

• BCI = pdetQmax + 5Qmaxxxxv

• BVE = (VV/BC) x 100xxxvi

IN DER URODYNAMIK HÄUFIG VERWENDETE ABKÜRZUNGEN 
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• ALPP: Abdominaler Leak Point Pressure

• BOOI: Blasenauslassobstruktionsindex (Bladder outlet
obstruction index)xxxvii

• BCI: Blasenkontraktionsindex

• BVE: Blasenentleerungseffizienz (Bladder voiding
efficiency)

• CLP: Cough Leak Point Pressure

• CMG: Zystometrogramm

• DLPP: Detrusor Leak Point Pressure

• DSD: Detrusor-Sphinkter-Dyssynergie

• EMG: Elektromyogramm

• FUL: Funktionale Urethraprofillänge

• ICS: International Continence Society

• IH2O: Rate der Flüssigkeitsinfusion

• ISD: Intrinsische Sphinkterinsuffizienz

• LinPURR: LinPURR (Linear Passive Urethral Resistance)
(Nomogramm ist in der UDS-Software verfügbar)

• LPP: Leak Point Pressure

• LUTS: Symptome des unteren Harntrakts (Lower
urinary tract symptoms)

• MCC: Maximale zystometrische Kapazität

• MUCP: Maximaler Urethraverschlussdruck

• MUP: Maximaler Urethradruck

• NGB: Neurogener Blasendruck - Pabd - abdominaler
Druck (Neurogenic bladder Pabd Abdominal pressure)

• Pabd: Abdominaler Druck

• Pclo: Verschlussdruck

• Pdet: Detrusordruck (oder Subtraktionsdruck)

• Pura: Urethradruck

• Pves: Intravesikaler Druck

• PVR: Nachentleerungsvolumen (Post-void residual)

• SHI: Stressharninkontinenz

• UDC: Ungehemmte Detrusorkontraktion

• UPP: Urethradruckprofil (auch UDP)

• URA: Urethra-Widerstandsfaktor - Nomogramm

• VH2O: Während des CMG infundiertes Volumen

• VLPP: Valsalva Leak Point Pressure

• VS: Valsalva

• VUR: Vesikoureteraler Reflux
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ANHANG F: ARM-WERTE 

MITTELWERTBEREICHxxxviii 

Kontinenzgrad 
Anzahl der 
Patienten (W:M) 

Ruhedruck 
(mmHg) 

Kneifdruck 
(mmHg) 

Rektales sensorisches 
Volumen (ml) 

Volumen für 
Reflexrelaxation 

Komplette Inkontinenz 39 (35/4) 51 (20–100) 88 (36-200) 31 (5-120) 18 (10-50) 

Partielle Inkontinenz 89 (72/17) 62 (18-144) 123 (0-420) 27 (5-23) 20 (5-50) 

Austretende Flüssigkeit und 
Verschmutzung 

42 (24/18) 62 (18-169) 178 (0-395) 40 (10–100) 21 (0-60) 

Normal (Kontrollen) 35 (19/16) 88 (43-164) 204 (62-380) 19 (5-60) 19 (10-40) 

Chronische Obstipation 41 (30/11) 88 (30-139) 173 (60-390) 43 (10-120) 25 (10-50) 
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